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[0317] The procedure of lVakePAT. MergePAT and
TransP/SI’ is similar to that descrbed above with refer-

ence to Fig. 21, except that the AID should be replaced
by the link information ofthe AID and the AID list should

be replaced by the link specifying AID list. Also, the pro-
cedure of SpfrtPAT is similar to that described above
with reference to Fig. 22, except mat the AID should be
replaced by the link information of the AID and the AID
list should be replaced by the link specitying AID list

[0318] Here. in the proceduresot Fig. 21 and Hg. 2,
the link specifying AID list generation is carried out
accorcfing to Fig. 49 as follows. Namely, a tuffer length
is determined first (step 89011) and a butter is gener-
ated (step S9012). Then. the link information of the
holder AID is copied to a vacant region of the generated
buffer (step S9017). That. the link irrlomation of the

member AID is copied to a vacant region at the resulting
butter (step $9018), and if the nod member AID acists
(step S9015 YES). the stat S9018 is repeated
[0319] Next. the determination of the link information
of the holda AID will be descrbed. Each of the Make-

PAT, the MergePAT. the SplitPAT, and the TransPAT com-
mands is defined to have two or more arguments. where
AID, PAT. or Enabler can be specified as an argument.
In this case, the PAT processing device specifies the link
information of the holder AID ofthe PAT to be outputted
after executing each command according to the follow-
ing rules

‘ Case of the MakePAT:
For the MakePAT command. it is defined that

AIDs are to be specified for the first argument to the
N.fl1ar9un-ef-|t(N_—_2'3‘ neaoluoc
blers are to be specified for the N+1 -th and subse-

quent arguments For exarmle. they can be
specified as follows.

Mal-rePAT AID1, AID2. - - - - - - - -, AIDN.
Enabler of AID‘, Enabler of AIDE,
~ - - -- -- -.EnabIerofAIDN

The PAT processing device interprets the link
information of AID of the first argument of the Make-

PAT command as the link irlfornation the holderAID.

Only when one of the Enablers ol the N+t-th

and subsequent arguments corresponds to the AID
of the first argument. the PAT processing device
specifies the link infomlation of this AID (that is the
link intorrnation of the AID of the first argument) as
the link intormation of the holder AID at the PAT to

be outputted after arecuting the Mal<ePAT com-
mand.

' Case of the MergePAT:
For the MergePAT command. it is defined that

PATs are to be specified for thefirst argument to the
N-thargument(N=2.3. - - - - - - - -)andEna-
bier is to be specified for the N+t-th argument

IO

15

85

50

Namely,theycanbespecifiedasfollows.

MergePATPA|’,PAT2 - - - ~ - -' - PATN Ena-
bIerofAlD

The PAT processing device interprets the link
infon'nationottt'leholdaAtDotthePATottl'netirst

argument of the MergePAT command as the link
informationofthehoIderAIDofthePAl'tobeout-

puttedatterexecutingthe MergePATcomrnand.
Only when the Enabler of the N+1 -th argument

corresponds tothe holder AID ot the PAT of the fist
argument. the PAT processing device specifies the
Iink intormationofthis AID (thatisthe link informa-
tionofthehoIderAlDotthePAl'ofthetirstargu-
merlt)asthefirtkinfom\ationotthel1o|derAlDof
the PATtobeoutputted after executing the Merge-
PATcommand.

CaseottheSptitPAT:
FortheSpIitPAToommand. itisdefinedthat

PATisIobespecifiedforthefirstargtm1a1t.asetot
oneormoreAlDsgroupedtngethabysornepre-
scrbedsynbolshssurnedtobeparenthesesoin
this example) are to be specified tor the second
argumenttotheN-Ihargurnent(N=3,4,
- - - - - - --).andEnablerist:obespecitiedfor
theN+1-thargurnenf. Namely.theycanbespeci-
tiedasfoflows

5051957 P571 (N911)
(NDN1

Atom) rambler of AID

(N021 N022)
NDN2

cuoolcnc - - . - . . .-

The PA!‘ processing device interprets the link
inbm1ation0ffl'leInldaAlDoHhePATdthefist
a'gurnentoIthe SplitPATcommand asthe link infor-
mationotthehohterAlDotthePATtobeoutputted
after executing the SptitPAT command.

Only whenthe Enabler of the N+t-th argument
corresponds tothe holder AID of the PAT otthe first
argument. the PAT processing device specifies the
link information of this AID (that is the link informa-
tionoftheholderAlDofIhe PAI'otthefirstargu-
ment)Ias the link information of the holder AID of
the PAT to be outputted after executing the SpfrtPAT
command.
Case at the TransPAT:

For the TransPAT commarld. it is defined that

PATs are to be specified for the first argument and
.. the second argument, an AID is to be specified for

the third argument. and Enablers are to be sped-
fied for the fourth argument and the fifth argument.
Namely. they can be specified as follows.

TransPAT PAT1 PAT2 AID Enabler of AID1 Ena-
bler of AID2

The PAT processing device interprets the link
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information ct AID of the third argument as the link
information otthe holder AID otthe PATtobeout~

putted after executing the TransPAT command pro-
vided that the link inlormation of AID of the third

argument of the TransPAT command is contained in
the PAT at the second argument

Only when the Enabler oi the fourth argument
corresponds to both the PAT of the tirst argument
and the PAT of the second argument and the Ena-
bier ofthe fifth argument conspondsto the AID oi
the third argument. the PAT processing device
specifies the link information of the AID of the third
argument as the link information oi the holder AID
ot the PAT to be outputted atter executing the Trans-
PAT command.

Next. the determination of the link intormations
of the member AlDs will be described The defini-

tions ot the MakePAT, the MergePAT, the SplitPAT.
and the TransPAT commands are as desabed

above. The PAT processing device mecities the link
inforrnations of the member AlDs oi the PAT to be

outputted after executing each command according
to the following rules
Case at the MalrePAT:

Only when the link information of the holder
AID of the P/(T to be outputted after executing the
MakePAT oonanand ‘s tormally determined, the PAT
processing darice interprets all the link informa-
tionsoftheAIDsotthesecond andsubsequent
arguments of the MakePAT command as the link
informationsotthememberAlDs otthe PATtobe

outputted after executing the MakePAT command.
The PAT processing device specifies only the

link intormations of those AlDs among all the AlDs
of the second and subsequent arguments which
conespond to the Enablers specified by the N-+1-th
and subsequent arguments as the link informations
otthe member AIDsof the PAT to be outputted after
executing the MakePAT command.
Case at the MergePAT:

Only when the link intormation oi the holder
Alootthe PA1'tobeoutputted afterexecutingthe
MergePAT command is formally determined, the
PAT processing device specifies the link interma-
tions ot the member AlDs ot all the PATs specified
by the first to N-th arguments of the MergePAT as
the link intormations of the member AlDs of the PAT

to be outputted atter executing the MergePAT com-
mand.

Case of the SpIitPAT:
Only when the link information ot the holder

AID of the PAT to be outputted after executing the
SplitPAT command is fomtally determined. the PAT
processing device specifies the link information of
the member AID ot the PAT specified by the first
argument of the SpfrtPAT conrnand as the link infor-
mation of the menber AID of the PAT to be output-
ted after executing the SpIitPAT command. At this
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point, the link inlomations ofthemerrber AlDs are
distrbuted into diffaent PAl's in urfits ct parenthe-
seso. Forexarrpleinthewseot:

SDIHPAT PAT (AID11)
(NDN1

Atom) Enabter ot AID

(AID21 AID-22)
Atom

noonoocc cocon--o

(AlDN1AlDN2 - - - - - - - - ArDN,,,)vraIbethe link infor-
mationsotthemerrberAIDsotditferentPATshavinga
common link information of holderAlD.
' CaseolTransPAT:

Only when the link information of the holder
AID ot the PATto beoumutted alter exewting the
TransPAT command is formally determined, the PAT
processing device aaeciliesallthelink informations
of the member AlDs remaining afta excluding the
lir1kirrfonrtati<>ncitttiemermerAIDthatissdwed—
uledtobeanewhoIderAlDtromalthe§nkinfor-

rratiorIsotthemen1:erAlDsottI1ePATspecitiedby
thefnst argument otthe TransPRI' contnand and
theIrril<irt§on11atiorisotthemerriberAlDsottI1ePAr

specitiedbythesecondatgurnentesthefirikirrfor-
nationsolthemerrberAlDsotthePATtobeout—

putted after eracuting the TransPAT command.
ThevaiticationotthepropernessottheEna-

bier in this seventh entzodiment is the same as

descrbedaI:ovewithreterericetoI'-‘rg.24.Also.tt1is
veriricationofthepropemessottheEnableriscorn-
mon to the MakePN. the MergePAT. the SpitPKr
andtheTransPAI'.

[0320] Next. the eighth enbodment ot the email
access control scheme accnlfing to the present ‘man-
tion will be desaibed in detait

[0321] lnthiseigtrthenbodment.theOlDisgivenby
a real email address

[0322] ThePAT'sanintornationcomprisingtwoor
morereaIemailaddresses.theholderindet.theva1idity
period. the transfer control flag and the PAT processing
device identifier (orthe oi the PAT processing
obiectonthenetwork),whichissigned using asecret
kzeyotthe PATprccessingdevice(orthe Pfirprocessing
object on the network).
[0323] Here. one of the real email addresses is a
holder email address of this PAT. Where the change of
the information contained inthe PATsuch as an addtion

of email adtress to the PAT. a deletion of email address

from the PAT. a change of the validity period in the PAT,
a change of the transfer control flag value in the PA‘I',
etc., an be made by presenting the holder email
address and an Enabler containing the holder email
address to the PAT processing device (or the PAT
processing object on the network).
[0324] On the other hand. the email addresses other
than the holder email address that are contained in the

PAT are all member email addresses, where a change

Petitioner Apple Inc. — Exhibit 1002, p. 3502



Petitioner Apple Inc. - Exhibit 1002, p. 3503

73

of the information contained in the PAT cannot be made
even when the member email address and an Enabler

containing the menber emafl address are presented to
the PAT processing derice (or the PAT processing object
on the network).

[0325] The holder index is a numerical data for identi-
lylngthe holder enail address. which isdelined totake

a value 1 when the holder email address is a top email
address in the email address list formed trom the holder

entail address and the member email addresses, a
value 2 when the holder email address is a second

email aidress from thetqaofthe email address list, or
a value n when the holds email address is an n-th email

address from the top of the email address list
[0326] The transfer control flag value is defined to take
either 0 or 1.

[0327] The holder email address is defined to be a real

ermil address which iswritten at aposition speciied by

the holder index in the email ackiress list The menber
email addresses are ddined to be all the email
addresses other than the holder email address.

[0328] The validityperiod isdefinedbyanyoneor
oon1binationotthenumberottimesforwlid1thePATis

available. the absolute time (UTC) by which the PET
beoomesunavailable. theabsolutetime(UTC) bywhich
the PAT becomes available, and the relative time (life-
time) since the PAT becomes available until it becomes
unavailable.

[0:29] The identifier of the PAT processing device (or
thePATprocessingobieclonthenetwork)isdefmedas
aseria.lnumberotthePATprocessingdevice(oranrfis-
tinguished name of the PKI’ processing object on the
network). The secret key at the PAT processing device
(or the PATprocessing object on the network) is delined
to be uniquely corresponding to the identifier.
[0330] Also in this eighth embodiment. an Enabler is
defined as an identitier corresponding to the real email

address. The Enabler is an infonnation comprising a
character string uniquely indicating that it is an Enabler
and a real email address itzselt, which is signed using the
secret key of the PAT processing device or the PAT
processing object on the network
[0331] The generation of the PAT in this eighth embod-
iment is carried out as follows.

[0332] Here. a directory will be descrbed as an exam-
ple of the PAT processing daject on the network The
directory manages the real email address and the dis-
closed information ot the user in correspondence. and
outputs the PAT upon receiving the search conditions
presented from an arbitrary user.
[0333] The user transnits the real email address and
the search conditions to the directory. Then, the direc-
tory acquires all the real email addresses which
uniquely correspond to the disclosed information that
satisfies thae search conditions. Then, the directory
generates a real email address list from the real email

address otthe user who presented the search condi-
tions and all the real entail addresses acquired as a
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search result Then. the directory appends the holder
index value. the validity period value. the transfer control
flag value, and the distinguished name ot the directory

to the real email address Fla. Fnafly. thedrrectory signs
the resultingdatausingasecretkayofthedirectory.
andtransmitsitasthe PATtotheuservimopresented
the search condtions

[0334] Next. the email access control in this eighth
embodiment is married out as follows

[0335] Thesenderspecifiestherealerrafl addressot
the sender in From: line. and “[PA‘l]@{real domain of
sender]' in T0: line of a nail. -
[0336] Thescsacquiresanernailreceivedbyan
MTA (Message Transfer Agent) such as SMTP (Sinple
Mail Transter Protocol). and carries out the authentica-
tion bythe following procature

(1) The signature at the FRI’ is verified using the
pi.bliclaeyotthePA1'.

Whe'nthePAl'istoundtohavebeenattered.

theernailiscfiscardedandtheprocessingistermi-
naietl.

when the PAT is found to have been not

altered. the totlowingprocessing (2) is executed.
(2)1'hesearchiscarriedoutbypresentirIglhe
sender‘sreal ernailaddresstothe PAT. '

Whenareal amiluidrthatcontpletely
matcheswitt1thesertder'srealerrtailatt1ressisnot

cor1tainedi1thePA1'.flteemailisdis¢ardedaridtl1e

processingisternirlated.
when a real anal addrx that completely

nratr:heswiththesender’sreal ernailaddressis

ccI't‘tai5rtedinthePA1'.thetoIowingproce$irig(3)is
enecuted

(8)'lhevalitityperiodvalueotthePATise\aluated.
WhenthePKl'isotnsidethevali:§typeriod.the

email is drstnrclai and the processing is termi-
nated.

WhenthePKI'iswitl'rinthe validity period. the
following processing (4) is executed.
mwhetherornottoautlienticatethesenderis
determined by reterring tothe transfer control flag
valueofthePAT.

when the value is 1. the challengelresponse
authaiticationbetweenthescsandthesender is

carriedout, andthesignatureotthe senderisveri-
tied. When the signature is vafid. the recipient is
specified andthe PATisattached. when the signa-
ture is invalid, the email is discarded and the
processing is terminated.

when the value is 0. the rec'pient is specified
and the PAT is attached without executing the chal-
lengelresponse authentication.

[0337] An exemplary challengelrwponse authentica-
tion between the SOS and the sender in this eight
embodiment can be carried out as tollows.

[0338] First. the SOS generates an arbitrary informa-
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tion such as a timestamp. tor ararrple. and transnits
the generated information to the sender.

[0339] Then. the sender generates the secret key and
the public key. signs the received inlorrration using the
secret key. and transmits it along with the public key.
[0340] The SCS then verifies the signature of the
received information using the public key presented
from the sender. When the signature is valid. the recipi-
errt is specified and the PAT is attached. When the sig-
nature is invalid, the email is discarded and the

processing is terninated.
[0341] The specifying of the recipient and the attach-
ing ot the PAT at the SCS in this eighth anbodiment can
be canied out as follows.

[0342] First, the SCS carries out the search by pre-
senting the sender's real email address to the PAT. so as
to acquire all the real email addresses which do not
conpletely match the senders real email address.

Then, all these acquired real email addresses are spec-
ified as reciplenrs real entail addreses.
[0343] Next. the SOS attaches the PAT to an arbitrary
position inthe email in crdertctransmit the PATto all
the rec'pient's email addressesso as to be able to real-

ize the bidirectional communications. Finally, the SCS
gives the ermil to the MTA

[0344] The receiving retusal with respect to the PAT at
the SCS in this eighth embodiment can be carried an
as follows.

[0345] Receiving refusal setting: 'lhe bidirectional
authenticationiscarriedoutbyartarbilrseyniemrs
between the user and the SCS5. Then. the usertrans-
mits a registration ccmrrand. his/her own real email
address, and arbitrary PATs to the S03 5. That, the
SCS 5 next verifies the signature at each received PAT
using a public key of the ADS. Those PATs with the
invalid signature are discarded by the SCS 5. When the
signature is valid. the SCS 5 carries out the search by
presenting the received real email address to each PAT.
For each of those PATs which contain the real enell

address that completely matches with the received real

entail address, the SCS 5 presents the registration com-
mand and the PAT to the storage device such that the
PAT is registered into the storage device. Those PATs
which do not contain the real email address that com-
pletely matches with the received real email address
are discarded by the SCS 5 without storing them into
the storage device.
[0346] Receiving retusal execution: The SCS 5 carries
out the search by presenting the PAT to the storage
device. When a PAT that corrpletely matches the pre-
sented PAT is registered in the storage device. the nail
is discarded. When a PAT that completely matches the
present PAT is not registered in the storage device. the
mail is not discarded.

[0347] Receiving refusal wncellation: The bidirec-

tional authentication is carried out by an arbitrary

means between the user and the SOS 5. Then. the user _
presents his/her own real email address to the SCS 5.
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Then. the SCS 5 next presents the presented real email
address as a search condition to the storage device and
acquire all the PATs that contain the presented real
email addrex. and then tresents all the acquired PATs
totheuser.Then.the userselectsallthe PATstcrwhich

the receiving refusal is to be cancelled by referring to all
the PATs presented from the SCS 5. and transmits all
the selected PATs along with a deletion comrrand to the
S08 5. Upon receiving the deletion command and all
the PATs tor which the receiving rehsal is to be can-
celled. the SOS 5 presents the deletion command and
all the PATs received from the user to the storage
detice, such that all the received PATs are deleted from

the storage device.

[0348] The editing ot the PAT in this eighth enbodi-
mentmnbecarriedoutaslotlows.

[0349] The MakePAT. the MergePRl', the SpfrtPAT. and
the Tra.rsPAT processings for the PAT using real email
addressesas its elements can be obtained irorn the the

MakePAT. the MergePAT. the Split?/Tl’. and the Tran-sPKl'
proce$ingsforthePATusingAtDsasitselemerrts
desubedabove. by repb.cingtheAlDbylhe real email
addressandIheEnablerotAlDby1heEnablerofreaI
ernefl addres.

[0350] ANulioperatorisanintnrmation corrprisinga
datawhich isurtiquelyindit-atirtgthatitis Milland which
hasatormatottherealemaieddress,whidiissigned
bythesecretkeyotthePA‘I’processingdeviceorthe
PAT processing daject on the netimrlc
[0351] sirrilarty.theGodoperatorisartintcrrrta§or1
comprising“ adatawhich‘ isuniqudy thatitis
Goda1dwl1ict1trasaforrrtatottt'iereatetrailacttress.

whicttissigitatbytttesecralreyoittief-Wl'procesairtg’
devicecrthePATpmce$ingcbjectorIthenetwoa1L
[0352] ‘lheEnablarctNi£operatcrisanintorniation
comprisingadatawhichisuniquely indicafatgthatitis
EnableraridtheNulioperatoritselt,vwricl1issigr\edby
thesecrakeyotthePAT prccessingdevice orthe PAT .
processing object on the network

[0353] The prccessings involving the Ndl operator
art! the God operator can be obtained trom the
processings tor the PAT using AlDs as its elements
described above, by replacing the AID by the real email
address. the Enabler at AID bythe Enabler or real email
address. the Null-AID by the Null operator. the God-AID
by the God operator. and the Enabler ct Null-AID by the
Enabler ot Null operator.
[0354] As desaibed. according to the present inven-
tion, a_PAT is used for verifying the access right of a
sender and the email access control among users is
carried out when the verilication result is valid. so that it
becomes poswle to disclose the information indicative
of characteristics of a user while concealing the true
identification of a user and canying out communications
appropriately according to this disclosed information

while preventing conventionally possible attacks from a
third person. In addition. even when a recipient receives
an attack fron1 a sender who maliciously utilizes the
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‘ anonymity, damages of a redpient due to that attack
can be minimized.

[0355] Also, according to the present invention, the
generation and the content change ot the personalized
accesstidretcanbemadebytheinitiativeotauserby
using an AID assigned to each user and an Enabler
dfined in oorreqaondence to the AID. so that it
bwomes possble to appropriately manage information
suchasthal ofa pointotcontactcteach merrberctthe

group communiration (mailing list. etc.) which changes
dynamically.

[0356] Also. according to the present invention, a Nutt-
AID and an Erlabler of Null-AID (‘an be introduced in

order to carry out the generation of a new PAT (Make-
PA'|') and the merging ot PATs (MergePAT) without giv-
ing the member AID and the Enabler of the member AlD
to the holder at the PAT. so that it becomes possble to
prevent the pretending using the member AID.
[0357] Also, according to the present invention. the
Null-AID can be used only as the holder AID ofthe PAT
(the Null-AID cannot be used as the merrber AID). that
S PAT<AlDN,_,. I AlD,,,emb.,,1, ‘ ' ' ' ‘ ‘ ' ',
AlDme,,,,,e,N > is allowed. but PAT<AIDhdde, I AIDNuu,
Alomembonv NDmembei2- ' ‘ ‘ ' ' ‘ ' '- Amnmiiberu >
is not allowed, so that the holder at PAT<AlD,.,,da, | AID-
mme, > cannot produce PAT<AID,M | AlDm,m,,e, >
from this PAT-:AlD,,dde, | AID,m,,,,,e, > as long as the
holder does not know Enabler of AlDme,,¢,,,
[0358] Also. according to the present invention." a
God~AlDcanbeintroducedinordertosetuparead
oniyattnbutetothe PAT, sothat itbecomespossbleto
fix the participants in the group communication.
[0359] Also. according to the present invention. the
link information tor uniquely specifying the AID can be
introduced and the PAT can be given in terms of the link
information such that the PAT does not contain the AID

itself. so that it becomes possible to realize the receiving
retusd function without using the AID itself.
[0360] It is to be noted that. besides those already
mentioned above, many modifications am variations of
the above embodiments may be made without depart-
ing trom the novel and advantageous features of the

’ present invention. Accordingly, all such rnodifications
and variations are intended to be included within the
scope of the appended claims.

Claims

1. A method of email access control, comprising the
steps of:

receiving a personalized access ticket contain-
ing a sender's identification and a rec‘pient's
identification in correspondence. which is pre-
sented by a sender who wishes to send an

email to a recipient so as to specify the recipi-
ent as en intended destination otthe email. at a

secure communication service for connecting

10

15

50

55

EPO946 022 A2 78

communications between the sender and the

receiver; and

oontrollirg accesses between the sender and
theredpientbyveritying anaccessrightcfthe
sender with respect to the recbient according
to the personalized access ticket at the secure

2. The method of ctaim 1, wherein at the controlling
step the secure comrnunication service authenti-
cates the personalized access ticket presented by
the sender. and refuses a delivery of the email
when the personalized access ticket presented by
the sender has been altered.

3. Themethodotciaimzwhereinthepersonalized
accessticlcetissignedbyasecretkeyotasecure
processing device which issued the personalized
accessticlnet andatthecontrollingstepthesecure
cornniuriit2fioriserviceatrlhenticatesthepersornl-
izedaccesstidtetbyverilyingasignatureoithe
secure processing device it the persondized
accessticketusingapubticlneyotthesecure
processingdevice

4. Themethodofclairntwhereinattlriereceiving
step the secure oornmunication service also
receives the sender's identfncation presented by
theserideralorigvwtltfliepersorzafizedaccess
tictcet.arIdattl1eoortti'ottirtgstepthesecurecorn-
rnrnicat$onservicet:t1eds\rmettiertt'teseridei’s

iderrliiirxtiortpresentedbythes-enderiscorlfiirled
inthepersonalizedaccessticlretxxeserrtedbythe
sender.andrdusesaddiveryottheana‘lwhen
thesender'sideritifi<:ationpresentedbyttiesender
isnotcontainedinthepersonalizedeooestiolret
presentedbythesender.

5. The method of claim 1. wherein the personalized
access ticket also contains a validity period indicat-
ingaperiodforwhidtthepersonalizedaccess
ticket is valid. and at the controlling step the secure
communication service chedrs the validity period’
contained in the personattzed access tidcet pre-
sented bythe senderandrettsesadeliveryotthe
email when the persoralized access ticket pre-
sented by the sender contains the validity period
that has already been expired.

6. The method of claim 5. wherein the validity period
ot the personalized access ticket is set by a trusted
third party.

7. The method of ciaim 1. further comprising the step
of:

issuing the personalized access ticket to the
sender at a directory service tor managing an
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identification of each registrant and a disclosed
information of each registrant which has a
lower seaecy than a personal information, in a
state which is accessible for search by unspec-
ified many. in response to search conditions
specified by the sender, by using an identifica-
tion of a registrant whose disclosed information
matches the search condtions as the recipi-
ents identification and the sender's identifica-

tion specified by the sender along with the
search conditions.

The method of claim 1, further comprising the stqa
of:

registering in advance the personalized access
ticket containing an identification of a specific
user from which a delivery of enails to a me-
cilic registrant is to be refused as the sender's
identification and an identification at the spe-
citic registrant as the recipient‘s
at the secure communication service;
wherein the controlling step the secure oom-

municetion service reluses a delivery ol the
ermil from the sender when the personalized
access ticket presented by the sender is regis-
tered therein in advance atthe registering step

The method of claim 8, further comprising the step
Of: .

deleting the personalized access ticket regis-
tered at the secure communication service

upon request from the specific registrant who
registered the personalized access ticket atthe
registering step.

10. The method of claim 1. wherein the personalized

12.

access ticket also contains a transfer control flag
indicating whether or not the sender should be
authenticated by the secure communication serv-
ice, and at the controlling step, when the transfer
control flag contained in the personalized access
ticket indicates that the sender should be authenti-
cated. the secure communication service authenti-

cates the sender's identification presented by the
sender and refuses a delivery of the email when an
authentication of the sender's identification tails.

. The method of ctaim 10, wherein the authentication

of the sender's identification is realized by a chat-
lenge/response procedure between the sender and
the secure communication service.

The method of claim 10. wherein the transfer con-

trol flag of the personalized access ticket is set by a
trusted third party.
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14.

15.

16.

17.

18.

19.

80

The method of claim 1, wherein the senders identi-

fication and the recipients identifitztion in the per-
sonalized aocess ticket are given by real email
addresses of the sender and the recipient,

The method of claim 1, wherein the senders identi-
ticationaridtheredpienfsiderttificationintheper-
sonalizedaocessticketaregiven byanonymous
identifications of the sender and the recipient.
where an anonymous identification of each user
contains at least one fragment of an official identiti-
catlonofeach userbywhidt eachuserisuniquely
identifiable by a certification authority.

The method otdaim 14, wheeln the anonymous
icle1tif'n<ztionofeactwserisanir1torn1atioricorrtain-

ing the at least onefiagment of the otfidal identifi-
aatiortofeachuserwtlidtissignedbythe
certiiicatiorrault\orityusingasecretkeyoftttecer-
titicationaulhority.

Themethodaldairnt4,whereir1theofficialiderlti-

ficationoleactnrserisacharacterstririguniquety
assignedtoear:tuser'bythecerfiicatiortaumority
andapufliclieyofeadtuserwhidraresignedbya
secretkeyotthecertificationauthority.

Themethodofclairn14,turthacorrprisingthestq)
of:

prohabiistically identifying an identity at the
serrderbyreconstructingtheotficial identiiica—
tiortotthesendebyiudgirtgiderrtityotaptt.n'al-
ityotanortymousiderIfi'cr:ationso!tt1esertde:
containedinapluralityotpersonatizedaccess
ticlcetstsedbythesenda.

The method of claim 1, wherein an anonymous
iderrtificationoteachuserttatoontainsatleastone

fragment of an official identitication of each user by
which each user is uniquely identifiable by a certifi-
mtioneuthorityandelinkintorrmtionoteach
anonymous idewtification by which each anony-
mous can be uniquely identitied are
defined. and the senders identification and the

recipients identification in the personalized awex
tidxet are given by a link inforrration of the anony-
mous idenfitication of the sender and a link informa-

tion of the anonymous identifimtion of the recipiderrt.

The method of claim 1. wherein the link information

of each anonymous identification is an identifier
uniquely assigned to each anonymous identifica-
tion by the certification authority.

20. The method of claim 18. further comprising the step
of:
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22.

23.

24.

25.

26.

81

p robabilistically identifying an identity of the
sender by reconstructing the official identifica-
tion of the sender byjudging identity at a plural-
ity of anonymous identifications ot the smder
corresponding to the link information contained
in a plurality ot personalized access tidrets
used by the sender.

The method ot claim 1, wherein the personalized
access ticket contains a single senders itentifica-
tion and a single recipient's identification in 1-to-1
conespondence. '

The method ot claim 1, wherein the personalized
access ticket contains a single sendefs identifica-
tion and a plurality at recipient's identifications in 1-
tc>N correspondence. where N is an integer greater
than 1.

The method of claim 22. wherein one identification

among the angle senders identification and the

plurality of recipients identifications is a holder
identification for identifying a holder of the personal-
ized access ticket while other identifications among
the single sender's identifitztion and the plurality of
recipient's identifications are member identifica-
tions for identifying members of a group to which
the holder belongs

The method ol claim 23. further comprising the step
of:

issuinganidenliticatior1otead'iuserendan
enablerottheident:'ficatioriofeachuseriridi-

eating a right to change the personalized
access ticket containing the identification of
each user as the holder identification, to each

user at a certification authority, such that pre-
scribed processing on the personalized access
ticket can be carried out at a secure processing
device only by a user who presented both the
holder identification contained in the personal-
ized aocess ticket amt the enabler correspond-

ing to the holder identification to the secure
processing device.

The method ol claim 24. wherein the certification

authority issues the enabler oi the identification of
each user as an information indicating that it is the
enabler and the identification at each user itself

which are signed by a secret key at the certifbioation
authority.

The method ol claim 24, wherein the prescribed

processing includes a generation of a new person-
alized access ticket. a merging of a plurality of per-
sonalized access tickets. a splitting at one
personalized access ticket into a plurality of person-
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30.

31.
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alized access tickets. achanging oithe holdercl
thepersonalized aocesstid<et.cluangingotava1id-
ityperiodotthepersonalizedeccessfiwetanda
changingofatr‘anstercontrolfhgotthepersonal-
izedaccessticket

‘lhemethodotdaim26.vohereinaspeoialidentifi-
cationandaspecialenablercorrespondirigtothe
specialidentificafiortwhiclrarekrimrrrtoallusers
are ddinedaichlhatthe gaiaationotanewper
sonalized access ticket and the changing ol the

hrJlderolthepersonalizedaocesstidoetcarrbecar-
riedoutbytheholderotthepersonalizedaocess
ticket by using the special identification and the
epecialenahlerwithoutusinganenablerotamern-
beridentitication.

The methodolclairn 27,whereinthespecial identi-
ficationisdefinedtobecapaueotbeingusedonly
as the holder identifirztion at the personalized
aocessliclet

Themett-iodotdaim26.whereinaspecialiderrtiti-
calionwltidtisknowntoallusersisdefitedsucli

thatareadorilyattri3utecanbesettott1epersorIal-
ized access ticket by using the special identifica-
tion.

Themethodotclaim1.where‘natthecontrollirig
step. when the access right of the sender with
respecttotherecipier'disver'fiedaotx:rdingtnthe
personaEz=edaooesstid<et.thesecurecorrururtica-
lion service‘ talmoutlherecipient‘s'‘ idenflication
fromthepersonatizedacoessficketby using the
senders identification presented by the sender.
converlsthenIailbyusingatakenoutrec‘pient's

identlficationiritoabnnatthatcanbeinterpreted
byamailtransterfunctiontoractuallycanyingouta
mail-delivery processing. and gives the mail after
oorrversiontoihemailtransiahmdionbyattaclting
thepersonalizedaccessticket_

A method of email access control, comprising the
steps of:

defining an oliicial of each user by
which each user is uniquely identifable by a
certification authority. and an anonymous iden-
tification at each user containing at least one
fragment of the otiicial identification; and
identifying each user by the anonymous identi-
fication of each user in cornrrunications tor
emails on a communication network

32. The method of claim 31, wherein the anonymous
identification of each user is an information contain-

ing the at least one fragment of the official identiti-
cation of each user which is signed by the
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cenitication authority using a secret ley at the cer-
tilication authority.

. The method ol claim 31. wherein the ottidal identi-

fication of each user is a character string uniquely
assigned to each user by the certification authority
andapublickeyoleachuserwhicharesignedbya
secret key of the certitication authority.

34. The method at claim 31. further comprising the
steps of:

receiving a personalized access ticket contain-

ing a sender's anonymous identilication and a
recipient's anonymous identification in corre-
spondence, which is presented by a sender
whowishestosendanemailtoareciplentso
as to specify the redpient as an intended desti-
nation of the entail, at a secure communication

service tor comecting communications
between the sender and the receiver; and
controlling accesses between the sends and
the recipient by verifying an access right at the
sender with respect to the recipient according
tothepersonalized accessticketatthesecure
communication senrice.

35. Themethodofclairn34,turttiercontprisirIgthestep
of:

probabilistically identifying an identity of the
sender at the secure communication service by
reconstructing the ofliciel identification of the
seruer while judging identity of a plurality of
anonymous identifications ot the sender con-
tained in a plurality of personalized access tick-
ets used by the sewer.

36. The method of claim 31. wherein the defiring step
also defines a link intonnation of each anonymous
identification by which each anonymous identifica-
tion can be uniquely identified. and each anony-
mous idenlilication also contains the link

information at each anonymous identification.

. The method of claim 36, wherein the link interma-
tion of each anonymous identification is an identitier
uniquely assigned to each anonymous identilica-
tion by the certification authority.

. The method of claim 36. further comprising the
steps ot:

receiving a personalized access ticket contain»
ing a link information of a sender's anonymous
identification and a link information of a recipi-
ent's anonymous identification in correspond-
ence, which is presented by a sender who

5

I0

15

45

wishestosendanemafltoarecipientsoasto
- specifytherecipientasanintendeddesfination

ottheenI1il,ataseci.ireoornmurication serv-
ice for connecting cunrrunications between
thesenderandthereceiver.and

controlling accesses between the sender and

therecipiembyverityinganaccessrightotttie
senderwithrespecttotherecipientaccording
tothepersonalizedaccessticketatthesecure
communicationservice.

39. The method of claim 38. further comprising the step
Of:

probabilistically identifying an identity oi the
sender by reconstructing the oliicial identifica-
tion of the senderwhile judging identity at a plu-
rality cl anonymous identifications of the
sender corresponding to the link intorrnation
contained in apluralityotpersonalized access
tickets used by the sender.

40.Acorrirriunitationsystemrealizirrgema.ilaocess
control. conprising:

a corrmunication networkto which a plurality of
userterrrinaisarecomectedzand
a secure corrurunimlion service device for

networK,byreceiv-ingapeisonalized acces
ticl<etcontain’ingaserdei"sIdentii'‘nation’ anda
redpienfs in correspondence.
\vtid1ispresentadbyasaIde’wt1owisl'Iesb
ser1danernaitoarec‘pierttsoastospecityti'ie
recipient as an intended destination of the
email, and controlling accesses between the
senderandtherecipientbyverityinganaccess
rightotthesenderwithrespecttothe recipient
acmidingtothe personalized accessticket-

- 41. The system oi deim 40. wherein the secure com-
nunication service device authenticates the per-
sonalized access ticket presented by the sender.
and refuses a clelivay oi the ernafl when the per-
sonalized access ticket presented by the sender
has been altered.

42. The system of claim 41, further comprising:

a secure processing device for issuing the per-
sonalized accessticketwhichissignedby a
secret key of the secure processing device;
wherein the secure communication service

device authenticates the personalized acces
ticket by verifying a signature at the secure
processing device in the personalized access
ticket using a public key of the secure process-
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43.

ing device.

The system of claim 40. wherein the secure corn-
munication service device also receives the

sender's identification presented by the sender
along with the personalized acce$ ticket. checks

whether the senders identification presemed by the
' sender is contained in the personafized access

ticket presented by the sender, and retuses e deliv-
ery ot the errail when the sender's identification
presented by the sender is not contained in the per-
sonalized access ticket presented by the sender.

The system at claim 40. wherein the personalized
access ticket also contains a validity period indicat-
ing a period tor which the personalized access
ticket is valid. and the secure comrmnication serv-

ice device checks the validity period contained in
the personalized access ticket presented by the

_ senderand refusesadeliveryofthe enailwhenthe

45.

46.

47.

personafized access ticket presented by the sender
contains the validity period that has already been
expired.

The ul claim 44. turther comprising:

a trusted third party for setting the vafidity
period at the personalized access ticket.

The system at claim 40, lurther conprising:

a directory service device for nanaging an
identificefionofeachregistrantandartdedis
closed of each registrant which has
a lower secrecy than a persoml intcrmation. in
a state which is accessible for search by
unwecilied nany, and issuing the personalized
access ticket to me sender in response to ’
search conditions specified by the sender. by
using an identification of a registrant whose
disclosed intormation matches the search con-

ditions as the recipient's identification and the
sender's identification specified by the sender
along with the search cnnditions

The system of ctaim 40. wherein the secure com-
munication service device registers in advance the
personafized access ticket containing an identifica-
tion at a specific user from which a delivery of
emails In a specific registrant is to be refused as the
sender's and an identification of the

specific registrant as the recipients identification,
and retuses a delivery at the email from the sender
when the personalized access ticket presented by
the sender is registered therein in advance.

The system oi claim 47. wherein the secure com-

. munication service device deletes the personalized

EPO94-6022A2
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access ticket registered therein upon request from
the specific registrant who ragistered the personal-
ized access ticket

49. Thesystemo1claim40.whereirIthepersonalized
accesstidcetalsocorrtainsatransfercorrtrotlhg

whetha or not the sender shoutd be
authenticated bythesecurecommunication serv-
ice.andwl1ertthetranstercorttrolflag_<xntainedin
the personalized access ticka indcates that the
sender shouldbeauthenticated. the secure com-
rmnication service device authenticates the

seru1ersidentil"i¢*.ationpresenta.lbythesertderartd
retusesadeliveryaltheemailwhenanar.rthentica-
tiorIotthesender’sideu-Ifiticationtails

The system 01 claim 49, wherein the authentication
ot the senders identification is realized by a chal-
lengdresponse procedure between the sender and
the secure communication service device

The system of claim 49. further corrprising a
trustedthirdpartytorsettirlgthetransteroontrolftag
otthepersonelizedaccesstideet.

52. Thesysternotclaim40.whereinthesender'sider1-
tificatior1andtherecipier1t'siderrtificationintheper—
sonalizedawessficketaregivenbyreal errail
atfiressesotthesenderandtherecipient.

53. Thesysternotctairn40,h:rthercor1;xising:

a atahority device for issuing an
anonymous at each user which
containsatleastonetragmentotanotticial
identifcationof each userbywhich eachuser
is uriquely identifiable by the certification
authority device:
wherein the senders identification and the

recipients identification in the personalized
access ticlet are given by anonymous identiti-
cafions ot the sender and the recipient.

54. The system at claim 53. wherein the anonymous
identification at each user is an inforrmtion contain-

ing the at least one fragment ot the official identifi-
cationoteach userwhidtissignedbythe
certification authority device using a secret key 01‘
the certification authority device

55. The system at claim 53. wherein the official identifi-
cation of each user is a character string uniquely
asigned to eadt user by the certitiation authority
deviceandapublickeyeteachuserwhichare
signed by a secret key at the certification authority
device. ‘

56. The system of claim 53, wherein the secure corn-
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57.

58.
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municaticn service device probabilistirnlly identifies
an identity of the sender by reconstructing the criti-
cial identification of the sender while judging iden-
tity ot a plurality at anonymous identifications ot the
sender comained in a plurality of personaliz
access tidrets used by the sender. '

The system of claim 40. further comprising:

a oertilicaticn authority device for issuing an
anonymous identification oi each user which
contains at least one fragment of an official

identificationoteadiuserbywhicheachuser
is uniquely identifiable by the certi'i"rcation
authority device and a link information of each
anonymous identilication by Whldi each anon-
ymous identifirztion can be uniquely identified;
wherein the sender's identification and the

recipimfs identfication in the personalized
access ticket are given by a link information of
the anonymous identifitztionotthesenderand

a link intorrration at the anonymous identifica-
tion of the recipient.

The system ot claim 57. whaein the link infome-

tionot eachanonymous identification is an identifier
uniquely assigned to each anonymous identifica-
tion by the certification authority device.

The system of claim 57, wherein the saaire com-
munication service device prtbabilistically identifies
an identity of the sender by reconstructing the atti-
c'al identification of the sender while judging iden-
tity at a plurality of anonyrnots identifications olthe
sender corresponding to the link information con-
tained in a plurality ct personalized access tickets
used by the sender.

. The system of claim 40. wherein the personalized
access ticket contains a single sender's iderrfifica-

.tion and a single recipient's identification in 1-to-1
correspondence.

. The system of claim 40, wherein the personalized
access ticket contains a single senders identifica-
tion and a plurality of recipient's identifications in 1-
to-N correspondence. where N is an integer greater
than 1.

The system of claim 61. wherein one identification
among the single senders identification and the
plurality of ra:ipient's identifications is a holder
identification for identifying a holder of the personal-
ized access ticket while other identifications among
the single sender's identification and the plurality of
recipier1l's identifications are merrber identifica-
tions tor identitying members ot a group to which
the holder belongs.
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63. The system of claim 62. further comprising:

acertificationauthoritydevicebrissuingto
eachuserartidentifirationoteacituserandan

enablerottheidewtilirzticnoteacti userindi-

eating a right to dtange the personalized
access ticket containing the identification of
each user as the holder identification: and

a secure processing device at which pre-
scrbad procesing on the persoralized aoces
tidcetcanbecarnedctnonlybya userwho
presented both the holder identitication con-
tained in the personalized access ticket and the
enabler corresponding to the holder identifica-
tion to the secure processing device.

64. The system ot ctaim 63. wherein the certification
authority device issues the enabler otthe identifica-

tiortoteadtuserasaninttxntatiortirtdicafirigtiiatit
istheenaialerartdtheiderititicaticnoteachuser

itseltwhicharesignedbyasecretleyotthecerti‘i-

65. The system oi claim 63, wherein the prescribed
processingindudesagenerationotanewperson-
alized acce$ ticket, a merging of a plurality at per-
sonalized access tidrets, a splitting of one
persoridizedaccesstidcetirrtnapluralilyofpersorv
alizedaccesstickets.adiar1giruotthehcIderot
thepeiscriaizedecoessfidet.o‘rarigingotevalid-
ityperiodcttheperscnalizedaccesstidretartda
charigirtgofatrartsiercontrolthgofthepersonal-
izedaccesstidret

66.Thesystemolclaim65.whereinaspecialidentiti-

67.

cationandaspecialembleroorrespondngtothe
special identification which are known to all users
are defited such that the generation of a new per-
sonalized ecces ticket and the changing at the
holderofthepersonatized accessticketcanbe rar-
ried out by the holder of the personalized access
tidret by using the special identification, and the
aaecial enabler without using an enazler of a mem-

The system at shim 66, wherein the special identi-
tication is defined to be capable of being used only
as the holder identification of the personalized
access tidret.

6& The system cl claim 65. wherein a special identiti-
aation whidi is known to all users is defined such

thatareadonlyattributecanbesettothepersonal-
ized access ticket by using the special identifica-
tion.

69. The system of claim 40. wherein when the access
right of the sender with respect to the recipient is
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73.
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veritied according to the personalized access ticket.
the secure comrmnication service device takes out

the recipient's identification from the personalized
access ticket by using the setters identification
presented bythe sender. converts the mail by using
a taken out rea‘pient‘s identification into a format

that can be interpreted by a mail transfer function
tor actually carrying out a mail delivery procesing,
and givesthe mailafterconversiontothemail
transfer function by attaching the personalized
access ticket

A communication system realizing anail access
control. comprising: ' '

a certification authority device tor defining an
otticlal identiflwtion at each user by which
each userisuniquefyiderrtiliablebythecertili-
cation authority device. and an anonyrnous
identiticatiort of each user which contains at

least one fragment of the official identification;
and

a cornnuniation network on which each user

is identified by the anonymous identification of
each userincornrmnimtionstorermilsonthe
commurirztion network ’

The system ofclaim 70,whereintheanonymous
Identrf'ncationoteachuserisaninlormationcorttarn-'

ingtheatleestor1etragmentottheotTir:ialidentiti-
cationoteadtuservmichissignedbythe
certificaticriauthoritydeviceusirigaseaetlreyot
thecertificationauthoritydevice.

The system at claim 70, wherein the official identifi- '
cation of each user is a character string uniquely
assigned to each user by the certification authority
device and a public key of each user which are
signed by a secret key of the authority
device.

The system of claim 70. turther comprising:

a secure communication service device for

connecting communications between the
serder and the receiver on the cornrrunication

network. by receiving a personalized access
ticket containing a senders anonymous identi-
fication and a recipient's anonymous identifica-
tion in correspondence. which is presented by
asenderwhowishestosend an emailtoa

recipient so as to specify the recipient as an
intended destination of the email, and commi-
ling accesses between the sender and the
redpient by verifying an access right 0! the
sender with respect to the rewient according
to the personalized access ticket.
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74. The system at «him 73, wherein the secure corn-
rmnication service device probabilistically
anidentityotthesenderbyreconstructingtheotti-
cial iteritificatimofttieseriderumitejtxtgingiiar
tityofapluralityctanonymousidentifirationscfthe
sender contained in a plurafity of personalized
accessticketsusedbythesender.

The in/stemotdaim 70,vvhereinthe certification
authority devioeaisoaefinesa link inlormation ot

anonymous identification can be uniquely identi-
fied.andeachanonymousiderttificationalsocon-
tainsthe linkintormationoteadtanonymous
.| .fi . .

The system of dalrn 75, wherein the link informa-
tior1ofeachanoriyrrtous‘rdentIt'ncatior1isariiderttrfi'er
uniquety assigned to each anonymous identifica-
tionbytheoertificaticrtauthoritydevice.

‘lhesysternofdairn75.tu'thercormrising:

.a semre communication service device for

connecting cornmunicaticns between the
senderandthereceiveronthecornrnunication

network. by receiving a personalized access
ticketcorttanng‘‘ aiirlkrntormation‘' ctasende’s
anonymousi1entitu:ahon'‘ andalinkintormatrom
ctarecipiermsar1orIynnusk1erfiscatioriirrcor-
reeporIdence.unichispreserItedbyasertder
wlnuéstiestnserdatertaiuaaredpieritso
estospecitytherecipientsaninterrleddesti
mtionoltheernai. anclcontrnting accesses
betweentheserIderandtheredpientbyverily-
inganaccessrightafthesenderwith respect
to the recipient according to the personalized
accessticket.

78. The system of chaim 77. wherein the secure corn-
rrunication service device probabilistically identities
an identityotthesenderby reconstructingtheotf-
dal at the sender white judging iden-
tityofaplurafltyotlirttrintormmiortsotarionynious

ot the sender contained in a plurality
of personalized access tickets used by the wnder.

71 Asecurecornntuniaationservicedeviceloruseina

communication system realizing email access con-
trol. corrprising:

a computer hardware; and
a computer software tor causing the computer
hardware to connect communimtions between

the sender and the receiver, by receiving a per-

sonalized access ticket containing a‘ senders
identification and a recipient's identification in
correspondence. which is presented by a
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senderwhowishestosend an email toarecip-
ientsoastospecitylherecipientasan
intended destination of the email, and control-
ling accesses between the sender and the
redpient by verifying an access right of the
sender with respect to the recipient acrxirding
to the personalize! access ticket.

80. The secure communication service device of claim
79,

wherein the conputer software causes the oornpu-
ter hardware to authenticate the personalized
access ticket presented by the sender. and refuse a
delivery of the email when the personaftzed access
ticket presented by the sender has been altered.

. The secure communication service device of claim
80.

wherein the personalized access ticket is signed by
a secret key of a secure processing device which
issuedthe personalized accessticket. andthecom-
puter software causes the corrputer hardware to
authenticate the personalized access ticket by veri-
fying a signature of the secure processing device in
thepersortalized accesstickel using aputiickeyot
the secure processing device.

. Thesecurecomr'rtunir:ationservicedeviceofclairn
79.

wherein the oorrputer software causes the corrpu-
ter hardware to also receive the sender's identitira-

tion presented by the sender along with the
personalized accis tidret. check whether the
sender's identification presented by the sender ‘s
contained in the personalized access ticlcet pre-
sented by the sender. and refuse a delivery of the
entail when the sender's identifhation presented by
the sender is rtct contained in the personalized
access ticket presented by the sender.

. The secure communication service device of claim
79.

wherein the personalized access ticket also con-
tains a Vmfdity period irtcficating a period for which
the personalized access ticket is valid. and the
computer software causes the computer hardware
to check the validity period contained in the person-
alized access ticket presented by the sertder and
rduse a delivery of the email when the personal-
ized access ticket presented by the sender contains
the validity period that has already been expired.

. The secure communication service device of claim
79.

wherein the corrputer software causes the compu-
ter hardware to register in advance the personal-
ized access ticket conteining an identification of a
specific user from which a delivery of emails to a
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specific registrant is to be refused as the senders
identification’ and an identification" of the specrhc"
registrant as the recipiertfs identitication. at the
secure communication service device. and retrse a

delivery otthe email trom the senderwhentheper-
sonalized access tidset presented by the sender is
registers! at the secure communication service

' device in advance.

85.

86.

89.

The secure communication service device of claim
84.

wherein the corrputer software causes the cornpu-
ter hardware to delete the personalized access
ticket registered at the secure corrmmication serv-
ice device rpon request from the specilic registram
who registered the pasonalized acox tidret

The secure cornrnurricationservicedeliceofdaim
79.

whereinthepersonatized aocessticl-rat also con-
tairlsatrarrstercorrtroltlagirvdcatirtgwttettverormt
theserI1erst'xtuldbeauthert§catedbythesecure
cor'nmr.rriicatiortservicedevioe.andwher1thetrarts-

fer control flag contained ‘at the personalized
accesstidret inciratesthatthesendershouldbe

authenticated, the cormuter software causes the
corrputer hardware to authenticate the sender's
iderrtificatiortpreserrtedbythesertderandretusea
deliveryottheertailwhenanautl1entirztionottfte
sendersidentiticationtafls.

The secure cormtunietion service device ot claim
86.

wherein the conputer software causes the corrpu-
terhardnaretorearrzetftearrtheruicationclttte

sertder's identification by a challengelresponse pro-
cedure between the sender and the secure cornrru-
nirztion service device.

The secure commuriratiorr service darioe of daim

79.
wherein the senda‘s identifiation and the recipi-
enfsidentification inthepersonalizedawessticket
arecivertbyanonymousidentificatiorrsotthe
sender and the redpient. where an anonymous
iderrtiticaticn of each user contains at least one

fragment of an otticial identification of each user by
which each user is uniquely identifiable by a certifi-
cation authority. and the computer software also
causes the computer hardware to probabilistically
identify an identity of the sender by reconstructing
the otficial identification of the senda by judging
identity of a plurality at anonymous identifications of
the sender contained in a plurality of personalized
access tidrets used by the sender.

The secure communication service device of claim

79.
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wherein an anonymous identititztion of each user
that contains at least one fragment of an otiicial
ideritifrcation of each user by which each user is
uniquely identifiable by a certification authority and
a link inlcrrnation of each anonymous identification
by which each anonymous identification can be
uniquely identified are ddined, the sender's identiti-
cation and the recipient's identification in the per-
sonalized access ticket are given by a link
information of the anonymous identification at the

sender and a link infomtation ot the anonymous
identification ot the recipient and the cormuter
software also causes the computer hardware to
probabilistically identify an identity of the sender by

reconstructing the official of the
sender by judging identity of a plurality cl anony-
mous identitications oi the sender corresponding to
the link information contained in a plurality 01 per-
sonalized access tickets used by the sender.

The secure corrirrunitztion servicedevice cl claim
79.

wherein when the access right of the sender with
respect to the recipient is verified according to the
personalized access ticket, the computer software
causes the corrputer hardware to take out the
recipient's iderrtilication from the personalized
am tidret by using the sender's identification
presented by the sender, convert the mail by using
a taken out recipients identification into a format
thatcanbe irrterpretedbyamailtranslerturiction
tor actually carrying out a mail delivery processing.
and givethe mail atterconversiontothemailtrans—
ler function by attaching the personalized access
ticket

A secure processing darice for use in a communi-
cation system realizing email access control, com-
prising:

a computer hardware; and
a computer software tor causing the computer
hardware to receive a request for a personal-
ized access ticket trom a user. and issue a per-
sonalized "access ticket containing a sender's
identification ard a recipients identification in
correspondence. which is signed by a secret
key at the secure processing device

A directory service device tor use in a communica-

_ tion system realizing email access control. compris-
mg:

a computer hardware; and
a computer software for causing the computer
hardware to manage an identilicaticn of each _
registrant and a disclosed information 01 each
registrant which has a lower secrecy than a

25
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personal information. in a state which is acces-
sible for search by unspecified many. and issue
a personalized access ticket containing a
senders identification and a recipients identiti-

cation in correspondence. to the sender in
response to search conditions spedfied by the
sender,byusing aniderrtilicationctaregistrarrt
whose disclosed intormation matches the

search conditions as the recipient's identifica-
tion and the senders specilied by
the sender along with the search conditions

93. A certification authority device tor use in a commu-
ritztion system reafizing email access control,
comprising:

acomputerhardware:and -
accrnputer softwaretorcausirigtheoortputer
mrdirraretoissuetoeactrLseranolTicialiden-

tificationoteachuserbywhicheachuseris
uniquely ideritifablebytheoertiticatiori author-

eacttuserwhidwcorrtainsatleaaonetragrriem
ottheotticieliderrtitimtion.

94. Acertil"rcationauthoritydevicetoruseir1aoommu-
nrcation system reafizing email access control.
oorrprising:

acompi.iterhardaare:am
arxzrrtrziitersofhniarettxcairsirtgttieccrmxlter
harduraretoissuetoeadiuseraniderititirzfion
oteactuiserandanertatzleroftheiderititication

oteachusei'ir'rii<:atingarigltttodiartgearty
personalized access ticket that contains the
idenfiicationoteachuseresa holderidentifi~

cation. where the persnalized access ticket
generally contains a sender's identification and
aplumlityot recipients iden1Hcationslncorre-
spondence, and oneotthesendefs identifica-
tion and the recipient's identifications is a
holderidentitication

95. A_secueproce$inqdevicetorr.iseinacommurii-
cation system realizing email access control. corn-
prising:

a computer hardware: and
a computer software for causing the computer
hardware to receive from a user a request for
prescribed processing on a personalized
access ticket containing a senders identifica-
tion and a plurality of recipient's identifications
in correspondence. where one of the senders
identification am the recipient's identifications
is a holder identification, and execute the pre-
scribed processing on the personalized access
tidret when the user presented both the holder
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identification contained in the personalized
access ticket and an enabler corresponding to
the holder identification which indicates a right

to dtange the personalized access ticket con-
taining the identification at the user as the
holder identification.

A computer usable medium having computer read-
able program code means embcded therein for
causing acomputertofuncticn as a secure commu-
nication service device for use in a communication

system realizing er-nail access contol, the compu-
ter readable program code means includes:

first computer readable program code means
for rausing said oonputer to rweive a person-
alized access ticket containing a sanders iden-
tification and a reo'pient‘s identification in
correspondence. which 3 presented by a
senderwhcwishestosendan emailtoarecip-
ient so as to specify the recipient as an
intended destination of the email; and

semnd ocnputer readable progam code
means for causing said computer to corrupt
accesses between the sender and the recbient
by verifying an access right of the sender with
respect to the recipient according to the per-
sor1alizedaccessticket.soasto connectccm-
munications between the sender and the
receiver on the communication network.

. The computer usable medium of claim 96. the sec-
ond computer remable program code means
uses said oorrputer to authenticate the personal-
ized access ticket presented by the sender. and
refuse a delivery of the er'nail when the personal-
ized access tidtet presented by the sender has
been altered.

The conputer usable medium of claim 97. wherein
the personalized access ticket is signed by a secret
key of a secure processing device which issued the
personalized access ticket, and the second compu-
ter readable program code means causes said
computer to authenticate the personalized access
ticket by verifying a signature of the secure
processing device in the personalized access ticloet
using a public key of the sewre processing device.

. The conputer usable mmlium of claim 96. wherein
the first ocnputer readable program code means
causes said computer to also receive the sender's
identification presented by the sender along with
the personalized access ticket. and the swcnd
computer readable program code means causes
said computer to check whether the senders iden-
tification presented by the sender is contained in
the personafrzed access ticket presented by the
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senderand reluseadeliveryoftheemailwhenthe
sender's identlfimticn presalted by the sender is
nctccr1tainedinthepersonalizedaccesstid<etpre-
sentedbythesender.

1(ll.The ccnputer usable medurn of claim 96. wherein
thepersonalizedaccessticketalsocorrtairrsavalid-
itypericdindicatingapericdtorwhichthepersor'ral-
izedaccestirzlretisvalidandtliesecoridcornputer

readableprogramcodemeanscausessaidcormw
tertocheckthevaIidityperiodcorrtainediritheper-
scnalized access tidcet presented by the sender
andrefuseaddiverycftheerrrailwhenthepersow
alized access ticket presented by the sender con-
hins the valillily period that has alreaiy been
attired.

101.The conouter usable medium of claim 96, wherein
the mend computer readable program code
mearrscausessaidcorrputertoregisterinadvance
thepersorraizedaccessticketcontairrirrganiderrti-
ficatiorIofaspet:iicuserfrcrnvvl'ridraddiver'yof
ernailstcasperificregistrarttistoberettrsedasthe
serrdersiderrtificeticrrarrdaniderrtifrcatiorwctthe

specific registrant‘ astherecrprer'rt’s'' identfl icahcn'.at
the secure ocmrrunication service device. and

retuseadeliverycftheerrrailtromthesenderwhen
the persorrafized access ticket presented by the
serrder'isregister'edattheseci.Iecommr1icatiorr
servicedeviceiradvance

1ozThe ccrrpulaer usable medum of claim 101,
wherein be second ccrrputer remable program
code mears cases said ccrrputer to delete the
personaizedaccesstidretregistered atthe secure
communication service device upon request from
the specific registrantwhcregistered the persoral-
izedaccessticket.

t03.The ccrrputer usable medium of claim 96, wherein
the personalized access ticket also contains a
transfer ccntrolgflag indicating whether or not the
sendersl'rorddbeautharticatedbyfhesecureoorrr-
municationservicedarice. andwhenthetransfer

control flag contained in the personalized access
ticket indicates that the sender should be authenti-

sated, the second corrputer readable program
code means causes said mmputer to authenticate

the sender's ideritificatiorr presented by the sender
- and refuse a delivery of the errail when an authen-

tication of the sender's identification fails.

104.The computer usable medium of claim 103.
wherein the second computer readable program
code means causes said computer to realize the
authentication of the sender's identifimtion by a
challenge/response procedure between the sender
and the secure communication service device.
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105.The computer usable medium of claim 96, wherein
the sender's identification and the recipient's identi-
fication in the personalized access ticket are given
by anonymous identifications ot the sender and the
recipient. where an anonymous iderttification of
eachusercontainsatleastonefragmentotanotii-
cial identification ot each user by which eadw user is
uniquety identifiable by a certification authority. and
the second conputer readable program code
means also causes said computer to probabilisti-
cally identify an identity at the sender by recon-
structing the office! identification of the sender by
judging identity of a plurality of anonymous identiti-
cations ot the sender contained in a plurality of per-
sonalized acoess tickets used by the sender.

106.The computer usable medium of claim 96. wherein
an anonymous identificafion orleadw userthatcon-
tains at least one fragment at an otficial

tion of each user by whidt eadt user is uniquely
identifatie by a certification authority and a link
information of each anonymous identification by
which each anonymous identification can be

uniquely identified are defined. the sender's identiti-
cation and the rec'pient's iderrfifitz-ttim in the per-
sonalized access ticket are given by a link
information ot the anonymous identiication of the
sender amt a link information at the anonymous
identification of the recipient. and the second com-
puter readable program code means also causes
said computer to probabifsticalty identify an identity
of the sender by reconstructing the official identiti-
tztionotthe senderbyjudgingidentityotepturality
of anonymous of the sender cone-
sponding to the link information contained in a plu-
rality of personalized access tickets used by the
sender.

107.The computer usable medium at claim 96. wherein
when the access right of the sender with respect to
the recipient is verified according to the personal-
ized access ticket. the second computer readable
program code means causes said ccnputer to take
out the recipients identification from the personal-
ized access ticket by using the sender's identifica-
tion presented by the sender. convert he nail by
using a taken out recipient's identification into a for-
mat that can be interpreted by a mail transter func-
tion tor actually rarrying out a nail delivery
processing, and give the mail after conversion to
the mail transter function by attaching the personal-
ized access ticket.

108.A computer usable mecfium having computer read-
able program code means errboded therein for

"causing a computer to function as a secure
processing device for use in a communication sys-
tem realizing email access control, the computer
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readabte program code means includes:

first oonputer readable. program code means

tor musing said cormuter to receive a request
torapersonalizedaccessticketfromauser:
and

secord conputer rmdable program code
means tor causing said computer to issue the
personalized aocas ticket containing a
sender's idmtification and a recipient's identifi-
cation in corremondence. which is signed by a
secret key of the secure processing device.

109.A conputer usable medium having ccnputer read-
able program code means errbodied therein tor
causingacornputertofuncfion as adirectoryserw
ice devicertor use in a communication system real-
izing errail access control. the conputer readable
pogam code mears includes:

firstcorrputerreadableprogramcodemearts
ior<ausirIgsai1r:orru.itertnnartageaniderrti—
t'irztionorleacl1registrantandadisclosedit1tor-
mationoteachregfstrant whichhasalower
secrecytmrtapersonalirttcrrrxatiorninastate
vvhidiisaccessibtetorsearchbyunspecified
many,arrt
secord corrputar readable program code
meatstonatrsirtgsaidcorrptrtertoissuea
personatized access tictet contairing a

_sendefsiderttit"rcatiortarIdare<:ipia1t'sider1titi-
cation ‘:1 correspondence. to the sender in
reqaonsebseerdtconditiortsspedtiedbythe
ser'xter.lryt.tsirIgarIidentit'natiorIotaregish'artt»
whose disclosed intornntion mautes the

search conditions as the recipients identifica-
tion and the sender's identification specilied by
the sender along with the search conditions.

1 10.A conputer usdale medium having computer read-'
able progiam code means errbodied therein tor
causingacomautertotunctionasacertitication
authoritydevicetorusein acommunicationsystem
realizing email access control. the computer reada-
ble program code means includes:

first computer readable program code means
torcausingsaidcorrputertoissuetoeachuser
an orlficial identification ot each user by which
each user is uniquely ‘tdentitiable by the certifi-
cation authority device; and
second ccrrputer readable program code
meansicrcausingsaidccnputertoissueto
each user an anonymous identification at each
user which contains at least one fragment of
the official identification.

t 11 .A conputer usable medium having computer read-
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able program code means emboded therein tor
causing a cormuter to function as a certification
authority device for use in a communication system

realizing email access control. the conputer reada-
ble program code means includes:

first computer reaiable program code means
torcausingsaidcomputertoissueto each user‘
an identification of each user; and

‘ second oorrputer readable program code
means tor causing said computer to issue to
each user an enabler of the identification of

each user indicating a right to change any per-
sonalized access ticketthat contains the identi-
fication of each use: as a holder identification,

where the persnalized access ticket generally
contains a senders identilication and a plurafity
of rea'pient's identifications in correspondence.
and one of the sender's identilication and the

recipient's identifications is a holder identifica-
tiort

112.A computer usable medum having cormuter read-
able program code means embocied therein for
causing a oortputer to function as a secure
processing device for use in a communimtion sys-
tem realizing email access control. the computer

readable program code means includes:

tirst corrputer readable program code means
torcausingsaidcomputertoreceivefroma
user a request tor prescribed processing on a
personalized access tidret containing a
serdefs iderrtitication and a plurality of recipi-
ent's identifications in correspondence. where
one ot the sender's identification and the recip-
ient‘s identifications is a holder identification;
and

second oorrputer readable program code
means tor causing said oonpuler to execute
the prescribed processing on the personalized
access ticket when the user presented both the
holder identification contained in the personal-
ized access ticket and an enabler correspond-
ing to the holder identification which indicates a
right to change the personalized access ticket
containing the identification ot the user as the
holder identification.
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FIG.4
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FIG.6
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System for communicating over a public network

(W) A system for communicating with a remote service
over a public network 18. such as the lnternet. includes a
client device 10 with a memory card 28 or the like, a card
reader 26 and a public network communication device
such as a personal computer or television, "and a
processor unlt. such as a central gateway 12, which is
located remotely from the client device "The memory card
includes user details which are transmitted by the client
device to the processor unit, and may be encrypted. The
card reader may activate communication with the

processor unit upon insertion of the memory card, which
may be a smart card or magnetic card. The processor unit
may determine which of a plurality of services 14,16 a user
is authorised to access. The system provides for secure
communication without burdenlng the user with
encryption or authorisation tasks.

  
Radandwriutu

Pemtifioos Va-ific3xionDatahas:

  
36 34

=8

" 2° 1‘ an
and cm

Services If

Vcrifiufion Dcubne [\)
ii El . w

mam: Services 5 1 U]
‘ -l>

A

At least one drawing originally filed was informal and the print reproduced here is taken from a later filed formal copy. >

Petitioner Apple Inc. — Exhibit 1002, p. 3562



Petitioner Apple Inc. - Exhibit 1002, p. 3563

1/2

 

 
 

 
 

  
 

2

10

Application & User ' _ ._ Intelligent Client
Smart Card Reader Device

Network Protocol (TCP/IP)

Client Software Component

Network Protocol (TCP/IP)

24

26

Authentication & HTTP Server for

   

Validation Central Gateway 112
Management Central

Server Access Read and Write to Gateway
Permissions Verification Database 34

14 20 34

1 l
Desired Private Network \
Services

llllflll

Verification Database 
Ill-Ellil

Desired Services

Fig 1

Petitioner Apple Inc. — Exhibit 1002, p. 3563



Petitioner Apple Inc. - Exhibit 1002, p. 3564

2/2

Insert Card

50

Enter PIN At

Prompt

52

 

 

 

  
  

 

  
 

 Reject User / Invalid Valid Authenticate

Offer Help Desk User for Desired
Service Service 

56 54 60

STOP

58

 Access or

52 Transaction on

Desired Service

64

Fig 2

Petitioner Apple Inc. — Exhibit 1002, p. 3564



Petitioner Apple Inc. - Exhibit 1002, p. 3565

10

15

20

30

23541 02

SECURITY SYSTEM

The present invention relates to a security system, for use for example in accessing

remote services such as on the Internet.

With the advent of modern technology, a growing number of transactions are being

carried out by the user across insecure networks. These can be, for example,

transactions involving confidential data and money for payment or investment. With

such transactions there are problems with security, fraud and so on. Various security

systems have been devised, such as use of personal identification numbers, encryption of

transmissions. While these systems usually work well for the particular environment for

whichthey havebeendesigned, theyeanbe anuisancetouseandmnbeidifficultor

expensive to implement for a new service provider. I

Systems have also been developed for Internet use. These systems concentrate on

authentication of the user and then, once this has been established, provide for un-

encrypted connection to the service. When particular transactions are undertaken, the

' service determines whether encryption is necessary, for example to secure credit card

details. Other solutions require entry of credit card details for each transaction. These

systems inevitably must provide a balance between security and user convenience as the

encryption mechanisms used cause additional work for andcnrnplication to the user.

The present invention seeks to provide an improved security system.

According to an aspect of the present invention, there is provided a security system for

communicating with a remote service over a public network including a user card or

other memory device, a user located card or memory device reader, a user located public

network communication device and a processor unit located remotely from the user

located public network communication device, wherein the user card includes user details

and the user located public network communication device is operable to transmit the

user details to the processor unit.
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Advantageously, the processor unit is operable to carry out encryption between it and the

user and to provide to the user a transparent path to the service. Thus, the user need not

be aware of any security steps taken or any encryption system used, this being carried

out by the card reader and the processor unit or central gateway.

The card may be any suitable device which can store user information and, preferably,

encryption data. The card, can for example be a smart card, a magnetic card such as a

credit/debit card or store loyalty card or any other suitable device. In addition to the

card, the user may be required to input a secret identification code, such as an

identification nmnber.

In the preferred embodiment, the system provides for the user to insert the card into

his/her card reader and to initiate the connection to the processor unit or central gateway.

Oncethe connection is made, theprocessorunitobtainstherelevantdata fromthecard

and upon verification by the identification code, allows the user access to the authorised

service without any intermediate tasks, such as requirements to encrypt or decrypt

transmitted data, to provide other user details and, where appropriate account or payment

details. Thus, as with the preferred embodiment, all communications between the

processor unit and the user can be encrypted, without the user necessarily being aware of

or involved in this encryption. The communication between the user and the processor

unit can therefore be totally secure yet without user inconvenience.

Advantageously, communications between the service and the processor unit, which are

preferably carried out via a secure link, need not be encrypted.

The splitting of the encryption from the service results in being able to provide a

dedicated encryption device, the processor unit, which can therefore be designed to

maximise encrypted communication efficiency. Typically, encryption of all

communications from the service unit is not practicable because the service unit is not

designed for such a task and even if it were it would result in a loss of efficiency in

providing the service itself.
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In the preferred embodiment, the processor unit is also able to determine which of a

plurality of services the user is authorised to access and/or the level of access such as

spending limit, and to control access to the service or relevant service on this basis. It

can also or alternatively undertake transactions against an account identified by the card.

An embodiment of the present invention is described below, by way of example only.

with reference to the accompanying drawings, in which: '

Figurelisaschematicdiagramofanembodimentofsecuritysystemcoupledtoa

processor unit or central gateway and aservice; and

Figure 2 is a flow chart of an example of validation routine for use with the system of

Figure l. " ‘

Referring to Figure 1, the embodiment of security system shown is designed for

comnrunications through the Internet or a similar public network. A

The system includes an intelligence client device 10, which may be a personal computer,

television, or any other suitable device which can communicate with a remote system. A

processor unit, in this example a central gateway 12 is coupled between the client -device

10 and one or more service units 14.

Communication between the client device 10 and the central gateway 12 is, in this

embodiment, via a public network 18 such as the Internet. Communication between the

central gateway 12 and the service units 14, 16 is, on the other hand, via a private

network 20 which cannot be accessed by the public.

The client device 10 is provided with an application and user interface 22; which can be

the usual computer devices such as monitor. keyboard and software in the case that it is a

personal computer; the screen and a suitable keyboard or keypad in the case that the
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device 10 is a television or any other suitable device. The device 10 could also be a

portable telephone with suitable display and keypad.

The device 10 also includes suitable network protocol 24 for allowing communication to

the gateway 12 through the chosen network 18 or other public transmission medium.

The device 10 also includes a card reader 26 designed for reading the card-type chosen

forthesystemand acard28whichis specifictothatuser. Thecar-d28couldbea'srnart

card or magnetic card of the types well known or any other portable memory device. lt

isenvisaged that the card 28 could have other functions in addition to the security

function for this system, for example it could also be a creditldebit mrd, store loyalty

card and the like.

The card 28 has stored thereon one or more user identifiers, one or more encryption keys 2

andthe desired service information, thatis detailsofthe servicetowhichtbeuser wants

access. His/her level of authorisation in the service and so on will be determined by the

central gateway 12.

The card reader 26 is designed, in the preferred embodiment, to be able to detect the

insertion of the card 28 thereinto and in response to such insertion to commence

immediately communication with the gateway 12 via the client device 10.

The central gateway 12 includes an encryption and network protocol stack 30 designed to

allow communication via the chosen public network 18 and to provide encryption of all

communications between itself and the client device 10. It also includes an

authentication and validation unit 32 for authenticating the client data from the client card

28. The authentication and validation unit 32 is coupled to a verification database 34 of

the gateway 12 in which is stored the identification data of all the users registered for the

services 14,16. The database 34 may be provided either within the gateway 12 or in a

remote database 34' accesses through secure network 20.
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The authentication and validation unit 32 is also coupled to server access permission unit

36 designed to control the type of access to the service units 14,16 in dependence upon

the user's authority.

5 Also provided in the gateway 12 are a typical HTTP server for management of the

gateway 12 and an authentication and attachment unit 38 for communicating with the

desired services 14,16 and with any remote verification database 34’. V

The central gateway 12 is designedspecifically for encrypting all comnumications over

10 the public network 18 and for carrying out the authentication procedure.

The operation of the this embodiment will now be described with refermee to Figure 2.

lnsertion50ofthecard28intothecardreader26promptsthecardreader26to

15 commence automatically the connection to the gateway 12. For this pxrpose, card reader

26 activates a software component in the device 10 to establish a communication link '

with the gateway 12 on the basis of inforrmtion stored on the card 28 about the location

2 on the Internet and access details of the gateway 12.

20 When a connection with the gateway 12 is established, the gateway 12 requests the user’s

personal identification code which is then inputted 52 at a suitable prompt on the user

interface 2.

Validation 54 of the user's details and identification code is carried out either internally

25 of the gateway 12, by the units 32 and 34, or externally at the verification database 34’.

V If the gateway 12 determines 54 that the user’s identification code is invalid, the user is

rejected 56 and the connection is cut 58. On the other hand. if it is determined 54 the

user's identification code is valid, the gateway 12 determines 60 the desired service 14,

30 16 and level of service to be provided and connects 62 to the desired service unit 14, 16.
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During the connection to the desired service 14, 16, all data transfers between the

gateway 12 and user device 10 are encrypted on the basis of the encryption keys on the

user’s card 28 and within verification database 34, while all data transfers between the

gateway 12 and the service units 14. 16 through the private network 20 are not encrypted

for ease of access and for increased efficiency. In practice, the user will not be aware of

the encryption between him/her and the gateway 12 as this will be carried out as a

background task. Moreover, the user will not need to re-confirm his/her identity or

financial details as these will be provided by the card 28 or gateway 12.

The gateway 12, in some embodiments, records the activities of the client, such as

transaction details, either within the gateway 12 or in a remote memory accessed via a

private network.

Disconnection from the services 14, 16 is, in this embodiment, effected simply by

removing 64 the card 28 from the card reader 26.

Thus, connection is made by a simple two step process ofinserting the card 28 into the

reader 26 and entering the user identification code and disconnection is effected by

removing the card 28 from the card reader 26. The user is not involved in any other

authentication or encryption process and need not re-enter personal details.

This system can be used for any remote service. including business to consumer (in

which case the card could be designed also to function as a store or credit card), business

to business (for example for transactions on account) and for internal networking (where

the activity of staff, for example, needs to be secured).

It will be apparent from the above that the system can provide simple but absolutely

secure access to a remote service. Moreover, by identifying the user to the desired

service, user access can be customised. By removing the need for entry of account

details, transactions into the desired service become quicker and less risky for the user's

perspective.
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Performance of the services can also be enhanced by carrying out the encryption tasks

within the gateway rather than in the service units.

In addition, the service company can establish a relationship with the user by providing

the user with the card and, possibly, also with the card reader.

It will beapbarent that the card 28 and card reader 26 could be confignred to

communicate with a plurality of separate gateways 12.
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CLAIMS

1. A security system for communicating with a remote service over a public network

including a user card or other memory device, a user located card or memory device

reader, a user located public network communication device and a processor unit located

remotely from the user located public network communication device, wherein the user

card includes user details and the user located public network communication device is

operable to transmit the user details to the processor unit.

2. A security system according to claim 1, wherein the processor unit is operable to

carry out encryption between itselfand the user.

3. Asecuritysystemaccordingtoclairnlor2,whereinthecardhasstoredthereon

user infomzation and, preferably, encryption data.

4. A security system according to claim 3, wherein the card is a smart card, a

magnetic card or any other suitable device.

5. A security system according to any preceding claim, wherein the card reader is

operable to activate communication with the remote processor means upon insertion of a

card thereinto.

6. A security system according to any preceding claim, wherein the processor unit is

operable to encrypt substantially all communications between the user and itself.

7. A security system according to any preceding claim, wherein the processor unit is

operable to determine which of a plurality of services a user is authenticated onto the

desired service.
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8. A security system substantially as hereinbcfore described with reference to and as

illustrated in the accompanying drawings.
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Real Time Tele-payment System

This invention is a mobile payment system that relates to payments of bills of the

mobile users, or providing the mobile users with the infonnation about their bank

account balance, the statement of account, or the movement on the account in a real

time basis, by using their portable telephones under any wireless telecommunications

systems.

BACKGROUND OF THE INVENTION

There are several mechanical and electronical payment systems for retail business

operations like, for example, what is introduced by US patent US-A-5 202 825, in

which a hand-held data terminal generates a record of purchases made by a customer

for charging a customer in accordance with customer-indicated payment preferences.

In these systems the waiter sends by use of a portable data tenninal the customer's

order to a customer service station which is a typical cash register based in the

restaurant. These systems reduces the time requirements for processing customers at

check-out counters in comparison with those of more traditional check-out procedures

of the recent past. These systems are only for sending the customer order to the cash

register in the retail business.

On the other hand in the fixed telecommunications networks a user (subscriber) can

be connected from his personal computer to his/her bank via telephone lines and

thereby pay his/her bills. In such systems user must use a data modern between his/her

computer and the telephone wire. Another disadvantage of such systems is that in

order to pay his/her bills, user must have access to a personal computer connected to

the fixed telephone infrastructure, therefore user mobility in such systems is

completely limited. Before this invention, there was no solution that provides the

portable/mobile telephone users with the possibilities to pay their bills by using their‘
personal portable telephones. There was also no payment system, based on use of

portable or mobile telephones, that could provide the retail or trading businesses with

the possibility to charge their customers in a real time basis; transferring the charges

from the customer's account to the account of the retail businessman. There continues

to exist a need to further improve the efficiencies of payment systems.

DESCRIPTION OF THE INVENTION

In order to serve such cun'ent need. the present invention provides a new and unique

mobile payment system. In the inventive system a portable telephone can be used in

order to pay bills or transfer money from a bank account to other, or request the bank

1
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for account iinfonnation. Certain features of the invention are intended as an

expansion of value-added services of currently existing mobile communications
systems. This invention addresses needs created by users mobility. _For example,
suppose that you are travelling and you want to pay a certain bill or transfer some
amount of money from your bank account to another person's account but you do not

have time for going to the bank or the bank may be closed and you may neither have

access to your personal computer (which can be connected to the bank via telephone

wire). This invention provides you the possibility to pay your bills, by using your

portable telephone while you are in move, regardless of are banks closed or not,
regardless of if it is night or weekend etc. This invention also provides the retail
businesses (for example restaurants) the possibility to charge their customers, via

wireless telecommunications networks, by using only the portable telephones. For

example, a waiter in a restaurant, after having entered the amount of payment and
customer's information (like account number etc.) to his/her portable tenninal can

send the payment infonnation to the inventive computing station, which is located in
the bank. In the computing station the customer's bank account will be charged in

accordance with the payment amount received from the waiter's portable telephone.

The most important advantage gained by the inventive system is that all mobile

telephone subscribers can pay their bills by using only their nonnal mobile telephones
(in which the mobile payment part is included) and their subscriber identity or codes,
without requiring any additional data modem, personal computer, and credit cards etc.
In this invention the subscriber identity and codes function as the credit card or bank

card of the portable terrninal's user.

By implementing the inventive mobile payment system a mobile user (subscriber) can
pay all his/her bills and handle ‘all his/her banking issues by only using his/her mobile
telephone and subscriber identity or codes, where ever under the coverage of a
wireless communications network. These and other improvements and advantages are

realised by providing _a portable telephone (hereafter called portable terminal)

including the inventive mobile payment part, and a computing ‘station which is based
in the bank. The present invention will now be described by way of examples with

reference to the accompanying drawings, in which:

Fig. 1 is a schematic representation of the inventive Real Time Tele-payment System.

Fig. 2 represents, as an general example, a payment flow diagram between the
portable terminal and the computing station, which is located in the bank.

Fig. 3 represents, as an general example, a payment flow diagram in which a mobile
user pays his/her bills or request the statement of his/her account by using his/her own

'74.
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portable telephone. In this figure also the payee is infonned about the reception of a
payment.

Fig. 4 is a schematic representation of two type of portable terminal: one is a normal

portable telephone that includes the inventive mobile payment part, and the other is a

portable telephone that includes the inventive mobile payment part, a charge slip

printer and a user-friendly SIM card reader (SIM: Subscriber Identity Module).

When a mobile user wants to pay a bill or transfer money from an account to other,

he/she enters all infonnation required for payment (like his/her account number, the

payee's account number, payment's due date. bill's reference number. etc.) to the

mobile payment part of his/her portable tenninal 1 (for example through the keypad).

As it is the object of this invention. the user's own account infonnation dose not need

to be entered into the mobile payment part if the computing station 2, based in the

bank 3, can identify the calling party. This needs that the user infonnation (identity)

should be confirmed by his/her telephone operator or service provider in a wireless

communications network 4 and then be sent to the bank as a confinnation of user

(subscriber) identification. More precisely, user identity can be sent by user's

telephone operator or service provider to the computing station 2 when portable

tenninal l set-ups a call or a short message to the computing station 2. Monitoring a

calling party's subscriber number or infonnation at a receiving tenninal is a feature

provided by today's digital telephone systems. In this invention, in order to implement

such procedure, for example the switching systems at the mobile network side can be

used so that only when a user set-ups a call_ or sends a message (by using short

message services of the mobile communications systems) to the computing station 2

his/her identity can be monitored in the computing station 2 in order to identify who is

the calling party. Therefore. in this invention the computing station 2 receives at least

the confirmed user identity from the user's telephone operator or-service provider of a

wireless communications network (WCN) 4 in order to identify who is in charge for

payment of bills sent by portable tenninal 1. Other required infonnation like

passwords or access codes to the user's bank account will be sent by user through

his/her portable terminal 1. In today's mobile telecommunications systems the user

identity. included in his/her SIM card, is checked and confinned by network 4 every

time his/her portable tenninal 1 is turned on and attached to the telephone network 4.

Since the user identity, transmitted from the portable tenninal 1 to the network 4, is

completely encrypted and secured therefore the payment messages between portable

terminal 1 and computing station 2 are also quite secured because of: first, the security

algorithms used in the today's digital wireless telecommunications systems and mobile

telephones. and secondly. because of the user's password or access codes used for

payment messages in the inventive mobile payment system. All kind of wireless

3
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communications networks can be used in order to communicate the payment messages

between the portable tenninal and computing station. For example if in the restaurants
there is a cordless network like DECT (Digital European Cordless Telephony) 5 then

the portable tenninal 6 can be connected through such network and PSTN (Public
Switched Telephone Network) or ISDN (Integrated Services Digital Network) 7 to the

computing station 2. ‘

The payment question-answering procedure between the user and portable tenninal 8
is entered by using the user interface 9 and received and handled by the inventive

mobile payment part 10. The payment infomiation entering procedure 11 is an
interactive procedure between the mobile payment part 10 and the user through user
interface 9. Then, the computing station's telephone number will be dialled 12 (either

automatically or by user) which after the portable terminal 8 sends the required
information for call set-up to the wireless communications network 15 and then

payment messages 13 to the computing station 14 via the same network 15. If the
portable temiinal 8 dose not send the user (telephone subscriber) identity to the
computing station 14, then the wireless communications network 15 confimis and
sends the user identity to the computing station 14 either directly or through the fixed

public network 16. The computing station 14 checks the calling party's account and
account number of payee (the account to which the payment should be transferred)
and then transfers the required amount of —payment from the payer's account to the

A account of payee 17. After thatthe payment has been completed the computing station
14 sends a message 18 to the portable tenninal 8 indicating "payment completed" or if
there is not enough credit (money) in the payer's account a "No effects" message 19
will be sent to the portable terminal 8, meaning that the payment can not be accepted.
For retail businesses, portable terminal includes also a charge slip printer 2(l. If the
portable terminal receives a "payment completed" command 18, the charge slip printer
20 prints a receipt for the customer. In this invention for the retail and trading
businesses, the customer's SIM card 39 is entered in the SIM card reader 36 of the

portable tenninal 1 (of a waiter in a restaurant, for example) temporary in order to pay
the bill. Then the portable terminal 8 will be connected to the wireless
communications network 15. The account number of payee (for example account

number of the restaurant) can be saved in the memory of his/her portable terminal in
order to reduce the information entering procedure of the mobile payment part. This

means that only the payment amount should be entered to the mobile payment part.

After that the payment amount has been entered to the mobile payment part 10 and the

computing station's 14 telephone number has been dialled 12, the wireless network 15
sends the customer's identity, which can be the subscriber identity or a different code,
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to the computing station 14. The computing station 14 can identify the calling party

(the payer) because it has received the calling party's identity from the wireless

network 15 and compared with the calling party's identity based in the computing

station 14. Therefore the calling party will be charged for the payment amount

received from the portable tenninal 8. The subscriber identity sent from the wireless
network 15 to the computing station 14 can be different than the payer's identity sent

by the portable terminal 8 to the wireless network 15 but both of these identities

belong to one user (subscriber). Alternatively the payer's identity, included in his/her

SIM card 39 or entered to the portable terminal by using user interface 9, can be sent

directly from the portable terminal 8 to the computing station 14. It should be

understood that for the simplicity of the description, messages for outgoing call set-up

and incoming call or short message services procedures are not explained with details

since these procedures are already well known in themobile communications systems.

Following is an example, in which a mobile user pays his/her bills or transfers money

form his/her bank account to other, or ask the bank for statement of account, by using

his/her own portable telephone. '

First, the payer enters the bill's information 22 (for example: account number of

payee, the amount of money which should be transferred, due date of the bill,

reference number 11)-to the mobile payment part 21 of his/her portable tenninal 41.

Then, after activating an OK function by user, the mobile payment part dials 23 the

telephone number of the computing station located in the bank 24, which after the

mobile payment part 21 sends the payment information 25 to the computing station

24, via a wireless communications network (WCN) 26 and fixed network 27

(PSTN/ISDN). Then, computing station 24 transfers the amount of payment,

mentioned on the bill, from the payer's account to the payee's account 28. Then,

computing station 24 sends a "Payment Completed" message 29 to the portable

tenninal's mobile payment part 21. If the payee has also a portable terminal 37, then

also his/her mobile payment part 42 would receive a "Payment Reception message"

30, from computing station 24, indicating the amount of payment, the payer and the

payment date. However, before dialling the number of computing station, the mobile

payment pan may ask the payer (the user of portable terminal) "Any other payment ?"

31. The answer can be respond by activating "Yes/No" function 32 or OK function of

the mobile payment part 21. Then the user can enter another bill information to the

mobile payment part 21 and when all information required by mobile payment part

has been provided, the telephone number of computing station 24 will be dialled 23..

After this, all bills information (payment messages) will be sent to the computing
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station in the bank 24 as explained above. Furthermore, there is a command 33 "Send

the Statement of Account" in the mobile payment part 21 for requesting the account

balance. the statement of account, or the movement on the account from the

computing station 24. When a user selects such command 33, the mobile payment part

21 sends this message 33, either by setting up a call or by using the short message

facilities of mobile communications networks 26 to the computing station 24. Then

computing station 24 sends the required account balance or the statement of account

34 to the mobile payment pan 21 of the portable tenninal 41. The computing station

24 also sends a "Monthly Statement of Account" 35, to the portable terminals 41, 42

once or twice per month. Then portable tenninal's printer 38 can print it for the user to

be filed as a record, if required.

Following is an example in which the payee (for example a restaurant or a retail
seller) has a portable terminal by which the payer's (a customer) account can be

charged.

Suppose that a customer wants to pay his/her bill in a restaurant for the service he/she
' has received. The customer can give hislher SIM card 39 or credit card to the waiter to

be entered to the waiter‘s portable telephone 1, 8. Then waiter dials the telephone

number of computing station 14, or the number will be dialled automatically after the

SIM card 39 or credit card has been read by the SIM card or credit card reader 36 of

the waiter‘s portable terminal. For example the telephone number of computing station
14 can be saved in the memory of the portable terminal of waiter, and every time a

customer's SIM or credit card 39 is entered to the portable terminal 1, the portable
terminal automatically contact the computing station 14, after having registered in the

network 15. In the bank, the computing station 14 checks the account infonnation of -

payer (a customer) and then transfers the transaction amount (the sum on the bill) to

the payee's (the restaurant) account 17. If the payer's account do not have enough

credit (money) the portable tenninal 8 may receive a "No effects" message 19, or the

bank may pay the transaction's amount on behalf of the payer and then later charge the

payer or his/her bank for the prepaid transaction. On the other hand if the payer's
account information (account number, account identity) is false the computing station

14 may send a "transfer not accepted" message to the payee's portable terminal, which

means that the payer (customer) should pay the amount of transaction in cash. If the

portable tenninal receives from the computing station 14 a "payment completed"
message 18, then the charge slip printer 20 prints a receipt for the customer, as"
explained in the first example.
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It should be considered that in all above-mentioned examples, payment messages can

be sent and received either by setting up a call between the portable terminal and

computing station or by using short message services facilities of_ the wireless
communications networks.

In the current mobile communications systems, like GSM, there is a facility called

"Short Message Services, (SMS)". In SMS a mobile telephone user can send short

messages to another subscriber without setting up an interactive call. In order to send

the payment messages by SMS, the software of SMS installed in the portable tenninal
can be modified so that it can also handle the payment parameters and/or commands

of the inventive mobile payment part 10. Then by using the SMS services of the

wireless communications network 15, the bill's information 13 can be sent to the

computing station 14. When computing station 14 receives such payment message 13

sent by SMS, it also generates a message to be sent to the portable terminal in order to

inform it if the payment has been completed 18 or not 19. However, if a user wants to

pay many payments (bills) at once and receive also balance or statement of his/her

bank account from the computing stations, such long message can be divided to

smaller parts and then be combined at the portable terminal or computing station. This

means that each bill information can be sent separately using the short message

services. This action is transparent to the user of portable terminal. For example

several payment information can be entered to the mobile payment part 10. Then

when user selects the "Send" function 40 on the portable terminal 1, each bill will be

sent by one short message in accordance of short messages length. For example. a

short message may not include more than 100 letters. If a payment message or the

statement of account (sent by computing station) needs more than the assumed 100

letters, then such long information will be divided into two or‘ several short messages

and then will be sent one by one to the portableterminal or computing station.

In this invention computing station can send and receive messages either via PSTN

(Public Switched Telephone Network) and ISDN (Integrated Services Digital

Network) and other fixed networks or via only a ‘wireless communications network.

The computing station includes all means for transmitting and receiving payment and

banking messages via the wireless networks.

It is to be understood that various changes and modifications can be made to alter the

specifically described structure or methods of operation of the preferred embodiment

without departing from the spirit and scope of the invention. This invention is to be

defined only by the scope of the claims appended hereto.
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Claims

1. A mobile payment system (43), characterised in that it is comprised of:

- at least one portable terminal (1, 6,, 8), such terminal including a mobile

payment part (10, 21) and other means for entering, transmitting, receiving and
printing of information relating to: the payments of bills of the telephone subscriber or
the user of said portable terminal; transferring of money from the bank account of the
subscriber or user to the others account; sending and receiving payment messages (1 3,
18, 19, 25, 29) or messages including the account balance, the statement of account.
or the movement on the bank account (33, 34, 35) of the telephone subscriber or the
user of the portable terminal (41, 37); I

- at least one computing station (2, 14, 24) which is located in the bank (3),

said computing station including means for communicating with said portable
terminal and for transfening the amount of payment (money) from the bank account

of portable tenninal's user and/or telephone subscriber to another bank account (17,
28), or from a customer's bank account, whose account information is entered into
said portable terminal. to the calling party's account; and to receive and send messages
about the account balance, the statement of account. or the ‘movement on the bank
account (33, 34, 35) of the portable ter'rninal's subscriber or user;

- at least one wireless communications network (4, 15, 26) through which said

portable tenninal can send and receive to or from said computing station said payment
messages or messages about the account balance, the statement of account, or the
movement on thebank account of said portable tenninal's subscriber or user.

2. A mobile payment system (43) according to claim 1, characterised in that
said at least one portable terminal (I, 6) is a first plurality of portable terminals, and in
which the number of said portable terminals in said first plurality of portable terminals
is "greater than said at least one computing station (2). I '

3. A mobile payment system (43) according to claim 1 and 2, characterised in
that the payments or bills of a mobile telephone subscriber can be paid by entering the
subscriber identity and codes into said portable terminal (1, 6, 8, 41) and the bill's
information, including the payee's bank account number, the amount of payment, bill's
due date and reference number into the mobile payment part (10, 21) of said portable
terminal, and by setting up a call or a short message to the bank's computing station
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(2, 14, 24) and sending the payment (bill's) messages (13, 25) to said computing

station (2, 14, 24).

4. A mobile payment system (43) according to claim 1, 2 and 3, characterised

in that said at least one portable terminal (1. 6) comprises all means for transmitting

and receiving payment messages to or from said computing station (2); and that:

- said portable terminal includes a mobile payment part (l0, 2]) for handling

the payment infonnation ( l l, 22, 3 l, 32) entered by user to said portable terminal, and

that said payment information can be saved into the memory of said portable temiinal

and be sent to said computing station, whenever required; and that:

- said portable terminal receives a message (18, 19, 29) from said computing

station indicating that either the payment or transferring of the required amount of

payment from the payer's to the payee's bank account has been accepted and/or

completed or not.

5. A mobile payment system (43) according to claim I, 2, 3 and 4

characterised in that the user of said portable terminal can enter more than one

payment or bill information to the mobile payment part (10, 2]) , and that after that

telephone number of said computing station based in the bank (2, 14, 24) has been

dialled (12, 23) either manually or automatically, all required payment information

(13. 25) will be sent to said computing station; and that:

- said portable terminal can send payment (bill's) information (13, 25), handled

in mobile payment part (10, 12), to the computing station (l4, 24) and receive the

required payment messages (18, 19, 29) from said computing station by setting up a

call or using the Short Message Services (SMS) of the wireless communications

network (4, 15, 26); and that

- said portable terminal's subscriber infonnation can be sent from the user's

telephone operating network (4, 15, 26) to the computing station (2, 14, 24); and that

- said portable terminal includes a charge slip printer (20. 38) that can print all

payment information and the information received from said computing station for

user of said portable terminal, and that,

- said mobile payment part (10, 21) can be included into any kind of digital or

analogue portable telephone that is capable of operating in cellular communications

systems.
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6. A mobile payment system (43) according to claim 1 - 5, characterised in that

said computing station (2, 14, 24) after receiving a payment message (13, 25) from
said portable terminal (1, 6, 8, 41), checks and charges the payer's account (17, 28) in

accordance with the payment amount received from said portable terminal and then

sends a message (18, 19. 29) to said portable terminal (8, 41, 37) in order to indicate

that payment has been accepted and/or completed or indicating that there is not

enough credit in the payer's account; and that:

- said computing station (2, I4, 24) can receive or send payment messages (18,

19, 29, 30) or other banking messages (33, 34, 35) to said portable terminal (1, 6, 8,

41) via either fixed and wireless communications networks (4, 7, 15, I6, 26, 27) or via

only wireless communications network (I5, 26); and that,

- said computing station (2, 14, 24) can receive the payer's information and

identity either from the payer's telephone operator or service provider through wireless
communications network (4, 15, 26) when payer telephones or send messages (13, 25)

to said computing station (2, 14, 24) or from the payer's portable tenninal (1, 6, 8,.41);

and that, the payer's information received from said payer's telephone operator or

service provider or from said portable terminal may include payer's subscriber

information or identity or any other required infonnation; and that,

- said computing station can monitor the subscriber infonnation or other

identity, received from said payer's telephone operator or service provider or portable

terminal, and based on said subscriber information or other identity and account

number transfer the required amount of payment (money) from the payer's account to

any other required account; and that,

- said subscriber infonnation or identity will be confirmed by subscriber's

telephone operator or service provider (4, 15, 26) and said confirmed infonnation will
be sent to said computing station (2, 14, 24) in which the subscriber identity will be

checked (17, 28) and based on that, the received payment message (13, 25) can be

accepted and a payment completed message (18, 29) will be sent to said portable

terminal (1, 6, 8, 41); and that,

- said computing station (2, 14. 24) can send or receive payment messages (13,

18, 19, 25, 29, 30, 33, 34, 35) to or from the portable tenninals (1, 6, 8, 41, 37) of

both the payer and the payee; and that,

- said computing station (2, 14, 24) is equipped with all means for transmitting

and receiving messages via anywireless communications network, to or from said

portable tenninal (1, 6, 8, 41, 37).

7. A mobile payment system (43) according to claim 1 - 6, characterised in that

the mobile payment part (10, 21) may ask the user to enter all payment infonnation

I0
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(11) such‘ as payee's account number, bill's reference number, bill's due date. the
amount of payment and other required information; and that:

- said mobile payment part (10, 21), after receiving all information about a

payment or a bill from the user through user interface (9), may ask the user of said

portable terminal "any other payment ?" (13) indicating dose user wants to pay

another bill or payment; and that,

8. A mobile payment system (43) according to claim 1 - 7, characterised in that

said portable terminal (1, 6, 8, 41) can be used in order to pay the bills of any mobile
telephone subscriber by entering each subscriber's identities and codes into said

portable terminal either by using the portable terrninal's user interface (9) or the SIM T
card (39) and card reader (36); and that:

- said mobile telephone subscriber's codes can be different than said

subscriber's identities; and that said subscriber codes can be included both in the
subscriber's SIM card (39) and said computing station (2) located in the bank (3); and

that:

- said portable terminal (1. 6) can be used in order to charge customers, in

retail or trading businesses, by entering the customers‘ telephone SIM card (39) into

said portable terminal (1, 6) and by using the telephone subscriber identities of each
customer as an identification for payment; and that:

- after that said customer's SIM card (39) has been entered to said portable

terminal (1, 6, 8), said portable terminal will be re-connected to the wireless
communications network (4, 15) in order to check the subscriber identity, which after

the customer's (subscriber's) bank account can be charged by sending payment

messages (13) to the computing station (2, 14).

11
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_ AMENDED CLAIHS
[received by the International Bureau on 25 March 1996 (25.03.96);

original claims 1 and 3-8 amended; new claims 9 and 10 added;
remaining claims unchanged (8 pages)]

1. A mobile payment system (43). utilizing the “Short Message Services (SMS)
facilities of mobile communication networks such as GSM (Global System for Mobile
Communications). and subscriber identity such as SIM card (Subscriber Identity Module).
and a new mobile—telephone—based functionality and mobile network architecture
characterized in that it is comprised of:

- at least one portable terminal (I. 6. 8). such terminal utilizing the inventive Mobile
Payment Part (10. 21). which provides a function and SMS-based adaptation and
application pan integrated into said portable terminal to provide at least an alphanumeric
payment (bill) inquiry (eg. I I). and including other means for entering. transmitting and
receiving. and printing of the information mainly related to: the payments of bills of the
telephone subscriber (l. 6. 8): transferring of money from the bank account of the
subscriber or user to the others account: sending and rece

ance. the statement of account. or the

iving payment messages (13. 18.

I9. 25. 29) or messages including the account bal

movement on the bank account (33. 34. 35) etc. of the telephone subscriber of the portable
terminal (M. 37) without requiring to use any additional data modem to be used in
conjunction with said portable terminal for transmission and reception of said payment etc.
messages:

- at least one computing station (2. 1-1. 24) which is located in the bank (3). as it is the
object of the architecture of the inventive payment system (43). said computing station
includes all information about the portableutelephone subscriber data which is connected to
the subscriber's bank account in the same bank wherein computing station is located. and

said computing station includes means for communicating with said portable terminal (4)
and transferring the amount of payment (money) from the bank account of the payer (i.e.
the calling subscriber) to another bank account ( 17. 28). and to receive and send messages
about the payments. account balance. the statement of account. the movement on the bank
account (33. 34. 35) or other banking messages etc. of the calling subscriber via SMS
facilities of the wireless communication network (4)-:

- at least one wireless communication network (4. 15. 26) equipped with Short

Message Services (SMS) infrastructure through which said portable terminal ( l. 6. 8) can
send and receive to or from said computing station said payment messages or other banking

messages etc. and that said wireless communication network can confirm ti.e. authenticate)
the subscriber identification for said computing station. whenever required or transfer the
subscriber data received from said portable temiinal directly to said computing station. in
which the subscriber data can be compared with the subscriber data already recorded there.

1 2
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2. A mobile payment system (43) according to claim 1. characterized in that said

portable tenninal (l. 6) is a first plurality of portable terminals. and in which the number of

said portable tenninals in said first plurality of portable terminals is greater than said at least

one computing station (2).

3. A mobile payment system (43) according to claim I. 2. characterized in that said

portable tenninal (l. 6, 4l ) comprises all means for transmitting and receiving payment etc. -

messages to or from said computing station (2) or other portable terminal (37): and that. ‘

- said portable tenninal includes the inventive Mobile Payment Part (10. 2]) which is

a short-message-based adaptation and application part for handling. dividing or connecting

the payment etc. information ( l I. 22. BI. 32). and that said payment etc. infonnation can be

saved into the memory of said portable tenninal and be sent to said computing station.

whenever required: and that,

- after that portable terminal has been registered into the mobile network (4), the

payments or bills of the mobile telephone subscriber ( l. 6) can be paid by entering the bill's

infonnation such as the payee's bank account number. the amount of payment. bill's due

date and reference number etc. into the Mobile Payment Part (l0, 2]), and by sending the

short messages (e.g. 13. 33) to the bank's computing station (2, l4. 24) via SMS facilities of
the mobile network (4) and receiving messages such as ( l8. I9, 30. 34. 35 etc.).

- said portable tenninal receives a message (e.g. 18. 19. 29) from said computing

station indicating that either the payment or transferring of the required amount of money

from the payer's to the payee's bank account has been accepted and/or completed or not: and

that.

- said portable terminal includes a charge slip printer (20. 38) that can print all

payment information and the infonnation received from said computing station for user of

said portable terminal. whenever required.

4. A mobile payment system (43) according to claims I, 2, 3. characterized in that

the computing station (2. l4. 24) after receiving a payment message (13, 25) from said

portable tenninal (l, 6, 8. 4l). checks and charges the subscriber’s (payer's) account (17.

28) in accordance with the payment amount received from said portable terminal and then I

sends back a message (e.g. l8. l9. 29) including all infonnation about the payment (e.g. bill

reference. payer. amount etc.) to said portable tenninal (8. 4|. 37) in order to indicate that

the payment has been accepted and/or completed or indicating that there is not enough

credit in the payer's account: and that:

1 3
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- said computing station (2. I4. 24) can receive or send payment messages leg. I8.

19. 29. 30) or other banking messages (eg. 33. 34. 35') or any other message to said

portable terminal (I. 6, 8, 41) via SMS of a mobile communication network (4. 5) through

either fixed and wireless communication networks (4. 5.-7. 15. 16. 26. 27) or via only

wireless communications network (4. 15. 26): and that.

- said computing station (2. 14. 24) can receive the payer's identity either from the

payer's telephone operator system (4. I5. 26) when payer sends messages (e.g. 13. 25) to

said computing station (2, l4. 2-1) or from the payer's portable tenninal (I. 6. 8. 4]); and

that said payer's data received from said payer's telephone operator or from said portable

tenninal may include the payer's subscriber data or identity parameters or any other required

information: and that.

- said subscriber data can be confirmed (i.e. authenticated) and secured either in the

databases and infrastructure of the subscriber‘s telephone operator (4). or in said computing

station. for example. by utilizing the algorithms used in mobile communication systems

such as those of the GSM: and that.

- after that the subscriber data. communicated between said portable tenninal and

wireless communication network or directly between said portable tenninal and computing

station has been authenticated. the Mobile Payment Part (I0) of the portable tenninal or

said computing station can send and/or receives payment etc. messages through SMS of a

mobile communication network (4): and that.

— said computing station can monitor the subscriber identity. number etc.. received

alternatively from said payer's telephone operator or said portable terminal. and based on

said subscriber identity, and/or number and checking of his/her bank account number

transfer the required amount of payment g(money) from said payer's account to any other

required account: and that,

- said subscriber data can alternatively be confirmed or sent by the subscriber's

telephone operating network (4. I5, 26) to the computing station (2, I4. 24); as a

confirmation of subscriber identification. enabling said computing station to compare the

received subscriber data with the data already recorded in said computing station. and when

subscriber data is compared and accepted by said computing station. the portable tenninal

can send payment messages to said computing station: andthat,

- said subscriber data may include the subscriber telephone number. confirmed by

mobile operator (4), or it may consist of the subscriber identity incorporated in SIM card, or

any other code: and that. 14
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- said computing station (2. I4. 24) can send or receive payment messages (e.g. 13.

I8. I9. 25. 29. 30. 33. 34. 35) to or from the portable terminals (I. 6. 8. 41. 37) of both the

payer and the payee: and that.

- said computing station (2. I4. 24) is equipped with all means for wired or wireless

transmission and reception of messages communicated between said computing station (2),

wireless communications network (4 or 5), and said portable terminal (1. 6. 8', 41. 37).

- said computing station may send eg. a monthly report (e.g. 35) to said portable

tenninal (I. 6. 37. 4|) to be displayed or printed (20. 38). for said subscriber. as a receipt

and bank report for payments (bills. etc.) charged from the subscriber/payer account to the

other subscriber/payee account. by said computing station.

5. A mobile payment system (43) according to any preceding claims. characterized

in that the subscriber. for eitample. a waiter etc. in a restaurant can send the payment

messages (e.g. a bill) by using the inventive portable terminal (I. 6. 8) either to the

computing station (2. 14) or directly to the customer's portable terminal (e.g. a mobile

telephone integrated with the inventive Mobile Payment Part), via SMS facilities of mobile

communication network (5, 4). which after the payment can be accepted by said customer

and be sent to the computing station (2) in which the payment procedure will be completed

and then a message (including the bill's infonnation) will be sent to both customer's and

waiter’s portable tenninals indicating that either the payment has been completed and/or

accepted (29, 30) or refused (I9): and that:

- said waiter etc. or customer can enter the customer‘s identity code to said waiter’s

portable tenninal. by using user interface (9), and then send the bill together with the

customer's code to the computing station. which after said computing station generates a

message and sends it to the customer’s portable terminal to be accepted by the customer.

and that after that the payment has been completed in the computing station. the computing

station can send a message such as “Payment Reception" including all information about

the payment (e.g. bill reference. payer. payment amount etc.) to the payee‘s terminal

I indicating that the payee has received the payment: and that.

- said portable terminal (I. 6) can be used in order to charge customers, in retail or

trading businesses, by entering alternatively the customers‘ telephone SIM card (39) into

said portable terminal’s SIM card reader (36) and by using the telephone subscriber identity

of each customer as an personal identification for payment: and that:

- after that said customer's SIM card (39) has been entered tosaid portable terminal

(I. 6. 8). said portable terminal will be re-registered to the wireless communications

15
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network (4. 15) and/or said computing station in order to check the subscriber identity.

which after the customer's (subscriber's) bank account can be charged by sending payment

messages te.g. l3) to the computing station (2. 14).

6. A mobile payment system (43) according to any preceding claims. characterized
in that whenever the subscriber turns on his/her portable tenninal (I, 6) the Mobile Payment

Part (10) sends the subscriber data. that can be included in the SIM card. to the computing

station (2. 14) through an available wireless communication network (4, 5), and after that

registration process between said computing station. said wireless communication network
and said portable tenninal (l. 6. 8) has been completed said portable tenninal can have
access to said wireless communication network through which it can send and/or receive

payment. banking etc. messages to/from said computing station. and also be able to use the
telecommunications services like voice etc. of said wireless communication network: and

that.

- after said portable terminal has been registered in said wireless communication

network (4) or computing station (2). the subscriber of said portable terminal can send

and/or receive banking messages leg. 33. 34. 35) or can pay his/her bills by sending and

receiving the payment etc. messages (e.g. l3. l8. I9. 25. 29) to the computing station (2,
14) or to another portable terminal. through the Mobile Payment. Part (I0) of his/her

portable terminal: and that.

- said subscriber data can be a data which is recorded only in the SIM card and in said

computing station that is located in the bank: and that.

- said subscriber data can be either similar to or different from that subscriber identity

which is incorporated in the subscriber‘s telephone SIM card provided by mobile operators

(4); and that. A _

— said subscriber data can be alternatively sent to said computer station after that

registration of said portable terminal into said wireless communication network (4. 5,) has
been completed. which after the subscriber can send and/or receive payment/bill messages

to said computing station via SMS of said wireless communication network (4. 5,).

7. A portable terminal t_ I. 6. 8. 41, 37) according to any preceding claims.
characterized in that it includes the inventive Mobile Payment Part (10. 21) which for each

payment procedure may ask the subscriber tie. the payer) to enter all payment infonnation
(e.g.’ l I) such as payee's account number. bill's reference number. bill's due date. the

1 6
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amount of payment and other information included in the bill or required for payment

procedure: and that:

- said Mobile Payment Part I ll), 2|). after receiving all information about a payment

or a bill from the user through user interface (9). may ask the subscriber of said portable

terminal e.g. "Any other payment ?" ( I3) indicating dose subscriber wants to pay another

bill or payment. and that after this message subscriber can enter other payment infonnation

into said Mobile Payment Part: and that.

- said portable terminal (1. 6. 8. 41) can be used in order to pay the bills of any mobile

telephone subscriber by entering each subscriber's identities and codes into said portable

tenninal either by using the portable terrninal's user interface (9) or by entering the SIM

card (39) and card reader (36); and that:

- more than one payment or bill etc. data can be entered into said Mobile Payment

Part (I0, 21) of said portable terminal. and that after that telephone number of said

computing station based in the bank (2. I4. 24) has been dialed (12. 23) either manually or

automatically, all required payment infonnation (e.g. I3. 25) will be sent to said computing

station via SMS facilities of the mobile network (4. 5. l5. 26): and that.

- said portable terminal (I. 6. 8. 37. -ll). includes all means of a
mobile/cellular/cordless telephone for receiving and transmitting voice and data so that said

portable terminal can function both as a mobile payment device and as a

mobile/cellular/cordless telephone without requiring any data modem to be used in

conjunction with the transmission and reception of payment etc. messages: and that.

- said Mobile Payment Part (10. 21) can be integrated into any kind of portable

telephone that is capable of operating in cellular communications systems; and that,

8. A portable tenninal (I, 6, 8. 41. 37) according to any preceding claims.

characterized in that a small printing device (20. 38) is integrated into said portable

terminal ( l, 6, 37, 41) for printing any data received from computing station (2) or other
portable terminals or any other source or the messages entered into said Mobile Payment
Part (10. I 1. 21) by its user or any other short messages received by said portable terminal.

9. A Mobile Payment Part (10) according to any preceding claims. characterized in

that it is a component and function integrated into the portable terminal (1. 6), said Mobile
Payment Part provides a payment (bill) inquiry (ll) procedure including for example

questions (such as payment amount. Bill reference. Receiver’s account number. Due date.

Recipient etc.) which can be displayed on the display 16) and which can be answered by the

1 7
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user of the portable tenninal through the user interface (9) ‘and such payment information

can be saved into the memory of the portable tenninal or be sent to the computing station

(2) or another portable terminal via SMS: and that i
- said Mobile Payment Part (10) can be either integrated into said portable tenninal as

A a component including the required soft-ware for providing said bill inquiry (eg. 11). or

said Mobile Payment Part can be integrated into the SIM card (i.e. Subscriber Identity

Module) to provide said bill inquiry whenever subscriber wants to pay a bill or perform a

payment: and that.

- said Mobile Payment Part is a function and SMS-based adaptation. integrated into

said portable terminal or alternatively into said SIM card to provide an alphanumeric

payment (bill) inquiry ( I 1) procedure: and that.

-' said Mobile Payment Part (10) can divide and split any long data of any length. for

example e-mails done in a personal computer etc. which can be connected to said portable
terminal into several short messages and send them to other portable terrninals/telephones

(e.g. l or 6) or to said computing station (2) via SMS facilities of a wireless communication

network (e.g. 4 or 5) without requiring any data modem to be connected between the

portable terminal and said personal computer. so that said Mobile Payment Part divides
such e-mail to several short messages in a numbering sequence. for example. first short

message. second short message etc.: and that,

- said Mobile Payment Part (10) is able to connect several short messages originated

from a long data of any length e.g. an e-mail according to said short messages’ numbers

defined in the sender’s portable terminal (e'.g. l) and their sender’s identity (e.g. subscriber

number). and put them into the original order and configure said original long data. which
can be a long information sent by computing station or another portable terminal (e.g. 6) or

any other source equipped with the inventive Mobile Payment Part (10) via SMS facilities

of a mobile communication system (4), and then display said original data (e.g. the e-mail)

on the display of the portable terminal (1, 6) or forward it to a separate monitor or personal

computer without requiring any data modem to be used between said portable tenninal and

said personal computer: and that.

- all short messages which are resulted from a longer data and received by said

portable tenninal (1 or 6) or computing station (2) may contain ‘a short message number

which is unique for each message and is defined according to their dividing sequence; and

that.

- all short messages which are divided from a longer data and received by said

portable terminal (1 or 6) or computing station (2) . through SMS infrastructure (.4 or 5).

1 8
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may contain both the sender‘s and receivers identity number (e.g. payer's and payee‘s

subscriber numbers), which can be added to each short message either at said message

sending portable terminal (e.g. I) or at the wireless communication networks SMS

facilities (4); and that.

- all short messages which are divided from a longer data and received by said

portable tenninal (l or 6) or computing station (2), through SMS infrastructure (4 or 5),

may be connected according to their sender’s identity and their an'ival time to the SMS

facilities of a mobile communication system (4) or their sending time from the portable

terminal or computing station or any other source: and that such sending or arrival time can

be defined either at said portable terminal (e.g. I), which sends the messages. or at the ‘SMS
facilities of the wireless communication network (4).

10. A mobile payment system (43) according to any preceding claims. characterized

in that the telephone calls made by portable tenninal (l. 6) can bevcharged simultaneously

after each or severalcalls. from the subscribers bank account (i.e. payer's account) to the

wireless communication operators (4 or 5) account. so that said operator can send the bills

relevant to the telecommunications services used by said subscriber. directly to said

computing station (2): and that.

- said computing station can include either the subscribers’ data and bank account

information or both the subscribers’ and said wireless communication operator’s data and

bank account infonnation so that the subscribers‘ all telephone calls can be charged directly

from the subscriber’s account to said wireless communication operator’s bank account. by

said computing station: and that.

— said computing station may send e.g. a monthly report (e.g. 35) to said portable

terminal (I, 6, 37, 41) to be displayed or printed (20, 38). for said subscriber. as a"-receipt

against charged calls or any telecommunications services used by said subscriber and

charged from said subscriber bank account to the wireless communication operator’s (4 or

5) bank account. by said computing station.
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V STATEMENT UNDER ARTICLE 19

Hereby we would like to file and publish the attached Amendment together with the
above application. The claims filed are amended in order to better define the scope of
the claims for the purposes of provisional protection. All claims are amended after
that International Searching Report was received by the applicant so that the amended
claims define the scope of the claims mainly based on using the second alternative
(i.e. Short Message Services facilities. see page 7 of description). Moreover. it was
noticed that the filed claims could. not cover all objects of the above—mentioned

application without applying for amendment. All claims amended here fall into the
description of the invention. and go not beyond the disclosure in the above
international application as filed. The differences between the claims as filed and as
amended are indicated in the next page.
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PatBase Results P386 7 of 11

16) Family number: 11389386 ( 1911031130 ig | at full-text 1 status i citations : < | > | '* 1
A2) 13: can

TRIO: SERVICE PROVIDING DB/ICE

Prlorlty: JP19970134856 19970710
Efl9fl1Y..flflD

Fl"“"V= Publication number Publication date Application number Application date Llnb
“'-"“' ' ’ JPi103113O A2 19990202 JP199701B-4866 19970710 3

Aulgneeu): FUJI XEROX CO LTD

Inventor“): KOJIMA SHUNICHI ; KONO KENJI ; NAKAGAKI JUHEI
International G06F15/O0 GD9Cl/O0 HO4L9/32 (Advanced/Invention);
clan (IPC I): GOGFIS/00 G09C1/O0 H04L9/32 (Core/Invention)
International GOGFIS/00 G09C1/O0 HO4L9/32
dau (EH: 1-
7):

Abnr-act:
Source: JP11l‘.l31t30A2 PROBLEM To BE SOLVED: To

provide the utilization of service only to a user who has
a legal right, minimizing the burden on the user and a
service provider. SOLUTION: when a plug-in 38 of an
Internet browser 31 is started, a verification program 15

In the plug-in 38 is started, communicates with a '
program 32 for certification and performs user
authentication. A certification data generation program
A36 of the program 32 cooperates with a certllicatlon
data generation program 837 in a token 33, calculates
based on a user Inherent information 16 and an access 9
Ucket 13 and communicates with the program is in the
plug-in 38 based on the calculation. As the result of the
communication, the success of authentication by the I I
program 15 is limited to only when the three of the user
inherent information, me access ticket and enclphered
contents correctly correspond with one another.
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0) Family number: 14153392 ( JP2000215165 lg 13 I !ull—text I status | citationsl < | > | A |
A3) 4 [31 t8

Tltiei MBHOD AND DEVICE FOR INFORMATION ACCESS CONTROL AND RECORD MEDIUM RECORDII
INFORMATION ACCESS CONTROL PROGRAM

Priority: JPl9990017401 19990126
E£!9m!_MJ!R

"MW: Publication number Publication date Application number Application date Lini-
F ‘ ' ' 192000215155 A2 zooooeoa 1919990017401 19990125 3

Aasigneeu): NIPPON TELEGRAPH AND TELEPHONE
(std): V

Inventor(e): OHARA YASUHIRO ; OSHIMA YOSHITO

International GUGFIZ/14 GOGFIS/00 G09C1/00 H04L9/32 (Advanccdllnvention);
dill (XPC I): GOSFIZ/14 G06F15/00 GO9C1/00 H04L9/32 (Core/Invention)

International G06F12/1.4 GOGFIS/DO GOGFI7/60 G09C1/00 H04L9/32
duo (Inc 1-
1):

Abstract:

Source: JP2D0O21516SA2 PROBLEM To BE SOLVED: To
provide the method and device for information access
control which can easily change the access authority to
be allowed to an accessing person in response to the
change of situation of a transaction and also to provide
a recording medium which records an information
access control program. SOLUTION: An access ticket
issuing means 1 issues the access tickets to every ‘t
accessing person and these tickets prescribe the access it.
authority to the target information for each of plural ff’
types and states. Receiving an access request from an d
accessing person, the means 1 reads the request and
the access authority corresponding to the type and state
of an inputted access ticket out of an access ticket
authority lnfonnation storing means 6 and decides to
pemtit or not permit the access request based on the
access authority. when a state transition request Is " 3'.‘
received from the accessing person, the transition
destination state is read out of a state transition
information storing means 5 based on the type and
state of the access ticket that is inputted together with
the state transition request. Based on the transition
destination state, the change of the access ticket is
updated.  
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17) Family number: 123932.36 (JP1l.012037 1 E I B I hill-text | status I citations I < I > I " I
A2) . :3: rs

Title: CERTIFICATION DATA GENERATING DEVICE

Priority: JP19970188B01 19970714
B(1n!1t!_HiD

F8|'fl"V= Publication number Pubiication data Application number Application date Link

5tfl'—'1.5K1“£'£' 1911032037 A2 19990202 1919970159501 19970714 9
P3641909 32 20050427 JP!99701B8801 19970714 Q

Aatignea(s): FUJI XEROX CO LTD

1mrentor(I): NAKAGAKI JUHE1 ; SHIN YOSHIHIRO

International GO6F1S/O0 GO6F9/06 G09C1/00 HO-SL9/32 (Advanced/invention);
ciau (IPC I): GOGFIS/O0 G06F9/06 G09C1/00 H04L9/32 (Corelinvention)

International G06F1S/00 G06F9/06 Go9C1/00 Ho4L9/32
class (We 1-
1):

Abstract:
Source: JP11032037A2 PROBLEM TO BE SOLVED: To

prc-pay access qualification to purchase or rent without
Imposing any surplus load on a certification data
generating device side. SOLUTION: A pre-paid purd-iase
ticket T2 is stored in an access ticket storing part 33.

Next, (Tl'. n1) is inputted to a certification data-
Imputting part 14. A use condition judging part 15
extracts a corresponding access ucket (t2, L2, n2),

checks whether or not a use condition L2 is fuifiiied, and
reduces frequency information V, when the use
condition is fuliiiied. A certification data generating and
outputting part 16 caicuiates certiiicafion data R by
using auxiliary certification decision (t): and the use

condition L2 extracted by the use condition decision part
15 and (du) read from a user specific information
storing part 11, and outputs T1. A user performs access
to a program in a purchase state or a rent state by

using the T1.  
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12) Family number: 13081071 ( JPx1205306 {E | Q i full-text | status | citations 3 < i > i “ I
A!) Di €83

Title: AUTHENTICATION SYSTEM AND AUTHENTICATION HHHOD

Priority: JP19980006267 19980116
Ei’.i.9.l:iIx.H§D

F3"|"Y= Publication number Publication data Application number Application date Lini-
f2ml'-l§=!9'£9‘=I mizoszros A2 19990730 m99aooos2a7 19930115 Q

Auigneeu): run xerzox co LTD

Inventor(l): xomora snuurcrrr ; xono KENJI .- TAGUCHI mxsarrrrzo ; TERAO mzo
International GO9Cl/D0 H04L9/32 (Advancedllnvention);
duo (IPC O): G09C1/(J0 H04L9/32 (Core/invention)
International GO9Ci/00 Ho-11.9132
dun (IPC 1-
1):

Altlttict:
Source: JP11205306A2 PROBLEM TO BE SOLVED: To

provide a system and method that realize diversified
services by using an access ticket generated from-
characteristlcs information not belonging to a person
and information specific to the user, as for the
authentificadon system that authenticates legality of the
user. SOLUTION: The authentication device 210 sends
authentication data and a ticket identifier to an
authentication device 250, the authentiflcation device
250 sends the authentication data to the authentication
device 210, which calculates an authentication challenge
(9 ) based on a ticket attribute revision request (u ) and
an authentication device authentlflcation data (x ). The
authentiflcatlon device 250 receives the p and the
(aepsi , v ) to authenticate an authentication device
open key based on input data and an authentication
device open key identifier (v ‘), to authenticate the
authentification device challenge and to revise contents
of a ticket attribute record (vi) depending on the ticket
attribute revision request (p ). Furthermore, an
authentificatlon data generating section calculates a
response (R) and the authentication device
authenticates the legality of the response (R).
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11) Family number: 13107360(JP11213121 I E I 3 i iuli-text 1 status | citations I l > I
A2) [ji

Tltlo: DEVICE AND METHOD FOR AUTHEN'T1CATlON

Priority: JP19980016710 19980129
Ennmmn

Ffl|“_"Y= Pubiication number Pubiication date Application number Application date Lini-
Emlbhiimflifl JP1l21512i A2 19990305 m993oo:571o 19980129 - Q

JP3791169 B2 20060628 )P1998001671O 19980129 3

Ass|gnee(s): FUJI XEROX CO LTD

Inventor(s): KIKO KENICHIROU

Intemationnl G09C1/00 H04L9]32 (Advanced/Invention);
dlll (IPC O): GO9Cl/U0 H04L9/32 (Core/invention)

International G09C1IO0 i-i04L9I32
clue (IN: 1-
7):

Abstract:
Source: JP1121S121A2 PROBLEM TO BE SOLVED: To
perform composite authentication by using the
combination of different kinds of issued tickets.
SOLUTION: The ticket holding section 202 of a certifying
device 20 holds a ticket indicating the specific right of a
user while a composite ticket hoiding section 206 holds
a composite ticket for certifying that the user holds a
pluraiity of other effective tickets. A certifying data
generating section 203 certifies the presence of a
compositeiy designated right by generating certifying
data through executing a prescribed operation by the
use of a prescribed access ticket, a composite ticket,
and inherent information of the certifying device to
authentication information sent from a verifying device
10.  
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2) Family number: 33519418(JP2005118143 A1) I I 3 2 full-
extended family text | status | citations | < | > 1 A 5D] cf)

Title: ENCRYFTION DEVICE USED IN A CONDITIONAL ACCESS sysren

Priority: US1997OOS4575P 1997080}
grorlty Map

Famiiw Publication number Publication date Applimtion number Application data Lini-

Emllilfilfil-fif 192005213143 A2 pzuosoan .iP20050120426 20050418 3
wo99o715o _/:1 1999021 1 WO199BUS1614S 19980731 Q E}

Asslgnee(s): SCIENTIFIC ATUKNTA
(std):

Assigneeu): SCIENTIFIC ATLANTA INC

Inventorts): PALGON MICHAEL S ; PINDER HOWARD G
(std):

Designated AL AM AT AU AZ BA 33 BE or as B] an at O4 CF CG CH CI cm cu cu cv cz DE DK EE ES FI I
states: GA GB GE GH GM an GR Gw HR HU 10 IE IL 15 IT JP KE KG KP KR xz LC uc LR LS LT LU Lv M

MDMGMK MLMN MRMWMX NENLNO NZPLPTRORUSDSE SGSISKSLSNSZTDTGTT
TRTTUAUGUZVNYUZW

International G09C1/00 HOGL9/03 H0413/I0 HOIN7/IO HO4N7l16 H04N7/167 (ltdvancedllnvention);
class (!PC I): GO9C1/OD H04L9/08 HO4L9/10 H04N7/10 H04N7/16 HU-‘IN7/167 (Core/Invention)

International H04L9/lo Ho4N7/16 rio4N7/167
class (we 1-
7):

European HO4N7/167D H04N7/16E2
class:

Cited WO9529560, US5787172, U55592552, US5400401, USS341425, EP07527B6.
documents:

Abstract:
Source: JP20D52i814JA2 PROBLEM TO BE SOLVED: To
provide a cable television system providing conditional
access to a service. SOLUTION: The cable television
system includes a heaclend trom which service
“instances”, or programs, are broadcast and a plurality
of set top units for receiving the instances and
selectively decrypting these instances for display to
system subscribers. The service instances are
encrypted, by using public and/or private keys provided
by service providers or central authorization agents.
Keys, used by the set tops for selective decryption may
also be public or private in nature, and these keys may
be reassigned at different times, to provide a cable
television system in which the anxiety for violation
actions is minimized. COPYRIGHT: (C)2005,JPO&NCIPI<
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Title: CONDITIONAL ACCESS SYSTEM

Priority: US19970054S75P 19970301 us199s0126921 19930731
Erlgfl]! Mgg

Famiiv: Publication number Publication date Application number Application date Llni

E¢|1111Y—E19|9l=I 192005253109 A2 20050915 1920050120425 20050418 -5
wo9909743 A2 19990225 WO1998US16079 19990731 -53

wo99097-:3 A3 19990527 wo199eus15079 19900731 133

Assiqi'iee(s): SCIENTIFIC ATLANTA
(std):

A.-zsignee(s): SCIENTIFIC ATLANTA INC

Inventor(s): mus GLENDON L In ; PALGON MICHAEL s ; FINDER HOWARD G ; WASILEWSKI ANTHONY J
(std):

1nventor(s)£ AKINS GLENDON L
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International H04H1/D0 H04L9/08 H04NS/O0 H04N7/i6 HO4N7/167 I-iO4N7/173 (Advanced/invention);
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Internationat H04L9/08 HO4N7/167
class (IPC :-
7):

European H04N5/OOM4 H04N7/16_7D Ho4N7/16E2class:

Cited W09704S53. USS381481, US5029207, US98fl7296, US486461S, US4736422, US9613901,
documents:

Abstract:
Source: .iP20052531D9A2 i>ROBLEM TO BE SOLVED: To

provide a cable television system which provides
conditional access to services. SOLUTION: This cable
television system includes a headend from which service
"instances" or programs are broadcast and a plurality 0!
set top units for receiving the instances and selectively
decrypting the instances for display to system
subscribers. The service instances are encrypted using,
public keys and/or private keys provided by service ' .
providers or central authorization agents. Keys used by
the set tops for a seleaive decryption may also be
public or private in nature, and such keys may be
reassigned at different times to provide a cable
television system in which piracy concerns are
minimized. COPYRIGHT: (C)20D5,JPO&NCIPI<
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(c) 2008 JPO & JAPIO. All rights reserved.
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CRYPTOGRAPHIC KEY SYSTEM

Pub. No.: 2006-180562 [JP 2006180562 A ]
Published: July 06, 2006 (20060706)
Inventor: SAITO MAKOTO
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Abstract. First, we introduce the notion of divertibility as a proto-
col property as opposed to the existing notion as a language property
(see Okamoto, Ohta [OO90]). We give a definition of protocol divertibil-
ity that applies to arbitrary 2—party‘protocols and is compatible with
Okamoto and Ohta’s definition in the case of interactive zero-knowledge
proofs. Other important examples falling under the new definition are
blind signature protocols. We propose asufficiency criterion for divertibil-
ity that is satisfied by many existing protocols and which, surprisingly,
generalizes to cover several protocols not normally associated with di-

vertibility (e.g., Diffie-Hellman key exchange). Next, we introduce atomic
proxy cryptography, in which an atomic proxy function, in conjunction
with a public prory key, converts ciphertexts (messages or signatures) for
one key into ciphertexts for another. Proxy keys, once generated, may be
made public and proxy functions applied in untrusted environments. We

present atomic proxy functions for discrete—log-based encryption, iden-
tification, and signature schemes. It is not clear whether atomic proxy
functions exist in general for all public-key cryptosystems. Finally, we
discuss the relationship between divertibility and proxy cryptography.

1 Introduction

This paper investigates two general ways in which an intermediary sitting be-
tween the participants of a 2-party protocol might transform the communica-
tion messages without “destroying” the protocol. First, we consider protocol

divertibility, in which the (honest) intermediary, called a warden, randomizes
all messages so that the intended underlying protocol succeeds, but informa-

tion contained in subtle deviations from the protocol (for example, information
coded into the values of supposedly random challenges) will be obliterated by
the warden’s transformation. Next, we introduce atomic prozy cryptography, in
which two parties publish a proxy key that allows an untrusted intermediary to

convert ciphertexts encrypted for the first party directly into ciphertexts that
can be decrypted by the second. The intermediary learns neither cleartext nor
secret keys.

Our paper is organized as follows. In Section 2 we discuss divertible proto-
cols. In Section 2.1 we define protocol divertibility. VVe propose a slightly stricter
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definition than the original one by Okamoto and Ohta [OO90]. In Section 2.2,
we present a sufficiency criterion for divertibility. Its usefulness is demonstrated
by many examples of known diverted protocols from the literature. Also many

known blind signature protocols can be interpreted as diverted proofs of knowl-

edge and in this form they satisfy our criterion (see [Bleu97]). In Section 3,
we introduce atomic proxy cryptography and propose a taxonomy for proxy

schemes. In Sections 3.1 to 3.3 we give proxy schemes for encryption, identifi-
cation, and signature. In Section 4, we discuss the deeper relationship between
protocol divertibility and proxy cryptography.

2 Divertible Protocols

The idea of divertibility entered the cryptographic literature during the mid 80’s
with applications to identification protocols. The basic observation was that some

2-party identification protocols could be extended by placing an intermediary—

called a warden for historical reasons [Sim84]—between the prover and verifier so
that, even if both parties conspire, they cannot distinguish talking to each other
through the warden from talking directly to a hypothetical honest verifier and
honest prover, respectively, Since identification protocols were developed in close

relation to interactive zero-knowledge proofs (ZKP), Okamoto and Ohta [0090]
(and later Desmedt and Burmester [BD91] and Ihto et al [ISS91]) established
the notion of divertibility as a language property, i.e., a language is considered

divertible if it can be recognized by a diverted interactive zero-knowledge proof
system. In this paper, we establish divertibility as a 2-party protocol property,
which is orthogonal to zero knowledge or any other particular protocol property.

2.1 Definitions

In order to deal with protocols of more than two parties, we generalize the notion

of interactive Turing machine (ITM) by Goldwasser et al [GMR89]. Then we
define connections of ITMs and finally give the definition of protocol divertibility.

Definition 1 ((m,n)-Interactive Turing Machine).

An (m,n)-Interactive Turing Machine ((m,n)-ITM) is a Turing machine with
m 6 IN read-only input tapes, m write-only output tapes, rn read-only random
tapes, a work tape, a read-only auxiliary tape, and n 6 IN0 pairs of communication

tapes. Each pair consists of one read-only and one write-only tape that serves for

reading in-messages from or writing out-messages to another ITM. (The purpose
of allowing it = 0 will become clear below.) The random tapes each contain an
infinite stream of bits chosen uniformly at random. Read-only tapes are readable

only from left to right. If the string to the right of a read-only head is empty,
then we say the tape is empty.

Associated to an ITM is a security parameter k: 6 IN, a family D = {D,,},,

of tuples of domains, a probabilistic picking algorithm pick(k) and an encoding

Petitioner Apple Inc. — Exhibit 1002, p. 3611



Petitioner Apple Inc. - Exhibit 1002, p. 3612

scheme S. Each member

D, = (In£,1),. . .,In§,"‘), OutS,1),. .., 0ut§,’"), 05,1), . .., .Q,(,"‘),

<IM£.”, OW’). . . . , (IM£.">. 0M<."’))

of D contains one input (output, choice, in-message, out-message) domain for

each of the m input (output, random) tapes and n (read-only, write—only) com-

munication tapes. The algorithm pick(k) on input some security parameter k
outputs a family index 7r. Finally, there is a polynomial P(k) so that for each 7r
chosen by pick(k), S encodes all elements of all domains in D,, as bitstrings of
length P(k).

ITMs proceed in rounds. During each round, an ITM first reads the messages
from all its read-only communication tapes, then performs some computations
and finally writes a message to each of its write—only communication tapes.
It may write an empty string—denoted 5. If, at the beginning of a round, an

ITM finds all its input tapes and all its read-only communication tapes empty,
then it performs a last computation, writes empty strings to all its write—only
communication tapes, writes results to all its output tapes, and then stops. The
overall number of reading, writing and computation steps during an execution

of an ITM is bound by a polynomial in the security parameter Is.

An (m, n)-ITM is an m—party protocol if n = 0, and linear if n 3 2. The
native functions of an ITM A are defined as the family

nativ, :I'[:';1{2,,,,~ x In,,,,- x I'[;.’=1 [Mm ——> 1'[;.’=, OM,“-

of functions that, on input (rnd, in, im), return the respective out-messages that
A would write to its write-only communication tapes would it read this data

from its random, input and read-only communication tapes.

Let A be an (m,4, n)-ITM and B be an (m3,n)—ITM, which together make
up a protocol P = (A,B). Let m‘ 5 min(mA,m3) be the number of pairs of
communication tapes shared by A and B. Then the view of A on B on respective
inputs, denoted as,

vz'ewS3A)P([inA,1,...,in,4,mA]A,[in}3Y1,. ..,z'n3,,,,B]B) ,

is defined as everything that A sees from B, i.e., the probability distribution of

all m* -tuples of pairs of in—messages sent by A to B and out-messages returned
from B to A, where the probabilities are taken over the choices of the viewer
A.‘

For m—party protocols P, we adopt the following interface notation:

(out1,...,outm) 4- P(z'n1,...,z'n,,,) ,

where the left arrow indicates a probabilistic assignment. If the inputs or outputs
consist of several components, we delimit them by square brackets.

1 This is a generalization of the definition given by Goldwasser, Micali and Rackoff
[GMRB9].
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Definition 2 (Connections of ITMS). - ..

Let A be an (m,;,n,;)-ITM and B be an (1'n3,n3)-ITM with equal picking -
algorithm pick. Then a connection C = (A, B) is any ITM consisting of A and

B sharing c 3 min{nA,n3} pairs of their communication tapes. The picking
algorithm of C is pick, and the domains of C are defined as the Cartesian products
of the respective domains of A and B. 0

Obviously, the linear connection operator (0, o) is associative and we can there-
fore omit brackets in the usual way:

<A,B,c>‘1—3‘<<A,B>,c>= <A,<B,c>> .

All connections we consider in the following are linear and have a small constant
number of rounds.

Definition 3 (Divertibility of Protocols).

Let P = (A,B) be a two-party protocol with interface P([y,:c,;]A, [y,:c3]
and input domains In, = (Y, x X,;,,) x (Y, x X3,,). Common inputs y are
taken from Y,, whereas private inputs :c,;, :53 are taken from XA’, and X3),,

respectively. The product domain of private inputs is denoted X, = XA’, x X3,
Furthermore, let R = {R,}, be a family of relations R, Q Y, X X,.

The protocol P is called perfectly (computationally) divertible over R iff a
(1,2)-ITM W exists such that the following properties hold:

3)

EXTENSIBILITY: For all indices 7r, all common and private inputs (y, mg, 233) E
R,, the ensembles of views of B on W and on A, i.e.,

view$‘3’<A, W,B)([y,z,a]",[ylW,hazel”), and

view£f’<A,B><[y,zm [y,zBlB)

as well as the views of A on W and on B, i.e.,

view$€’<A, WaB)(lya$AlAall‘/lwali‘/a111BlB)a and

view§;"<A,B><[y,zA1A,W313)

are equal (polynomially indistinguishable).

PERFECT (COMPUTAT10NAL)_ INPISTINGUISHABILITY: For all polynomial-time
actively adversary lTMs A, B, for all indices 7r, all common and private

inputs (y, IA, 163) E R,_and all_po1ynomial size strings q representing shared
a pri(_)ri knowledge of A and B, the ensembles of simultaneous views of A
and B upon W and of their views upon honest B and A, i.e.,

m"ew‘;3=’§’</1, w,é><iy,zA,qmy1W,1y,zB,q1§> and

<m’ew§;"</1, B)(lZ‘/»113A» qr‘, iy, $313), m'ew£:’><A, é)(l3/:$AlA: iy, ms, ql5’))
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are equal (polynomially indistinguishable).2 3

An ITM W that satisfies extensibility and perfect (computational) indistin-

guishability is said to perfectly (computationally) divert protocol P over R. O

Divertibility as defined by Okamoto, Ohta [0090] and almost equivalently by
Itoh et al [ISS91] has been introduced as a language property. A language L is
considered divertible, if there exists a diverted zero knowledge proof system for

proving membership in L. In contrast, we define divertibility as a 2-party proto-
col property. The main difference between the two definitions is that we ask for a

concrete protocol P to be divertible, whereas they ask for existence of a divert-

ible protocol meeting a certain specification S (namely to be a zero-knowledge

proof). Consequently, Definition 3 (extensibility) relates the two interfaces of
the diverted protocol P’ to the interface of the given protocol P, where their
definition relates them to S. Another difference is, that we suggest a stronger
definition than Okamoto and Ohta’s. We require Indistinguishability even for

two attackers /i and 3 who know of each other (a-priori common knowledge
q) and who therefore know which of their views result from the same diverted
protocol instance. VVe discuss this further in Section 2.4.

An immediate consequence of the definition is that if a protocol P is di-

vertible, then we can insert second and third wardens and we, again, obtain a
diverted protocol.

2.2 Main Divertibility Result

Theorem 4 (Criterion for Perfect Divertibility).

Let P = (A,B) be a two-party protocol with interface P([y,:1:A]A, [y,:1:3]B). Let
the input domains be (Y, X X,;,,,) x (Y, x X3,,,), the random domains be 0,1,, X
031,, the out-message domains be 0M/4!” x OMB,“ and let the native functions
ofA and B be

nativA,,, 2 0,1,, x Y, x XA,,, >< OMB’, —> 0MA:7f ,

nativl-3),, : 03,, X Y, x X3’, >< 0M,4),, —> OMB), .

Furthermore, let R = {R,,},, be afamily of relations R, Q Y, x (XAJ, >< X3,,,),
which capture the correspondence between the private and the public inputs.

Then P is perfectly divertible over R if only there exist:

a family (.Q,,,®, 1) of {not necessarily commutative) groups, and

2 By view§3A)P, we denote the view of A on B in a protocol P. This notion as well
as that of polynomial indistinguishability of families of random variables is defined,

e.g., by Goldwasser, Micali and Rackoff [GMR89].
3 Equality (polynomial indistinguishability) is required only for the views on complete

runs of the diverted protocol, i.e., runs that the warden has not aborted, for example,

because he has detected either A or B cheating.
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{ three families of functions

base, 2 Y, X X,;,, X X3’, —v OMA}, X OMB’, ,

join, 2 .QA,, X .03’, X Y, X XA,, X X3’, —V 0,,

divrt, : Q, X Y, X 0MA,, X OMB’, —» 0MA,, X OMB’, ,

with the following properties:

Function divrt(u2, y, 0,1, o3) is defined only for (oA,o3) that live in the re-

spective image 0M,,y of native,; and nativeg, i.e.,

0Mn,y = nativ6A(-QA, YJJIA, 03) X 77'“ti'U5B(-QB: 9,933, 0A) ,

where (y,zA,z3) E R,.4
Second, for each fixed a,fl, y, zA,z3 E R,, the functions,

join-;r(aIaB7y>$A>$B) and join-;r(a7.6/7y7$A:$B) 7

are each bijective on 0,; and .03, respectively.
a warden W that on input two in-messages oA,o3 computes two out-

messages o’A, 0'3 such that

(02, 02) = divrt(w, 11, (am 03)) -

Now, for every ‘Jr, for all random choices a E QA,,,[3 6 03,, all common
and corresponding private inputs (y, $A,:c 3) 6 R,, and all out-messages 0,; 6
0M,;,,, 03 6 0M3:, the following three conditions must hold:

DECOMPOSITION:

(na’tivA(a1 ya ‘TA: 03): nativB(IB1 ya 1:3: 0.4»

= dl-'Urt(j0in(a7 :8: ya $.47 1:3): ya ba’Se(y7 -TA» -'33)) 2

GROUND:

diWt(1,y, (0A,0B)) = (0A,0B) ,
Mixi-:13 ASSOCIATIVITY:

divrt(w', y, divrt(w, y, (o,;, oB))) = divrt(w Ow’, y, (oA, 03)) .

0

Proof. First observe that if divrt satisfies the premises GROUND and MIXED

ASSOCIATIVITY, then it is injective as a function ofw: For all (oA, 03) E 0M,,y,
we have:

(Om 019) = diWt(1, 11, (GA, 03))

divrt(w Q w'1,y, (oA,o3)) (for any to)

divrt(w’1,y,divrt(w,y,(oA, oB))) .

4 Note that the input variables 0,4 and 03 in the definition of OM,,,, refer to the
output of native and nativg, respectively. This recursion is guaranteed to terminate
by the following requirement (iii) below.
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So, function divrt turns out to be bijective on (2,, for the entire parameter domain

OM,,,y. We may thus write: divrt-1(a), 0) = divrt(w'1,o).
In order to infer extensibility and indistinguishability of P, we look separately

at the out-messages between (A, W) and B and those out-messages between A
and (W, B). We deal with the former case in detail and argue that the latter case

can be handled analogously due to symmetry reasons. Using DECOMPOSITION
and MIXED ASSOCIATIVITY, we rewrite the above mentioned out—messages as
follows:

(nativ(,4’w)(w, a, y, 2,4, 03), natz'vB(fi, y, 23, o,4))

= div'rt(w, y, (natz'v,4(a, y, 2,4, 0'3), nativ3(fi, y, 23, o:4)))

= dz'vrt(w, y, divrt(w’, y, base(y, 2,4, 213))),

where w’ = j0in(a, H, y, 2,4, 23)

= div'rt(w' (9 cu, y, base(y, 2,4, 23))

= (na‘tiv/1 (alv yv ‘T/1703)? na'tivB(w7 fila Z/71:3} 0/1» 9

where (0/,fi') =joz'n"1(w' (D w, y, 2,4, 23) .

It then follows from the bijectiveness of join and the fact that (D is a group
operation that the probability of each pair of out-messages is the same over

Bob’s choices B and over 3’ . Together with the analogous result for out-messages

between A and (W, B) (this is where invertibility of divrt is needed), this settles

extensibility. ~ _
For perfect indistinguishability, we need to deal with arbitrary attackers A, B,

instead. Assume, these attackers produce their out-messages with a certain distri-
bution D that respects the domain of function divrt. Otherwise, divrt is undefined

and the distribution could be ignored according to indistinguishability. Then by
decomposition, we see that this given distribution D can also be achieved by
honest Alice and Bob if Bob would chose his fl according to some appropriate
distribution d. Following the above rewriting, and again taking into account that
join is bijective and (D is a group operation, we conclude, that the distribution

of w’ (9 w is d because, by presumption, the warden is honest and therefore an

is uniformly distributed. Hence, the out—messages of (A, W) and B are also dis-
tributed according to D, if the probabilities are taken over B’. Together with the
analogous result for out—messages between A and (W, B), this in addition settles
perfect indistinguishability and therefore perfect divertibility. D

2.3 New Exaxnple of Diverted Protocol

The most prominent examples of diverted protocols in the literature are diverted
interactive proofs and blind signatures. Since divertibility has been introduced

only in the former context, blind signatures are a good example to illustrate
the more general concept of divertibility of protocols as proposed in Defini-

tion 3. The practical value of Theorem 4 is demonstrated in [Bleu97] by proving
many protocols unconditionally divertible; in particular the diverted ZKP

that Okamoto and Ohta used to prove their main theorem [0090] and (ii) a
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blind modified ElGamal Signature, which was presented by Horster, Michels

and Petersen [HMP95] who built on ideas of Camenisch, Piveteau and Stadler
[CPS95].

Here, we consider a new sort of protocol for divertibility, namely key ex-

change. In Figure 1, we present a diverted Diffie~Hellman key exchange protocol
[DH76]. Let p be a k-bit prime (k: 6 IN), q be a large prime divisor ofp — 1 and

Gq be the unique (multiplicative) subgroup of order q in Z; Furthermore, g 75 1
denotes a randomly chosen element of Gq. (The restriction to g aé 1 asserts that
g generates Gq). p, q and g are global system parameters and neither Alice nor
Bob have private inputs.

([a"l", [b"]B) <- DDH(l]", []W:l]B)

Alice Warden Bob

(1) aénlq wen Z4 flea Z4
(2) 0 <- 9° 17 <- 9”

<3) 4-» (aw) ~ (a“2b“) ~"—

all {_ bio ‘L 4 bu {_ alfi

Fig. 1. Diverted Diffi&Hellman Key Exchange

Proposition 5. The warden ofpratocol DDH computationally diverts the Diflie-
Hellman protocol between Alice and Bob over R = (0. 0

Proof (Sketch. If for given (a, b), an attacker could distinguish valid from invalid

diverted out-messages (a’, b’) with non-negligible probability, i.e., probability

> m for some polynomial P, then he had broken the simultaneous discrete
log assumption [CEG88]. D

2.4 Why the Previous Definition is a Little too Weak

The previous definition of divertibility by Okamoto and Ohta [OO90], and by
Itoh et al [ISS91] as well, requires that two attackers A, B who on the one hand

form a linear 3-party protocol _P’ with an intermediate warden~and on the other
hand form 2-party protocols (A, B) with an honest B and (A, B) with an honest

A cannot distinguish their views in (A,B) and (A, B) from those in separate
instances of (A, W, B). More formally, they require indistinguishability of the
two ensembles (protocol inputs exactly as in Definition 3 before):

(m‘ew‘,:,‘)(,«i, W,B),view(,3)(A, w,B)) (1)

and (viewS9A)(A, B), view£,B)(A, (2)
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However, the attacker model that seems to underly the literature on divertibility
is stronger than expressed by the above requirement. The attackers A and B are

usually assumed to know when they engage in a protocol with the warden and
so they know which of their views result from the same protocol instances.

A good example to illustrate this difference is protocol DDH in Section 2.3.

The two ensembles according to (1) and (2) above are equal and thus protocol
DDH would have to be regarded as perfectly diverted. This is counterintuitive

because the warden in DDH uses less random coins than Alice and Bob together.
On the other hand, according to Definition 3, DDH is only computationally
diverted, which is the most we would expect.

3 Atomic Proxy Cryptography

A basic goal of public-key encryption is to allow only the key or keys selected

at the time of encryption to decrypt the ciphertext. To change the ciphertext
to a different key requires re—encryption of the message with the new key, which
implies access to the original cleartext and to a reliable copy of the new encryp-
tion key. Intuitively, this seems a fundamental, and quite desirable, property of

good cryptography; it should not be possible for an untrusted party to change
the key with which a message can be decrypted.

Here, on the other hand, we investigate the possibility of atomic pro:1:yfunc-
tions that convert ciphertext for one key into ciphertext for another without

revealing secret decryption keys or cleartext messages. An atomic proxy func-
tion allows an untrusted party to convert ciphertext between keys without access
to either the original message or to the secret component of the old key or the
new key. In proxy cryptography, the holders of public-key pairs A and B cre-

ate and publish a proxy key 7r,4_.3 such that D(H(E(m, eA), 7rA_.3),d3) = m,
where E(m, e) is the public encryption function of message 771 under encryption

key e, D(c,d) is the decryption function of ciphertext c under decryption key
(1, H (c, 7r) is the atomic proxy function that converts ciphertext c according to
proxy key 7r, and e,4, e3, (1,4, d3 are the public encryption and secret decryption

component keys for key pairs A and B, respectively. The proxy key gives the
owner of B the ability to decrypt “on behalf of” A; B can act as A’s “proxy.”
In other words, the H function effectively allows the “atomic” computation of

E(D(c, d,4), e3) without revealing the intermediate result D(c, (1,4).

We consider atomic proxy schemes for encryption, identification and signa-

tures. An encryption proxy key 7rA_.B allows B to decrypt messages encrypted
for A and an identification or signature proxy key 7r ,4_. 3 allows A to identify

herself as B or to sign for B (i.e., transforms A’s signature into B’s signature).
Generating encryption proxy key 7r,4... 3 obviously requires knowledge of at least

the secret component of A (otherwise the underlying system is not secure) and
similarly generating identification or signature proxy key 7r,4_.3 requires B’s

secret, but the proxy key itself, once generated, can be published safely.
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Categories of proxy schemes Encryption proxy functions (and similarly but
contravariantly, identification or signature proxy functions) can be categorized
according to the degree of trust they imply between the two key holders. Clearly,

A must (unconditionally) trust B, since the encryption proxy function by defi-
nition allows B to decrypt on behalf of A. Symmetric proxy functions also imply
that B trusts A, e.g., because d3 can be feasibly calculated given the proxy key

plus d,4. Asymmetric proxy functions do not imply this bilateral trust. (Note
that this model implies that proxy cryptography probably makes sense only in
the context of public-key cryptosystems. Any secret-key cryptosystem with an

asymmetric proxy function could be converted into a public-key system by pub-
lishing one key along with a proxy key that converts ciphertext for that key into

ciphertext for a second key (which is kept secret.))
We can also categorize the asymmetric proxy schemes that might exist ac-

cording to the convenience in creating the proxy key. In an active asymmetric
scheme, B has to cooperate to produce the proxy key 7r,4_. 3 feasibly, although

the proxy key (even together with A’s secret key) might not compromise B’s
secret key. In a passive asymmetric scheme, on the other hand, A’s secret key

and BS public key suffice to construct the proxy key. Clearly, any passive asym-
metric scheme can be used as an active asymmetric scheme, and any asymmetric
scheme can be used as a symmetric scheme.

Finally, we can (informally) distinguish proxy schemes according to the “meta-
data” they reveal about the identity of the secret-public key-pairs being trans-

formed. Transparent proxy keys reveal the original two public keys to a third
party. Translucent proxy keys allow a third party to verify a guess as to which

two keys are involved (given their public keys). Opaque proxy keys reveal noth-
ing, even to an adversary who correctly guesses the original public keys (but
who does not know the secret keys involved).

Proxy schemes in theory and practice The proxy relationship is necessarily
transitive. If there are public proxy keys 7r,4_.3 and 7rB_.g, then anyone can

compute a proxy function for A —> C. Symmetric proxy schemes further establish
equivalence classes of keys where the secret component of any key can be used to
decrypt messages for any other key in the same class. Note that creating a single
symmetric proxy key between a key in one class and a key in another effectively
joins the two classes into one.

The notion of proxy cryptography is a rather natural generalization of public-

key cryptography and has some nice theoretical properties. The proxy schemes
we consider below have the additional property that anyone can use the proxy

key 7r,4...B to transform the public key of A to the public key of B. For such
proxy schemes, as we will see in the various examples below, certain aspects of

the security of publishing a proxy key actually follow from the fact that anyone,
trusted or not, can use a proxy key to transform ciphertext and keys.

For example, suppose random messages m and m’ are encrypted with random
secret keys a and b as E(m, a), E(m’,b). Suppose that knowing the proxy key

71',4_. 3 enables Eve, who knows neither a nor b, to recover m or m’. Then, ignoring

Petitioner Apple Inc. — Exhibit 1002, p. 3619



Petitioner Apple Inc. - Exhibit 1002, p. 3620

B altogether and starting with just two (presumably secure) ciphertexts E(m, a)

and E(m’, a), Eve can pick a random proxy key 7‘ = 7rA_,Q for some Q, transform

E(m’,a) to E(m’, q) (where q is the unknown secret key of Q), transform A’s
public key into Q’s public key, and proceed with the hypothesized cryptanalysis.

We conclude that if it is safe for A to publish It messages then it is safe for A
and B to publish a total of k messages and to publish a proxy key, provided

only that Eve can successfully apply the proxy key to transform ciphertext and
public keys.

Because proxy keys are tied to specific key pairs, it is not necessary in many

applications to certify or otherwise take special care in distributing them (except

to prevent denial-of-service). In particular, it is generally sufficient to rely on
the certification and trust established in A (for encryption) or B (for signatures)

when using proxy key 7rA_, 3, since a valid proxy key can by definition only be
generated with the cooperation of the owner. Furthermore, the proxy function
can be safely applied at any convenient time or place, by the message’s sender or

receiver, or at any intermediate (and possibly untrusted) point in the network.
Proxy functions potentially also have practical utility for key management

in real systems. For example, some pieces of secure hardware (e. g., smartcards)

limit the number of secret keys that can be stored in secure memory, while some
applications might require the ability to decrypt messages for more keys than
the hardware can accommodate. With proxy cryptography, once a new key is
created and a corresponding proxy key generated, the secret component of the

old (or new) key can be destroyed, with the (public and externally—applied) proxy
key maintaining the ability to decrypt for both. In effect, proxy functions allow
us to increase the number of public keys without also increasing the number of
secret bits or the amount of secret computation. Because proxy functions can

be computed anywhere, messaging systems, such as electronic mail, can proxy
“forward” messages encrypted with one key to a recipient who holds a different
key. Proxy functions make it possible to associate a single key with a network

or physical address but still decrypt messages forwarded (and proxied) from
other addresses. Finally, proxy functions effectively allow changing or adding a

key without obtaining new certificates or altering the distribution channel for the

previous public key; this could be useful when it is difficult to distribute or certify
new keys (e.g., old keys were published in widely-distributed advertisements or
embedded in published software, or the certification authority charges high fees

for new certificates).

Security of proxy schemes and ad hoc substitutes If Alice wants Bob
to be able to read her mail, instead of issuing a proxy key she might just give

Bob her secret key (perhaps, obviating the need to involve Bob, by encrypt-
ing it in Bob’s public key and publishing it). This would be inferior to using
a proxy scheme for several reasons. First, as discussed above, Bob’s computing

environment may be limited and therefore incapable of automatically processing
encrypted secret keys; any new software to decrypt and manage such keys would
have to run within the environment trusted by Bob. Proxy processing, on the
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other hand, can take place entirely outside of Alice’s and Bob’s trusted envi-

ronments and without their active involvement. Furthermore, encrypting one’s
secret key with another’s public key is not in general secure. The cryptosys-

tem we present below, a variant of ElGamal [ElG85], is thought to be secure in
part because the cryptanalysis problem is random-self-reducible—which allows

one to assert mathematically that recovering m from the public information

(ea,E(m,ea),e(,) is hard on average if it is hard at worst. The task of recov-
ering m from (ea, E(m,ea),E(da, eb), eb), however, may be considerably easier

since E(da,e¢,), in the context of ea and eb, may leak information about d,,———
specifically, the new cryptanalysis problem is probably not random—self-reducible

and due to the problem’s obscurity it is not clear what, if any, mathematical guar-

antees of security can be given. By contrast, the proxy scheme we give below is
just as strong as the underlying cryptosystem.5

Related work A natural question to ask is whether there exist atomic proxy

functions (and feasible schemes to generate proxy keys) for any public key cryp-
tosystems.

Previous work on delegating the power to decrypt has focused on develop-

ing eflicient transformations that allow the original recipient to forward spe-

cific ciphertezts to another recipient. Mambo and Okamoto [M097] develop this
formulation and give efficient transforms (more efficient than decryption and

re-encryption) for ElGamal and RSA. Mambo, Usuda and Okamoto [MUO96]
apply a similar notion to signature schemes.

VVhile such schemes have value from the standpoint of efficiency, they are not,
however, “atomic proxy cryptosystems” by our definition because the transform-
ing function must be kept secret and applied online by the original keyholder on

a message-by-message basis (the schemes are not atomic). The security seman-
tics of these systems are essentially the same as a decryption operation followed

by a re-encryption operation for the new recipient. Our formulation of proxy
cryptography is distinguished from the previous literature by the ability of the
keyholder to publish the proxy function and have it applied by untrusted parties
without further involvement by the original keyholder.

3. 1 Proxy encryption

Although the problem of proxy cryptography seems like a natural extension of
public-key cryptography, existing cryptosystems do not lend themselves to obvi-

ous proxy functions. RSA [RSA78] with a common modulus is an obvious can-
didate, but that scheme is known to be insecure [Sim83,DeL84]. Similarly, there

5 Note that Bob of this example may be a government mandating that Alice provide
him with access to her key. It has been argued that such a scheme makes the system
as a whole less trustworthy due to the extra engineering effort involved; we argue here
that in the case of random—self-reducible cryptosystems such as ElGamal variants,
requiring Alice to encrypt her secret key using the government’s public key may also
weaken the underlying cryptosystem in the precise mathematical sense of spoiling
the random-self-reducibility.
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do not appear to be obvious proxy functions for many of the previous discrete-
log-based cryptosystems. This is not to say, of course, that proxy functions for
existing systems do not exist.

We now describe a new secure discrete-log-based public-key cryptosystem
that does have a simple proxy function. The scheme is similar in structure to

ElGamal encryption [ElG85], but with the parameters used differently and the

inverse of the secret used to recover the message.“ (This approach has merit
beyond proxy encryption; [Hug94] proposed a Difiie—Hellman—like key agreement
protocol based on the inverse of the secret, which allows a message’s sender to

determine the key prior to identifying its recipient).

Cryptosystem X (encryption) Let p be a prime of the form 2q + 1 for a

prime q and let g be a generator in Z;; p and g are global parameters shared
by all users. A’s secret key a, 0 < a < p — 1, is selected at random and must

be in Zgq, i.e., relatively prime to p — 1. (A also calculates the inverse a'1 mod
2q). A publishes the public key g“ mod p. Message encryption requires a unique

randomly-selected secret parameter k 6 Zgq. To encrypt m with A’s key, the
sender computes and sends two ciphertext values (cl, cg):

cl = mgk mod};

02 = (galk mod?

Decryption reverses the process; since

CE“) = 9" (mod P)

it is easy for A (who knows a’1) to calculate g’‘ and recover m:

_ (“-1) -1 dm-01((C2 ) )m0 P

The efficiency of this scheme is comparable to standard ElGamal encryption.

Symmetric proxy function for .1’ Observe that the c1 ciphertext component
produced by Cryptosystem X is independent of the recipient’s public key. Re-

cipient A’s key is embedded only in the cg exponent; it is sufficient for a proxy
function to convert ciphertext for A into ciphertext for B to remove A’s key a
from cg and replace it with B’s key b. Part of what a proxy function must do,

then, is similar to the first step of the decryption function, raising cg to a“ to
remove a. The proxy function must also contribute a factor of b to the exponent.

Clearly, simply rasing cg to a’1 and then to b would accomplish this, but obvi-
ously such a scheme would not qualify as a secure proxy function; anyone who
examines the proxy key learns the secret keys for both A and B.

This problem is avoided, of course, by combining the two steps into one.

Hence, the proxy key 7rA_.3 is a‘1b and the proxy function is simply c;"‘“’3.

6 David Wagner notes that this proxy scheme can be extended to work with standard
ElGamal encryption.

Petitioner Apple Inc. — Exhibit 1002, p. 3622



Petitioner Apple Inc. - Exhibit 1002, p. 3623

Note that this is a symmetric proxy function; A and B must trust one another

bilaterally. B can learn A’s secret (by multiplying the proxy key by b‘1), and A
can similarly discover B’s key. Observe that applying the proxy function is more

efficient than decryption and re-encryption, in that only one exponentiation is
required.

Security of X First, we show that X is secure—that cleartext and secret

keys cannot be recovered from ciphertext and public keys. Beyond that, we also
show that publishing the proxy key compromises neither messages nor secret

keys. Since recovering a secret key enables an adversary to recover a message
and since cryptanalysis is easier with more information (i.e., a proxy key), it is
sufficient to show that no cleartext is recoverable from ciphertext, public keys,

and proxy keys. Specifically, we will show that the problem of recovering m from

(ga7 gb7gc7 ‘ ' ' 7 gaki ' ' ')'

is at least as hard as Diffie-Hellman.

Theorem 6. Suppose there exists a randomized algorithm f that with probability
6 > 1/|p|0(1) succeeds in recovering m from the public information

(9“,9”, - . -,m9'°,9“'°,b/a, - - -)

where the probability is taken over f ’s random choices as well as over m and the

parameters a, b, and k. Then, for each 77 = 2‘l"l0m, there exists a randomized
polynomial-time algorithm for Difie-Hellman that succeeds with probability 1-77.

Proof. The proof is found in [BS98].

Similarly one can show that recovering a from (g“,g",mg'°,g“k,b/a) is as
hard as the discrete log, so publishing the proxy key does not compromise a—
not even to the level of Diffie-Hellman.

3.2 Proxy identification

In this section we describe a discrete—log-based identification scheme. With p, g, a
as before, Alice wishes to convince Charlotte that she controls (2; Charlotte will

verify using public key g“. As before, the proxy key 7rA..3 will be a/b—it will

be safe to publish a/b and Alice and Charlotte can easily use a/b to transform
the protocol so Charlotte is convinced that Alice controls b.

Note that in the case of a secure identification proxy key that transforms
identification by A into identification by B, it is B whose secret is required

to construct the proxy key because identification as B should not be possible
without B’s cooperation.
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Cryptosystem )7 (identification) Let p and g be a prime and a generator in

Z,",, respectively. Alice picks random a 6 25,, to be her secret key and publishes
g“ as her public key. Each round of the identification protocol is as follows:

— Alice picks a random 1: E 2;, and sends Charlotte s1 = gk.
—— Charlotte picks a random bit and sends it to Alice.

— Depending on the bit received, Alice sends Charlotte either s2 = Ic or sg =
k/a.

— Depending on the bit, Charlotte checks that (g“)53 = 31 or that gs’ = gk.

This round is repeated as desired. As with existing protocols, there may be

ways to perform several rounds in parallel for efficiency [FFS88].

Symmetric proxy function for )7 A symmetric proxy key is a/b. Suppose
Charlotte wants to run the protocol with gb instead of g“. Either Alice or Char-
lotte or any intermediary can use the proxy key to convert Alice’s responses lc/a
to k/b.

Security of )7

Theorem 7. Protocol )7, with or without proxy keys published, is a zero knowl-
edge protocol that convinces the verifier that the prover knows the secret key.

Proof. The proof is found in [BS98].

3.3 Proxy signature

The concept of proxy cryptography also extends to digital signature schemes.
A signature proxy function transforms a message signature so that it will verify
with a public key other than that of the original signer. In other words, a signa-

ture proxy function H(s,7rA_,B) with proxy key 1rA_.B transforms signature 3
signed by the secret component of key A such that V(m, H(S(m, A), 7rA_.B),B)
returns VALID, where S(m, k) is the signature function for message m by key I:

and V(m, s, k) is the verify function for message m with signature s by key 1:.
Again, existing digital signature schemes such as RSA [RSA78], DSA [NIS91] ,

or ElGamal [ElG85], etc. do not have obvious proxy functions (which, again, is
not to say that such functions do not exist).

As in the case of proxy identification, in order to construct a proxy key
that transforms A’s signature into B’s signature, B ’s secret must be required to
construct the proxy key because signing for B should not be possible without
B’s cooperation.

Now we will see how to use the proxy identification scheme to construct a
proxy signature scheme. We suppose there exists a hash function h whose exact

security requirements will be discussed below. The parameters p, g, a,b are as
before.
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Cryptosystem Z (signature) To sign a message m, Alice picks k1,k:2, . . .kg

at random and computes g'°1,...g'”. Next Alice computes h(g'°1,...g'”) and
extracts Z pseudorandom bits ,6], . . . , fig. For each 2', depending on the i’th pseu-

dorandom bit, Alice (who knows a) computes s2,,- = (k,- — m,6,~)/a; that is,
s2,,- = (kg — m)/a or s2,,- = k,-/a. The signature consists of two components:

31 : (gk17"':gkl)

S2 = ((191 - W151)/0, - --;(ke — mm)/0)

To verify the signature, first the ,8,-’s are recovered using the hash function.
The signature is then verified one “round” at a time, where the i’th round is

(g'°", (kg — m,6,~)/a). To verify (g’‘, (k: — m,6)/a) using public key g“, the recipient
Charlotte raises (g“) to the power (k:—mfi) /a and checks that it matches gk/gmfi.

Symmetric proxy function for Z A symmetric proxy key 7rA_.B for this

signature scheme is a/b. The proxy function H leaves s1 alone and maps each
component s2,,- to s2,,~7r,4_.B.

Security of Z This scheme relies on the existence of a “hash” function h.

Specifically (Hash Assumption), we assume there exists a function h such that:

— On random input (g“,m), it is difficult to generate {r,} and {,6,-} such that

,...,g“"+'""l) = (m ...,a>.

-— More generally, it is difficult to generate such {r,-} and {B,-} on input g“, m,
and samples of signatures on random messages signed with a.

h(gar1 +m,61

It is not our intention to conjecture about the existence of such functions h.
In particular, we do not know the relationship between the hash assumption and

assumptions about collision freedom or hardness to invert.7 We note that this
generic transformation of a protocol to a signature scheme has appeared in the

literature [FS87].
We now analyze the hash assumption. Note that in order to produce a legit-

imate signature on m that verifies with g“, a signer needs to produce (g'“) and

((19; — m,8,-)/a). Thus, putting (,6,-) = h((g"‘)) and then (r,-) = ((k,- — m,6,-)/a), it
is straightforward to see that the signer could actually produce r,~’s and ,6,-’s of

the stated type in the course of producing the signature.
While we do not address the security of h, we can state that issuing proxy

keys does not weaken the system.

Theorem 8. Suppose h satisfies the hash assumption. Then, for most b, it is

also hard to produce {r,} and {,8,~} given additional input a/b, g'’, and samples
of messages signed with b.

Proof. The proof is found in [BS98].

7 The hash assumption does imply that, on random input g“, it is hard to find (73)
making all the H.-’s zero, i.e., such that h(g"'1 , . . . ,g‘"‘) = 0.
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4 Conclusions

Conceptually, divertibility and proxiability of protocols are both defined in terms
of an effectiveness property and one or two security properties. The eflectiveness
property is basically the same in both cases, namely extensibility as in Defini-

tion 3. Our more recent work shows that a proxy key can be naturally incorpo-

rated into (and makes sense for) divertibility as well. In the case of divertibility,
the security requirement is that Alice and Bob cannot communicate any sub-
liminal message through the warden. In the case of proxiability, the security
requirement is that the proxy key releases no more information than what ei-

ther Alice or Bob would release in the original protocol. A complete unifying
framework remains as future work.

We have introduced the notion of perfect and computational protocol divert-

ibility, and have given a sufficiency criterion for the former. All existing diverted
protocols we have found in the literature turned out to satisfy this criterion. The

first example of a diverted key distribution protocol was given. This is also the
first computationally divertible protocol we know of.

Intuitively, atomic proxy cryptography is a fairly natural extension of the
basic notion of public-key cryptography. It surely seems plausible, given that

there exist cryptosystems that can grant the ability to encrypt without granting
the ability to decrypt, that there might also exist cryptosystems that can grant
the ability to re-encrypt without granting the ability to decrypt. However, it is

not at all obvious whether there exist atomic proxy schemes in general.
Indeed, while this paper demonstrates that there do exist eflicient and se-

cure public-key encryption and signature schemes with symmetric atomic proxy

functions, this observation probably raises more new questions than it answers.
In particular, do proxy functions exist for public-key cryptosystems based on
problems other than discrete-log? (One possibility is that, for some cryptosys-

tems, proxy functions do exist but it is infeasible to find a proxy key.) More
importantly, we have yet to discover a secure asymmetric proxy function of any

kind; asymmetric proxy functions are probably much more useful in practice,
since there are likely many situations where trust is only unidirectional. Are
there cryptosystems for which asymmetric proxy functions exist?
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SYSTEM AND METHOD FOR CONNECTING

GAMING DEVICES TO A NETWORK FOR REMOTE PLAY

Background of the Invention

Field of the Invention

[0001] The present invention generally relates to electronic devices. In particular,

_ the invention relates to methods and systems of interactive gaming.

Description of the Related Technology

[0002] Traditionally, the way for a gaming operator to increase revenue from

gaming devices is to increase the number of gaming devices available for play. In order for

casinos to increase the number of gaming devices available for play, casino floor space must be

added to house the additional gaming devices. The floor space allocated to house additional

gaming devices must meet specific criteria as defined by the gaming authority for the jurisdiction

in which the gaming devices are to be located. Providing additional floor space is an expensive

process for casino operators and often requires constructing new casino properties. Also, adding

gaming devices typically requires payment of additional licensing fees for each additional game.

[0003] A trend in the gaming industry has been to provide Internet gaming. Internet

gaming allows players to make wagers on the outcome of casino style games similar to that

described above, except that the player does not have to be physically located in a casino to do

so. Internet players make wagers and play casino games using a personal computer and wager on

games running on computers connected to the Internet.

[0004] More broadly, interactive gaming is the conduct of gambling games through

the use of electronic devices. The popularity of Internet gambling sites has indicated a strong

market for remotely accessible gaming, or other interactive gaming. Regulated casino operators

strongly desire to provide interactive gaming while capitalizing on existing infrastructure. Thus

there is a need for improved electronic devices that support regulated remote gaming.

Sugg of the Invention

[0005] The system of the present invention has several aspects, no single one of

which is solely responsible for its desirable attributes. Without limiting the scope of this

invention as expressed by the claims which follow, its more prominent features will now be

discussed briefly. Afier considering this discussion, and particularly after reading the section

entitled “Detailed Description of the Invention” one will understand how the features of this

invention provide advantages which include providing remote gaming in regulated environment.
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[0006] A gaming system and method of using the same to allow a host gaming device

to be played from remote player devices to allow casino operators to obtain maximum advantage

from their gaming licenses.

[0007] More particularly, in one embodiment gaming system may comprise a data

network, a host gaming device connected to the data network, the gaming device configured to

execute at least one game and a plurality of remote player devices connected to the data network.

Each of the remote player devices is configured to receive game information provided by the host

gaming device. Whether each remote player device is permitted to receive gaming data may be

based upon, at least in part, the geographic location of the remote player device.

[0008] The host gaming device may be configured to allow no more than a

predetermined number of remote player devices to concurrently receive game information provided

by the host gaming device during the gaming session. This predetermined number may be

determined by a gaming agency. ‘

[0009] In another embodiment of a gaming system, at least one of the plurality of

remote player devices may be permitted to receive game data based upon, at least in part, the

geographic location of the remote player device, an age of a user of the remote player device.

[0010] A gaming system according to the invention may also include a central gaming

controller configured to record gaming transactions on the host gaming device and on each remote

gaming device.

[0011] The data network may be, in part, the Internet, and be comprised of one or

more logical segment, which may include closed—loop networks. The host gaming device may be

configured to identify the geographic location of a remote player device based, at least in part, on a

logical segment corresponding to the remote player device. A mobile communications network, or

- a GPS device may also allow identification of the geographic location of the remote player device.

[0012] The host gaming device may be in a location approved by a gaming agency and

include at least one game control configured to provide local use. This game control may be

disabled when the host gaming device is providing game infomiation to a remote player device. A

host gaming device may also be configured to save an encrypted game state allowing a game to be

resumed following a device or network failure. .

[0013] A remote player device may be coupled to a credential device configured to

receive information relating to a user of the remote player device. The information relating to a

user may include the age of the user, or a password that is input by the user. The credential device

is a smart card reader, a biometric device such as a fingerprint reader, or any type of input device.

The credentials may be verified against information, such as age, password, or fingerprint in a

database configured to provide information associated with each of a plurality of users of the

gaming system.
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[0014] In another embodiment, a gaming system may be comprised of a means for

executing at least one game, the game providing game information during its execution, a local

access means provides local access to the game information for a user in a location approved by a

gaming agency, player means for receiving game information, presenting the game information to a

user and providing at least one game control, a means for providing the game information over a

data network to a predetermined number of receiving means, means for determining the location of

the receiving means, and means for disabling the local access means. Other similar embodiments

may also be comprised of means for creating an auditable record of gaming transactions on the

playing means and on the gaming means.

[0015] Another embodiment of a gaming system, in addition to the features of the

embodiments discussed above, may also include customized promotional messages to players of

gaming devices.

[0016] On a remote player device, an embodiment of a method of remotely accessing

a host gaming device may include: establishing access to the host gaming device through a data

network, receiving gaming related information from the host gaming device through the data

network, presenting the gaming related information to a player, receiving at least one control signal

from the player, sending the control signal to the host gaming device through the data network, and

disabling local use of the host gaming device. In one embodiment, the method may also include

recording each gaming transaction occurring on the remote player device. Another embodiment of

the method may include providing a geographic location of the remote player device. In another

embodiment of the method, the age of the user of the remote player device is also provided.

[0017] On a host gaming device, an embodiment of a method of providing remote

access, including: verifying the geographic location of a remote player device, establishing a

gaming session on a host gaming device from a remote player device through a data network,

receiving at least one control signal from the remote player device through the data network, and

sending gaming related information from the gaming device through the data network. One

embodiment of a method may also include recording each gaming transaction occurring on the host

gaming device,

[0018] In order to provide tolerance for failures of system components, a method of

resuming an interrupted gaming session on a gaming device is provided. One embodiment of a

method may include generating a gaming state of the gaming session on the first gaming device,

encrypting the gaming state, transporting the encrypted gaming state from the gaming device. The

method may also include the converse: transporting the encrypted gaming state from the first

gaming device to a second gaming device, decrypting the gaming state on the second gaming

device; and loading the game state into a second gaming device to resume the gaming session.
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[0019] An‘ embodiment of a gaming system which provides for resuming interrupted

gaming sessions across a data network. The system may include a first host gaming device

connected to the data network, the gaming device configured to execute at least one game, generate

a gaming state based on execution of at least one game, encrypt the gaming state, and send the

encrypted gaming state over the data network. A second host gaming device may be connected to

the data network, the second gaming device configured to receive the encrypted gaming state over

the data network, decrypt the gaming state, and resume executing at least one game from the

gaming state. A plurality of remote player devices, configured to receive game information

provided by the host gaming device, may be connected to the data network. The gaming state may

include user payment or credit information, and game jackpot or payout information.

[0020] Another embodiment of a gaming system providing resumption of interrupted

gaming sessions may include means for executing at least one game, means for generating a

gaming state based on execution of at least one game, means for encrypting the gaming state, and

means for sending the encrypted gaming state. The system may also include means for receiving

the encrypted gaming state, means for decrypting the gaming state and means for resuming

executing at least one game from the gaming state.

[0021] To enable gaming regulatory compliance, methods authenticating gaming

system users are also provide. An embodiment of a method of authenticating a user of a host

gaming device may include receiving a security certificate fi'om the smart card, sending the security

certificate from the gaming device to an authenticator device, receiving an authentication reply

from the authenticator, and playing a game in response to the authentication reply.

[0022] An embodiment of the method may also include presenting the security

certificate from the gaming device to a certificate authority for authentication over a data network.

[0023] An embodiment of a method of authenticating a user of a remote player device

for playing a host gaming device may include receiving an indicia of identity for a user, sending the

indicia of identity to an authenticator device, receiving an authentication reply from the

authenticator device, and authorizing use of a host gaming device based on the indicia of identity.

The indicia of identity for a user may be provided by a biometric device, a smart card, or a

password provided by the user.

[0024] Another embodiment of a gaming system provides authentication of users.

The system may include a data network, a host gaming device interfaced to the data network, a

plurality of remote player devices interfaced to the data network, and a security device configured

to provide player credentials to at least one remote player device. The each of the remote player

devices may be configured to receive game information provided by the host gaming device. The

host gaming device may provide game information to a predetermined number of permitted remote
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player devices. Whether a remotelplayer device is permitted to receive gaming information may be

based upon, at least in part, on player credentials provided by the security device.

[0025] In one embodiment, a method of remotely accessing a gaming device provides

for creating records of gaming transactions on both host gaming devices and remote player devices

sufficient to provide an auditable record for a gaming authority in the jurisdiction. The method

may include establishing a gaming session on a gaming device for a _remote player device through a

data network, sending gaming related information from the gaming device through the data

network, receiving at least one control signal from the remote player device through the data

network, creating an auditable gaming session record representing each gaming transaction of a

gaming session on the host gaming device and on the remote gaming device. In addition, the

record may be sent to a third party, such as a gaming authority, through the data network.

[0026] In another embodiment of a gaming system, the gaming system includes a

network comprised of a plurality. of logical segments. A security policy controls the flow of data

between logical segments. A host gaming device may be connected to the data network, the

gaming device configured to execute at least one game. A plurality of remote player devices may

be connected to the data network. The plurality of remote player devices are each configured to -

receive game information provided by the host gaming device, and to control a gaming session

established on the gaming device, subject to the security policy. The security policy may be based,

at least in part, on the geographic location of a logical segment.

[0027] One embodiment of the gaming system may include a promotional message

server to deliver customized promotional messages to users of the gaming system. In this

embodiment, a gaming system may include a‘ data network, a promotional message server

configured to provide customized promotional messages. Each message may be customized with

information associated with a user of the gaming system. In addition, a gaming system may

include a host gaming device interfaced to the data network, and a plurality of remote player

devices interfaced to the data network. The plurality of remote player devices are each configured

to receive game information provided by the host gaming device and to receive and present

promotional messages.

[0028] In another embodiment, a gaming system may include a means for data

communication, means for executing at least one game, means for providing game information over

the data network to a predetermined number of receiving means, a plurality of means for receiving

game information over the data communication means. Each means for receiving game

information may be coupled to a means for receiving customized promotional messages. A gaming

system may also include a means for presenting promotional messages in conjunction with gaming
data.
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[0029] A related method of displaying information on a remote player device is also

provided. The method may include receiving a promotional message on a remote player device,

presenting the promotional message in conjunction with gaming information for an amount of time;

and removing the promotional message fi'om the remote player device. Information in the

promotional message may be used to calculate the amount of time to present the promotional
message.

[0030] A remote player interface of a gaming system may have a number of

embodiments. In one embodiment of a gaming system, the gaming system includes data network, a

host gaming device interfaced to the data network, and at least one remote player device interfaced

to the data network. The remote player device is configured to receive game information provided

by the host gaming device. The remote player interface of the gaming system may include a video

display device in communication with the remote player device and a remote control device in

communication with the remote player device. The remote control device is configured to control

operation of a game.

[0031] An embodiment ofmethod of remotely accessing a gaming device may include

establishing a gaming session on the host gaming device from a remote player device through a

data network, receiving gaming related information from the host gaming device through the data

network, presenting gaming related information to a player via a video display device, receiving at

least one control signal generated by a remote control device for controlling the gaming session,

and sending the control signal to the host gaming device through the data network.

BriefDescription of the Drawings

[0032] FIG. 1 depicts a simplified block diagram of a gaming system according to one

embodiment of the invention. .

[0033] FIG. 2 depicts a simplified block diagram of system elements relating to a host

gaming device of FIG. 1 according to one embodiment of the invention. ,

[0034] FIG. 3 depicts a simplified block diagram of system elements relating to a 0

remote player device of FIG. 1 according to one embodiment of the invention.

[0035] FIG. 4 is a flowchart depicting thesequence of events for acknowledging

command messages in a gaming system as embodied in FIG. 1.

[0036] FIG. 5 is a flowchart depicting the sequence of events for establishing a

remote gaming session, playing a game, and terminating the remote gaming session in a gaming

system as embodied in FIG. 1. i

[0037] FIG. 6 is a flowchart depicting the sequence of events for transferring funds

"from a player’s source of funds in the gaming system of FIG. 1.
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[0038] FIG. 7 is a flowchart depicting the sequence of events for a host gaming

device of FIG. 2 to connect to a network using security certificates and acertificate authority.

[0039] FIG. 8 is a flowchart depicting the sequence of events for a gaming device of

FIG. 2 to build and deliver an encrypted block of data representing the complete state of the

gaming device.

[0040] FIG. 9 is a flowchart depicting the sequence of events for retrieving a block of

data representing the state of a gaming device from a database and loading the block into a gaming

device as performed by a gaming system embodiment as in FIG. 1. I

[0041] FIG. 10 is a more detailed block diagram of a gaming system as depicted in

FIG. 1.

[0042] FIG. 11 is a detailed block network diagram of a portion of a gaming system

as depicted in FIG. 10.

Detailed Description of the Preferred Embodiment

[0043] The following detailed description is directed to certain specific embodiments

of the invention. However, the invention can be embodied in a multitude of different ways as

defined and covered by the claims. In this description, reference is made to the drawings wherein

like parts are designated with like numerals throughout.

[0044] In a traditional casino environment, gaming devices are generally located on a

gaming floor. Gaming devices are subject to regulation by gaming regulatory agencies.

Regulations may limit the locations where gaming devices may be placed and by limit users of

gaming devices to those of legal age to gamble in the respective jurisdiction. Regulatory agencies

for a given jurisdiction may also limit the number of licensed gaming devices provided to a

licensee. Where gaming devices are physically located on a casino gaming floor, verification of

whether a device is being used in its licensed location within the jurisdiction may be determined by

physical inspection of the gaming floor. Further, monitoring of the gaming floor in casinos ensures

that players are of legal age as set by the jurisdiction.

[0045] An embodiment of a gaming system according to the present invention allows

a licensed host gaming device to be used by one or more remote player devices geographically

separated from the host gaming device, but still located within the jurisdiction of a gaming

authority. FIG. 1 depicts a simplified block diagram of an embodiment of a gaming system 100

according to the invention. One or more host gaming devices 160, 161, 162 are licensed gaming

devices. Although three host gaming devices are shown on FIG. 1, the gaming system 100 may

employ any number of host gaming devices ranging from one to thousands. For convenience of

discussion, set forth below is a description of certain aspects of the host gaming device 160. It is to

be appreciated that the other gaming devices may contain the following or different aspects.

.7-
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[0046] A host gaming device may be any device, comprised of electronic, mechanical,

or a combination of electronic and mechanical components, which is used for gaming and which

affects the result of a wager by determining Win or loss. A host gaming device 160 is connected to

a data network 150. In the embodiment depicted in FIG. 1, the data network of gaming system 100

is comprised of three logical segments. Gaming network 150 connects each host gaming device

160 and related elements such as the database 170 and central gaming controller 180. Remote

network 120 connects remote player devices 110, 111, 112 to the system. Backbone network 140

provides interconnection between the gaming network 150 and the remote network 120.

[0047] The database 170 may be computer server running database sofiware, or any

other commercially available database solution. In one embodiment, as depicted, the database 170,

is a casino database. In other embodiments, the database may also contain other data related, or

unrelated to the casino operation.

[0048] Remote network 120 connects remote player devices 110, 111, 112 to the
system. Each remote player device 110 allows a user to play a game executing on a host gaming

device 160. For convenience of discussion, set forth below is a description of certain aspects of the

remote player device 110. It is to be appreciated that the other remote player devices may contain

the following or different aspects. Although threeremote player devices are shown on FIG. 1, the

gaming system 100 may employ any number of remote player devices ranging from one to

thousands.

[0049] The remote network 120 may be any form of computer network, as discussed

below. In one particular embodiment, the remote network 120 is part of a network provided by a

cable television system. FIG. 10 depicts an embodiment of a gaming system where the remote

network 120 _is provided through a digital home communications terminal (DHCT) 1000, such as a

set-top box. .

[0050] Each host gaming device 160-may be located in any location approved by a

gaming agency, such as a casino gaming floor. A host gaming device 160 provides a legally

regulated random number generator. Once generation of random number has been performed, a

game result is determined. Any further interaction through the game’s user interface is for the

benefit of a user. For example, in one embodiment of a gaming system, the host gaming device

may be a slot machine. Afier payment is made, through a coin, token, credit device, etc, the player

pulls a lever arm to execute play. In a mechanical game, for example, a slot machine, a game result

may be determined by ‘the interaction of spinning wheels. In a host gaming device 160 of an

embodiment of the present invention, however, pulling the arm triggers generation of a random

number which determines the game result. Thus any spinning wheels or its electronic equivalent is
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purely forentertainment of the user. A host gaming device 160 plays at least one ga.rne of chance,

including, but not limited to, Slots, Blackjack, Poker, Keno, Bingo, or Lotteries.

[0051] FIG. 2 depicts a more detailed block diagram of an embodiment of a gaming

system 100 showing additional gaming system elements coupled to the host gaming device 160.

The host gaming device 160 may include local controls 220' such as an arm. The host gaming

device 160 may have a display 210 to present the results of a game to a user. Further, the gaming

device 160 may have a smart card reader 280. Functions of the smart card reader 280 may include

receiving payment for a game, or identifying a user for promotional or loyalty programs. A

biometric identity device 290, such as a fingerprint scanner, may be used for similar functions by

the gaming system.

[0052] Networks 120, 140, 150 may include any type of electronically connected

group of computers including, for instance, the following networks: Internet, Intranet, Local Area

Networks (LAN) or Wide Area Networks (WAN). In addition, the connectivity to the network

may be, for example, remote modem, Ethernet (IEEE 802.3), Token Ring (IEEB 802.5), Fiber

Distributed Datalink Interface (FDDI) Asynchronous Transfer Mode (ATM), Wireless Ethernet

(IEEE 802.11), or Bluetooth (IEEE 802.l5.l). Note that computing devices may be desktop, server,

portable, hand-held, set-top, or any other desired type of configuration. As used herein, the network

includes network variations such as the public Internet, a private network within the Internet, a secure

network within the Internet, a private network, a public network, a value-added network, an intranet,

and the like. In embodiments of the present invention where the Internet is the backbone network

140, gaming network 150 and remote network 120 may form a virtual private network (VPN)

transported over the Internet.

[0053] In preferred embodiments, the remote network 120 may be a closed-loop

network, such as the cable network depicted in FIG. 10. A closed-loop network 120 may have a

limited geographic scope which allows the geographic location of a remote player device 110 to be

identified. For example, a given cable network may be limited to a specific hotel. Each hotel room

may be provided with a remote player device 110 which may then be identified with that location.

In other embodiments, the remote network 120 may be a mobile telephone network which is

capable of identifying a caller’s geographic location.

[0054] As depicted in the simplified block diagram of FIG. 3, a remote player

interface 300 may comprise a remote player device 110, a display 310 for presenting game

information and a control 320 to provide user game control for the remote player device 160. In

one embodiment, a remote player interface 110 may also comprise a remote control 395 to provide

game controls. In preferred embodiments of the remote control, the connection 394 between the

remote control 395 and the remote player device 160 may be any type of wireless connection,
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including infra—red based protocols, or a RF wireless protocol such as Bluetooth (802.15.1). The

remote control 395 may also be connected to the remote player device 160 through a wired

connection such as Universal Serial Bus (USB), serial, or equivalent connection. The remote

control 395 may also include controls customized for gaming. A handheld computer may also

comprise a remote control 395.

[0055] The display 310 may be a television, a personal computer, or a handheld

computer device. A fixed or wireless telephone handset may comprise a display 310 and controls

320 of a remote player interface. In some embodiments the controls 320 may be integrated with

display 310, as for instance, in a touch screen.

[0056] In one embodiment, the game infomiation may be a random number which

represents the result of the game, information related to gaming device jackpots, or player credits.

In another embodiment, the gaming information may be multimedia, sound and images, including,

in one embodiment, video, representing the execution of a game. In another embodiment, game

information may also be software for execution onia remote player device 110 or on any element of

a remote player interface 300, such as a remote control 395, which interactively presents the game

through the remote player interface 300.

-[0057] To enable regulatory conformance of the gaming system, gaming device users

must be geographically within an approved jurisdiction and of legal age in the jurisdiction. In a

regulated gaming environment, such as a gaming floor, physical control of the premises allows

enforcement of this requirement. For remote player devices 110 not operated in the regulated

gaming environment of a gaming floor, the age of the user of a remote player device 110 must be

verified before game information is provided by a host gaming device 160. Credentials may be

received from a user using a variety of security devices and compared to records, such. as in a

database 170 to confirm identity and thus age of the user.

[0058] To ensure compliance with regulatory requirements, a gaming system 100 may

identify the geographic location of a remote player device 110. As discussed above, a network 120

may be a closed-loop network 120 whose devices are thereby identified in geographic location by

the location of that network. Other embodiments may employ a GPS system on the remote player

device 110 to provide the geographic location of the device 110. In other embodiments, the remote

network 120 may be a mobile communications network which provides the geographic location of

network clients, such as a remote player device 110.

[0059] In one embodiment, a security device may be a smart card reader 380 that is

coupled to the remote player device 110. In embodiments using a smart card reader, a user inserts

a smart card into the reader which provides credentials sufficient to verify the age of the user. In

-10-
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one such embodiment, indicia present on the smart card reader are compared to records in a casino

database 170 to verify the age of the user.

[0060] In other embodiments, a remote player device 110 may be coupled to a

biometric identity device 390, such as a fingerprint scanner. In one embodiment, information

received from the biometric identity device 390 may be compared to records in a casino database

170 to verify the age of the user. In other embodiments a biometric identity device 390 may be

retinal scanner or facial recognition device.

[0061] In some embodiments, the controls 320 may include an input device (not

pictured in FIG. 3) coupled to a remote player device 110 to receive a password or PIN as a

security device. The password or PIN may be compared to information, such as records in a casino

database 170 to verify the identity, and thus the age, of the remote player device user. For

example, the input device may be a keyboard, rollerball, pen and stylus, mouse, or voice

recognition system. The input device may also be a touch screen associated with an output device.

The user may respond to prompts on the display by touching the screen. The user may enter

textual or graphic information through the input device. The controls 320 may be coupled to a

display 310 in the form of a personal computer, a television, a television with a set-top box, a

handheld computer, or a telephone, fixed or mobile, handset. .

[0062] Embodiments of a remote player device 110 may be a television, a cable

interactive set-top box, a remote control, a personal computer, or a mobile or fixed telephone

handset. Another embodiment may comprise a handheld computer coupled to a fixed or preferably

Wireless network. Also, a host gaming device 160 may also be a remote player device 110.

[0063] In one embodiment, a remote gaming device 110 may be in a location

approved by a gaming agency with controls 320 and display 310 which match the appearance of a

stand-alone gaming device. For example, a remote gaming device 110 may be appear to be a slot

machine with an arm ‘control 320, a mechanical ‘or electronic “slots” display 310. In other

embodiments, remote gaming devices 110, regardless of location, may have controls and displays

which match the appearance of a host gaming device 160. This may include control devices

coupled to personal computers or set-top boxes which may be customized for one or more games.

[0064] Indicia of identity and age received fi'om a smart card reader 380, biometric

identity device 390, or user entry of a password may also be compared to records stored on the

remote player device 110. For example, a remote player device 110 in a hotel room may be

programmed by hotel staff to store identification information for eligible guests in the room

containing the gaming device without the identification information being included in the casino

database 170. In these embodiments, access to the remote player device thus may itself be an

indicium of legal age to the central gaming controller 180 or host gaming device 160.

-11-
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[0065] A central gaming controller 180 may manage the interaction of remote player

devices and host gaming devices. The central gaming controller 180 may comprise one or more

server computers or may be integrated with a host gaming device. In the embodiment depicted in

FIG. 10, the application server 1027 and request processing servers 1023 comprise the" central

gaming controller 180.

[0066] One embodiment of a gaming system 100 comprises a single remote player on

a remote player device 110 establishing a gaming session on a host gaming device 160 with no

local player using the host gaming device 160. In this embodiment, the local controls 20 of a host

gaming device 160 become disabled for local play during the remote gaming session.

Correspondingly, a host gaming device 160 in this embodiment also becomes unavailable for

remote play while a player uses the local controls 220 to use the host gaming device 160.

[0067] Another embodiment comprises a single player using the local controls 220 of

a host gaming device 160 and a single remote player on remote player device 110 concurrently.

Thus in this embodiment, the local game controls 220 on the host gaming device 160 are not

disabled during the remote gaming session.

[0068] Another embodiment of the gaming system 100 comprises a single local player

of the host gaming device 160 and multiple remote players on a plurality of remote player devices

110 having concmrent gaming sessions. A similar embodiment comprises multiple concurrent

remote players and no local players on the host gaming device 160 because the local controls 220

may be disabled during the remote gaming sessions.

[0069] Another embodiment of a gaming system 100 comprises one or more remote

player devices 110 which are physically located in a location approved by a gaming agency and

networked to a host gaming device 160 that hosts both local and remote player sessions. Players

physically located in the casino may occupy a remote player device 110 and .play the games

provided by the host gaming device 160. Concurrently, gaming sessions to one or more remote

player devices 110 physically located outside the casino may be provided. Thus, in this

embodiment, players may concurrently play using the host gaming device 160, a physically remote

player device 110, or a remote player device 110 in a location approved by a gaming agency.

[0070] Another embodiment of the invention comprises one or more remote player

devices 110, physically located in a location approved by a gaming agency and at least one host

gaming device 160. In this embodiment, player sessions may only be established on a host garning

device 160 from a remote player device 110 if that remote player device 110 is physically located

in a location approved by a gaming agency, such as a casino gaming floor. Players may also play

4 the host gaming device 160 using local controls 220 concinrently with remote player sessions.
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Thus, in this embodiment, players may concurrently play using the host gaming device 160, or a

remote player device 110 that is located in a location approved by a gaming agency.

‘[0071] In each of the above disclosed embodiments, the remote player devices 110

that may concurrently receive game information from a host gaming device 160 may be limited to a

predetermined nmnber that is determined by a regulatory gaming agency for the jurisdiction.

[0072] A remote player device 110 that is physically located in the casino in a

location approved by a gaming agency, such as a casino gaming floor, may differ from a remote

player device physically located outside the casino floor. In one embodiment, a remote player

device 110 located in a location approved by a gaming agency resembles the appearance of a stand-

alone gaming device and may thus be similar in appearance and operation to the host gaming

device 160.

[0073] In one embodiment, a remote player device 110 requests game data from the

host gaming device 160 by sending a request for a garne to a central gaming controller 180. The
central gaming controller 180 then transmits the request for a game to the host gaming device 160.

The host gaming device 160 receives the request and provides game data to the central ‘gaming

controller 180 that passes to the remote player device 110. That information is then translated into

a game by the remote player device 110 and displayed or performed to the player. The remote

player device 110 may contain on-board hardware and software that may be required to present a

game. The regulated portion of hardware and software required to execute a game, such as a

random number generator, is on the host gaming device 160 and the information transmitted to the

remote player device 110 each time a game is requested.

[0074] Gaming devices according to an embodiment of the invention may use mixed-

protocol delivery systems for game content and game results. Game information and results

comprising image and sound data may be delivered by packet based network protocols such as IP

datagrams, by connection-oriented network protocols, or by a combination of both. Streaming

media protocolsmay also be employed. During a given gaming session, these communication

methods may be used interchangeably or concurrently.

[0075] In one embodiment, communication over the data networks 120, 140, or 150,

may use IP datagrams to package image and sound data comprising a host gaming device interface

and display, encrypts it, and delivers it to the remote player device.

[0076] Internet Protocol (IP) is a network layer protocol used by many corporations,

governments, and the Internet worldwide. IP is a connectionless network layer protocol that

performs addressing, routing and control functions for transmitting and receiving datagrams over a

network. The network layer routes packets from source to destination. An IP datagram is a data

packet comprising a header part and a data part. The header part includes a fixed-length header
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segment and a variable—length optional segment. The datapart includes the information being

transmitted over the network. As a connectionless protocol, IP does not require a predefined path

associated with a logical network connection. Hence, IP does not control data path usage. If a

network device or line becomes unavailable, IP provides the mechanism needed to route datagrams

around the affected area.

[0077] The remote player interacts with a game through a remote player interface 300.

A remote player device 110 may send commands back to the central gaming controller 180 as, in

one embodiment, IP datagrams. The IP datagrams are interpreted by the central gaming controller

180 and used to proxy user interface interaction between the gaming device and the remote player.

Game results may also be packaged as IP datagiarns and delivered to the remote player through this
method.

[0078] _ Alternative embodiments may use connection-oriented protocols such as TCP,

or a combination of connection oriented protocols and connectionless packet protocols such as ll’.

Transmission Control Protocol (TCP) is a transport layer protocol used to provide a reliable,

. connection-oriented, transport layer link among computer systems. The network layer provides

services to the transport layer. Using a two-way handshaking scheme, TCP provides the

mechanism for establishing, maintaining, and temiinating logical connections among computer

systems. TCP transport layer uses IP_ as its network layer protocol. Additionally, TCP provides

protocol ports to distinguish multiple programs executing on a single device by including the

destination and source port number with each message. TCP performs functions such as

transmission of byte streams, data flow definitions, data acknowledgments, lost or corrupt data re-

transmissions, and multiplexing multiple connections through a single network connection.

Finally, TCP is responsible for encapsulating information into a datagram structure.

[0079] Static content comprisingithe game interface or other elements of the game

may be delivered to the remote player device 110 and stored on the remote player device. This

delivery of content may use a mixed—protocol as described above. A static image may be a fixed

image or an animation activated by the remote control device. Such images may further be

overlaid with additional game content such as images and sound that is delivered dynamically

during game play.

[0080] In an embodiment of the invention, a central gaming controller 180 converts

image and sound data comprising the gaming device interface and display from the remote machine

into a data stream (for example but not limited to MPEG-2), encrypts it, and delivers it to the

remote player device 110. The remote player interacts with the game using the remote player

interface 300 to send commands back to the central gaming controller as IP datagrams. The ll’

datagrams may be interpreted by the central gaming controller 180 and used to proxy user interface
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interaction between the gaming device 160 and the remote player device 110. Game results may

also be packaged as a data stream and delivered to the remote player through this method.

[0081] FIG. 4 is a flowchart depicting a method employed when a command message

is acknowledged by a central gaming controller 180 according to one embodiment of a gaming

system 100. Depending on the embodiment, additional steps may be added, others removed, steps

merged, or the order of the steps rearranged. Note that in some embodiments, not all messages

received by the central gaming controller 180 need be acknowledged. Starting at step 401, a

command message is sent to the central gaming controller 180 by a host on the network. The host

may be remote player device 110 used for remote play, or other authorized network devices. Next,

at step 405, a qualified request message is received by the central gaming controller 180. Moving

to step 410, the message is then recorded in a database. The database may be a casino database

170. Proceeding to step 415, the message is processed and a response prepared. Next at step 420,

theiresponse is recorded in the database. Moving to step 425, the ‘response is sent back to the

requesting device. At step 430, a test to determine whether an acknowledgment of the message has

been received is made. Continuing at step 435, if the timeout value has passed control continues to

step 440, if the timeout period has not expired control returns to step 430. Moving to step 440,

whether the message has not been acknowledged by the originating host is tested. If

acknowledgement has been received, control proceeds to 445, if not control proceeds to step 455.

At step 445, the message status is recorded as “RECEIVED” and the process moves to the end

state. Returning to step 455, where the process flow continues following an unacknowledged

message, the system sends a status request message to the sending host. Next, at step 460, if the

originating device responds to the message then flow continues to step 465, otherwise control

moves to step 480. Moving to step‘ 465, a diagnostic message is sent to query whether the

originating device is ready to receive the original message. Next at step 470, if the originating host

responds that it is ready to receive the original message, then control transfers to step 425 but if the

originating host fails to respond then control moves to step 480. Moving to step 480, the status of

the originating host is set to offline until such time as the originating host can respond or

reinitializes, and the process moves to the-end state.

[0082] FIG. 5 is a flowchart depicting a method used when a request for a remote

gaming session is received, when playing a game, and when terminating the remote gaming

session. Depending on the embodiment, additional steps may be added, others removed, steps

merged, or the order of the steps rearranged. Starting at 510, a request for a remote gaming session

is received as a request for a secured encrypted connection to the central gaming controller 180.

Included in the request are the remote players security credentials in the form of a security

certificate, for example, X.509 certificate. Next at 515, the security credentials are authenticated.
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This authentication may be performed by submitting the security certificate to a certificate

authority for authentication. Moving to 520 if the player is not authenticated, control reverts to

515. Continuing to step 525, the central gaming controller 180 establishes a secure encrypted

connection with the remote player device 110. Next, at step 530, if required the player transfers

fimds to use during the remote gaming session. Continuing to step 535, the player then chooses a

host gaming device 160 to play. Next, at step 540, in one embodiment, when a host gaming device

160 is chosen for remote access play the local controls of the host gaming device 160 is disabled to

prevent local play. Moving on to step 545, a remote play session isopened on the host gaming

device 160. Continuing at step 550, after a remote gaming session is established on the host

gaming device, the central gaming controller 180 sends a message to the host gaming device 160

instructing it to displace representations of its user controls, graphics and sounds to the remote

player interface 300. The central gaming controller 180 directs the host gaming device 160

controls over the secured encrypted connection and manages the remote gaming session. Next at

step 555, the remote player may transfer flmds from a player account to the host gaming device 160

for wagering on the host gaming device 160. Moving to step 560, a wager is made. Next at, 656 a

game is played. . Continuing to step 570, the central gaming controller 180 delivers the results of

the game to the remote player interface 300. Next at step 571, the remote player may repeat the

sequence from step 560. Next at step 575, if there are any credits on the host gaming device 160

when the player terminates the remote gaming session, the central gaming controller 180

automatically transfers those credits back to the players account. Moving to step 580, the central

gaming controller 180 terminates the remote gaming session with the host gaming device 160.

Continuing to step 585, the central gaming controller 180, enables local play on the host gaming

device 160, control is then transferred to the end state.

[0083] FIG.-7 is a flowchart depicting a method for a host gaming device 160 to

become connected to a network using security certificates and a certificate authority. Depending

on the embodiment, additional steps may be added, others removed, steps merged, or the order of

the steps rearranged. Starting at 705, a host gaming device 160 starts the process of connecting to a

network as part of its initialization mode. Continuing to step 720, at a point during initialization,

the host gaming device 160 submits a security certificate to a certificate authority for

authentication. Moving to step 725, the certificate authority authenticates the certificate. Next at

step 730, if the certificate is authenticated control moves to step 740, otherwise control moves to

step 735. Continuing on to step 740, the host gaming device 160 is permitted onto the network and

the process moves to its end state. Returning to step 735, if the certificate is not authenticated then

a log entry is generated and the host gaming device 160 is not permitted onto the network.
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[0084] Embodiments according to the invention may also use instant messaging

and/or email messaging systems. Typical instant messaging systems permit computer users to type

text messages and add file attachments into a host program and have the host program

automatically deliver the text through a virtual direct connection to a target computer. Public email

systems are those available for general use, as over the intemet. Examples of public instant

messaging systems in use today include‘ but are not limited to chat programs like IRC, MSN

Messenger, AOL Instant Messaging and a host of others. Private systems are restricted to a casino

or gaming system. Typical email messaging systems permit messages and file attachments to be

entered into a host program and addressed to a specific recipient on a network. These messages

may not be delivered directly to the addressee, but are sent to a storage area where the recipient

may retrieve the message at a time of their own choosing. V

[0085] Gaming devices 160 and remote player devices 110 routinely exchange

information with a central gaming controller 180 for, typically, but not limited to, account and

game tracking functions. In one embodiment of the invention, devices may send and receive data

over public and/or private email-type messaging systems. The message body of any particular

message may vary, using a proprietary or non—proprietary format, and may be encrypted or in

human-readable. format. Messages may be sent at a time determined by the message originator,

typically, but not exclusively, in response to an event. The recipient of the message may be any

device capable of consuming the message. The message recipient may be responsible for checking

the prescribed message storage area for messages addressed to it. The message recipient may reply

to a received message or may generate a new message to a specific recipient, a group of recipients,

or all recipients connected to the system. Remote player devices 110 may periodically check for

new messages in the system and process them.

[0086] According to one embodiment of the invention, gaming devices 160 may send

and receive data over public and/or private instant messaging systems. The message body of any

particular message may vary, using a proprietary or non-proprietary format, and may be encrypted‘

or in human-readable format. Messages may be sent at a time determined by the message

originator, typically, but not exclusively, in response to an event. The recipient of the message may

be any device capable of consuming the message. Both the gaming device 160 and the message

recipient may queue incoming and outgoing messages. Queuing messages permits devices

involved in instant message communications to accept new messages while processing received

messages and to generate outgoing messages for delivery as system resources permit.

[0087] In another embodiment according to the invention, devices may send and

receive data over public and/or private email-type messaging systems. The message body of any

particular message may vary, using a proprietary or non-proprietary format, and may be encrypted

or in human-readable format. Messages may be sent atia time determined by the message
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originator, typically, but not exclusively, in response to an event. The recipient of the message may

be any device capable of consuming the message. The message recipient may be responsible for

checking the prescribed message storage area for messages addressed to it. The message recipient

may reply to a received message or may generate a new message to a specific recipient, a group of

I recipients, or all recipients connected to the system Gaming system devices 110 and 160 may

periodically check for new messages in the system and process them.

[0088] Embodiments according to the invention may present promotional messages

during remote play sessions. Messages sent may comprise instant messages for promotional

information, notification of events, or other pieces of information that can be communicated

electronically. Promotional messages may also include jackpot and bonus information. A

promotional message server may be used to construct and send promotional messages. In one

embodiment, a computer server, comprising a central gaming controller 180, may also comprise the

promotional message server.

[0089] A user interface may be provided to construct message templates. These

templates are then used to construct a deliverable message. Embodiments of a message template

may comprise a timeout value that indicates how long the message is to be displayed, the fiequency

with which the message displays in relationship to other scheduled messages, a limitation value

that prevents the message fi'om being displayed too often and an expiration date after which the

message is no longer used in the system. Custom graphics and display modes may also be

specified for a message template, such as icons, animations, and various scrolling methods.

[0090] A remote player device 110 may present a promotional message for an amount

0 of time determined from the contents of the promotional message. The promotional message may

be presented to a user in conjunction with gaming information. The presentation may ‘contain

icons, animations, and various scrolling methods. In addition multimedia such as sound and video

may be utilized.

[0091] The promotional message server may also provide a dynamic data insertion

function to insert player information such as the player’s name or birthday into a message prior to

delivery. Dynamic data insertion may be accomplished through the use of specialized tags within

the message body. When encountered, the tag characters within the message are replaced with data

from a related data source. The specific tag’s character sequence is associated with a specific

subset of the data in the data source, such as a player’s name in a data source of player information.

Processing comprises reading the data source and itsisubsets, parsing the specialized tags from the

message template, indexing the data source and replacing the tag characters with data from the data

source to create a deliverable message for each item in the data source. This sequence continues

until all the data in the data source has been included in messages. The messages may be delivered.
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as they are created or queued until all items in the data source have been used to create messages,

then all messages may be’ sent at the same time.

[0092] In one embodiment, a gaming system 100 may comprise a card reader installed

in a gaming device 280 or remote player device 380. Promotional messages may be based on '

information obtained about a player that is either stored on a card inserted into the card reader or

by using identifying information from the card to access the .casino’s proprietary database

systems 170.

[0093] One embodiment of the promotional message server may also provide a

dynamic grouping function in which a subset of players currently gaming is selected and collected

into a group. Casino operators may address a message template to this dynamic subset of current

players and send a specific message or messages exclusively to that subset. These messages may

be constructed using the dynamic data function. The dynamic grouping flmction may use criteria

specified by the casino and available in the casino’s proprietary database systems 170 and criteria

generated by live gaming activity to establish a profile that players must meet to be selected. The

criteria may comprise loyalty points the player has earned, a player’s birthday, length of current

gaming session, or other data that is collected by the casino on players and gaming activity.

[0094] The dynamic grouping function may be scheduled to run at time intervals

determined by the casino. Each time the interval is reached the promotional gaming server

searches for current players that meet the established criteria and builds a dynamic group then

sends the assigned message to that group of players exclusively. The gaming devices 160, remote

player device 110, card readers installed in gaming devices 280 and remote player device 380, and

casino proprietary database systems 170 may provide data to search for players that meet the

specified criteria and assemble them into a dynamic group. -

[0095] In one embodiment of the invention, the casino may advertise a casino

sponsored event. The casino may use a user interface display to construct the message and schedule

. its delivery start time, duration of the message e.g. number of hours, days, weeks, or months that

the message will run, and specific values that weight the message’s delivery interval and frequency

amongst other promotional messages scheduled in the system. The style of message may also be

specified, including but not limited to flashing, scrolling, scroll direction, and the use of custom

graphics. The casino operator may also specify the criteria players must meet to receive the

message. Once the casino operator accepts the promotional message configuration, the

promotional message server may deliver the message across a network to remote player devices

110 or host gaming systems 160.

[0096] An embodiment of a gaming system 100 may provide for the electronic

transfer of funds to a gaming device for the purpose of making wagers. When a player chooses a

gaming device 160 to play remotely, funds are electronically transferred to the gaming device and
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appear as credits on the gaming device 160. The player then uses those credits to make wagers on

game outcome. When the player is finished, the system transfers any remaining credits on the

gaming device back to the source of fimds or to an alternate storage. Limitations on the amount of

funds transferred may be set for a minimum or maximum amount transferred, a minimum or

maximum amount transferred within a given time period, or a minimum or maximum amount

transferred for the life of the account, or a combination of any of these. The limitation may also

varyibetween accounts, permitting one account to have a different limitation on transfers than

another. When the limitation set is reached, further transactions are prevented until the limitation

is resolved. The limitation may be set voluntarily by the player, by the casino, or by a gaming

authority. Limitations may be set for all players within a specific jurisdiction or for selected

players only. The source of funds used by a player for remote access play may be maintained in a

database located on a computer that is directly or indirectly connected to the casino network 150.

[0097] FIG. 6 is a flowchart depicting an embodiment of the invention whereby a

player transfers funds from a bank account to a player account for the purpose of wagering on

games. Depending on the embodiment, additional steps may be added, others removed, steps

merged, or the order of the steps rearranged. Starting at step 601, a remote player device 110

initiates an electronic fimds transfer. Continuing to step 605, the central gaming controller 180

verifies the remote players banking information. Next at step 610, if the banking information is

valid, control transfers to step 620, otherwise control moves to step 615. Continuing at step 620,

the remote player device 110 prompts the player to enter the amount of the transfer. Moving to

step 615, the central gaming controller 180 verifies fund availability. Next at step 630, if funds are

not available control moves to step 615. Otherwise, control moves to step 635, where‘, in a one

embodiment, the ‘central gaming controller 180 may consult a casino database 170 and determine

whether the remote players total gaming activity exceed limits placed on that activity. Next at step

640, if the limit is reached control moves to step 615. Otherwise, continuing at step 645, the

transfer is completed. Returning to step 615, if the players banking information is not correct,

funds are not available or a transfer limit is reached, then the transaction is canceled and control

transferred to the end state. __ ‘

[0098] An embodiment of a gaming system 100 may record the interaction between

remote players and host gaming devices 160 dining remote gaming sessions for the purpose of

resuming games in-progress afier a communications failure. If at anytime the connection between

the remote player and a gaming device becomes unavailable, the system has a sufficient record of

player positions to restart the game ‘as at the time just prior to the failure. Thus an embodiment of a

gaming system may record, transfer, and reinstate on a like device an encrypted block of data

representing the precise state of a particular gaming device 160 at the time that the data block is

requested. The encrypted block of data is generated by the gaming device 160 and transferred
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using a communication protocol. The encrypted block of data may be used to continue a game in-

progress that was interrupted by a gaming device 160 failure or other system failure. In addition,

the payer’s wager and credit data along with gaming payout data may be included in the data block.

The data may also be transported to another gaming device 160 for the purpose of completing an

0 interrupted game or resuming a gaming session. The destination gaming device 160 receives the

encrypted block of data, decrypts it, and loads the game state into its own systems, allowing a game

in-progress to complete or‘ a game session to continue. _

[0099] ‘FIG. 8 is a flowchart depicting a method for a gaming device 160 to build and

deliver an encrypted block of data representing the complete state of the gaming device.

Depending on the embodiment, additional steps may be added, others removed, steps merged, or

the order of the steps rearranged. Starting at 805, a central gaming controller 180 sends a message

to a host gaming device 160 to initiate the build of the encrypted data block. Continuing to step 10,

the gaming device responds with an acknowledgement. Next, at step 815, the gaming device 160

begins the build process. When finished with the build and encryption process, at step 820, the

gaming device saves the data block to non-volatile memory in the gaming device. Continuing to

step 825, the gaming device 160 sets an indication that may be queried by the central gaming

controller 180 as to the status of the build/encryption process. Moving to step 830, the central

gaming controller 180 checks the gaming device’s status. Next at step 835, if the build/encryption

process is complete, control continues. to step 840, otherwise control returns to step 830. Moving

to step 840, the central gaming controller 180 retrieves the data block from the gaming device 160.

Next, at step 845, when the central gaming controller 180 has retrieved the data block it saves the

data block to a database. Continuing to step 850, the central gaming controller then checks the

validity of the saved datablock. If the data block is not verified then the central gaming controller

initiates another retrieval by returning control to step 840.

[0100] FIG. 9 is a flowchart depicting a method for retrieving an encrypted block of

data representing the state of a gaming device from a database and loading the encrypted block into

a gaming device. Depending on the embodiment, additional steps may be added, others removed,

steps merged, or the order of the steps rearranged. Starting at step 905, the central gaming

controller 180 retrieves a saved encrypted data block fiom the database. Next at 910, the controller

180 verifies the integrity of the data block. Continuing to 915, if the data block is verified, control

continues to step 925, if not control moves to step 920. Returning to the flow of control at 925, the

central gaming controller 180 notifies a target gaming device 160 of an intent to upload the data

block. Next, at step 930, the target gaming device 160 responds with a message indicating whether

it is available for the upload. Moving to step 935, if the target device is ready control moves to

step 940, if not control is diverted to step 920. Returning back to step 940, the encrypted data
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block is uploaded to the target gaming device 160. Next at step 945, the target gaming device 160

verifies the encrypted data block. Moving on to step 950, if the data block was verified, the

gaming device moves on to step 955., if not verified, control moves to step 920. Continuing on to

step 955, the gaming device 160 initializes its state to the new state defined by the received data

block and the process moves to the end state. Returning back to step 920, which is reached on

error conditions, an error log entry is generated and the requesting process notified.

[0101] FIG. 10 is a block diagram depicting one embodiment of a gaming system

according to the present invention wherein the host gaming devices 160 are available for remote

play over a network that connects to a cable modem termination system. The cable modem

termination system 1005 is located at the head—end of a cable television provider who makes

broadband network connectivity available as a service to its customers. Cable television customers

who subscribe to broadband or digital television services access the remote network 120 through a

digital home communications terminal (DHCT) 1000. The remote player device 110 may be a

stand-alone cable modem or a set-top box that includes a cable modem and a digital television

broadcast decoder. The DHCT 1000 may, in some embodiments include the remote player device

110. The remote player interface 300 may be any device or combination of devices that remote

players operate to interact with the remote player device 110, for example, a television with remote

control or a personal computer. To connect to the central gaining controller 180, a remote player

uses the remote player device 110 to send messages, using, in one embodiment, IP datagrams,

through the DHCT and the cable modem termination system 1005. The cable modem termination

system 1005 uses a network router 1004 to route the IP datagrams over a network connection 140

to the central gaming controller 180. The backbone network connection 140 can be any type of

network connection such as a dedicated T1 or fiber opfic over which network traffic can be

exchanged. In preferred embodiments the backbone network 140 is part of a closed loop network.

However, in other embodiments, a public network such as the Internet may form at least a portion

of the backbone network Encryption of the data may be performed, either at the endpoints such as

remote player device 110, at a host gaming device 160, at a central gaming controller 180, over

network 120, or only over network 140.

[0102] Network traffic from the remote network 120 and backbone network 140

travels over a number of virtual local area networks (VLAN) configured using a multilayer network

switch 1022. Segmenting the internal network into VLANs creates security zones whereby only

permitted network traffic appears on a given VLAN.

[0103] IP datagrams are received over the backbone network 140 through network

router 1020 and firewall 1021. Network router 1020 filters IP datagrams that are not coded with

the configured port for access to the gaming network 150. If an IP datagram passes the network
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router 1020 it then must pass the firewall 1021 in order for the IP datagram to be processed by the

request processing server(s) 1023 which comprise a portion of a central gaming controller 180 in

this embodiment.

[0104] The firewall 1021 has two network interfaces 1050, 1051; the extemal-facing

network interface 1050 is connected to the router 1020 and the intemal—facing network interface

1051 is connected to the multilayer network switch 1022. In this configuration the firewall 1021

acts as a type of network switch that may perfonn additional security checks on the IP datagram,

then move the datagram to the intemal-facing network interface 1051 where the multilayer network

switch 1022 moves the datagram to the VLAN where request processing server(s) 1023 are located.

[0105] Each request processing server 1023 has two network interfaces 1052, 1053,

both connected to the multilayer network switch 1022. Each network interface 1052, 1053 may be

configured on a different VLAN of the multilayer network switch 1022. The multilayer network

switch 1022 moves IP datagrams between the firewalls 1021 intemal-facing network interface 1051

and the request processing server(s) 1023 extemal-facing network interface 1052. This

embodiment provides a layer of protection for the host gaming devices 160 in the event that the

request processing server(s) 1023 are compromised.

[0106] When an IP datagmm arrives at a request processing servers 1023 external-

facing network interface 1052, the request processing server 1023 interprets the IP datagram and

issues commands over its intemal-facing network interface 1053 to the application server 1027.

The request processing server 1023 may reject invalid commands or make other determinations as

to the appropriateness of a request that prevent the request from being passed on to the application

server 1027. Likewise, the request processing server 1023 may request data from the application

server for use in building its own response to the request, which mayior may not require an

acknowledgement from the remote player device 110 as described below.

[0107] Command messages received by the application server 1027 maybe recorded

in a database using the database server 1025. The application server 1027 then executes the

command, which may include any fimction relevant to the operation of the host gaming device 160

and may or may not return data to the request processing sewer 1023 for delivery to the remote

access player. In one embodiment, the database server 1025 may comprise the casino database

170. In other embodiments the database server 1025 and the application server 1027 may comprise

the casino database 170.

[0108] Some commands may require the remote player device 110 to acknowledge the

receipt of information sent from the central gaming controller 180. For commands that require

acknowledgement, the central gaming controller 180 queues the status of the messages that are sent

to the remote player device 110. The status of messages sent but not acknowledged is stored in a
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database as “open” using the database server 1025. When the remote player device 110 receives

the message it sends an acknowledgment message back to the central gaming controller, which in

turn marks the message in the database as “closed”; indicating that the message has reached its

destination and has been acknowledged. If the message is not aclmowledged within a specified

timeout,-the message is resent. FIG. 4 depicts the sequence of events for the receipt, queuing and

response loop for qualifying messages. .

[0109] Recording of messages between the remote player device 110 and a host

gaming device 160 by the central gaming controller 180 allows each game or transaction, on both

the host gaming device 160 and remote player device 110, to be recorded. This allows each host

gaming device or remote player device to be individually auditable using standard accounting

practices in the gaming jurisdiction where the game is located. In one embodiment, a third party,

‘such as a gaming authority may be sent the records of games and transactions online by the gaming

system 100.

[0110] When the application server 1027 receives a command request that requires

communication with gaming devices 160, 161, 162 it connects to those devices using terminal

server 1035. Terminal server 1035 provides Ethernet connectivity to the RS232 serial interface

1054 of the game. Through that interface the remote player device 110 communicates to the

gaming devices 160, 161, 162 using a communications protocol supplied by the gaming machine

.manufacturer. The protocol includes commands that permit the remote operation of the gaming

devices 160, 161, 162 and the reporting of game results so that the application server 1027 can

control remote play.

[0111] H FIG. 11 depicts a more detailed network diagram of one embodiment of

network 150 and elements of a gaming system 100 connected to network 150. This includes a host

gaming device 160, and a database 160. As in the embodiment of FIG. 10, a central gaming

controller 180 may be comprised of request processing sewers 1027 and mi application server 1023

connected to one or more VLANs of network 150.

[0112] _ While the above detailed description has shown, described, and pointed

out novel features of the invention as applied to various embodiments, it will be understood that

various omissions, substitutions, and changes in the form and details of the device or process

illustrated may be made by those skilled in the art without departing from the spirit of the

invention. The scope of the invention is indicated by the appended claims rather than by the

foregoing description. All changes which come within the meaning and ra.nge of equivalency of

the claims are to be embraced within their scope.
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WHAT IS CLAIIVIED IS:

1. A gaming system comprising:

a data network, wherein the data network is comprised of at least one logical

segment, wherein at least one logical segment is a closed-loop network;

a host gaming device connected to the data network, the gaming device configured

to execute at least one game wherein the host gaming device in a location approved by a

gaming agency;

a plurality of remote player devices connected to the closed-loop network; and

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device and on each of the plurality of remote player

devices,

wherein the plurality of remote player devices are each configured to receive game

information provided by the host gaming device, and

wherein the host gaming device is configured to provide game information to a

predetermined number of permitted remote player devices.

2. ' A gaming system comprising:

a data network;

a host gaming device connected to the data network, the gaming device configured

to execute at least one game; and

a plLn'ality of remote player devices connected to the data network,

wherein the plurality of remote player devices are each configured to receive game

information provided by the host gaming device,

wherein the host gaming device is configured to provide game information to a

predetermined number of permitted remote player devices, and

wherein at least one of the plurality of remote player devices is permitted based

upon, at least in part, the geographic location of the remote player device.

3. The system of Claim 2, wherein the predetermined number is determined by a

gaming agency.

4. The system of Claim 2, wherein at least one of the plurality of remote player

devices is permitted based upon, at least in part, an age of a user of the remote player device.

5. The system of Claim 2, wherein the data network is, at least in part, the Internet.

6. The system of Claim 2, wherein the data network is comprised of at least one

logical segment.

7. The system of Claim 6, wherein at least one logical segment is a closed-loop

network.
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8. The system of Claim 6,.wherein the host gaming device is configured to identify

the geographic location of a remote player device based, at least in part, on a logical segment

corresponding to the remote player device. ’

9. The system of Claim 2, wherein the host gaming device is configured to identify

the geographic location of a remote player device based, at least in part, on information provided

by a mobile communications network.

10. The system of Claim 2, wherein the host gaming device is configured to identify

the geographic location of a remote player device based, at least in part, on information provided

by a GPS device.

11. The system of Claim 2, wherein the data network is, at least in part, the casino

intranet

12. The system of Claim 2, wherein the data network is, at least in part, the hotel

intranet.

13. The system of Claim 2, wherein the data network is, at least in part, a wireless

network.

14. The system of Claim 2, wherein the host gaming device is in a location approved

by a gaming agency.

15. The system of Claim 2, wherein the host gaming device includes at least one game

control configured to provide local use.

16. The system of Claim 15, wherein the host gaming device is configured to disable

local use when the host gaming device is providing game information to a remote player device.

A 17. The system of Claim 2, wherein each of the remote player devices is in a location

approved by a gaming agency.

18. The system of Claim 2, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.

19. The system of Claim 2, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.

20. The system of Claim 2, wherein the gaming information is, at least in part,

software.
J

21. The system of Claim 2, wherein at least one remote player device is coupled to a

credential device configured to receive information relating to a user of the remote player device.

22. The system of Claim 21, wherein the infomiation relating to the user is an age of

the user.
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23. The system of Claim 21, wherein the information relating to a user is a password

that is input by the user.

24. The system of Claim 21, wherein the credential device is an input device

configured to receive a password from the user.

25. The system of Claim 21, wherein the credential device is a smart card reader.

26. The system of Claim 21, wherein the credential device is a biometric device.

27. The system of Claim 28, wherein the biometric device is a fingerprint reader.

28. The system of Claim 21, further comprising: a database configured to provide

information associated with each of a plurality ofusers of the gaming system.

29. The system of Claim 28, wherein the information associated with a user includes a

password.

30. The system of Claim 28, wherein the information associated with a user includes

an age of the user.

31. The system of Claim 28, wherein the information associated with a user includes

information relating to a fingerprint of the user.

32. The system of Claim 2, wherein the host gaming device is configured to encrypt

the ‘game information.

33. The system of Claim 2, wherein the game information is provided via a public

email system.

34. The system of Claim 2, wherein the game information is provided via a private

email system.

35. The system of Claim 2, wherein the game information is provided through a public

messaging system.

36. The system of Claim 2, wherein the game information is provided through a

private messaging system.

37. A gaming system comprising:

a data network;

a host gaming device in a location approved by a gaming agency connected to the

data network, the gaming device configured to execute at least one game; and

a plurality of remote player devices connected to the data network.

wherein the plurality of remote player devices are each configured to receive game

information provided by the host gaming device, and

wherein the host gaming device is configured to disable local use of the gaming

device when providing game information to the remote player devices.
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38. The system of Claim 37, further comprisingi

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.

39. The system of Claim 37, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.

40. The system of Claim 37, wherein the host gaming device is configured to allow no

more than a predetermined number of remote player devices to concurrently receive game

information provided by the host gaming device.

41. A gaming system comprising:

gaming means for executing at least one game, the game providing game

information during execution;

local access means for providing local access to the game infomiation for a user in

a location approved by a gaming agency;

player means for receiving game information, presenting game" information and

providing at least one game control;

means for providing the game infomiation over a data network to a predetermined

number of receiving means; '

means for determining the location of the receiving means; and

means for disabling the local access means.

42. The system of Claim 41, further comprising:

a means for creating an auditable record of gamingltransactions on the gaming
means. I

43. The system of Claim 41, further comprising:

a means for creating an auditable record of gaming transactions on the playing
means.

44. The system of Claim 41, wherein the predetermined number is determined by a

gaming agency.

45. The system of Claim 41, further comprising:

means for receiving information associated with a user of the gaming system.

46. The system of Claim 45, whereinthe in:fo_rmation associated with the user includes

the age of the user.

47. The system of Claim 45, wherein the means for receiving information associated

with a user is a smart card reader.

48. The system of Claim 45, wherein the means for receiving information associated

with a user is a biometric identity device.
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49. The system of Claim 45, wherein the means for receiving information associated

with a user is a keyboard configured to receive a password.

50. The system of Claim 45, wherein the user information includes, at least, a

credential for authentication of the user.

51. The system of Claim 50, finther comprising:

means for authenticating the credential coupled to means for limiting access to the

gaming system.

52. A method of remotely accessing a host gaming device on a remote player device

comprising:

establishing access to the host gaming device from the remote player device

through a data network;

receiving gaming related information from the host gaming device through the data

network;

presenting the gaming related information to a player;

receiving at least one control signal from the player;

sending the control signal to the host gaming device through the data network; and

disabling local use of the host gaming device.

53. The method of Claim 52, further comprising:

recording each gaming transaction occurring on the remote player device.

54. The method of Claim 52, further comprising:

providing a geographic location of the remote player device.

55. The method of Claim 52, further comprising:

providing infomiation relating to a user of the remote player device to the gaming

device.

56. The method of Claim 55, wherein the information relating to a user includes, at

least, the age of the user. .

57. The method of Claim 52, further comprising:

allowing no more than a predetermined number of remote player devices to

concurrently establish a gaming session on the gaming device.

58. A method ofproviding remote access to a host gaming device comprising:

verifying _a geographic location of a remote player device;

establishing a gaming session on a host gaming device from a remote player device

through a data network;

receiving at least one control signal from the remote player device through the data

network;
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sending gaming related information from the gaming device through the data

network;

59. The method of Claim 58, further comprising:

recording each gamiI1g transaction occurring on the host gaming device.

60. . The method of Claim 58, further comprising:

receiving information relating to a user of the remote player device on the gaming

device.

61. The method of Claim 60, wherein the information relating to a user includes, at

least, the age of the user.

62. The method of Claim 58, further comprising:

disabling local access to the gaming device.

63. The method of Claim 58, further comprising:

allowing no more than a predetermined number of remote player devices to

concurrently establish a gaming session on the gaming device.

64. . A method ‘of resuming an interrupted gaming session on a first host gaming device

comprising:

generating a gaming state of the gaming session on the first gaming device;

encrypting the gaming state;

transporting the encrypted gaming state from the first gaming device;

transporting the encrypted gaming state to a second gaming device;

‘decrypting the gaming state on the second gaming device; and

loading the game state into a second gaming device to resume the gaming session.

65. A gaming system comprising:

a. data network;

a first host gaming. device connected to the data network, the gaming device

configured to:

execute at least one game,

. generate a gaming state based on execution of at least one game;

encrypt the gaming state; and

send the encrypted gaming state over the data network;

a second host gaming device connected to the data network, the gaming device

configured to:

receive the encrypted gaming state over the data network;

decrypt the gaming state;

resume executing at least one game from the gaming state; and

a plurality ofremote player devices connected to the data network,
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wherein the plurality of remote player devices are each configured to receive game

information provided by the host gaming device.

66. The system of Claim 65, wherein the remote player devices are each configured to

receive an encrypted gaming state from a first gaming device over the data network and to send the

encrypted gaming state to the second gaming device.

67. The system of Claim 66, wherein the first gaming device is the second gaming

device. _

68. The system of Claim 65, wherein the second gaming device is configured to

receive an encrypted gaming state from a first gaming device over the data network.

69. The system of Claim 65, wherein the gaming state includes user payment

information.

70. The system of Claim 65, wherein the gaming state includes gaming machine

payout information. _

71. The system of Claim 65, fmther comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.

72. The system of Claim 65, fmther comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.

73. A gaming system comprising:

means for executing at least one game;

means for generating a gaming state based on execution of at least one game;

means for encrypting the gaming state;

means for sending the encrypted gaming state;

means for receiving the encrypted gaming state;

means for decrypting the gaming state; and

.mea.ns for resuming executing at least one game from the gaming state.

74. The system of Claim 73, wherein the gaming state includes user payment

infonnation. '

75. The system of Claim 73, wherein the gaming state includes gaming machine

payout information.

76. The system of Claim 73, further comprising:

a means for creating an auditable record of gaming transactions on the host gaming
device.
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77. The system of Claim 73, further comprising:

a means for creating an auditable record of gaming transactions on each of the

plurality of remote player devices.

78. A method of authenticating a user of a host gaming device comprising:

receiving a security certificate from the smart card;

sending the security certificate to a certificate authority for authentication;

receiving an-authentication reply from the authority; and -

playing a game in response to the authentication reply.

79. A method of authenticating a user of a remote player device comprising:

receiving an indicia of identity for a user;

sending the indicia of identity to an authenticator device;

receiving an authentication reply from the authenticator device; and

authorizing use of a host gaming device based on the indicia of identity

80. The method of Claim 79, wherein the indicia of identity for a user is provided by a

biometric identity device.

81. The method of Claim 79, wherein the indicia of identity for a user is provided by a

password input by the user.

82. The method of Claim 79, wherein the indicia of identity for a user is provided by a

sma.rt card.

83. I A gaming system comprising:

"a data network;

a host gaming device interfaced to the data network;

a plurality of remote player devices interfaced to the data network; and

a security device configured to provide player credentials to at least one remote

player device,

wherein the plurality of remote player devices are each configured to receive game

information provided by the host gaming device,

wherein the host gaming device is configured to provide game information to a

predetermined number of permitted remote player devices, and

wherein at least one of the plurality of remote player devices is permitted based

upon, at least in part, on player credentials provided by the security device.

84. The system of Claim 83, wherein the security device is a smart card reader.

85." The system of Claim 83, wherein the security device is a biometric device.

86. The system of Claim 83, wherein the security device is an input device.

87. The system of Claim 86, wherein the player credentials are, at least in part, a

password.
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88. The system of Claim 83, wherein the remote player device is authorized to receive

game information provided by the host gaming device based, in part, on the player credentials.

89. The system of Claim 83, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.

90. The system of Claim 83, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.

91. A method of remotely accessing a gaming _device comprising:

establishing a gaming session on a gaming device for a remote player device

through a data network; .

sending gaming related information from the gaming device through the data

network; '

receiving at least one control signal from the remote player device through the data

network.

creating an auditable gaming session record representing each gaming transaction

of a gaming session on the host gaming device;

creating an auditable gaming session record representing each gaming transaction

of a gaming session on the remote gaming device; and

sending the record to a third party through the data network.

92. The method of Claim 91 wherein the third party is a gaming authority.

93. A gaming system comprising:

a data network comprised of a plurality of logical segments wherein a security

policy controls the flow of data between logical segments;

a host gaming device connected to the data network, the gaming device configured

to execute at leastrone game; and

a plurality of remote player devices connected to the data network,

wherein the plurality of remote player devices are each configured to receive game

infonnation provided by the host gaming device, and

wherein the plurality of remote player devices are each configured to control a

gaming session established on the gaming device subject to the security policy wherein the

security policy is based, at least in part, on the geographic location of a logical segment.

94. The system of Claim 93, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.
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95. The system of Claim 93, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.

96. A gaming system comprising:

a data network;

a promotional message server configured to provide customized promotional

messages wherein each message is customized with information associated with a useriof

the gaming system;

a host gaming device interfaced to the data network; and

a plurality of remote player devices interfaced to the data network,

wherein the plurality of remote player devices are each configured to receive game

information provided by the host gaming device and to receive and present promotional

messages.

97. The system of Claim 96, wherein the remote player devices are in a location

approved by a gaming agency.

98. The system of Claim 96, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.

99. The system of Claim 96, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.

100. The system of Claim 96, wherein promotional message are comprised of bonus

information. 9

101. The system of Claim 96, wherein promotional message are comprised of jaclcpot

infonnation.

102. The system of Claim 96, further comprising: at least one database configured to

provide information associated with a plurality of users of the gaming system.

103. The system of Claim 96, wherein each of the plurality of remote game devices is

associated with a user. i

104. The system of Claim 96, further comprising a smart card reader configured to

provide information associated with a user of the gaming system.

105. The system of Claim 102, wherein the database is configured to provide

information which forms, at least in part, the content of the promotional message.

106. The system of Claim 96, wherein each of the plurality of remote player devices is '

configured to receive and present the promotional message in conjunction with game information

provided by the host gaming device.
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107. The system of Claim 106, wherein each of the plurality of remote player devices is

configured to present the promotional message for an amount of time.

108. The system of Claim 106, wherein the amount of time is based, at least, in part on

information associated with the promotional message.

109. The system of Claim 102, wherein the database is configured to provide

information which comprises, at least in part, the content of the promotional message.

110. The system of Claim 96, wherein the promotional messages are transported via an

instant messaging system. I

111. The system of Claim 96, wherein the promotional messages are transported via an

email system.

112. A method of displaying information on a remote player device comprising:

receiving a promotional message on a remote player device;

presenting the promotional message in conjunction with gaming information for an

amount of time; and

removing the promotional message from the remote player device.

113. The method of Claim 112, further comprising '

calculating the amount of time based, at least in part, on information associated

with the promotional message.

114. A gaming system comprising:

means for data communication;

means for executing at least one game;

means for providing game information over the data network to a predetermined

number of receiving means; and

a plurality of means for receiving game infomiation over the data communication

means, each coupled to a means for receiving customized promotional messages.

115. The method of Claim 114, further comprising:

means for presenting customized promotional messages in conjunction with game

information.

116. The method of Claim 114, further comprising:

means for sending promotional messages.

117. The method of Claim 114, further comprising:

means for providing data used to select which players receive customized

promotional messages.

118. The method of Claim 114, further comprising:

means for providing data which forms, at least in part, the content of promotional

messages.
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119. The system of Claim 114, further comprising:

a means for creating an auditable record of gaming transactions on the host gaming

device.

120. _ The system of Claim 114, further comprising:

a means for creating an auditable record of gaming transactions on each of the

plurality of remote player devices.

121. A gaming system comprising:

a data network;

a host gaming device interfaced to the data network;

at least one remote player device interfaced to the data network;

a video display device in communication with the remote player device; V and

a remote control device in communication with the remote player device,

wherein the remote player device is configured to receive game information

provided by the host gaming device and the remote control device is configured to control

operation of a game. _

122. The system of Claim 121, wherein the video display device is a television.

123. The system of Claim 121, wherein the video display device is a computer.

124. The system of Claim 121, wherein the video display device is a control device.

125. The system of Claim 121, wherein the remote player device is coupled to a cable

television system.

126. The system of Claim 121, wherein the data network is, at least in part, the Internet.

127. The system of Claim 121, wherein the data network is, at least in part, the casino

intranet. ' A

128. The system of Claim 121, wherein the data network is, at least in part, the hotel

intranet.

129. The system of Claim 121, wherein the data network is, at least in part, a wireless

network.

130. The system of Claim 121, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on the host gaming device.

131. The system of Claim 121, further comprising:

a central gaming controller configured to create an auditable record of gaming

transactions on each of the plurality of remote player devices.
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132. A method of remotely accessing a host gaming device comprising:

establishing a gaming session on the host gaming device fiom a remote player

device through a data network;

receiving gaming related information from the host gaming device through the data

network;

presenting gaming related information to a player via a video display device;

receiving at least one control signal generated by a remote control device for

controlling the gaming session; and

sending the control signal to the host gaming device through the data network.

133. The method of Claim 132, further comprising.

recording each gaming transaction occurring on the remote player device.
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ENABLING VIEWERS OF TELEVISION SYSTEMS

TO PARTICIPATE IN AUCTIONS

Related Application

The present invention is related to co-pending U.S. Patent Application Entitled,

“Encoding Hot Spots in Television Signals”, Serial Number: 09/276,266, Fil_ing Date: March

25, 1999, which is incorporated in its entirety into the present application.

‘Background of the Invention

Field of the Invention

The present invention relates to television systems, and more specifically to a method

and apparatus for using television signals to enable viewers of television systems to participate

in auctions.

Related Art

An auction generally refers to a process in which multiple parties are provided the

opportunity to bid for an offered item. The offered item can be a process or a service. In a

typical bidding process, a seller offers an item, and a party (“bidder”) bids for the offered

item usually by specifying a price the party is willing to pay. The seller may specify the

minimum acceptable price and a time at which the auction closes.

Typically, an offered item is sold to the highest bidder (i.e., party specifying highest

price) in return for the specified highest price. However, criteria other than price (e.g., credit

worthiness) of the bidder may also be taken into consideration in determining the bidder to

whom to sell an offered’ item.

Central servers are known in the relevant arts which coordinate the bidding process.

For example, web site at URL of http://www.ebay.com enable sellers to offer products
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according to various categories (e.g., sports memorabilia, computers), and a bidder may bid

on the offered products by using a browser on the world-wide web as is well known in the

relevant arts.

Organizations such as those providing the web sites to enable auctions are hereafter

referred to as “service providers”. Service providers often advertize on various other web sites

so that users accessing (“surfing”) these web sites may know about the general service.

Typically, a user (viewer of the advertisement) can click on an advertisement to access the

web sites providing the auction service.

However, these advertisements are typically targeted to the users surfing the world

wide web, and may not target at least some of the viewers‘(“television viewers”) of television

systems. The television viewers constitutes a big segment of the auction market, and it is

therefore desirable to enable television viewers to participate in the auctions.

Such participation may be particularly important as the viewers of a specific television

program may be expected to be of certain ‘profile’, and certain items may be suitable for

people of that profile. For example, a person watching Mark McGuire (a baseball player

in United States baseball) hit a record breaking home run may be interested in purchasing a

baseball bat signed personally by ‘Mr. Mark McGuire. That is, the auction items can be

targeted to the viewers of television programs.

At least for the above—stated reasons, what is needed is a method and apparatus for

enabling viewers of television systems to participate in auctions.

Summag of the Invention

The present invention enables viewers (“television viewers”) of television systems to

participate in auctions. The auctions may be occurring on web sites on the lntemet also. In
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an embodiment of the invention, data describing an item (“auction item”) available for bidding

and an access address of a system at which a television viewer may bid are encoded in a

television signal.

The user may submit a bid at a system (e.g., a web site) identified by the access

address. In case the system is a web server, users (‘surfers’) of world-wide-web may also

submit bids by accessing the web server on the world—wide web. Accordingly, the present

invention may be used to draw television viewers to web-sites (e.g., www.ebay.com) dedicated

to auctions also.

In an embodiment, the data is encoded in the non-display portion (e.g., vertical

blanking interval) of the television signal. However, other portions of a television signal may

also be used for encoding the data. Other information of interest to the viewer such as a

minimum bid amount specified by a seller and the present maximum may also be encoded in

the television signal, and displayed for viewer convenience.

A transaction enabler may recover the data encoded in the television signals, and

display the information to the viewer. The viewer may conveniently bid on the auction items,

for example, by specifying the bid price (offer) and clicking on a pre-specified portion of a

displayed image.

The bid may be automatically sent to a server identified by the access address. In the

alternative, the viewer may be first navigated to a web server specified by the access address,

and the user may specify the bid price then. A unique code identifying the auction item may

also be encoded in the television signal, and the code may be used to identify that the bid price

relates to the auction item. In the alternative, the URL itself may contain such identification

codes.
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The transaction server may also provide updated information on a present highest bid.

For example, an end time associated with the auction may be provided to the television viewer,

and the viewer may check the present highest bid at a later time before the end time, and then

decide whether to submit a bid. In addition, the transaction server may interact with the

system providing the auction service, and provide periodic updates at viewer’s option. As a

result, a viewer may make an informed decision on whether to bid.

Therefore, the present invention enables a television viewer to panicipate in an auction

by encoding in a television signal the data identifying an auction item and an access address.

The present invention enables television viewers to be drawn to web sites providing

auction service by specifying the URL of the web site asthe access address.

The present invention is useful for broadcasters as the broadcasters may facilitate the

joining of additional bidders to a bidding process, and be compensated for such additions.

The present invention is useful for service providers providing auction service as the

television viewers are drawn to bid for on-going auctions.

The present invention is useful for service providers providing auction service also

because higher commissions may be charged for the auction items sold in accordance with the

present invention.

The present invention is usefial for television viewers as a television viewer may have

non-intrusive access to information on auctions, and purchase the auction items by a

convenient user interface.

The present invention is useful for sellers participating in auctions as the sellers may

attain greater return for the auction items due to additional pool of bidders participating in

accordance with the present invention.
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Further features and advantages of the invention, as well as the structure and operation

of various embodiments of the invention, are described in detail below with reference to the

accompanying drawings. In the drawings, like reference numbers generally indicate identical,

‘functionally similar, and/or structurally similar elements. The drawing in which an element

5 first appears is indicated by the leftmost digit(s) in the corresponding reference number.

Brief Description of the Drawings

The present invention will be described with reference to the accompanying drawings,

wherein: .

Figure 1 is a block diagram illustrating an example environment in which the present

10 invention can be implemented;

Figure 2 is a flow-chart illustrating a method in accordance with the present invention;

Figure 3 is a block diagram illustrating an example broadcast system which encodes

data related to an auction item in a television signal;

Figure 4 is a block diagram illustrating the details of a transaction enabler in an

15 embodiment of the present invention;

Figure 5 depicts a display screen using which a user may participate in auctions in

accordance with the present invention.

Detailed Description of the Preferred Embodiments

1. Overview and Discussion of the Invention

20 The present invention allows viewers (“television viewers”) of television systems to

participate in auctions. Typically, the data relating to an item (“auction item”) offered for sale

in an on-going auction is encoded in a television signal. The encoded information may be

displayed while the television viewers watch the images encoded in the television signal. The
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viewers may be provided a convenient interface to bid on the auction item.

Auction items consistent with expected viewer profiles may be sold using the present

invention. A seller may be able to sell at higher prices as many viewers are likely to bid. For

example, a diamond ring may be auctioned towards the end of a romantic movie. The

invention is described below-with respect to several examples for illustration.

2. Example Environment

Figure 1 is a block diagram illustrating an example environment in which the present

‘ invention can be implemented. The environment may include bidding systems 110-A and

110-B, Internet 120, web site 130, broadcast system 150, and television 170. A viewer of

television 170 may participate in auctions as described below in further detail.

Web site 130 may provide an auction service. As an illustration, web site 130 may

implement the interface of www.ebay.com, well known in the relevant arts. Bidder systems

110-A and 110-B may access Internet 120 to bid on the items offered for sale on web site 130.

Bidding systems 110-A and 110-B, Internet 120, and web site 130 may be implemented in a

well-known way. Even though the auction service is shown as being provided from web site

130, it should be understood that different other servers using different access technologies

(e.g., dial-up) may be used in providing the service.

Broadcast system 150 includes information related to an auction item in a television

signal and transmits the televisionfsignal on broadcast medium 146 (airwaves, cable, etc.).
The data may specify the item offered for sale, the present highest bid, and an access address

for enabling the viewer to bid. For example, the access may contain a URL of web site 130.

An example embodiment of broadcast system 150 is described below.

The auction may be in progress (on-going) on web site 130, and accordingly broadcast

system 150 may access web site 130 to access any data (eg, present highest bid) for inclusion
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in the television signal. Link 134 may be provided on Internet 120 even though a dedicated

line is shown in Figure 1.

Viewer bidding system 150 receives the television signal, and enables a viewerto

participate in auctions. Viewer bidding system 150 may display the images encoded in the

received television signal. In addition, viewer bidding system 150 may recover the data‘

related to the auction item, and display the corresponding information. By appropriate action,

the user may indicate a higher bid and transmit the higher bid on virtual link 163 on Internet

120.

In an embodiment, viewer bidding system 150 may include television 170, transaction

enabler 160, and remote control 180. Transaction enabler 160 may overlay any images

necessary for providing an user interface on top of the images encoded in the television signal

(“television signal images”). For example, information identifying the auction item (e.g.

Mark McGuire’s bat) and the highest bid price may be overlaid on television signal images.

. Transaction enabler 160 may encode the overlaid image in a form consistent with

conventional television signals for display on television 170. In other words, transaction

enabler 160 operates as a ‘set-top’ box. However, transaction enabler 160 may be integrated

into television 170, for example, using embedded chip-sets provided by TeleCruz Technology,

Inc. In either case, remote control 180 enables the user to specify the bid price and to transmit

the new bid. An example embodiment of transaction enabler 160 is described below in further

detail. However, first a method in accordance with the present invention is described first

below.
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3. Method

Figure 2 is a flow—chart illustrating a method in accordance with the present invention.

The method begins in step 201, in which control passes to step 210. In step 210, data

identifying an auction item and an access address may be encoded in a television signal. The

data identifying an auction item may include both a descriptive component (e.g., “baseball bat

signed by Mark McGuire”) and a unique code specifying the auction item (or group in case

multiple items of the same type are available).

The data may be encoded in one of different formats depending on different criteria,

but consistent with an interface at viewer bidding system 150. For example, a uniquecode

identifying an auction item may be encoded as a parameter of a URL (access address) since

the web browser’s based technology lends well to such encoding and later submission of a bid.

The television signal may also be encoded with image frames for display on television signals.

Both (images and data related to auction items) encoding may be performed in a known way.

In step 220, the television signal may be broadcasted to television systems covering

a large geographic area. In step 240, the television signal may be received at a viewer end

(e.g., by transaction enabler 160 of Figure 1). In step 260, the data related to the auction item

(encoded in step 210) may be recovered. The recovery generally needs to be consistent with

the encoding scheme used by broadcast system. In general, any compatible encoding scheme

may be used.

In step 280, the user is provided a convenient user interface to bid on the auction item.

Typically, the description of the auction item is displayed, and the user may be provided the

option to bid, in which case the bid is submitted to a system identified by the access address.

While submitting the bid, the unique code identifying the auction item may be used to specify

to the system that the bid relates to that particular item. The access address is used to connect
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the user to a central machine (e.g., web site or any server) or person. The user’ may then

submit the bid. The highest bidder is generally entitled to the offered auction item for the

submitted bid. A

The method and environment described above may be applied in several ways as will

be apparent to one skilled in the relevant arts based on the disclosure herein. All such

implementationsare contemplated to be within the scope and spirit of the present invention.

However, it may be desirable to have bidders (television viewers) participation at different

points of a broadcast. The manner in which the point can be controlled is described below

with respect to broadcast system 140.

4. Broadcast System

Figure 3 is a block diagram illustrating an example embodiment of broadcast system

140. Even though the description of broadcast system is provided substantially with respect '

to broadcasters producing a television signal, the present invention can be practiced by

intermediate broadcasters also. Such advertisements are generally more targeted to the

specific geographic profile. Broadcast system 140 may contain production block 310,

authoring block 320, broadcast block 330, timing determination block 340, auction data

interface 360, and storage 350. Each block is described in further detail below.

Timing determination block 340 may determine the specific time at which to encode

data related to an auction item. For example, it may be desirable to broadcast data related to .

a baseball bat (auction item) when a home run is hit. Timing determination block 340 may

be implemented to monitor the scores of the baseball game and generate an indication to

auction data interface 360. Several other criteria can be used in determining when to send data

related to an auction item.

Timing determination block 340 may also determine when to send updates
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corresponding to various auctions. When timing determination block 340 determines to cause

update corresponding to an auction to be sent, auction data interface 360 may interact with

web site 130 to retrieve a present highest bid from web site 130. The present highest bid may

be provided to authoring block 320 for encoding in a broadcast television signal.

Auction data interface 360 receives data on line 134 if a web based auction is on—going

for the auction item of interest on web site 130. The data may indicate the present highest bid,

bid history, the seller, any comments about the seller. As noted above, auction data interface

360 may provide the data to be encoded in the television signals. The data may contain, in

addition to the data retrieved from web site 130, data identifying the auction item (descriptive

component and unique code).

Some of the data may be pre-stored in storage 350 also. For example, it may be

desirable to display graphic icons on television systems to represent different auction items.

Bit maps representing the graphics icons may be stored in storage 350. In general, auction

data interface 360 may gather any data which may be of interest to bidders, and pass the data

to authoring block 320.

Production block 310 may contain different components such as cameras which are

used to film a show/program. The display sigial is preferably in a form suitable for eventual

transmission as a television signal. In general, production block 310, may encode images in

a display data portion of a television signal. The images may be displayed later on a television

system for viewing a broadcast program. Production block 310 may be implemented in a

known way.

Authoring block 320 encodes data received from auction data interface 360 into

television signals. The data may be encoded according to any convention, and transaction

enabler 160 may need to be accordingly designed. Several such conventions can be designed
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in known way. Authoring block may either store the resulting signal in storage 350 ‘or forward

to broadcasting block 330.

In one embodiment, authoring ‘block 320 encodes the data in non—display portion.(e.g.,

vertical bla.nking interval) of the display signal. Such encoding may be performed in a known

way. In an alternative embodiment, the data may be encoded in other portions (e..g, least

significant bits of pixel data elements representing an image) as well. This alternative

embodiment is described in further detail in co-pending U.S. Patent Application Entitled,

“Encoding Hot Spots in Television Signals”, Serial Number: 09/276,266, Filing Date: March

25, 1999, which is incorporated in its entirety into the present application.

Even though the encoding is described with reference to analog television signals, it

should be understood that the present invention may be practiced in conjunction with digital

television signals (e.g., those suitable for HDTV) also. Some of the techniques described in

this application may be employed for such encoding in the digital television signals. Many

other techniques will be apparent to one skilled in the relevant arts based on the disclosure

herein. Such other techniques are also contemplated to be within the scope and spirit of the

present invention.

Broadcast block 330 may broadcast television signals (containing the hot spot data in

the display data portion) in a known way. It should be noted that the television signal can be

in progressive scan format or interlaced format. Production block 310 and authoring block

320 need to be implemented taking into consideration the transmission standard (progressive

vs. interlaced, and digital vs. analog) of the television signals. Thus, broadcast block 330

generates television signals containing data which may be used to enable television viewers

to bid on the auction items.

Transaction enabler 160 receives the television signals and enables a viewer to bid on
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the auction items. Example embodiments of transaction enabler 160 are described below in

further detail. Before describing example embodiments of transaction enabler 160 in detail,

it is helpful to understand some typical problems with the user interface.

5. Problems and Solutions

In one embodiment, a highest present bid may be encoded in the television signal, and

the user may submit a higher bid that the highest present bid. One problem associated in the

environments of Figures 1 and 2 is that many bidders may bid for the auction item based on

the same highest bid. As the bids are generally marginally more than the present highest bid,

the approach may not maximize the return for the seller.

Accordingly, an improvement may be implemented in which an “auction close time”

(time at which the auction for the auction item ends) may be associated with the auction item.

The auction close time may also be encoded and transmitted in the television signals. Thus,

viewers may choose a later convenient time for bidding on the auction item. However, in such

a situation, viewer bidding system 150 may need to store the required data.

Yet another problem is, a viewer may wish to know an updated highest bidding price

before actually submitting a bid. Thus, the viewer may be provided a convenient user

interface to request a ‘present highest bid’ associated with an auction item of interest. The

updated price may also be received on virtual link—163. In this case also, viewer bidding

system 150 may need to store the required data.

In yet another scenario, a viewer may wish continuous updates of the highest bidding

price. Accordingly, a viewer may be provided an option of initiating a small windowin which

the updates to the highest bids are provided continuously (e.g., when highest bid changes or

every 3 seconds). An embodiment of Uansaction enabler 160, which provides for at least these

features is described below.
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6. Transaction Enabler

Figure 4 is a block diagram illustrating the internals of an example embodiment of

transaction enabler 160 containing image decoder 410, memory 430, recovery block 420,

processor 450, digital to analog converter (DAC) 485, multiplexor 480, infra-red (IR) receiver

460, telephone interface 470 and broadband interface 475. Each component is described

below in further detail.

I Image decoder 410 generates pixel data elements representing image frames encoded

in a television signal received on broadcast channel 146. In response to the operation of

remote control unit 180, image decoder 410 may store the pixel data elements representing an

image frame in memory 430. Such storage enables overlays. Image decoder 410 may be

implemented in a known way. Memory 430 may represent several memory modules such as

fast random access memories and relatively slower non-volatile memories. The non-volatile

memories may store data and program instructions which enable the operation of the present

invention.

Recovery block 420 recovers the data related to auction items encoded in the received

television signal. Inlgeneral, recovery block 420 needs to be implemented consistent with any,

conventions or protocols used at broadcaster end 380 for encoding the hot spot data. If the

data is encoded in non—display portions (e.g., VBI), the data may be recovered in a known

way.If the data is encoded in display data portion (i.e., in images), recovery block 420 may

examine the pixel data elements stored in memory 430 to recover the data. Further details of

recovery are noted in co-pending U.S. Patent Application Entitled, “Encoding Hot Spots in

Television Signals”, Serial Number: 09/276,266, Filing Date: March 25, 1999, which is

incorporated in its entirety into the present application.
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Infra-red (IR) receiver 460 receives remote control signals from remote control unit

180, and provides digital data representing the remote control signals to processor 450. The

control signals may indicate whether the user wishes to see auction item related data, to enter

the bid, to receive an updated present highest bid, etc. Several features of the user interface

may be activated by a viewer using IR receiver 460. IR receiver 460 may be implemented in

a known way. It may be noted that other receivers which receive control signals from viewers

and provide corresponding digital data to processor 450 may be implemented.

Telephone interface 4_70,enables a telephone call to be initiated. Such telephone calls

may be generally initiated either to connect to the Internet via an ISP or to contact a phone

with a live-operator. When a telephone call is initiated with a live operation, telephone

interface 470 may provide the necessary micro-phone (for a viewer to speak) and receiver for

reproducing audible voice. Alternatively, a user may utilize a conventional telephone set that

is attached to line 335.

Broadband interface 475 may provide a high speed connection (e.g., using a local area

network, digital subscriber loop technology or cable interface) to connect with a web server

(corresponding to an URL) or even initiate a voice call (e.g., using voice over Internet

Protocol). Telephone interface and broadband interface may be logically viewed as being part

of line 163 of Figure 1. In general, broadband interface 475 and telephone interface 470

provide the communication to a system (specified by access address) providing auction

service.

Processor 450 receives data related to auction items from recovery block 420, and

enables a user to send a bid to a system identified by an access address. The transmission of

the bid may be either by broadband interface 475 or telephone interface 470 as specified by

the type of access address. Processor 450 may also implement the user interface features noted
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in the section above.

For a suitable user-interface, processor 450 may control the images displayed on

television system 1 10. For example, processor 450 may overlay information in the auction

‘items related data on the television signal image. Specifically, the portion to be overlaid on

television images may be provided by processor 450, and control line 481 may be controlled

to accomplish the overlay function. However, when a user does not wish to bid or when data

related to auction items is absent in television signals, processor 450 may control select line

481 to cause the television signal received on line 146 to be passed directly on line 167. In

addition, processor 450 may cause auction related data to be displayed in a transparent mode.

Typically, techniques such a half—tone control are used‘ for achieving such transparency of

display.

If the access address is a URL, transaction enabler 160 may need to operate as a

web-browser. Processor 450 may enable such an operation by executing the program

instructions provided by memory 430. The web-browser enables transaction enabler 160 to

receive different web-pages in a known way. Processor 450 may convert the web pages into

image frames, and encode the image frames into a television signal having a format

compatible with conventional television signals such’ that the images can be displayed on

television system 110. Well known methods may be employed for such conversion and

encoding.

Therefore, transaction enabler 160 may operate in conjunction with broadcast system

140 to enable a television viewer to participate in auctions. As a result, viewers of television

systems may be drawn to participate in auctions which are generally accessed mostly by users

surfing the world-wide-web. It should be understood that web site 130 and broadcast system

140 may be integrated as one unit depending on the available technologies, and in such a case,
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transaction enabler 160 may communicate with such a unit directly. The present invention is

described in further detail below with reference to an example user interface considering some

of the description of above.

7. User Interface’

Figure 5 is a diagram illustrating the manner in which transaction enabler 160 may

‘ enable a viewer of television programs to participate in auctions. It should be understood that

transaction enabler may use other display devices from which a user can participate in

auctions. In addition, other types of systems (such as computers) which display images in

television signals may also be used to participate in auctions in accordance with the present

invention.

Continuing the description with reference to Figure 5, there is shown television display

500 (for example, on television 170). Auction related data may be received in accordance

with the present invention, and the relevant data may be displayed in a small window 540.

Window 540 is preferably overlaid on television program images as a transparent window

using techniques such as half-toning well known in the relevant arts. By using a transparent

display, a viewer may beable to watch the programs encodedinthe television signal while

participating in the auctions.

Window 540 may be used to display the description of the auction item (“McGuire’s

70"‘ Home Run Bat” in the example there), the present highest bid, bidder of the highest bid,

and the time at which the auction for this item is expected to close may be displayed. The

present highest bid may be periodically updated using the data received on the broadcast

television signal. On the other hand, a viewer may select (click on) ‘Update’ text to cause

transaction enabler 160 to initiate a dialogue with web server 130, and retrieve updated

information for a presently watched auction item. Thus, in Figure 5, such a selection may

Petitioner Apple Inc. — Exhibit 1002, p. 3694



Petitioner Apple Inc. - Exhibit 1002, p. 3695

l0

15

20

wo 01/03044 PCT/US00/18510

17

cause transaction enabler 160 to display $4300 (representing an increase in the present highest

bid).

The user may select ‘Bid History’ to view the previous bidders and history. The

relevant data may either be displayed based on data stored locally or the data may be retrieved

from web site 130 in response to a user request. As is well known in the relevant arts, auction

sites such as www.ebay.com provide such bid histories.

The user may specify her/his bid price in the box provided next to text ‘Your Bid’.

The user may then select the .‘Submit’ text to cause transaction enabler 160 to submit the bid.

As noted above, the submission may be according to any mechanism. The bid can potentially

be over a broadband interface to access a web site or toa server accepting over a telephone

connection. Once the bid is submitted to a server at the access address, the auction item may

be sold to a bidder in a known way. If the user of system 150 has the highest bid, the user may‘

pay the bid amount and receive the auction item.

Thus, an interface such as the one above, a user (or television viewers) may bid for

auction items in accordance with the present invention. The bid may be submitted according

to any pre-specified protocol between transaction enabler 160 and an auction server (e.g., web

site 130). The implementation of auction on web site 130 based on such received bid prices

will be apparent to one skilled in the relevant arts.

8. Conclusion

While various embodiments of the present invention have been described above, it

should be understood that they have been presented by way of example only, and not

limitation. Thus, the breadth and scope of the present invention should not be limited by any

of the above-described exemplary embodiments, but should be defined only in accordance

with the following claims and their equivalents.
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What Is Claimed Is:

1. A method of enabling a viewer of a television system to participate in auctions, said

method comprising:

(a) encoding in a television signal a data describing an auction item and an access

address of a server at which auction service for said auction item is provided; and

(b) transmitting said television signal,

wherein said data can be used to enable said viewer to bid for said auction item at said

server.

2. The method of claim 1, wherein said method further comprises:

(c) receiving said television signal encoded with said data in a transaction enabler;

(d) recovering said data encoded in said television signal;

(e) displaying information describing said auction item on said television system;

(0 enabling said viewer to bid at said server specified by said access address.

3. The method of claim 2, further comprising:

(g) enabling said viewer to specify a bid price for said auction item.

4. The method of claim 3, wherein said enabling said viewer to specify said bid price

comprises:

(h) enabling said viewer to indicate said bid price; and

(i) transmitting said bid price to said server at said access address.

5. The method of claim 4, wherein said access address comprises a telephone number
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' of said server, and said method further comprises:

(i) encoding a unique code identifying said auction item;

(k) recovering said unique code in said transaction enabler; and

(1) transmitting said unique code along with said bid price to said server,

whereby said server can easily associate said bid price with said auction item using said

unique code.

6. The method of claim 4, wherein said access address comprises a universal resource

locator (URL) of a web site, wherein said web site comprises said server, and wherein steps

(h) and (i) comprise the further step of enabling said viewer to indicate said price on a web

page provided by said web site.

7. The method of claim 1, further comprising:

(m) encoding a present highest bid in said television signal, wherein said present

highest bid may be displayed to said viewer before said viewer decides to submit a bid.

8. The method of claim 7, wherein said server comprises a web site, and said method

comprising the further step of retrieving said present highest bid from said web site.

9. The method of claim 1, wherein step (a) comprises the step of encoding said data

in non-display portion of said television signal.

10. The method of claim 1, wherein step (a) comprises the further step of encoding

said data in a non-display portion of said television signal.
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11. The method of claim 10, wherein said non-display portion comprises vertical

blanking interval (VBI).

12. The method of claim 1, further comprising:

transmitting an updated highest bid price in said television signal, wherein said updated

highest bid price corresponds to a present highest bid for said auction item.

13. The method of claim 12, further comprising:

retrieving said updated bid price from said server,

wherein said step of transmitting said updated highest bid price is perfonned after said .

step of retrieving said updated bid price from said server.

14. The method of claim 13, f11rther comprising:

enabling said viewer to request a bid history; and

displaying all of said updated bid prices to said viewer.

15. The method of claim 14, wherein said display corresponding to said bid history

further comprises a description of the bidder corresponding to each of said present highest bid.

16. The method of claim 1, wherein said data further comprises a time at which

auction for said auction item closes.

17. A method of enabling a viewer of a television system to participate in auctions,
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said method comprising:

(a) receiving in a transaction enabler a television signal encoded with a data, said data

including a description of an auction item and an access address of a server at which auction

service for said auction item is provided;

(b) recovering said data encoded in said television signal;

(c) displaying said description of said auction item on said television system;

(d) enabling said viewer to bid at said server specified by said access address.

18. The method of claim 17, further comprising:

(e) enabling said viewer to indicate said bid price; and

(1) transmitting said bid price to saidserver at said access address.

19. The method of claim 4, wherein said access address comprises a telephone number

of said server, and said method further comprises:

(g) encoding a unique code identifying said auction item;

(h) recovering said unique code in said transaction enabler; and

(i) transmitting said unique code along with said bid price to said server,

whereby said server can easily associate said bid price with said auction item using said

said unique code.

20. An environment enabling a viewer of a television system to participate in auctions,

said environment comprising:

encoding means for encoding in a television signal a data describing an auction item
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and an access address of a server at which auction service for said auction item is‘ provided;

and

transmission means for transmitting said television signal,

wherein said data can be used to enable said viewer to bid for said auction item at said

SCI‘VCI'.

21. An environment enabling a viewer of a television system to participate in auctions,

said environment comprising:

receiving means for receiving a television signal encoded with a data, said data

including a description of an auction item and an access address of a server at which auction

service for said auction item is provided;

recovery means for recovering said data encoded in said television signal;

displaying means for displaying said description of said auction item on said television

system;

enabling means for enabling said viewer to bid at said server specified by said access

address.

22. An environment enabling a viewer of a television system to participate in auctions,

said environment comprising:

a broadcast system to encode in a television signal a data describing an auction item

and an access address of a server at which auction service for said auction item is provided,

said broadcast system being designed also to transmit said television signal,

wherein said data can be used to enable said viewer to bid for said auction item at said

SCFVCI‘.
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23. The environment of claim 22, wherein said broadcast system comprises:

a production block to generate images to encode in a display data portion of said

television signal;

an authoring block to encode said data in said television signal; and

a broadcast block to transmit said television signal containing said images and said

data.

24. The environment of claim 23, further comprising an auction data interface to

receive a present -highest bid from a server, said auction data interface to provide said present

highest bid to said authoring block, wherein said authoring block encodes said present highest

bid in said television signal.

25. The environment of claim 24, fitrther comprising a timing determination block to

determine the time at which said authoring block encodes said data including said present

highest bid in said television signal.

26. The environment of claim 22, further comprising:

a viewer bidding system to receive said television signal, and enabling said viewer to

submit a bid and participate in said auction.

27. The environment of claim 26, wherein said viewer bidding system comprises:

a television system;

a remote control which enables said viewer to submit said bid; and
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a transaction enabler coupled to said television system and to receive said commands

from said remote control, said transaction enabler to recover said data encoded in said

television signal and display information contained in said data on said television,

wherein said viewer can submit said bid using said remote control.

28. The environment of claim 27, wherein said transaction enabler is integrated within

said television system.

29. The environment of claim 27, wherein said transaction enabler is provided external

to said television system, and wherein said transaction enabler overlays a window with

information contained in said data on images encoded in the display data of said television

signal.

30. The environment of claim 27, wherein said window is displayed in a transparent

mode on said images.
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METHOD AND APPARATUS FOR ENCRYPTED TRANSIVIISSION

The present invention relates to a method and apparatus for encryption of messages

between two devices, for example a decoder and a portable security module in a

digital television system.

Transmission of encrypted data is well-known in the field of pay TV systems, where

scrambled audiovisual information isusually broadcast by satellite to a number of

subscribers, each subscriber possessing a decoder capable of ‘descrambling the

transmitted program for subsequent viewing.

In a typical system, scrambled data is transmitted together with a control word for

descrambling of the data, the control word itself being encrypted by a so-called

exploitation key and transmitted in encrypted form. The scrambled data and encrypted

control word are then received by a decoder having access to air equivalent of the

exploitation key stored on a portable security module such as a smart card inserted in

the decoder. The encrypted control word is then decrypted on the smart card and

subsequently communicated to the decoder for use in descrambling theitransmitted

data.

In order to try to improve the security of the system, the control word is usually

changed every ten seconds or so. This avoids the situation with a static or slowly

changing control word where the control word may become publicly known. In such

circumstances, it would be relatively simple for a fraudulent user to feed the know

control word to the descrambling unit on his decoder to descramble the transmission.

Notwithstanding this security measure, a problem has arisen in recent years where the

stream of control words sent during a broadcast becomes known through monitoring

of data communicated at the interface between the smart card and decoder.

information may be used by any unauthorised user who has recorded the still-

scrambled broadcast on a video recorder. If the film is replayed at the same time as

the stream of control words is fed to the decoder, visualisation of the broadcast
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becomes possible. This problem has further been exacerbated with the rise of the

internet and it is now common to find any number of internet sites that list the stream

of control words emitted during a given transmission.

The European patent application PCT W0 97/3530 in the name of Digco addresses

this problem by proposing a solution in which the control word stream passed across

the interface between the smart card and decoder is itself encrypted with a session key.

The session key is generated randomly by the decoder and encrypted with a second

key held in the decoder and corresponding to a public key used with a private/public

encryption algorithm. The associated smart card possesses the necessary private key

to decrypt the session key, which is thereafter used by the smart card to encrypt the

control word stream sent fi'om the smart card to the decoder.

As will be appreciated, the use of a locally generated session key to encrypt the

control word stream means that the encrypted stream cannot thereafier be fed into

another decoder for use in descrambling the data since each decoder will possess a

different session key for use in decrypting the control word stream sent from the smart

card.

Whilst this solution provides a higher level of security than conventional systems there

are nevertheless a number of disadvantages associated with this system.

Notably, the use of a public/private key algorithm is effectively obligatory in such a

system since it is not desirable for security reasons to store both a syrnmetric key and

the associated algorithm in the decoder, due to the ease in which this information may

be extracted fi'om a decoder memory. This problem does not arise in the case of a

public key, since possession of this key does not enable decryption of private key

encrypted messages.

It is one object of the present invention to provide a more adaptable alternative to the

above known system. However, the invention is not limited to the field of decoder

security and, as will be described below, may be applied to a number of other
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situations in which secure communication of data is required.

A first aspect of the present invention provides a method’ of encryption of data

communicated between a first and second device, wherein at least one precalculated

key pair is stored in a memory of the first device, said at least one key pair

comprising a session key and an encrypted version of the session key prepared using

a transport key, the encrypted version of the session key being subsequently

communicated to the second device which decrypts the encrypted version using an

equivalent transport key stored in its memory such that data communicated from at

least ‘the second to the first device may thereafter be encrypted and decrypted by the

session key in the respective devices.

A preferred embodiment provides a method of encryption of data communicated

between a first and second device, characterised in that one or more precalculated key

pairs are stored in a memory of the first device, the or each key pair comprising a

session key and an encrypted version of this session key prepared using a transport

key, the encrypted value of the session key being subsequently communicated to the

second device which decrypts this value using an equivalent transport key stored in

its memory such that data communicated from at least the second to the first device

may thereafter be encrypted and decrypted by the session key in the respective

devices.

Unlike the Digco system described above, the use of a precalculated stored pair of

values avoids the necessity of having to provide an encryption algorithm within the

first device (e.g. the decoder) to encrypt an internally generated session key. As a

consequence, the algorithm chosen to encrypt the session key need not be limited to

a public/private key algorithm but may correspond to a symmetric type algorithm if

desired. Nevertheless, as will be understood, the present invention may also be

implemented using public/private key algorithms to encrypt the session key, as will

be discussed in further detail below.

Advantageously, a plurality of key pairs are stored in the memory of the first device,
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the first device selecting and processing one or more session keys to generate a

definitive session key and communicating the associated encrypted value or values to

the second device for decryption and processing by the second device to generate the

definitive session key.

The provision of a plurality of key pairs within the first device enables the first device

to choose and definea different definitive session key for each communication session.

In one embodiment, a subset of a plurality of stored session keys is chosen by the first

device to generate the definitive session key, the associated encrypted values of these

subset session keys being communicated to the second device for decryption and

processing.

Depending on the type of operation used, the resulting definitive session key may be

dependent on the order of combination of the chosen session keys. In such an

embodiment, this order information is communicated to the second device to enable

the second device to correctly generate the definitive session key using the associated

encrypted values.

For example, an initial session key value known to both the first and second devices

may be repeatedly encrypted in both devices by an ordered sequence of session keys

using an encryption algorithm sensitive to the order of encryption, such as the DES

symmetric algorithm.

Of course, where the first device is using a selected subset of keys to generate the

. definitive session key, it may not be necessary to also use an order dependent

algorithm to generate a changeable definitive session key and the keys may be

combined, for example, using a simple arithmetical operation.

In one advantageous embodiment, the one or more precalculated key pair values may

be selected from a larger set of precalculated key pairs prior to storage in the first

device. For example, the operator or system manager may communicate a large

niunber of precalculated key pairs to the manufacturer of the first device, the device
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manufacturer thereafier selecting at. random the key pairs to be stored in a given

device.

. In this way, the key pair or pairs embedded in the first device will be unique to that

device, or at least quasi-unique, thereby increasing the level of security for the system.

Furthermore, the entity responsible for manufacture of the device need not possess the

algorithm or keys used to prepare the encrypted session key values but may be simply

supplied with a table of key pairs.

Preferably, the encrypted key value or values communicated to the second device also

include a signature value that may be read by the second device to verify the

authenticity of the communicated value.

Such a ‘signature ‘value can be generated and verified in accordance with a

conventional signature system, for example using combination of hash and

public/private key algorithms such as MD5 and RSA, this signature being appended

to the key pair values stored in the first device.

Conveniently, the signature value can also be precalculated at the time of calculation

of the encrypted key value and thereafter stored in the first device.

‘In a particularly preferred’ embodiment, the algorithm and transport key used to

encrypt and decrypt the session key or keys correspond to a symmetric algorithm and

associated symmetric key. The use of a symmetric algorithm enables an increase in

the processing time necessary for the second device to decrypt the session key in

comparison with an operation using a public/private key algorithm.

Whilst one of the advantages of the present invention lies in the adaptability of the

present system to use a symmetric algorithm, it will be appreciated that this is not

obligatory. For example, in an alternative embodiment, the session key or keys may

be encrypted by a public key prior to storage in the first device and decrypted by an

equivalent private key within the second device.
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Further preferably, the encryption algorithm used with the session key to encrypt and

decrypt data communicated between the first and second device (or vice versa)

corresponds to a symmetric algorithm. The choice of algorithm used may depend on

the system requirements such as the need to have bidirectional communication between

the devices.

Suitable symmetric algorithms may include DES or even an appropriate proprietary

algorithm. Suitable public/private key algorithms may comprise RSA or other similar

algorithms.

As mentioned above, the present invention is particularly applicable to the field of

digital television and, in one preferred embodiment, the first device corresponds to a

decoder and the second device to a portable security module (or vice versa).

The portable security module may conveniently comprise a smart card. If so, the data

encrypted with the session key may correspond to simple control word information

used by the decoder to descramble broadcast data.

The same principle may also be applied to the case where the descrambling unit in the

decoder is implemented as a detachable conditional access module or CAM, broadcast

data being descrambled in the conditional access module and communicated to the

decoder.

In this embodiment, the first device may thus correspond to a decoder and the second

device to a detachable conditional access module. If so, the data encrypted with the

session key will normally correspond to the data descrambled by the conditional access

module e.g. the broadcast programme itself.

In a conditional access module implementation, a smart card may also form part of the

system, this card being inserted in the conditional access module to decrypt the control

word, which is then passed to the conditional access module to permit descrambling

of the broadcast programme. If so, the first device may then correspond to a
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conditional access module, the second device to a smart card and the data encrypted

with the session key to control word data.

Within the field of digital television, the invention may also be applied to the

communication of data between a decoder and other devices, such as a television or

video recorder. In particular, in one embodiment, the first device corresponds to a

first decoder and the second device to a second decoder.

In households possessing a first and second decoder, there are often a number of

problems associated with maintaining communication between a first or “master”

decoder and a second “slave” decoder. The use of a secure encrypted link to

communicate audiovisual data, control word data, or even data relating to current

subscription rights and exploitation keys, may prove useful in this context.

In yet a further realisation, the present invention may be applied to home network

system, the first and second devices corresponding to first and second consumer

electronic devices adapted to transfer data via a communication link (e.g. radio, PLC,

infra-red etc.).

The above embodiments have been described in relation to a method of encryption of

data. Viewed from another aspect, the invention may equally be applied to first and

second devices adapted to carry out such a method.

Another aspect of the present invention provides a system _for providing secure

communication of data between first and second devices, said first device comprising

a memory for storing at least one precalculated key pair comprising a session key and

an encrypted version of the session key prepared using a transport key, and

communication means, such as a communication link, for communicating the

encrypted version of the session key to said second device, said second device

comprising amemory for storing an equivalent transport key, decryption means, such

as a processor, for decrypting said encrypted version of the session key using said

equivalent transport key, and means, such as the processor, for encrypting data to be
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communicated to said first device using said session key.

Features described above relating to method aspects of the present invention can also

be applied to device or system aspects, and vice versa.

As used above, the terms “portable security module”, “smart card” and “conditional

access rnodule” may be interpreted intheir broadest sense as applying to any portable

microprocessor and/or memory based ‘card capable of carrying out the described

functions.

As particular examples of such devices, a smart card may correspond to a card device

constructed in accordance with the known international standards ISO 7816-1, 7816-2

and 7816-3 whilst the conditional access module may be implemented as a PCMCIA

or PC card corresponding to the standards fixed by the PCMCIA group. Other

physical shapes, and forms are of course possible.

The terms “scrambled” and “encrypted” and “control word”. and “key” have been used

at various parts in the text for the purpose of clarity of language. However, it will be

understood that no fundamental distinction is to be made between “scrambled data”

and “encrypted data” or between a “control word” and a “key”. .

Similarly, unless obligatory in view of the context stated or unless otherwise specified,

no limitation to either symmetric or public/private algorithms is to be inferred for a

given encryption and/or decryption process. In the same way, whilst the matching

keys used in encrypting and decrypting information may be referred to by the same

name (e.g. “transport key”, “session key”) it is to be understood that these need not

be numerically identical keys as long as they fiilfil their functions. For example, the

corresponding public and private keys used to encrypt and decrypt data will normally

possess numerically different values.

The term “receiver/decoder” or “decoder” as used herein may connote a receiver for

receiving either encoded or non-encoded signals, for example, television a.nd/or radio
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signals, which may be broadcast or transmitted by any appropriate means.

Embodiments of such decoders may also include a decoder integral with the receiver

for decoding the received signals, for example, in a “set-top box”, a decoder

functioning in combination with a physically separate receiver, or such a decoder

including additional functions, such as a web browser, integrated with other devices

such as a’ video recorder or a television.

As used herein, the term “digital transmission system” includes any transmission

system for transmitting or broadcasting for example primarily audiovisual or

multimedia digital data. Whilst the present invention is particularly applicable to a

broadcast digital television system, the invention may also be applicable to a fixed

telecommunications network for multimedia intemet applications, to a closed circuit

television, and so on.

As used herein, the term “digital television system” includes for example any satellite,

terrestrial, cable and other system.

There will now be described, by way of example only, a number of embodiments of

the invention, with reference to the following figures, in which:

Figure 1 shows by way ofbackground the overall architecture of a digital TV system;

Figure 2 shows the architecture of the conditional access system of Figure 1;

Figure 3 shows a method of encryption of data between a smart card and a decoder

according to this embodiment of the invention;

Figure 4 shows the generation of a session key in a decoder operating according to the

embodiment of Figure 3; and

Figure 5 shows the steps in the preparation of a session key in a smart card interfacing

with the decoder of Figure 4.
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The present invention describes a method of encryption of data, in particular but not

exclusively applicable to the encryption of data across the interface between a portable

security module and decoder in a digital television system. By way of background,

the architecture of a known digital television system will now be described.

Digital Television System

An overview of a digital television system 1 is shown in Figure 1 comprising a

broadcast system 2 which uses the MPEG-2 compression system to transmit

compressed digital signals. In more detail, an MPEG-2 compressor 3 in a broadcast

centre receives a digital signal stream (for example a stream of audio or video signals).

The compressor 3 is connected to a multiplexer and scrambler 4 by linkage 5. The

multiplexer 4 receives a plurality of further input signals, assembles one or more

transport streams and transmits compressed digital signals to a transmitter 6 of the

broadcast centre via linkage 7, which can of course take a wide variety of forms

including telecom links.

The transmitter 6 transmits electromagnetic signals via uplink 8 towards a satellite

transponder 9, where they are electronically processed and broadcast via. a notional

downlink 10 to earth receiver 11, conventionally in the form of a dish owned or rented

by the end user. The signals received by receiver 11 are transmitted to an integrated

receiver/decoder 12 owned or rented by the end user and connected to the end user’s

television set 13. The receiver/decoder 12 decodes the compressed MPEG-2 signal

into a television signal for the television set 13.

A conditional access system 20 is connected to the multiplexer 4 and the

receiver/decoder 12, and is located partly in the broadcast centre-and partly in the

decoder. It enables the end user to access digital television broadcasts from one or

more broadcast suppliers. A portable security module in the form of a smartcard

capable of decrypting messages relating to broadcast programmes or data can be

inserted into the receiver/decoder 12.
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An interactive system 17, also connected to the multiplexer 4 and the receiver/decoder

12 and again located partly in the broadcast centre and partly in the decoder, may be

provided to enable the end user to interact with various applications via a modemmed

back cha.nnel 16.

The conditional access system '20 will now be described in more detail. With

reference to’ Figure 2, in overview the conditional access system 20 includes a

Subscriber Authorization System (SAS) 21. The SAS 21 is connected to one or more

Subscriber Management Systems (SMS) 22, one SMS for each broadcast supplier, for

example by a respective TCPS-IP linkage 23 (although other types of linkage could

alternatively be used). Alternatively, one SMS could be shared between two broadcast

suppliers, or one supplier could use two SMSs, and so on.

First encrypting units in the form of ciphering units 24 utilising "mother" smartcards

25 are connected to the SAS by linkage 26. Second encrypting units again in the form

of ciphering units 27 utilising mother smartcards 28 are connected "to the multiplexer

4 by linkage 29. The receiver/decoder 12 receives a portable security module, for

example in the form of "daughter" smartcard 30. It is connected directly to the SAS

21 by Communications Servers 31 via the modemmed back channel 16. The SAS

sends, amongst other things, subscription rights to the daughter smartcard on request.

The smartcards contain the secrets of one or more commercial operators. The

"mother" smartcard encrypts different kinds of messages and the "daughter" smartcards

decrypt the messages, if they have the rights to do so.

The first and second ciphering units 24 and 27 comprise a rack, an electronic VME

card with sofiware stored on an EEPROM, up to 20 electronic cards and one

smartcard 25 and 28 respectively, for each electronic card, one card 28 for encrypting

the ECMs and one card 25 for encrypting the EIv1Ms.

The operation of the conditional access system 20 of the digital television system will

now be described in more detail with reference to the various components of the
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television system 2 and the conditional access system 20.

Multiplexer and Scrambler

With reference to Figures 1 and 2, in the broadcast centre, the digital audio or video

signal is first compressed (or bit rate reduced), using the MPEG-2 compressor 3. This

compressed signal is then transmitted to the multiplexer and scrambler 4 via the

linkage 5 in order to be multiplexed with other data, such as other compressed data.

The scrambler generates a control word used in the scrambling process and included

in the MPEG-2 stream in the multiplexer. The control word is generated internally

and enables the end user’s integrated receiver/decoder 12 to descramble the

programme.

Access criteria, indicating how the programme is commercialised, are also added to

the MPEG-2 stream. The programme may be commercialised in either one of a

number of "subscription” modes and/or one of a number of "Pay Per View” (PPV)

modes or events. In the subscription mode, the end user subscribes to one or more

commercial offers, or "bouquets", thus getting the rights to watch every channel inside

those bouquets. In the preferred embodiment, up to 960 commercial offers may be

selected from a bouquet of channels.

In the Pay Per View mode, the end user is provided with the capability to purchase

events as he wishes. This can be achieved by either pr_e-booking the event in advance

("pre-book mode"), or by purchasing the event as soon as it is broadcast ("impulse

mode"). In the preferred embodiment, all users are subscribers, whether or not they

watch in subscription or PPV mode, but of course PPV viewers need not necessarily

be subscribers.

Entitlement Control Messages

Both the control word and the access criteria are used to build an Entitlement Control
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Message (ECM). This is a message sent in relation with a scrambled program; the
message contains a control word (which allows for the descrambling of the program)

and the access criteria of the broadcast program. The access criteria and control word

are transmitted to the second encrypting unit 27 via the linkage 29. In this unit, an

ECM is generated, encrypted and transmitted on to the multiplexer and scrambler 4.

During a broadcast transmission, the control word typically changes every few

seconds, and so ECMs are also periodically transmitted to enable the changing control

word to be descrambled. For redundancy purposes, each ECM typically includes two

control words; the present control word and the next control word.

Each service broadcast by a broadcast supplier in a data stream comprises a number

of distinct components; for example a television programme includes a video

component, an audio component, a sub-title component and so on. Each of these

components of a service is individually scrambled and encrypted for subsequent

broadcast to the transponder 9. V In respect of each scrambled component of the

service, a separate ECM is required. Alternatively, a single ECM may be required for

_ all of the scrambled components of a service. Multiple ECMs are also generated in

the case where multiple conditional access systems control access to the same

transmitted program.

Entitlement Mana ement Messa es MMs

The EMM is a message dedicated to an individual end user (subscriber), or a group

of end users. Each group may contain a given number of end users. This organisation

as a group aims at optimising the bandwidth; that is, access to one group can permit

the reaching of a great number of end users.

Various specific types of EMM can be used. Individual EMMS are dedicated to

individual subscribers, and are typically used in the provision of Pay Per View

services; these contain the group identifier and the position of the subscriber in that

group.
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Group subscription l3MMs are dedicated to groups of, say, 256 individual users, and

are typically used in the administration of some subscription services. This EMM has

a group identifier and a subscribers’ group bitmap.

Audience EMMS are dedicated to entire audiences, and might for example be used by

a particular operator to provide certain free services. An “audience” is the totality of

subscribers having smartcards which bear the same conditionalaccess system identifier

(CA ID). Finally, a “unique” EMM is addressed to the unique identifier of the

smartcard.

EMMS may be generated by the various operators to control access to rights associated

with the programs transmitted by the operators as outlined above. EMMS may also

be generated by the conditional access system manager to configure aspects of the

conditional access system in general.

The term EMM is also often used to describe specific configuration type messages

communicated between the decoder and other elements of the system and, for

example, will be used later in this application to refer to a specific message passed

fiom the decoder to a smart card.

Subscriber Management System (SMS)

A Subscriber Management System (SMS) 22 includes a database 32 which manages,

amongst others, all of the end user files, commercial offers, subscriptions, PPV details,

and data regarding end user consumption and authorization. The SMS may be

physically remote from the SAS.

Each SMS 22 transmits messages to the SAS 21 via respective linkage 23 which imply

modifications to or creations of Entitlement Management Messages (EMMS) to be

transmitted to end users.

The SMS 22 also transmits messages to the SAS 21 which imply no modifications or
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creations of EMMS but imply only a change in an end user’s state (relating to the

authorization granted to the end user when ordering products or to the amount that the

end user will be charged).

The SAS 21 sends messages (typically requesting information such as call—back

information or billing information) to the SMS 22, so that it will be apparent that

communication between the two is two-way.

Subscriber Authorization System {SAS}

The messages generated by the SMS 22 are passed via linkage 23 to the Subscriber

Authorization System (SAS) 21, which in tum generates messages acknowledging

receipt of the messages generated by the SMS 21 and passes these acknowledgements

to the SMS 22.

In overview the SAS comprises a Subscription Chain area to give rights for

subscription mode and to renew the rights automatically each month, a Pay Per View

Chain area to give rights for PPV events, and an EIVHVI Injector for passing EMMs

created by the Subscription and PPV chain areas to the multiplexer and scrambler 4,

and hence to feed the MPEG stream with EMMs. If other rights are to be granted,

such as Pay Per File (PPF) rights in the case of downloading computer software to a

user’s Personal Computer,’other similar areas are also provided.

One function of the SAS 21 is to manage the access rights to television programmes,

available as commercial offers in subscription mode or sold as PPV events according

to different modes of commercialisation (pre-book mode, impulse mode). The SAS

21, according to those rights and to information received from the SMS 22, generates

EMMs for the subscriber.

The EI\/fl\/Is are passed to the Ciphering Unit (CU) 24 for ciphering with respect to the

management and exploitation keys. The CU completes the signature on the EIVIM and

passes the EMM back to a Message Generator (MG) in the _SAS 21, where a header
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is added. The EMMs are passed to a Message Emitter (ME) as complete EMMs. The

Message Generator determines the broadcast start and stop time and the rate of

emission of the EMMs, and passes these as appropriate directions along with the

EMMs to the Message Emitter. The MG only generates a given EMM once; it is the

ME which performs cyclic transmission of the EMMs.

On generation of an EMM, the MG assigns a unique identifier to the EMM. When

the MG passes the EMM to the ME, ‘it also passes the EMM ID. This enables

identification of a particular EMM at both the MG and the ME.

Programme Transmission

The multiplexer 4 receives electrical signals comprising encrypted EMMs from the

SAS 21, encrypted ECMs from the second encrypting unit 27 and compressed

programmes from the compressor 3. The multiplexer 4 scrambles the programmes and

sends the scrambled programmes, the encrypted EMMs and the encrypted ECMs to

a transmitter 6 of the broadcastcentre via the linkage 7. The transmitter 6 transmits

electromagnetic signals towards the satellite transponder 9 via uplink 8.

Programme Reception

The satellite transponder 9 receives and processes the electromagnetic signals

transmitted by the transmitter 6 and transmits the signals on to the earth receiver 11,

conventionally in the form of a dish owned or rented by the end user, via downlink

10. ' The signals received by receiver 11 are transmitted to the integrated

receiver/decoder 12 owned or rented by the end user and connected to the end user’s

television set 13. The receiver/decoder 12 demultiplexes the signals to obtain

scrambled programmes with encrypted EMMs and encrypted ECMs.

If the programme is not scrambled, that is, no ECM has been transmitted with the

IVIPEG-2 stream, the receiver/decoder 12 decompresses the data and transforms the

signal into a video signal for transmission to television set 13.
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If the programme is scrambled, the receiver/decoder 12 extracts the corresponding

ECM from the l\/fl’EG—2 stream and passes the ECM to the "daughter" srnartcard 30

of the end "user. This slots into a housing in the receiver/decoder 12. The daughter

smartcard 30 controls whether the end user has the right to decrypt the ECM and to

access the programme. If the end user does have the rights, the ECM is decrypted

within_the smart card and the control word extracted.

Thereafter the smart card then communicates the control word to the decoder 12 which

— then descrambles the programme using this control word. In most conventional

systems, the control word is communicated across the smart card interface in a clear

or non-encrypted form, leading to the problems of security described in the

introduction of the present application. Afier descrambling by the decoder, the

MPEG-2 stream is decompressed and translated into a video signal for onward

transmission to television set 13.

In the system described above, the descrambling of the MPEG data is carried out

within the decoder using the control word information communicated to the decoder

from the smart card. In other systems, the descrambling circuitry may be implemented

in a detachable conditional access module or CAM, commonly embodied in the form

of a PCMCIA or PC card insertable in a socket in the decoder.

The CAM module may itself further include a slot to receive a smart card. In such

systems, control word data is decrypted in the smart card communicated to the CAM

module which then descrarnbles the scrambled MPEG data stream to supply the

decoder with a clear MPEG stream for decompression and subsequent display.

In this type of system, sensitive data may be passed between the smart card and CAM

(control word data) and/or between the CAM and decoder (descrambled IVIPEG data)

and problems of security may arise at either of these interfaces.

Data Encryption across an Interface
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Referring to Figure 3, there will now be described a method of data encryption as

applied to the control word data communicated between a smart card a.nd a decoder

in one of the simplest embodiments of this invention. However, the same principles

may be applied to the encryption of control word data between a smart card and a

CAM, audiovisual MPEG data between a CAM and a decoder, or indeed any type of

data between two such devices.

In accordance with the present invention, a set of key pairs is stored in a non-volatile

memory of the decoder e.g. a FLASH memory. Each key pair corresponds to ,a key

value in clear form and an encrypted version of the key. As will be described, the

encrypted version of the key will be eventually communicated an EMM message

. sent to a smart card inserted in the decoder.

Thus, within the decoder a set of EMM message/key pairs are stored as follows:

n EMM (19 octets) Key (8 octets)

1 EMM(l ) Key( 1 )

2 EMM(2) Key(2)

3 EMM(3) Key(3)

is EMM(1.6) Key(16)

The encrypted value of the key stored in the EMM is calculated external of the

decoder using an encryption algorithm not present in the decoder. In the present

example the key values Key(l), Key(2) etc. correspond to symmetric keys to be used

with a symmetric encryption algorithm such as DES.

The encryption algorithm used to prepare the encrypted DES key values contained

with the stored EMM messages may also correspond to a symmetric encryption

algon'thm_. For increased security, a proprietary symmetric algorithm (PSA) different

fiom DES will be used to prepare the encrypted values, although in another
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embodiment DES may also be used to encrypt the key values.

In addition to the encrypted valueiof the associated key, the EMM message may also
include a signature value associated with the message and prepared as per any

conventional signature preparation method. For example, a message may be subject

to a hash fimction such as MD5 followed by encryption of the hash value by a private

key of private/public key algorithm such as RSA. Verification of the signature may

then be carried out at the point of reception using a MD5 algorithm and the

corresponding public key of the private/public key pair.

The EMM message will additionally include a standard smart card header element (as

defined by the international standard ISO 7816-3) to place the message in a format

necessary to permit it to be read by a smart card. An EMM associated with an 8 byte

key will therefore typically have the following structure:

Header 5 bytes

Encrypted key 10 bytes

Signature 9 bytes

In the present embodiment a set of 16 key/message pairs are implanted in the memory

of the decoder. Alternative «embodiments are equally possible using more or less

key/message pairs and the invention may even be implemented using a single

key/message pair. Whilst it may be envisaged that all decoders are equipped with the

same key/message pairs it is preferred for security reasons that each decoder has a

unique set of key/message pairs. In implementing this embodiment, an operator may

supply to a decoder manufacturer a set of ten thousand or more key/message pairs, the

decoder manufacturer taking a random selection of 16 pairs during the personalisation

of each decoder.

In order to increase the security, a different subset of the message/key pairs stored in

the decoder will be used during each session. A session may be defined as

corresponding to each time the decoder is switched on and off, or each time the
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decoder changes channel, for example.

Referring to Figure 3, a random number generator 40 within the decoder selects 8 out

of the 16 message/key pairs to be used in that session. The 8 selected EMM messages

41 of the pairs are then communicated to the smart card 30 to be verified and

decrypted and processed as shown at 42 and 43 to obtain the appropriate session key

(see below). The same key generation operation is carried out within the decoder at

43 using the corresponding key values of the pairs so as to obtain the same session

key value.

The generation of the session key within the decoder will now be described with

reference to Figure 4.

A base session key value KeyS Initial shown at 44 and constant -for all decoders is

encrypted at 45 by the first key 46. of the subset chosen by the random generator 40.

The resulting value is then encrypted at 47 using the second key 48 of the session

subset and the operation repeated just until the last encryption operation 49 carried out

with the last key 50 of the subset so as to obtain the final session key value shown at

51.

The initial session key value KeyS Initial can be a universal value present in all

decoders and smart cards, a value linked to a specific decoder/smart card pair or even

a value generated at the start of each session in the decoder and thereafter

communicated to the smart card.

In the example given above, the session key is prepared by a sequence of repeated

operations on the KeyS Initial using the DES algorithm and the selected keys 46, 48,

50 etc. In the case of the DES algorithm, the order in which the keys are applied is

important and must be respected to produce the same key each time.

However, whilst the session key S is itself a numerical value that will be used as a

DES key in the subsequent decryption operation (see below), the steps used to
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generate this key value need not correspond to DES encryption steps. Instead, the

subset of keys chosen by the random number generator may be combined together in

any number of ways to arise at a suitable session key value KeyS Final. For example,

the keys may be combined using a sequence of simple arithmetic operations.

Depending on the method chosen, it may not be necessary that the order of the steps

in the preparation of the KeyS be respected in order to regenerate the same key.

Referring now to Figure 5, the decryption and processing operations 42 and 43 carried

out in the smart card 30 to generate the session key used by the smart card will now

be described.

Upon insertion of the smart card in the decoder, the subset of EMM messages

matching the selected key values are sent to the smart card. Authentification of each

EMM messages is first carried out with reference to the attached signature value, using

for example an MD5/RSA type process as described above. For simplicity, this step

has been omitted from Figure 5.

The first EMM message 60 is then decrypted at 61 using a transport key 59 embedded

in a secure and non-readable manner within the smart card. As mentioned above, for

security reasons the algorithm used in the decryption 61 of the EMM message may

correspond to a proprietary security algorithm PSA known only to the operator

responsible for preparation of the message/key pairs used in the decoder and the

personalisation of the smart card. “

The transport key KeyT shown at 59 may be a key value common to all smart cards

in the system or unique to one such card. The use of a unique key value KeyT

requires that the message/key table stored in the decoder be prepared with the same

key as that in the card, such that a decoder and card will be irreversibly linked

together. In practice, this may not be desirable.

A similar decryption operation using the transport key 59 is then carried out at 62 on

the next EMM message 63 in the series and 50 on until the last decryption operation
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64 on the final EMM message 65.

In the present embodiment, encryption of each of the EMM messages 60, 63, 65

produces keys 46, 48, 50 identical to those associated in the message/key table present

in the decoder and used for generation of the session key as described previously. For

this reason, the same reference numbers have been used for these keys and for the key

generation operation 43 also carried out in the decoder. Similarly, the same initial

session key 44 present in the decoder is also stored in the smart card.

The initial session key KeyS Initial shown at 44 is then encrypted at 45 by the first

key 46, the result re-encrypted at 47 by the second key 48 and so on until the final

encryption step carried out at 49 using the last key 50 in the series so as to obtain the

final session key at 51.

Both the decoder and smart card now possess the same session key KeyS which may

thereafter be used in encrypting and decrypting data passed in either direction between

the two devices.

Referring back to Figure 3, the smart card 30 receives an encrypted ECM message

containing the control word necessary for descrambling an associated segment of

MPEG audiovisual or other data.‘ The smart card decrypts the ECM at 71 to obtain

the control word value CW.

In passing, we note that the algorithm used to encrypt ECM messages for a user may

conveniently correspond to the Proprietary Security Algorithm used for decryption of

the EMM messages received from the smart card as described above.

The decrypted control word is then re-encrypted at 72 using the session key KeyS and

the encrypted control word value f(CW) transmitted over the decoder/smart card

interface as shown. The encrypted value f(CVV) is then decrypted at 73 using the

session key KeyS held in the decoder and the clear value of the control word CW

obtained at 74.
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As the session keyiis symmetric, it may equally be used in the encryption of data

transmitted from the-decoder to the smart card. Furthermore, the data transmitted

from the smart card to the decoder may be data other than simple control word data.

As mentioned above, the same principle may be applied across all interfaces in a

system comprising a decoder in which a detachable CAM module is inserted

(decoder/CAM interface, CAM/srnart card interface etc.). Similarly, the same

principle may be applied in the case of a portable module (either a CAM type module

or a smart card) inserted in other devices such as a television or video recorder.

In fact, the above method of setting up an encrypted communication channel may be

applied to any pair of devices where security of data communication is required. In

particular, the same principle may be applied in a home network system where

multiple consumer devices (television, video, PC, decoder etc.) transfer data such as

audiovisual data or computer files via a communication link. This may be an RF link,

an infrared link, a dedicated bus, a power line connection etc. For example, it may

be desired to transmit control word in other data in an encrypted form between a

decoder and a television or between a master decoder and a slave decoder in the same

household.

Other examples of systems of this type where a secure communication link would be

desirable will also be apparent to the reader.
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CLAIMS

1. A method of encryption of data communicated between a first and second device,

wherein at least one precalculated key pair is stored in a memory of the first device,

said at least one key pair comprising a session key and an encrypted version of the

session key prepared using a transport key, the_ encrypted version of the session key

being subsequently communicated to the second device which decrypts the encrypted

version using an equivalent transport key stored in its memory such that data

. communicated from at least the second to the first device may thereafter be encrypted

and decrypted by the session key in the respective devices.

2. A method as claimed in claim 1, in which a plurality of key pairs are stored in the

memory of the first device, the first device selecting and processing at least one

session key to generate a definitive session key and communicating the associated

encrypted version of said at least one session key to the second device for decryption

and processing by the second device to generate the definitive session key.

3. A method as claimed in claim 2 in which a subset of a plurality of stored session

keys is chosen by the first device to generate the definitive session key, the associated

encrypted versions of the subset of session keys being communicated to the second

device for decryption and processing.

4. A method as claimed in claim 2 or 3, in which the order of combination of a

plurality of session keys used to generate the definitive session key is cornmunicated

from the first to the second device.

5. A method as claimed in claim 4 in which an initial session key value known to

both the first and second devices is repeatedly encrypted in both devices by an ordered

sequence of session keys using an encryption algorithm sensitive to the order of

encryption.

6. A method as claimed in any preceding claim in which said at least one
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precalculated key pair is selected from a larger set of precalculated key pairs prior to

being stored in the first device.

7. A method as claimed in any preceding claim in which the encrypted version of a

session key communicated to the second device also includes a signature value

readable by the second device to verify the authenticity of the encrypted version of the

session key.

8. A method as claimed in any preceding claim in which an algorithm and transport

key used to encrypt and decrypt a session key correspond to a symmetric algorithm

and associated symmetric key.

9. A method as claimed in any preceding claim in which an encryption algorithm

used with a session key to encrypt and decrypt data communicated between the first

and second device corresponds to a symmetric algorithm.

10. A method as claimed in any preceding claim, in which the first device is a

decoder.

11. A method as claimed in any preceding claim, in which the second device is a

portable security module.

12. A method as claimed in claim 11, in which the portable security module

_ corresponds to one of a smart card and a conditional access module.

13. A method as claimed in any of claims 1 to 9, in which the first device

corresponds to a conditional access module and the second device corresponds to a

smart card.

14. A method as claimed in any of claims 10 to 13, in which data encrypted and

decrypted with a session key corresponds to control word data.
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15. A method as claimed in any of claims 10 to 13, in which data encrypted and

decrypted with a session key corresponds to descrambled broadcast data.

16. A method as claimed in any of claims 1 to 9 in which the first and second device

correspond to a first and second decoder respectively.

17. A method as claimed in any of claims 1 to 9 as applied to a home network

system, the first and second devices corresponding to first and second consumer

electronic devices adapted to transfer data via a communication link.

18. A first device adapted to be used in a method as claimed in any of claims 1 to

17, the first device including a memory in which at least one precalculated key pair

is stored, said at least one precalculated key pair comprising a session key and an

encrypted version of this session key.

19. A second device adapted to be used in a method as claimed in any of claims 1

to 18 and with a first device as claimed in claim 18, the second device comprising a

memory in which is stored a key and algorithm that are needed to decrypt the

encrypted session key value stored in the memory of the first device. V

20. A first and second device as claimed in claims 18 and 19, in which the first

device corresponds to a decoder and the second device to a portable security module.

21. A system for providing secure communication ofdata between first and second

devices, said first device comprising a memory for storing at least one precalculated

key pair comprising a session key and an encrypted version of the session key

prepared using a transport key, and communication means for communicating the

encrypted version of the session key to said second device, said second device

comprising a memory for storing an equivalent transport key, decryption means for

decrypting said encrypted version of the session key using said equivalent transport

key, and means for encrypting data to be communicated to said first device using said

session key.
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22. A system as claimed in claim 21, wherein the memory of the first device is

adapted to store a plurality of key pairs, the first device comprising means for

selecting and processing at least one session key to generate a definitive session key

said communication means being adapted to communicate the associated encrypted

version of said at least one session key to the second device, said second device

comprising means for processing said at least one session key to generate the definitive

session key.

23. A system as claimed in claim 21 or 22, in which the encrypted version of a

session key includes a signature value readable by the second ‘device to verify the

authenticity of the encrypted version of the session key.

24. A system as claimed in any of claims 21 to 23, in which an algorithm and

transport key used to encrypt and decrypt a session key correspond to a symmetric

algorithm and associated symmetric key.

25. A system as claimed in any of claims 21 to 24, in which an encryption algorithm

used with a session key to encrypt and decrypt data communicated between the first

and second device corresponds to a symmetric algorithm.

26. A system as claimed in any of claims 21 to 25, in which the first device is a

decoder.

27. A system as claimed in any of claims 21 to 26, in which the second device is a

portable security module.

28. A system as claimed in claim 27, in which the portable security module

corresponds to one of a smart card and a conditional access module.

29. A system as claimed in any of claims 21 to 25, in which the first device

corresponds to a conditional access module and the second device corresponds to a
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smart card.

30. A system as claimed in any of claims 21 to 25 in which the first and second

device correspond to a first and second decoder respectively.

31. A system as claimed in any of claims 21 to 25 as applied to a home network

system, the first and second devices corresponding to first and second consumer

electronic devices adapted to transfer data via a communication link.

32. A method of encryption of data communicated between a first and second device

substantially as herein described.

33. A system for providing secure communication of data between first and second

devices substantially as herein described.
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Capab/'/ity- and Object-Based
System Concepts

 

Although the complexity of computer applications increases
yearly, the underlying hardware architecture for applications
has remained unchanged for decades. It is, therefore, not sur-
prising that the demands of modern applications have exposed
limitations in conventional architectures. For example, many
conventional systems lack support in:

l. Infarrnation sharing and communications. An essential system
function is the dynamic sharing and exchange of informa-
tion, whether on a timesharing system or items a network.
Fundamental to the sharing of storage is the addressing or
naming of objects. Sharing is dificult on conventional sys-
tems because addressing is local to a single process. Sharing
would be simplified if addresses could be transmitted be-
tween processes and used to access the shared data.

2. Protection and secw-ity. As infonnation sharing becomes eas-
ier, users require access controls on their private data. It
must also be possible to share information with, or run pro-
grams written by, other users without compromising confi-
dential data. On conventional systems, all of a user's objects
are accessible to any program which the user runs. Protec-
tion would be enhanced if a user could restrict access to only
those objects a program requires for its execution.

3. Reliable canstnutian and maintenance ofcomplex synans. Con-
ventional architectures support a single privileged mode of
operation. This structure leads to monolithic design; any
module needing protection must be part of the single operat-
ing system kernel. lf, instead, any module could execute
within a protected domain, systems could be built as a col-
lection of independent modules extensible by any user.
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Capability- and
Object-Based System _ _
Concepts Over the last several decades, computer industry and um-

versity scientists have been searching for alternative architec-
tures that better support these essential functions. One alterna-
tive architectural structure is capability-bated addressing.

Capability-based systems support the object-based approach to
computing.

This book explains the capability/object-based approach
and its implications, and examines the features, advantages,
and disadvantages of many existing designs. Each chapter
presents details of one or more capability-based systems. Table
1-1 lists the systems described, where they were developed,
and when they were designed or introduced.

 _{:.?_

System Developer , Year Attributes
Rice University Rio: University 1959 segmented memory
Computer with "eodeword”addressing

Burroughs B5000 Burroughs Corp. 1961 stack machine withdescriptor addressing

Basic Language International 1964 high-level machine with
Machine Computu-s Ltd., U.K. codeword addressing
Dennis and Van MIT 1966 conceptual design for
Horn Supervisor capability supervisor
PDP-I Tirne- MIT 1967 capability supervisor
sharing System

Multieomputerl University of 1967 first capability
Magic Number Chicago Institute hardware system
Machine for Computer Resnrch design

CA1.-TSS U.C. Berkeley I968 capability operating
Computer Center system for CDC 6400

System 250 Plessey Corp., U.K. 1969 first industrialcapability hardware
and software system

CAP Computer University of 1970 capability hardware
Cambridge, UK. with microcode support

Hydra Carnegie-Mellon 1971 object-based multi-
Universiry procusor 0.5.

STAROS Carnegie-Mellon 1975 obiect-based multi-
University processor 0.5.

System/38 IBM, Rochester, MN. 1973 first maiut commercialcapability system,
tagged capabilities

iAPX 432 Intel, Aloha, OR. 198! highly-integrated
object-based micro-
processor system

Table 1-1: Major Descriptor and Capability Systems
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1.1 Capability-
Before surveying these systems at a detailed architectural Based systems

level, it is useful to introduce the concepts of capabilities and
object-based systems. This chapter defines the concept of ca-
pability, describes the use of capabilities in memory addressing
and protection, introduces the object-based programming ap-
proach, and relates obiect—based systems to capability-based
addressing.

Simplified examples of capability-based and conventional
computer systems are presented throughout this chapter.
These examples are meant to introduce the capability model by
contrasting it with more traditional addressing mechanisms. In
fact, many design choices are possible in both domains, and
many conventional systems exhibit some of the properties of
capability systems. No one of the following models is repre-
sentative of all capability or conventional systems.

1.1 Capability-Based Systems

Capability-based systems differ significantly from conven-
tional computer systems. Capabilities provide (1) a single
mechanism to address both primary and secondary memory,
and (2) a single mechanism to address both hardware and soft-
ware resources. While solving many difficult problems in com-
plex system design, capability systems introduce new chal-
lenges of their own.

Conceprually, a capability is a token, ticket, or key that
gives the possessor permission to access an entity or object in a
computer system. A capability is implemented as a data struc-
ture that contains two items of information: a unique abject
identifier and access riglm, as shown in Figure 1-1.

The identifier addresses or names a single object in the com-
puter system. An object, in this context, can be any logical or
physical entity, such as a segment of memory, an array, a file, a

Unique obiecl identifier

  
An obiect

I-Tgure 1-1: A Capability

Petitioner Apple Inc. — Exhibit 1002, p. -3753



Petitioner Apple Inc. - Exhibit 1002, p. 3754

Capability» and
Object-Based system
Concepts line printer, or a message port. The access rights define the

operation: that can be performed on that object. For example,
the access rights can permit read-only access to a memory seg-
ment or send-and-receive access to a message port.

Each user, program, or procedure in a capability system has
access to a list of capabilities. These capabilities identify all of
the objects which that user, program, or procedure is permit-
ted to access. To specify an object, the user provides the index
of a capability in the list. For example, to output a record to a
file, the user might call the file system as follows:

PUT( file_capability , "this is a record” );

The capability specified in the call serves two purposes. First,
it identifies the file to be written. Second, it indicates whether

the operation to be performed (PUT in this case) is permitted.
A capability thus provides addressing and access rights to an

object. Capabilities are the basis for object protection; a pro-
gram cannot access an object unless its capability list contains a
suitably privileged capability for the object. Therefore, the sys-
tem must prohibit a program from directly modifying the bits
in a capability. If a program could modify the bits in it capabil-
ity, it could forge access to any object in the system by chang-
ing the identifier and access rights fields.

Capability system integrity is usually maintained by prohib-
iting direct program modification of the capability list. The
capability list is modified only by the operating system or the
hardware. However, programs can obtain new capabilities by
executing operating system or hardware operations. For exam-
ple, when a program calls an operating system routine to create
a new file, the operating system stores a capability for that
file in the program's capability list. A capability system also
provides other capability operations. Examples include opera-
tions to:

1. Move capabilities to different locations in a capability list.
2. Delete a capability.
3. Restrict the rights in a capability, producing a less-privi-

leged version.
4. Pass a capability as a parameter to a procedure.
5. Transmit a capability to another user in the system.

Thus, a program can execute direct control over the movement
of capabilities and can share capabilities, and therefore, ob-

4 iects, with other programs and users.
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1.1 Capability-
It is possible for a user to have several capability lists. One Based Systems

list will generally be the master capability list containing capa-
bilities for secondary lists, and so on. This structure is similar
to a multi-level directory system, but, while directories address
only files, capabilities address objects of many types.

I.I.I Memory Addressing in Computer Systems

This section presents simplified models for both conven-
tional and capability-based memory addressing systems. Al-
though capabilities can control access to many object types,
early capability-based systems concentrated on using capabili-
ties for primary memory addressing. The first use of capabili-
ties for memory protection was in the Chicago Magic Number
Machine [Fabry 67, Yyngve 68], and an early description of
capability-based memory protection appeared in Wilkes’ book
on timesharing systems [V/ilkes 68]. Later, [Fabry 74] de-
scribed the advantages of capabilities for generalized ad-
dressing and sharing.

For purposes of a simplified model, consider a conventional
computer supporting a multiprogramming system in which
each program executes within a single process. A program is
divided into a collection of segments, where a segment is a
contiguous section of memory that represents some logical en-
tity, such as a procedure or array. A process defines a pro-
gra.rn’s address space: that is, the memory segments it can ac-
cess. The process also contains data structures that describe
the user, and a directory that contains the names of a set of
files. These files represent the user’s long-temt storage.

When a program is run, the operating system creates a proc-
ess-local segment table that defines the memory segments
available to the program. The segment table is a list of descrip-
tors that contain physical information about each segment. Fig-
ure 1-2 shows example formats for a process virtual address
and segment table descriptor. The operating system loads
various segments needed by the program into primary
memory, and loads the segment table descriptors with the
physical address and length of each segment. A process can
then access segments by reading from or writing to virtual
addresses.

Each virtual address contains two fields: the segment num-
ber and the oflset of a memory element within that specified
segment. On each virtual address reference the hardware uses
the segment number field as an index to locate an ennry in the 5
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Capabi|ily- and
Object-Based System
Concepts 4

Virtual Address
Virtual segment number Element ollsel  

  
 

 
  

Segment D.GSCI1'Di0l'5

Segment segment physical
length address

Process-Local Segment Table

 

Figure 1-2: Conventional Segment Address Translation

process segment table. This descriptor contains the physical
location of the segment. The length field in the descriptor is
used to check that the offset in the virtual address is within t.he

segment bounds. The rights field in the segment table entry
indicates the type of access permitted to that segment (for ex-
ample, read or write).

The model shown in Figure 1-2 has the following

properties:

1. The system supports a segmented process virtual address
space. A virtual address is local to the process and is u'ans-
lated through the process—local segment table.

2. A program can construct any virtual address and can at-
tempt to read or write that address. On each reference, the
hardware ensures that (a) the segment exists, (b) the offset is
valid, and (c) the attempted operation is permitted. Other-
wise, an error is signaled.

3. Loading of segment table enu-ies_ is a privileged operation
and can be accomplished only by the operating system. In
general, a segment table is created at the time a program is
loaded. The program then executes in a static addressing
environment.

4. Sharing of segments between processes requires that the
operating system arrange for both process-local segment
tables to address the shared segments. Iftwo processes wish
to use the same virtual address to access a shared segment,
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the segment descriptors must be in the same locations in
both segment tables.

5. Any dynamic sharing of segments requires operating system
intervention to load segment descriptors.

A capability-based system also supports the concept of a proc-
ess that defines a program’s execution environment. In the
capability system, each process has a capability list that defines
the segments it can access. Instead of the segment table de-
scriptors available to the conventional system hardware, the
capability addressing system consists of a set of capability regis-
ters. The program can execute hardware instructions to transfer
capabilities between the capability list and the capability regis-
ters. The number of capability registers is generally small com
pared to the size of the capability list. Thus, at any time, the
capability registers define a subset of the potentially accessible
segments that can be physically addressed by the hardware. A
simplified hardware model for this system is shown in
Figure 1-3.

The model shown in Figure 1-3 has the following
properties:

1. The system has a segmented virtual address space. A seg-
ment of memory an only be addressed by an instruction if a
capability for that segment has been loaded into a capability
register.

Virtual Add/essCapability register number Element allset
 

 
 

 Segment identifier

Process Capability Registers

Memory
Segment

I I   

Frgure I-3: Capability Register Addressing
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Capability- and
Object-Based System
Concepts 2. While loading of a segment descriptor in the conventional

system is privileged, loading of a capability register is not.
Instead of controlling the loading of the register, the capa-
bility system controls the pattern of bits that can be loaded.
Only a valid capability can be loaded into a capability
register.

3. The capability system provides a dynamically changing ad-
dress space. The address space changes whenever the pro-
gram changes one of the capability registers.

4. A vinual address identifies a process-local capability regis-
ter. In this sense, a virtual address has similar properties to a
vinual address in the conventional system. Sharing a virtual
address does not in itself give access to the same segment.

5. A capability, however, is not process-local. Capabilities are
context independent; that is, the segment addressed by a capa-
bility is independent of the process using that capability. A
process can share a segment by copying or sending a capabil-
ity from its capability list to the capability list of a cooperat-
ing process: Each of the processes can then access the
segment.

One important difference between the conventional and
capability approaches involves the ability ofa program to affect
system-wide or process-local objects. In the conventional sys-
tern, a program executes within a virtual address space defined
by a process. Every procedure called by that program has ac-
cess to the process address space, including segments and files.
Every procedure executes within an identical protection
environment.

In the capability system, a procedure can only affect objects
for which capability registers have been loaded. It is possible,
therefore, for different procedures called by the same program
to have access to different segments. Although all procedures
may have the potential to load capability registers from the
capability list, some procedures may choose to execute within a
very small addressing sphere.

The ability to restrict the execution or addressing environ-
ment of a procedure has several benefits. First, if a procedure
is allowed access only to those segments absolutely needed, the
hardware can detect any erroneous references. For example,
a reference past the end of an array tnight be caught before it
destroys another variable. Second, ifa procedure is found to be
in error, it is easy to determine what segments might have been
affected. If the segments that could have been modified were
local to the procedure, recovery might be substantially easier.

Most capability systems go a step further by allowing each
procedure to have a private capability list. A procedure can
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_ _ _ _ _ 1.1 Capability-
thus protect its 0b]ECts from accidental or mahcious access by Based systems

its callers, and a program can protect its objects from access by
called procedures. Every procedure can have, in effect, its own
address space. To permit a procedure access to ‘a local object, a
program can pass a capability for the object as a parameter

' when the procedure is called. Therefore, in a capability sys-
tem, every procedure can be protected from every other proce-
dure because each has a private capability list. When one pro-
cedure calls another, it knows that the called procedure can
access only local objects for which capabilities are passed.

1.1.2 The Context of an Address

Each object in a capability system has a unique identifier.
Conceptually, each obiect’s identifier is unique for all time.
That is, an identifier is assigned when an object is created and
that identifier is never reused, even after the object is deleted.
During the object’s lifetime, its unique identifier is used within
capabilities to specify the object. An attempt to use a capability
with an identifier for a deleted obiect causes an error.

In practice, the object identifier field of a capability must be
used by hardware to locate the object. From the hardware
viewpoint, the identifier is an address——either the address of a
segment or perhaps the address of a central descriptor that
contains physical information about the segment. The need to
handle addresses efficiently in hardware typically causes ad-
dresses to be small—16 or 32 bits, for example. For this rea~
son, identifiers tend to have too few bits to be unique for all
time. However, the choice of the number of bits in an identi-
fier is an important system design decision that dictates the
way in which capabilities can be used.

In conventional systems, an address is meaningful only
within a single process. In a capability system, addresses (capa-
bilities and their identifiers) are context-independent. That is,
the interpretation of a capability is independent of the process
using it. The unique identifier within a capability must have a
system-wide interpretation. Unique identifiers must be large
enough to address all of the segments likely to be in use by all
executing processes at any time. This allows capabilities to be
freely passed between processes and used to access shared data.

Addressing on most conventional systems is restricted in
terms of time as well as context. An address is meaningful only
within the lifetime of a single process. Therefore, addresses
cannot be used to name objects whose lifetimes are greater than 9
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the process creating the objects. If a process wishes to create a
long-term storage object, such as a file, it must interface to the
file system. Files typically require different naming, protec-
tion, and storage mechanisms than memory segments.

A significant advance made possible by capabilities is the
naming and protection of both long~term and short-term ob-
jects with a single mechanism. If the identifier field is very
large, it may be possible to implement identifiers unique for all
time. Each object is addressed by capabilities containing its
unique identifier, independent of whether it is stored in pri-
mary or secondary memory. The operating system or hardware
can maintain data structures that indicate the location of each

object. If a program attempts to access an object in secondary
memory, the hardware or operating system can bring the ob-
ject into primary memory so that the operation can be com-
pleted. From the program's point of view, however, there is
a single-level address space. Capabilities, as well as data, can
be saved for long periods of time and stored in secondary
memory.

There are, therefore, several contexts in which an address
can have meaning. For example, for:

1. Primary memory segments of a single process.
2. Primary memory segments of all existing processes.
3. All existing segments in both primary and secondary

memory.

Most conventional systems support only type 1, while capabili-
ties allow for any of the listed addressing types. More impor-
tantly, while conventional systems are concerned only with the
protection of data, capability systems are concerned also with
the protection of addresses. A process on a capability system
cannot fabricate new addresses. As systems become more gen-
eral in their addressing structure as in types 2 and 3, the protec-
tion of addresses becomes crucial to the integrity of the system.

1.1.3 Protection in Computer Systems

Lampson contrasts the capability approach with the undi-
tional approach by showing the su'ucture of protection infor-
mation needed in a traditional operating system [Lampson 71].
Figure 1-4 depicts an access matrix showing the privileges that
each system user is permitted with respect to each system ob-
iect. For example, user Fred has read and write privileges to
Filel and no privileges to I-‘ile2, while user Sandyis allowed to
read both files.
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Use“ Read Read Send

Sandy- Receive

Figure 1-4: System Object Access Matrix

One conventional approach to the maintenance of protec-
tion information is access control lists, in which the operating

system keeps an access list {or each object in the system. Each
obiect’s list contains the names of users permitted access to the
object and the privileges they may exercise. When a user at-
tempts to access an object, the operating system checks the
access list associated with that object to see if the operation is
authorized. Each of the columns of Figure 1-4 represents an
access control list.

The capability system offers an alternative structure in
which the operating system arranges protection information by
user instead of by object. A capability list is associated with
each user in the system. Each capability contains the name of
an object in the system and the user’s permitted privileges for
accessing the object. To access an object, the user specifies a
capability in the local capability list. Each of the rows of Figure
1-4 represents a capability list. Figure 1-5 shows an access list

Access Us! for Mailbox 10 Capability list for Fred

Fre-d(send} Fi/e1(read, write)
Sandytsend, receive) File-3(read) "
MoIIy(send) ProcassJ(delere,suspend.wakeup)

Mallbox10(send)

Figure 1-5: Access Control and Capability Usts ' "
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and a capability list derived from the protection matrix in
Figure 1-4.

One important difference between the capability list and
access list is the user’s ability to name objects. In the access list

approach, a user can attempt to name any object in the system
as the target of an operation. The system then checks that
obiect’s access list. In the capability system, however, a user
can only name those objects for which a capability is held: that
is, to which some access is permitted.

In either case, the integrity of the system is only as good as

the integrity of the data structures used to maintain the protec-
tion information. Both access control list and capability list
mechanisms must be carefully controlled so that users cannot

gain unauthorized access to an object.
Similar protection options ex.ist outside the computer

world. -A useful analogy is the control of a safe deposit box.
Suppose, for example, that Carla wishes to keep all of her valu-
ables in a safe deposit box in the bank. On occasion, she would
like one or more trustworthy friends to make deposits or with-
drawals. There are basically two ways that the bank can control
access to the box. First, the bank can maintain a list of people
authorized to access the box. To make a transaction, Carla or

any of her friends must prove their identity to the bank’s satis-
faction. The bank checks the (access control) list for Carla’s

safe deposit box and allows the transaction if the person is
authorized. Or, instead of maintaining a list, the bank can
issue Carla one or more keys to her safe deposit box. If Carla
needs to have a friend access the box, she simply gives a key to
the friend.

A number of observations can be made about these two

alternative protection systems. The properties of the access list
scheme are:

1. The bank must maintain a list for each safe deposit box.
2. The bank must ensure the validity of the list at all times

(e.g., it cannot allow the night watchman to add a name).
3. The bank must be able to verify the identity of those asking

to use a box.

4. To allow a new person to use the box, the owner must visit
the bank, verify that he or she is the owner of the box, and
have the new name added to the list.

5. A friend cannot extend his or her privilege to someone else.
6. If a friend becomes untnrstworthy, the owner can visit the

bank and have that person's name removed from the list.
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The alternative scheme rnvolvmg keys has the following Based Approach
properties:

1. The bank need not be involved in any transactions once the
keys are given, except to allow a valid keyholder into thevault.

2. The physical lock and key system must be relatively secure;
that is, it must be extremely difficult to forge a key or to pick
the lock on a safe deposit box.

3. The owner of a box can simply pass a key to anyone who
needs to access the box.

4. Once a key has been passed to a friend, it is difficult to keep
them from giving the key to someone else.

5. Once a friend has made a transaction, the owner can ask for
the key hack, although it may not be possible to know
whether or not the friend has made a copy.

The advantage of the key-based system is case of use for both
the bank and customer. However, if today's friends are likely
to become tomorrow’s enemies, the access list has the advan-
tage of simple guaranteed access removal. Of course, the access
control list and the key (or capability) systems are not mutually
exclusive, and can be combined in either the computer or
banking world to provide the advantages of both systems for
increased protection.

1.2 The Oblect-Based Approach

Over the last few decades, several areas of computer science
have converged on a single approach to system design. This
approach, known as object-based computing, seeks to raise the
level of abstraction in system design. The events that have
encouraged object-based design include:

1. Advances in computer architecture, including capability sys-
tems and hardware support for operating systems concepts.

2. Advances in programming languages, as demonstrated in
Simultt [Dahl 66], Pascal [Jensen 75], Smalltalk [mfialls 78] ,
CLU [Liskov 77], and Ada [DOD 80].

3. Advances in programming methodology, including modular-
ization and information hiding [Pamas 72] and monitors
[Hoare 74].

This section introduces the object approach and discusses its
relationship to capability-based computer systems.

What is object-based computing? Simply stated, the object
approach is a method of structuring systems that supports ab- 1:
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stracnbn. It is a philosophy of system design that decomposes a
problem into (1) a set of abstract object types, or resources in the
system, and (2) a set of operatimu that manipulate instance: of
each object type.

To make this idea more concrete, consider the following

simplified example. Imagine that we are programming a traffic
simulation for a city. First, define a set of objects that repre-
sent, abstractly, the fundamental entities that make up the
traffic system. Some of the object types for the traffic sirnula-
tion might be:

' passenger
- bus

- bus stop
- taxi
- ear

Then, for each object type, define the operations that can be
performed. Bus objects, for example, might support the
operations:

- PUT_BUS_IN'l‘O..SERVlCE( bus-number)
- MOVE_BUS( bus_number, bus_stop )
- I.OAD_PASSENGERS( bus_number, passenger..list )
- UNLOAD_PASSENGERS( bus_number, passenger_list )
- GFl‘_PASSENGElLCOUNT( bus.number )
- GE'I'._POSITION( bus_number )
- REMOVE_BUS_FROM_SERVICE( bus..number )

Each bus operation accepts a bus number as a parameter. At
any time there may be many bus objects in the system, and we
identify each bus by a unique number. Each of these bus ob-
jects is an instance of the type bus. The type of an object identi-
fies it as a member of a class of objects that share some behav-
ioral properties, such as the set of operations that can be
performed on them.

What has been gained by defining the system in this way?
First, there now exist a fundamental set of objects and opera-
tions for the simulation. We can now implement the proce-

dures to perform the operations on each type of object. Since
only a limited number of procedures operate on each object
type, access to the internal data su-uctures used to maintain the
state of each type can be restricted. This isolation of the knowl-
edge of those data structures should simplify any future
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changes to one of the object abstractions because only a limited Based Approach
set of procedures is affected.

Second, and more importantly, we have raised the level of
abstraction in the simulation program. That is, we can now
program the simulation using buses, passengers, and bus stops
as the fundamental objects, instead of bits, bytes, and words,
which are normally provided by the underlying hardware. The
buses and passengers are our data types just as bits and bytes
are the data types supported in hardware. The simulation pro-
gram will consist mainly of control structures plus procedure
calls to perform operations on instances of our fundamental
objects.

Of course, in this example, the procedures implementing
the operations are programmed using lower-level objects, such
as bytes, words, and so on. Or, they may be further decom-
posed into simpler abstract objects that are then implemented
at a low level. Object-‘based systems provide a fundamental set
of objects that can be used for computing. From this basis, the
programmer constructs new higher-level object types using
combinations of the fundamental objects. In this way the sys-
tem is extended to provide new features by creating more so-
phisticated abstractions.

This methodology aims to increase productivity, improve
reliability, and ease system modification. Through the use of
well-defined and well-controlled object interfaces, systems de-

signers hope to simplify the construction of complex computer
systems.

1.2.] Capalzilities and Object-Based Systems
In the simulation example, each object is identified by a

unique number. To move a bus from one stop to another, we
call the MOVE_BUS operation with the unique number of the
bus to move. For purposes of the simple simulation, a small set
of integers suffices to identify the buses or other objects. No
protection is needed because these objects are implemented
and used by a single program.

The use of the object approach to build operating system
facilities presents different requirements. For example, sup-
pose we wish to build a calendar system to keep track of sched-
uled meetings, deadlines, reminders, and so on. The funda-
mental object of the calendar system, from the user’s point of
view, is a calendar object. Our calendar management system
provides routines that create a new calendar, and modify, 15
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concepts query, or display an existing calendar. Many users in the sys-

tem will, of course, want to use this facility.
Several familiar issues now arise: (1) how does a user name a

calendar object, (2) how is that calendar protected from access
by other users, and (3) how can calendars be shared under
controlled circumstances? Only the owner of a calendar should
be able to make changes, and the annotations in each calendar
must be protected from other users, since they might contain
confidential information. However, a user might permit se-
lected other users to check if he or she is busy during a certain

time, in order to automate the scheduling of meetings.
Capabilities provide a solution to these problems. When a

user creates a new calendar, the calendar creation routine allo-

cates a segment of memory for which it receives a capability.
This segment is used to store data structures that will hold the
calendar’s state. The create routine uses this capability to ini-
tialize the data structures, and then returns it to the caller as

proof of ownership of the calendar. In order to later modify or
query the calendar, the user specifies the returned capability;
the capability identifies the calendar and allows the modify or
query procedure to gain access to the data structures. Only a
user with a valid capability can access a calendar.

A weakness with this scenario is that the calendar system

cannot prevent the calendar owner from using its capability to
access the data structures directly. The calendar system would
like to protect its data structures both to ensure consistency
and to guarantee that future changes in data format are invisi-
ble outside of the subsystem. In addition, if a user passes a
calendar capability to another user, the second user can then
modify the data structures or read confidential information.

These problents exist because the calendar system returns a
fully-privileged calendar capability to the user. Instead, what is
needed is a capability that identifies a specific calendar and is
proof of ownership, but does not allow direct access to the
underlying data. structures. In other words, the calendar sys-
tem would like to return only rertriued capabilities to its cli-
ents. However, the calendar system must retain the ability to
later amplify the privileges in one of its restricted capabilities so
that it can access the data structures for a calendar.

There are several ways of providing type managers with this
special ability. (These mechanisms are examined in detail
throughout the book.) However, given this power over capa-
bilities for its objects, a type manager can ensure that its clients
operate only through the well-defined obiect operation inter-

16 face. A client can pass a capability parameter to the type man-
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ager when requesting a service, but cannot otherwise use the 1.3 summary
capability to read or write the object it addresses. This facility
is fundamental to any system that allows creation and protec-
tion of new system types.

' 1.3 Summary

The capability concept can be applied in hardware and soft-
ware to many problems in computer system design. Capabili-
ties provide a different way of thinking about addressing, pro-
tection, and sharing of objects. Some of the properties of
capabilities illustrated in this chapter include their use in:

1. Addressing primary memory in a computer system.
2. Sharing objects.
3. Providing a uniform means of addressing short- and long-

term storage.

4. Support for a dynamic addressing environment.
5. Support for data abstraction and info:-mafion hiding.

These, of course, are advantages of capability-based sys-
tems. The most important advantage is support for object-
based programming. Object-based programming methodology
seeks to simplify the design, implementation, debugging, and
maintenance of sophisticated applications. While capabilities
solve a number of system problems, their use raises
a whole new set of concerns. And, as is often the case in com-

puter system design, the concept is much simpler than the
implementation.

The remainder of this book is devoted to examining many
different capability-based and object-based designs. The char-
acteristics of each system are described with emphasis on ad-
dressing, protection, and object management. Each system
represents a different set of tradeoffs and presents different
advantages and disadvantages. When comparing the systems,
consider the differences in goals, technologies, and resources
available to the system developers.

The final chapter of this book considers issues in capability
system design common to all of the systems described. A few
of the questions to be considered follow. It may be useful to
remember these questions when examining each system
design.

1. What is the striicture of an address?
2. How is a capability represented? How is a capability used to

lomte an object? 17
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Concepts 3. How are capabilities protected?

. What is the lifetime of a capability?
5. What types of objects are supported by the hardware and

software?

6. What is the lifetime of an object?
7. How can users extend the primitive set of obiects provided

by the base hardware and software?

A

1.4 For Further Reading

The concept of capability is formally defined in the 1966
paper by Dennis and Van Horn [Dennis 66]. Chapter 3 exam-
ines this paper in some detail. The paper by Fabry [Fabry 74]
compares capability addressing and conventional segmented
addressing of primary memory, while Redell [Redell 74a] de-
scribes issues in capability systems and the use of sealing mech-
anisms that support the addition of new object types to a sys-
tem. These papers are a fundamental part of capability
literature.

Capability systems have been discussed in various contexts.
Two papers by Lampson [Lampson 69 and Lampson 71] de-
scribe the requirements for protection in operating systems
and the capability protection model. The surveys by Linden
[Linden 76] and Denning [Denning 76], which appeared in a
special issue of ACM Computing Surveys, describe capability
systems and their relationship to security and fault tolerance in
operating systems.

The architecture books by Myers [Myers 82] and Iliffe
[Iliffe 82] also discuss some of the systems described in this
book. Myers’ book contains details of Sward [Myers 80], a
capability-based research system built at IBM that is omitted
here. A capability system model, as well as discussion of some
existing capability systems, appears in the book by Gehringer
[Gehringer 82]. Jones [Jones 78a] provides a good introduction
to the concepts of object-based programming.

18
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«.52.!
The Burroughs B5000 computer. (Counesy Burroughs Corporation-)
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Superdistribution
By Brad Cox

It has become a maxim: intangible electronic goods - software applications, online magazine stories, clip art -
are quite distinct from tangible goods like baskets, potatoes, and oil refinery machinery. Tangible goods are
made of atoms; electronic goods are made of bits. While those who produce electronic goods must expend
the same capital, labor, and knowledge asthose producing tangible goods, their products can be copied in
nanoseconds and transported at the speed of light. A ‘ ‘

The hard-to-copy nature of tangible goods made the traditional pay-per-copy mechanism a natural choice.
But an_info product's ease of duplication so thoroughly undercuts the traditional notion of pay-per-copy that
the g hwfsibility of an abundant supply of pre-fabricated information-age goods is nearly nixed.

I But imagine a significantly altered market mechanism for electronic goods. Instead of treating ease-of-'
replication as a liability to be prevented - via labor—intensive copy protection and legal or moral restrictions -
this new model treats ease-of-replication as the asset upon which a new foundation for software engineering
could be based. In Japan this new way is called superdistribution. Superdistribution lets information flow
freely, without resistance. Eschewing the low-tech property-rights mechanisms already widespread

' (shrinkwrap software, license servers, dongles, demoware, shareware), superdistribution allows miners,
refiners, fabricators, assemblers, distributors, and marketers to cooperate and compete as producers and '
consumers of electronic goods within ‘a global information-age society.

Existing copyright law distinguishes between copyright (the right to copy or distribute) and useright (the right
to "perform," or to use a copy once obtained). In the eyes of the law, when Joe Sixpack buys a record or CD
at a store, he's actually purchasing a bundle of rights that includes ownership of a physical medium along
with a limited useright that allows use of the music on that medium only for personal enjoyment. Large
television and radio companies buy an entirely different bundle of rights. They often have the same media
(whose only difference is a "not for resale" sticker on the cover) thrust upon them for free by publishing
companies in expectation of substantial fees for the useright to play the music on the air. These fees are
administered by ASCAP (American Society of Composers, Authors and Publishers) and BMI (Broadcast
Musicians Institute), who monitor how often each record is broadcast to how large a listening audience.

Similarly, superdistribution treats each personal computer as a broadcasting station whose "audience"

http://wired.com/wired/archive/2.09/superdisJ)r.html A. 02/11/2005
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Consists of a single "listener." First pioneered in 1987 by Ryoichi Mori, head of the Japan Electronics Industry

Development Association, superdistribution is based on the observation that electronic objects are
fundamentally unable to monitor their own copying but trivially able to monitor their use. For example,
making software - whether it's Microsoft's Word or Mike's string-compare subroutine - count how many times

' it has been invoked is easy, but making it count how many times it has been copied is much more difficult. So
why not build an information-age market economy around this difference? If revenue collection were based

on monitoring the use of software inside a computer, vendors could dispense with copy protection altogether.
They could distribute electronic objects for free in expectation of a usage-based revenue stream. (This, of
course, raises the same hairy privacy issues that we trade off when we choose to use credit cards instead of

cash or talk by telephone rather than face to face. The real risk to privacy here does not arise when usage
information is used only for billing, but from any possibility that it might be used for other purposes.)

Treating ease-of-replication as an asset rather than a liability, superdistribution actively encourages free
distribution of information-age goods via any distribution mechanism imaginable. It invites users to download
superdistribution software from networks, to give it away to their friends, or to send it as junk mail to people

. they've never met.

why this generosity? Because the software is actually "meterware." It has strings attached, whose effect is to
decouple revenue collection from the way the software was distributed. superdistribution software contains
embedded instructions that make it useless except on machines that are equipped for this new kind of
revenue collection. 4 I

Supe.distribution-equipped computers are otherwise quite ordinary. They run ordinary pay-by-copy software A
just fine, but they have additional capabilities that only superdistribution software uses. In Mori's prototype, .
these extra services are provided by a silicon chip that plugs into a Macintosh coprocessorslot. The hardware
is surprisingly uncomplicated (its main complexities being tamper-proofing, not base functionality), and far
less complicated than hardware that the computer industry has been routinely building for decades. Electronic
objects intended for superdistribution invoke this hardware, which provides instructions. These instructions

check that revenue-collection hardware is present, prior usage reports have been uploaded, and prior usage
fees have been paid. They also keep track of how many times they have been invoked, storing the resulting
usage information temporarily in a tamper—proof persistent RAM. Periodically (say monthly), this usage
information is uploaded to an administrative organization for billing, using encryption technology to
discourage tampering and to protect the secrecy of the. metered information. (Think of your utility bill.)

Software users receive monthly bills for use of each top-level component - say, Microsoft Excel, Myst, or a
Net-based rock video. When these bills are paid, payments are divvied up between the makers of the
component and makers of subcomponents - in proportion to usage. For example, for the rock video, payment
might go to .MTV as well as to‘ the artist. In other words, the end-user's payments are recursively distributed
through the producer-consumer hierarchy. The distribution is governed by usage metering information
collec‘-.=.‘d from each end-user's machine, plus usage pricing data provided to the administrative organization
by e. _.»i component vendor. (The various rounds of payment resemble-those made by Visa or MasterCard.)

Since communication is infrequent and involves only a small amount of metering information, the
communication ‘channel could be as simple as a modem that autodials a hardwired 800 number each month.

Many other solutions are viable, such as flash cards or even floppy disks to be mailed back and forth each
month.

Consider an author who wishes to distribute or sell a multimedia document that cannot be handled as a

simple text file. Without-superdistribution, the author's market‘ is confined to those who have already
purchased a program capable of displaying this document - a run-time’ version of Macromedia Director, for
example. The same occurs at each lower level of the producer/consumer hierarchy. The market of a
programmer who wishes to sell a reusable software component is restricted to those who have already
purchased the components and tools upon which the software component relies. »

with superdistribution, the market is no longer restricted to those who own Director, because it will be
acquired by the customers‘ operating system as if it were a part of the document. The creator of the
document accrues revenue from those who read it, as does the creator of Director.

The user's operating system acquires subcomponents of the document, such as Director and any
subcomponents it relies on (QuickDraw, etc.), from the hard drive's cache, automatically loading it as needed
from the network. The operating system can do this automatically and transparently because loading software
involves no financial commitments when revenue is based on usage instead of acquisition of copies.

Imp;//wircd_gom/wired/archive/2.09/supcrdis_pr.hIml 02/1 1/2005
Petitioner Apple Inc. — Exhibit 1002, p. 3771-



Petitioner Apple Inc. - Exhibit 1002, p. 3772

'-I

2.09:_S°uperdistribu}Iion 5 ' ' I ' Page 3 of 3
Superdistribution addresses the perennial, implicit questions of those who might potentially provide the
Smaller-granularity reusable software components upon which an advanced software engineering culture
could be founded: Where do software components come from? Why should I bother to provide them? Why
should I engage in such gritty activities as testing and documenting reusable software components sufficiently
so that others might use them? What is in it for me?

Where software's ease-of-replication is a liability today (by disincentivizing those who would provide it),
superdistribution turns this liability into an asset by allowing goods to be distributed for free. where software
vendors must now spend heavily to overcome software's invisibility, superdistribution would thrust software
out into the world to serve as its own advertisement. Where the personal computer revolution isolates

individuals inside a stand-alone personal computer, superdistribution establishes a cooperative/competitive
community around an information-age market economy.

By separating revenue collection from acquisition of copies, hard drives and computers can disappear and
become just part of the plumbing that conveys information-age goods between producers and consumers.

Computers and telecommunications links become invisible,,a transparent window through which individuals
can communicate, cooperate, coordinate, and compete as members of an advanced socioeconomic
community. '

 

Brat fljpx (bcox@gmu.edul is founder of the Coalition. for Electronic Markets and a faculty member in George
Mason University's Program on Social and Organizational Learning.
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Abstract

This paper introduces atomic prory cryptography, in which an atomic pro:-y function, in
conjunction with a public pros-y key, converts ciphertext (messages in a public key encryption
scheme or signatures in a digital signature scheme) for one key (kl) into ciphertext for another
(kg). Proxy keys, once generated; may be made public and proxy functions applied in untrusted
environments. Various kinds of proxy functions might exist; symmetric atomic proxy functions
assume that the holder of Ir; unconditionally trusts the holder of 1:‘, while asymmetric proxy
functions do not. It is not clear whether proxy functions exist for previous public-key cryptosys—
terns. Several new public-key cryptosysterns with symmetric proxy functions are described: an
encryption scheme, which is at least as secure as Diffie-Hellman, an identification scheme, which
is at least as secure as the discrete log, and a. signature scheme derived from the identification
scheme via a hash function.

1 Introduction

1. 1 Overview

A basic goal of public-key encryption is to allow only the key or keys selected at the time of
encryption to decrypt the ciphertext. To change the ciphertext to a different key requires re-
encryption of the message with the new key, which implies access to the original cleartext and to a
reliable copy of the new encryption key. Intuitively, this seems a fundamental, and quite desirable,
property of good cryptography; it should not be possible for an untrusted party to change the key
with which a. message can be decrypted.

This paper, on the other hand, investigates the possibility of atomic prory functions that convert
ciphertext for one key into ciphertext for another without revealing secret decryption keys or
cleartext messages. An atomic proxy function allows an untrusted party to convert ciphertext
between keys without access to either the original message or to the secret component of the old
key or the new key. In proxy cryptography, the holders of public-key pairs A and B create and
publish a. pros-y key 1r,q_,3 such that D(l'I(E(m,e,q),1r,q_,3),d3) = m, where E(m,e) is the public
encryption function of message m under encryption key e, D(c, d) is the decryption function of

ciphertext c under decryption key d, II(c, 1r) is the atomic proxy function that converts ciphertext 

‘Current draft available at ftp://fcp.research.att.com/dist/mab/proxy.ps
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c according to proxy key 1r, and e,4,e3,d,4,dg are the public encryption and secret decryption
component keys for key pairs A and B, respectively. The proxy key gives the owner of B the
ability to decrypt “on behalf of" A; B can act as A’s “proxy.” In other words, the 11 function
effectively allows the “atomic” computation of E(D(c,d,4),eg) without revealing the intermediate
result D(c,d,4).

We consider atomic proxy schemes for encryption, identification and signatures. An encryption
proxy key 1r,4_,g allows B to decrypt messages encrypted for A and an identification or signature

proxy key 1r,q_,3 allows A to identify herself as B or to sign for B (i.e., transforms A’s signature

into B's signature). Generating encryption proxy key 1r,4_,3 obviously requires knowledge of at
least the secret component of A (otherwise the underlying system is not secure) and similarly

generating identification or signature proxy key 1r,;_,3 requires B’s secret, but the proxy key itself,
once generated, can be published safely.

1.2 Categories of proxy schemes

Encryption proxy functions (and similarly but contravariantly, identification or signature proxy

functions) can be categorized according to the degree of trust they imply between the two key
holders. Clearly, A must (unconditionally) tnist B, since the encryption proxy function by definition
allows B to decrypt on behalf of A. Symmetric proxy functions also imply that B trusts A, e.g.,

because d3 can be feasibly calculated given the proxy key plus d,4. Asymmetric proxy functions
do not imply this bilateral trust. (Note that this model implies that proxy cryptography probably
makes sense only in the context of public-key cryptosystems. Any secret-key cryptosystem with

an asymmetric proxy function could be converted into a public-key system by publishing one key

along with a proxy key that converts ciphertext for that key into ciphertext for a second key (which
is kept secret.))

We can also categorize the asymmetric proxy schemes that might exist according to the conve-

nience in creating the proxy key. In an active asymmetric scheme, B has to cooperate to produce
the proxy key 1r,4_,3 feasibly, although the proxy key (even together with A’s secret key) might
not compromise B’s secret key. In a passive asymmetric scheme, on the other hand, A’s secret key
and B’s public key sufiice to construct the proxy key. Clearly, any passive asymmetric scheme can

be used as an active asymmetric scheme, and any asymmetric scheme can be used as a symmetric
scheme. ‘

Finally, we can distinguish proxy schemes according to the “metadata" they reveal about the
identity of the keys being transformed. Cllunsparent proxy keys reveal the original two keys to a
third party. flhznslucent proxy keys allow a third party to verify a guess as to which two keys are

involved (given their public keys). Opaque proxy keys reveal nothing, even to an adversary who
correctly guesses the original keys (but who does not know the private keys involved).

1.3 Proxy schemes in theory and practice

The proxy relationship is necessarily transitive. If there are public proxy keys 1rA_,3 and 1r3_,c,

then anyone can compute a proxy function for A —> C. Symmetric proxy schemes further establish
equivalence classes of keys where the secret component of any key can be used to decrypt messages
for any other key in the same class. Note that creating a single symmetric proxy key between a

key in one class and a key in another effectively joins the two classes into one.
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The notion of proxy cryptography is a rather natural generalization of public—key cryptography

and has some pleasing theoretical properties. The proxy schemes we consider below have the
additional property that anyone can use the proxy key 7'|'_4_,g to transform the public key of A to
the public key of B. For such proxy schemes, as we will see in the various examples below, certain

aspects of the security of publishing a proxy key actually follow from the fact that anyone, trusted
or not, can use a proxy key to transfonn ciphertext and keys.

For example, suppose random messages m and m’ are encrypted with random secret keys a and

b as E(m, a), E(m',b). Suppose that knowing the proxy key 1r,4_.3 enables Eve, who knows neither
a nor b, to recover m or m’ . Then, ignoring B altogether and starting with just two (presumably
secure) ciphertexts E(m,a) and E(m’,a), Eve can pick a random proxy key r = 1r,4_.Q for some

Q, transform E(m’,a) to E(m’, q) (where q is the unknown secret key of Q), transform A’s public
key into Q’s public key, and proceed with the hypothesized cryptanalysis. We conclude that if it
is safe for A to publish 1: messages then it is safe for A and B to publish a total of k messages and
to publish a. proxy key, provided only that Eve can successfully apply the proxy key to tra.nsform
ciphertext and public keys.

Because proxy keys are tied to specific key pairs, it is not necessary in many applications to

certify or otherwise take special care in distributing them (except to prevent denial-of-service).
In particular, it is generally sufficient to rely on the certification and trust established in A (for

encryption) or B (for signatures) when using proxy key 1r,4_.3, since a valid proxy key can by
definition only be generated with the cooperation of the owner. - Furthermore, the proxy function
can be safely applied at any convenient time or place, by the message's sender or receiver, or at
any intermediate (and possibly untrusted) point in the network.

Proxy functions potentially also have practical utility for key management in real systems. For
example, some pieces of secure hardware (e.g., smartcards) limit the number of secret keys that can
be stored in secure memory, while some applications might require the ability to decrypt messages

for more keys than the hardware can accommodate. With proxy cryptography, once a new key

is created and a corresponding proxy key generated, the secret component of the old (or new)

key can be destroyed, with the (public and externally-applied) proxy key maintaining the ability

to decrypt for both. In efl'ect, proxy functions allow us to increase the number of public keys
without also increasing the number of secret bits or the amount of secret computation. Because
proxy functions can be computed anywhere, messaging systems, such as electronic mail, can proxy

“forward” messages encrypted with one key to a recipient who holds a different key. Proxy functions
make it possible to associate a single key with a network or physical address but still decrypt

messages forwarded (and proxied) from other addresses. Finally, proxy functions effectively allow
changing or adding a key without obtaining new certificates or altering the distribution channel

for the previous public key; this could be useful when it is difficult to distribute or certify new
keys (e.g., old keys were published in widely-distributed advertisements or embedded in published
software, or the certification authority charges high fees for new certificates).

1.4 Security of proxy schemes and ad hoc substitutes

If Alice wants Bob to be able to read her mail, instead of issuing a proxy key she might just

give Bob her secret key (perhaps, obviating the need to involve Bob, by encrypting it in Bob’s
public key and publishing it). This would be inferior to using a proxy scheme for several reasons.
First, as discussed above, Bob’s computing environment may be limited and therefore incapable
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of automatically processing encrypted secret keys; any new software to decrypt a.nd manage such
keys would have to run within the environment trusted by Bob. Proxy processing, on the other
hand, can take place entirely outside of Alice's and Bob's trusted environments a.nd without their
active involvement. Furthermore, encrypting one’s secret key with another’s public key is not in

general secure. The cryptosystem we present below, a variant‘ of ElGamal, is thought to be secure
in part because the cryptanalysis problem is random—self-reducibile—which allows one to assert
mathematically that recovering m from the public information (e,,,E(m, e.,),eb) is hard on average
if it is hard at worst. The task of recovering m from (ea,E(m, ea), E(da, eh), eb), however, may be

considerably easier since E(da,e,,), in the context of e,, and eb, may leak information about da-
specifically, the new cryptanalysis problem is probably not random-self-reducible and due to the

problem’s obscurity it is not clear what, if any, mathematical guarantees of security can be given.
By contrast, the proxy scheme we give below is just as strong as the underlying ElGamal-like
cryptosystem?

1.5 Related work

A natural question to ask is whether there exist atomic proxy functions (and feasible schemes to
generate proxy keys) for any public key cryptosystems.

Previous work on delegating the power to decrypt has focused on developing eflicient trans-
formations that allow the original recipient to forward specific ciphertezts to another recipient.

Mambo and Okamoto[MO97] develop this formulation and give eflicient transforms (more efficient
than decryption and re-encryption) for ElGamal and RSA. Mambo, Usuda and Okamoto[MUO96]
apply a similar notion to signature schemes.

While such schemes have value from the standpoint of efiiciency, they are not, however, “atomic

proxy cryptosystems” by our definition because the transforming function must be kept secret
and applied online by the original keyholder on a message-by-message basis (the schemes are not

atomic). The security semantics of these systems are essentially the same as a decryption operation
followed by a re-encryption operation for the new recipient. Our formulation of proxy cryptography
is distinguished from the previous literature by the ability of the keyholder to publish the proxy
ftmction and have it applied by untnisted parties without further involvement by the original
keyholder.

2 Proxy encryption

Although the problem of proxy cryptography seems like a natural extension of public-key cryptogra-
phy, existing cryptosystems do not lend themselves to obvious proxy functions. RSA[RSA78] with a
common modulus is an obvious candidate, but that scheme is known to be insecure[Sim83][DeL84].

Similarly, there do not appear to be obvious proxy functions for many of the previous discrete-log- 

‘David Wagner notes that our proxy scheme can be extended to work with standard ElGa.mal[E|G85] encryption.
‘Note that Bob of this example may be a government mandating that Alice provide him with acc& to her key. It

has been argued that such a scheme maks the system as a whole less trustworthy due to the extra engineering effort
involved; we argue here that in the case of random-selfireducible cryptosystems such as ElGamal variants, requiring
Alice to encrypt her secret key using the government's public key may also weaken the underlying cryptosystem in
the precise mathematical sense of spoiling the random-self-reducibility.
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based cryptosystems. This is not to say, of course, that proxy functions for existing systems do not
exist, only that we have not discoverd them.

We now describe a new secure discrete-log-based public-key cryptosystem that does have a

simple proxy function. The scheme is similar in structure to ElGamal encryption[ElG85], but with
the parameters used differently and the inverse of the secret used to recover the message. (This

approach has merit beyond proxy encryption; [Hug94] proposed a Diflie-Hellman-like key agreement
protocol based on the inverse of the secret, which allows a message’s sender to determine the key
prior to identifying its recipient).

2.1 Cryptosystem X (encryption)

Let p be a prime of the form 2q + 1 for a prime q and let g be a generator in Z;; p and g are global
parameters shared by all users. A’s secret key a, 0 < a < p - 1, is selected at random and must

be in z;,,, i.e., relatively prime to p — 1. (A also calculates the inverse a'1 mod 2q). A publishes I
the public key g“ mod p. Message encryption requires a unique randomly-selected secret parameter

k E Z§,,. To encrypt m with A’s key, the sender computes and sends two ciphertext values (C1,C2)2

mg‘ mod p
(9")" mod 20

C1
C2

Decryption reverses the process; since

°(2°_l) = 9" (mod P)

it is easy for A (who knows (F1) to calculate g" and recover m:

m = c.<<o‘;“")“) map

The speed of the scheme is comparable to standard ElGamal encryption, although initial key

generation requires the additional calculation and storage of (F1.

2.2 Symmetric proxy function for X

Observe that the (:1 ciphertext component produced by Cryptosystem.X is independent of the

recipient’s public key. Recipient A’s key is embedded only in the C2 exponent; it is sufficient for a
proxy function to convert ciphertext for A into ciphertext for B to remove A’s key a from C2 and
replace it with B’s key b. Part of what a proxy function must do, then, is similar to the first step
of the decryption function, raising C2 to a'1 to remove a. The proxy function must also contribute
a factor of b to the exponent. Clearly, simply rasing C2 to a" and then to b would accomplish this,
but obviously such a scheme would not qualify as a secure proxy function; anyone who examines
the proxy key learns the secret keys for both A and B. '

This problem is avoided, of course, by combining the two steps into one. Hence, the proxy key
1r,q_,3 is a"b and the proxy function is simply d2""" . Note that this is a symmetric proxy function;
A and B must trust one another bilaterally. B can learn A’s secret (by multiplying the proxy key

by b"), and A can similarly discover B’s key. This proxy function is also translucent; the proxy
key does not directly reveal A or B, but anyone can verify a guess by encrypting a message with
A‘s public key, applying the proxy function, and comparing the result with the encryption of the
same message (with the same In) with B's public key. Observe that applying the proxy function is
more efficient than decryption and re-encryption, in that only one exponentiation is required.
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2.3 Security of A’

First, we show that X is secure-—that cleartext and secret keys cannot be recovered from ciphertext

and public keys. Beyond that, we also show that publishing the proxy key compromises neither
messages nor secret keys. Since recovering a secret key enables an adversa.ry to recover a message
and since cryptanalysis is easier with more information (i.e., a proxy key), it is sufficient to show
that no cleartext is recoverable from ciphertext, public keys, and proxy keys. Specifically, we will
show that the problem of recovering m from

(g°,g",g‘,...,mgk,g°",a'1b,a'lc,...).

is at least as hard as Diffie-Hellman. " V

Theorem 1 Suppose there ea:ists a randomized algorithm f that with probability 6 > 1/|p|°(1)
succeeds in recovering m from the public information

(g°,g°,...,mg",g“",b/a,...)

where the probability is taken over f ’s random choices as well as over and the parameters a,
b, and k. Then, for each 1] = 2‘lP'om, there exists a randomized polynomial-time algorithm for
Diflie-Hellman that succeeds with probability 1 — 7;.

Proof. For simplicity we assume there are only two public keys and one proxy key; the gen-
eral case is similar. Suppose we had an algorithm F that always succeeds in recovering m from

(g",g",mg",g°",b/a). Then note that on input g",g9, we have F1(g",g”) = F(g”,g9,1,g", 1)‘1 =
g'/”, and since F1 (g, g”) = g‘/” we'd have

F2(9’.9") = F1(9‘.F1(s.9")) = F1(9‘. V") = 9”"-

In fact, f is only guaranteed to recover m with probability 5 so we need to use the random-selti
reducibility [Fei93] of the discrete log to achieve our objective.

On input g’, g” for :z:,y E Z5‘, let f1 pick r, s,t,u E Z50 at random and query

f(y’”.g"’.g‘.g“‘.s/r).

By hypothesis, with probability 5 we get g‘-("=)/(W) from which f; can recover g=/v. Since
f1(g,g9) = g1/V we can define f2 by

f2(9’,y”) = fr(s’.fi(s,9”));

this is equal to

fr(9’.9"”) = 9””

with probability at least :7.
Our next step is to construct an algorithm that runs correctly with high probability on most

inputs in z;,. For this, we define the algorithm f3(g‘, g”), 2:, y E Z;,,, as follows. Pick r, s,t, u at ran-
dom with r,s,u E Z-3,, and 0 3 t < 2q even. Compute fg(g", g”) = g”‘”+‘ and f2(g(‘+')/",g“") =
g‘”+"+"' for some c,c’ that depend on the respective input to f2. Check whether (g""”+°)'/" -

6
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.x'

(g‘V+"”+°’)/g‘" and is of the form 9‘ for z E Z5, and if so output the common value, otherwise
abort.

We need to show that the probability that f3 outputs the correct answer is substantial and the

probability that it outputs an incorrect answer is negligible. Note that the inputs to f2 are random,
so, by hypothesis, at least 5" of the time c = c’ = 0 and therefore f3 will answer correctly. For f3 to
answer incorrectly, we must have c,c’ 96 0 and c/rs = c’. Note also that in this case c and c’ must

be even so that my + c’ = my + c/(rs) are in Z§,,. Even conditioned on the four inputs to two calls
to f2, the six random variables 1', s, t,u,z,y have two degrees of freedom lefi, and it is easy to see
that r and s and therefore rs remain uniformly distributed. Thus, c/rs is uniformly distributed

among even numbers modulo 2q and only equals d with probability 1/q. Thus if we repeat f3 a

total of O(— log 7;)/5" times we will have a probability 1 — n of a correct answer and only a tiny
chance of getting any incorrect answer. ‘

Next, we show how to construct an algorithm f4(g“,g") that succeeds, with high probability,

on all inputs g‘, g9 such that :c,y E Z-5,. Pick 1', s at random from Z5, and compute f3(g"‘, g"’)‘/’’.
The input to f3 is uniformly distributed, so by hypothesis f3(g"‘, g”) = g"”‘5' with high probability
and we recover g"”.

Before considering general g’, gl’ we recall some facts about arithmetic modulo 2q. The integers
modulo 2q consist of 0, q, (q- 1) multiples of 2 (other than 0), and (q — 1) invertible elements (the
odd numbers other than q). Given an input g’ where g is a primitive element modulo p = 2q + 1,

one regards z modulo 2q. We can learn whether 2 is invertible from g’: If 2 = 0 then g‘ = 1,
ifz = q then g’ = -1, if 1: is odd then (g')‘' = g" = -1 and if: is even then (g‘‘)‘' = g° = 1.
(Raising g’ to the power q is polynomial-time, but expensive. However, we do not need to do this
when using the cryptosystem.)

Finally, consider general input g’, g”. The cases 2 = 0,z = q or y = 0,y = q are easy to detect
and handle, so we assume that we are not in one of these cases. We can determine s and t in

{0,1} so that z + sq,y + tq E Z5, We have g” = g(‘+‘°)(9'”")/g“‘“'”"'+"°’ = :tg("”")(9'”‘-7) =
if4(g'+"‘-7, gV+“') (and we can determine the sign). Cl

Similarly one can show that recovering a from (g‘’, g°,mg",g“",b/a) is as hard as the discrete
log, so publishing the proxy key does not compromise a—not even to the level of Difiie-Hellman.

3 Proxy identification

In this section we describe a discrete-log-based identification scheme. With p,g,a as before, Alice
wishes to convince Charlotte that she controls a; Charlotte will verify using public key g“. As

before, the proxy key 1rA_.3 will be a/b-—it will be safe to publish a/b and Alice and Charlotte can

easily use a/b to transform the protocol so Charlotte is convinced that Alice controls b.
Note that in the case of a secure identification proxy key that transforms identification by A into

identification by B, it is B whose secret is required to construct the proxy key because identification
as B should not be possible without B’s cooperation.

3.1 Cryptosystem J7 (identification)

Let p and g be a prime and a generator in Z,;, respectively. Alice picks random a E Z5, to be
her secret key and publishes g“ as her public key. Each round of the identification protocol is as
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follows:

0 Alice picks a random 1: 6 Z5,’ and sends Charlotte .91 = g".

- Charlotte picks a random bit and sends it to Alice.

0 Depending on the bit received, Alice sends Charlotte either s2 = k or 3; = k/a.

0 Depending on the bit, Charlotte checks that (g‘‘)‘'2 = .91 or that 9” = g".

This round is repeated as desired. As with existing protocols, there may be ways to perform
several rounds in parallel for efficiency [FFS88].

3.2 Symmetric proxy function for J?

A symmetric proxy key is simply a/b. Proxy identification is useful as follows: Suppose Charlotte
wants to run the protocol with 9'’ instead of g“. Either Alice or Charlotte or any intermediary
can use the proxy key to convert Alice’s responses k/a to k/b. Also, either party can transform its
share of the key pair (a, 9“) to b or 9° before any protocol takes place. Thus Alice and Bob can
authenticate for each other but otherwise the protocol is secure. This proxy scheme is translucent.

3.3 Security of 3)

Theorem 2 Protocol 3), with or without proxy keys published, is a zero-knowledge protocol that
convinces the verifier that the prover knows the secret key.

Proof. Without proxy keys published, this protocol is similar to others in the literature (see, e.g.,
[FFS88]). Note that if a prover could produce both Ho and k then the prover could produce a
from g" (perhaps only with significant probability).

Now suppose that a proxy key a/b is published for random public keys g" and g'’, and suppose
that D can then impersonate A. Since D could already generate a random proxy key r and
matching public key g‘"’, it follows that D could impersonate A even without knowing a/b and 9".
Thus publishing proxy keys does not weaken the system. [3

4 Proxy signature

The concept of proxy cryptography also extends to digital signature schemes. A signature proxy
function transforms a message signature so that it will verify with a public key other than that of the
original signer. In other words, a signature proxy function l'I(s, 1rA_,3) with proxy key 1rA_,g trans-
forms signature .9 signed by the secret component of key A such that V(m, l'I(S (m, A), 1r,4.,3), B) =
VALID, where S(m, k) is the signature function for message m by key I: and V(m, s, k) is the verify
function for message m with signature .9 by key It.

Again, existing digital signature schemes such as RSA[R.SA78], DSA[NIS91], ElGa.rnal[ElG85],
etc. do not have obvious proxy functions (which, again, is not to say that such functions do not
exist).
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As in the case of proxy identification, in order to construct a proxy key that transforms A’s
signature into B’s signature, B's secret must be required to construct the proxy key because signing
for B should not be possible without B ’s cooperation. .

Now we will see how to use the proxy identification scheme to construct a proxy signature
scheme. We suppose there exists a hash function h whose exact security requirements will be

discussed below. The parameters p, g, a, b are as before.

4.1 Cryptosystem Z (signature)

To sign a message m, Alice picks k1,k2,...k¢ at random and computes g"‘,... g"‘. Next Alice
computes h(g"1,. . .g"‘) and extracts I pseudorandom bits 61, . . . , fig. For each 2‘, depending on the

¢"th pseudorandom bit, Alice (who knows a) computes s2,.- = (kg —mfl,‘)/a; that is, 32,,’ = (kg —-m)/a
or sg_.~ = kg/a. The signature consists of two components:

31 = (gkl:--'19,”)

32 = (UH-mfiil/0»---a(l=t—mfit)/'1)

To verify the signature, first the B,-’s are recovered using the hash function. The signature is then

verified one “round” at a time, where the i‘th round is (g’‘'’, (In, —mfi,-)/a). To verify (g", (k—mfl)/a)
using public key g“, the recipient Charlotte raises (g“) to the power (I: — mfl) /a and checks that it

matches g" /gm”. ‘

4.2 Symmetric proxy function for Z

A symmetric proxy key 1r,1_.5 for this signature scheme is a/b. The proxy function II leaves s1

alone and maps each component s2,,- to sgl,-1r,1_.5. The proxy scheme is translucent.

4.3 Security of Z

This scheme relies on the existence of a “hash” function h. Specifically,

Assumption 1 We assume there exists a function h such that:

0 On random input (g“,m), it is diflicult to generate {r,-} and {fig} such that

h(gan+mfi|’ . _ _ ’gar¢+m/5;) = (fil ' ' . ’fil).

- More generally, it is diflicult to generate such {r,-} and on input g“,m, and samples of
signatures on random messages signed with a.

It is not our intention to conjecture about the existence of such functions h. In particular, we
do not know the relationship between Assumption 1 and assumptions about collision freedom or

hardness to invert.3 We note that this generic transformation of a protocol to a signature scheme
has appeared in the literature [FS86].

°Assumption 1 docs imply that, on random input y“, it is hard to find (r.-) making all the fl;’s zero, i.e., such that
h(g'"‘, . ..,g‘"‘) = 0.
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We now analyze Assumption 1. Note that in order to produce a legitimate signature on m that
verifies with g“, a signer needs to produce (g*‘) and (UR - mflg)/a). Thus, putting (fig) = h((g"“))
and then (rg) fl (UR — mflg)/a), it is straightforward to see that the signer could actually produce
r,-‘s and ll,-’s of the stated type in the course of producing the signature.‘

While we do not address the security of h, we can state that issuing proxy keys does not weaken

the system.

Theorem 3 Suppose h satisfies Assumption 1. Then, for most b, it is also hard to produce {r,-}

and {/3,-} given additional input a/b,g°, and samples of messages signed with b.

Proof. As above, a signer not having access to b’s messages and proxy keys could simulate this
by choosing a random proxy key r, generating g” = g‘", and convert some messages signed with a
into messages signed with b. D

5 Conclusions

Intuitively, atomic proxy cryptography is a fairly natural extension of the basic notion of public-key

cryptography. It surely seems plausible, given that there exist cryptosystems that can grant the
ability to encrypt without granting the ability to decrypt, that there might also exist cryptosystems

that can grant the ability to re-encrypt without granting the ability to decrypt. However, it is not
at all obvious whether there exist atomic proxy schemes in general.

Indeed, while this paper has demonstrated that there do exist efficient and secure public-key
encryption and signature schemes with symmetric atomic proxy functions, this observation probably
raises more new questions than it answers. In particular, do proxy functions exist for public-

key cryptosystems based on problems other than discrete-log? (One possibility is that, for some
cryptosystems, proxy functions do exist but it is infeasible to find a proxy key.) More importantly,
we have yet to discover a secure asymmetric proxy function of any kind; asymmetric proxy functions
are probably much more useful in practice, since there are likely many situations where trust is
only unidirectional. Are there cryptosystems for which asymmetric proxy functions exist?
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Atomic Proxy Cryptography

Matt Blaze

AT&T Shannon Laboratory

This talk introduces atomic proxy cryptography, in which an atomic proxy fimction, in conjunction
with a public proxy key, converts ciphertext (messages in a public key encryption scheme or
signatures in a digital signature scheme) for one key ($k_l $) into ciphertext for another ($k_2$).
Proxy keys, once generated, may be made public and proxy functions applied in untrusted
environments. Various kinds of proxy functions might exist; {\em symmetric} atomic proxy
functions assume that the holder of $k_2$ unconditionally trusts the holder of $k_l $, while {\em
asymmetric} proxy functions do not. It is not clear whether proxy functions exist for previous
public-key cryptosystems. Several new public-key cryptosystems with symmetric proxy functions
are described: an encryption scheme, which is at least as secure as Diffie-Hellman, an identification
scheme, which is at least as secure as the discrete log, and a signature scheme derived from the
identification scheme via a hash function.

Full paper available.

This is joint work with Martin Strauss.

_.___.. -._...._..._.___.._.___._-......_____.._. .____._._._.._.._____........_.___. ...._.__-?_._._.___.___.._.___.___..__.__.._._...__-_ __.-..._._._.

Matt Blaze, Atomic Proxy Cryptography

Gates 498, 10/20/98, 4:15 PM
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Matt Blaze's Technical Papers

Last updated 6 August 2006

Many of my technical papers are available here. Newer papers are usually in Adobe
PDF format; like it or not, PDF is the de facto standard format for scientific papers
these days. Most of the older papers are in PostScript format; you'll need a
PostScript printer or viewer (such as GhostView) to read them. Most of these files
have also been converted to Adobe PDF format (using ps2pdf) and can be viewed or
printed with a PDF viewer such as Acrobat, acroread4, or xpdf. If you have a choice,
you'll probably find the PostScript version looks and works better than the PDF
version does (ps2pdf doesn't do particularly well with some of the fonts). A few
papers are available as plain ASCII text or LaTeX source.

Wiretapping, Surveillance and Countermeasures

The Trustworthy Network Eavesdropping and Countermeasures (TNEC) project
studies the reliability of communications interception systems and technologies. A
better understandingiof the limitations of eavesdropping techniques could lead to
more trustworthy law enforcement wiretap evidence (or at least more appropriate
treatment of electronic evidence), networks with properties that inherently frustrate
(or facilitate) interception, and new techniques for achieving communications
security.

One of our first efforts is a comprehensive analysis of the wiretapping technologies
used by law enforcement (for both voice and data). We have found serious
exploitable weaknesses in fielded interception systems. For details, including audio
demos of novel eavesdropping countermeasures, see the vwretapping web page here.

   
o M. Sherr. E. Cronin, S. Clark and M. Blaze.

‘ ' . to.com/ ers/wireta ingl web page.  

o M. Sherr, E. Cronin, S. Clark and M. Blaze. "Signaling Vulnerabilities in
Wiretapping Systems." IEEE Security and Privacy. November/December
2005. |,PDF|.

Similar vulnerabilities exist in digital Internet eavedropping systems as well:

a E. Cronin, M. Sherr, and M. Blaze. "The Eavedsdropper's Dilemma."
Technical Report MS-CIS-05-24. University of Pennsylvania. 2005. ]PID.Fl.

Another focus of the TNEC project examines local host-based surveillance. The
JitterBug demonstrates a novel eavesdropping threat against typed keyboard input.
Commercially-available hardware keyboard "sniffers" can easily Capture and store
an unsuspecting user's keystrokes. Because a subverted keyboard has no direct
network connection, sniffer attacks are generally assumed to require either support
software on the host or periodic in-person access by the attacker to retrieve the data.
We show that this need not be the case. A new technique based on "JitterBugs" can
exflitrate captured data entirely through subtle perturbations in the precise times at
which typed keystrokes are passed to the host. Whenever a user runs an interactive
network application (such as SSH), an attacker can derive previously captured
keystrokes entirely by observing the timing of network packets, even from across the

')'7/1 1 nnns
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Internet or via encrypted wireless tramc. The JitterBug demonstrates that input
devices must be scrutinized as part of any trusted computing base and, more
generally, that simple "supply chain attacks" can represent a practical and serious
threat to data confidentiality. (Gaurav Shah and Andres Molina won the Best Student
Paper award at USENIX Security 2006 for this work.)

0 G. Shah, A. Molina, and M. Blaze. "Keyboards and Coven Channels." Proc.
15th USENIX Security Symposium. Vancouver, BC. August 2006. |PDF|.

0 Gaurav Shah's JitterBug page:
htt ://www.cis.u enn.edu/~ auravsh/‘itterbu

prototype code and PCB template.

.ht:nl. JitterBug
   

Physical and"Human-Scale" Security

Cryptologic techniques can be applied outside of computers and networks, Perhaps
surprisingly, the abstractions used in analyzing secure computing and
communications systems turn out also to be useful for understanding mechnical locks
and their keyspaces. Indeed, modeling master keyed locks as online authentication
oracles leads directly to efficient solutions for what might naively seem like
exponential problems for the attacker. In fact, it seems like almost a textbook
example, as if master keying practices for locks were designed specifically to
illustrate this class of weakness. We sometimes assume that hardware-based security
is inherently superior to that based in software, but even the humble mechanical lock
can bejust as insecure as complex computing systems, and can fail in similar ways.

A widely circulated paper of mine describes attacks against master keyed mechanical
locks. For an overview of the attack, which was described in the January 23rd 2003
New York Times, click here. For a brief commentary on the reaction to this paper, see
my essay, "Kee it secret stu id!" click here , which was originally posted to
comp.risks. '

  

(Warning: there are embedded photos in this paper; they make the PS and PDF files
very large. The GZIPed PostScript version is 5.7MB long (uncompresses to 14MB),
and the PDF version is 4MB long.)

a M. Blaze. "Cryptology and Physical Security: Rights Amplification in Master-
Keyed Mechanical Locks." March 2003. IEEE Security and Privacy.
March/April 2003. |'GZTPed PostScript], [PDF].

o My Notes on Picking Pin Tumbler Locks, intended primarily for use by
students in my security seminar, can be found here |[_-ITMLI.

While the security metrics and mechanical safeguards used in safes and vaults may
not relay on the latest technology, they are often quite ingenious. They may have
much to teach computer security. Some of what I understand about the subject is in
the survey paper below (warning -- heavily illustrated 2.5MB .pdf file). And for a
brief commentary on the reaction to this paper, see my essay, "the. second sincerest
form of flatterv" (click. here), which was originally posted to interesting -people.

o M. Blaze. "Safecracking for the Computer Scientist." U. Penn CIS Department
Technical Report. 7 December 2004 (revised 20 December 2004). |l’DF l.

. . 77/ll/9.006
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This position paper, presented at the Cambridge Security Protocols Workshop 2004,
introduces and advocates the "Human Scale Security Project," which supports the
above work.

. M. Blaze. "Toward a broader view of security protocols." 12th Cambridge
International Workshop on Security Protocols. Cambridge, UK. April 2004.
|PDF|.

Trust Management

These papers introduce the "trust management" approach to specifying and enforcing
security policy.

0 The Trust Management Web Page, updated regularly.

o M. Blaze, J. Ioannidis, A. Keromytis. "Offline Micropayments without
Trusted Hardware." Financial Cryptography 2001. Grand Cayman, February
2001. [EostSc-ript 1, IEDF1.

o M. Blaze, J. Ioannidis, A. Keromytis. "Trust Management for IPSEC." NDSS
2001. San Diego, February 2001. ]’PDF|.

o M. Blaze, J. Feigenbaum, J. Ioannidis, A. Keromytis. The KeyNote Trust
Management System, Version 2. RFC-2 704. IETF, September 1999. [ASCII
Textl.

o M. Blaze, J. Ioannidis, A. Keromytis. "Compliance Checking and IPSEC
Policy Management." Internet Drafi‘. draft-blaze—ipsp-trustmgt-00.txt.
IETF, March 2000. IASCII Textl.

o M. Blaze, J. Ioarmidis, A. Keromytis. "DSA and RSA Key and Signature
Encoding for the KeyNote Trust Management System." RFC-2 792. IETF,
March 2000. IASCII Text]

o M. Blaze, J. Ioannidis, and A. Keromytis. " Trust Management and Network-
Layer Security Protocols." 1999 Cambridge Protocols Workshop. Cambridge,
April 1999. |.EostScript], JEIDFI, |'LaTeX Sourcel.

o M. Blaze, J. Feigenbaum, J. Ioannidis, and A. Keromytis. "The Role of Trust
Management in Distributed Systems Security." Chapter in Secure Internet
Programming: Security Issues for Mobile and Distributed Objects, (Vitek and
Jensen, eds.) Springer-Verlag, 1999. |PostScript|, IPDF I.

o M. Blaze, J. Feigenbaum, M. Strauss. "Compliance-Checking in the
PolicyMaker Trust-Management System.“ Proc. 2nd Conference on Financial
Cryptography. Anguilla 1998. LNCS 1465, pp 251-265, Springer-Verlag,
1998. ]_.EostScript |, |.PD'F|.

o M. Blaze, J. Feigenbaum and J. Lacy. "Decentralized Trust Management."
IEEE Symposium on Security and Privacy, Oakland, CA. May 1996.
[P.gst_SCJi_.>11. IEEE]-

Angelos Keromytis's KeyNote Trust Management toolkit and open-source reference

')"II11I’)flnK
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implementation is available here as a GZlPed TAR archive. The toolkit runs under
most Unix-like (BSD, linux, etc.) platforms, with limited support for Win32
platforms.

Also see Angelos Keromytis' KeyNote. web page for the latest details on the
KeyNote implementation.

Remotely-Keyed Encryption

These papers introduce and formalize the notion of "remotely-keyed" encryption, in
which a low-bandwidth, but trusted device (such as a smart card) assists a high-

. bandwidth, but untrusted host with bulk encryption.

0 M. Blaze, J. Feigenbaum, and M. Naor. "A Formal Treatment of Remotely
Keyed Encryption (Extended Abstract)". Eurocrypt '98, Helsinki. LNCS 1403
pp. 251-265. |PostScript|, lI’DF,|.

0 M. Blaze. "High-Bandwidth Encryption with Low-Bandwidth Smancards."
January 18, 1996. Cambridge Workshop on Fast Software Encryption,
February 1996. |_PostScript|, |PDFl.

Key Escrow

These papers describe and evaluate various key escrow proposals, from a technical
(as opposed to political) perspective.

o The Risks ofKey Recovery, Key Escrow, and Trusted Third-Party Encryption
(second edition). June 1998. |I—_I'TMLI, l.PDF|.

o The Risks ofKey Recovery, Key Escrow, and Trusted Third-Party Encryption
(first edition). May 1997. (OBSOLETE: superseded by second edition, above).
[ASCII Text], IPDFI, IEostScript|.

o M. Blaze. "ObIivious Key Escrow." First Cambridge Workshop on
Information Hiding May 1996. Springer 1997. l'l.’ostScript|, JPIDFI, |LaTeX
source].

0 Memo from NSA regarding key length report, with comments from M. Blaze
and W. Diflie. July 18, 1996. IASCIII. Text].

0 M. Blaze, W. Diflie, R. Rivest, B. Schneier, T. Shimomura, E. Thompson and
M. Wiener. "Minimal Key Lengths for Symmetric Ciphers to Provide
Adequate Commercial Security". Report of ad hoc panel of cryptographers
and computer scientists. January 1996. IASCII Text |, ]'PDF|, |PoslScn'pt|.

o M. Blaze, J. Feigenbaum and F.T. Leighton. "Master-Key Cryptosytems."
Abstract presented at Crypto '95 (rump session), Santa Barbara, CA, August
1995. ]l_’ostScript|, |[ZDiF|

o M. Blaze. "Protocol Failure in the Escrowed Encryption Standard."

Proceedings ofSecond ACM Conference on Computer and Communications
Security, Fairfax, VA, November 1994. lPostScri_pt|, |PD'Fl.
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Network-Layer Security

These papers describe the design and implementation network-layer and related
security protocols, including JFK, a secure key exchange protocol, and swIPe, a
predecessor to the IPSEC standard. (At this point, swIPe is of primarily historical
interest, although the USENIX paper should be of some value to IPSEC
implementors. JFK is a useful key exchange protocol that should be especially
valuable for IPSEC and network security key management).

0 W. Aiello, S. M. Bellovin, M. Blaze, R. Canetti, J. Ioannidis, A. D. Keromytis,
and O. Reingold. "Efficient, DoS-Resistant, Secure Key Exchange for Internet
Protocols." In Proc. ACM Computer and Communications Security (CCS)
Conference. November 2002, Washington, DC. (pp 48-58). ]PDF|.

o J. Ioannidis and M. Blaze. "The swIPe IP Security Protocol." Internet Draft.
December 1993. IASCII Text].

o J. Ioannidis and M. Blaze. "Architecture and Implementation of Network
Layer Security Under UNIX." Proceedings ofthe Fourth USENIX Security
Workshop, October 1993. [PostScript|, [EDP].

Cryptographic Applications

. R. Levein, L. McCarthy, M. Blaze. "Transparent Internet E-mail Security
(DRAFT)". August 9, 1996. |.EOStSc1'ipt[, |PDF|.

o M. Blaze and S.M. Bellovin. "Session-Layer Encryption." Proceedings ofthe
USENIX Security Workshop, June 1995. [Postscript].

- M. Blaze. "Key Management in an Encrypting File System." USENIX Summer
1994 Technical Conference, Boston, MA, June 1994. |PosIScripI1, IPDF [.

o M. Blaze. "A_:Cryptographic File System for Unix." Proceedings ofthe First
ACM Conference on Computer and Communications Security, Fairfax, VA,
November 1993. |PostScript'|, |PDF|.

The latest CFS code can be found h_e1§.

Ciphers and Algorithms

0 S. M. Bellovin, M. Blaze. "Cryptographic Modes of Operation for the
Internet." NIST Workshop on AES Modes. Santa Barbara, CA. August 2001.
IPDF |.

0 M. Blaze, M. Strauss. "Atomic Proxy Cryptography." Full version of our
EuroCrypt '98 paper. May 1997. |I’ostScripI|, IPDFI.

o M. Blaze. "Efficient Symmetric-Key Ciphers Based on an NP-Complete
Subproblem (DRAFT)". October 2, 1996. ,[BDE]

. M. Blaze and B. Schneier. "The MacGuff1n Block Cipher Algorithm." Leuven
Workshop on Cryptographic Algorithms, Leuven, Belgium, December 1994.
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|'PostScri1;t |, |PDF I.

Cryptography Policy, Export Regulations, and
Politics

0 M. Blaze. Declaration in Felten, et al v. RIAA. 13 August 2001. JASCII Text'|.

o S. Bellovin, M. Blaze, D. Farber, P. Neumann, E. Spafford. "Comments on the
Carnivore System Technical Review." Formal comments to the US
Department of Justice. 3 December 2000. [T-]'TMl.<[.

o M. Blaze & S. M. Bellovin. "Tapping, Tapping on my Network Door."
INSIDE RISKS 124. CACM, October 2000. ]HTML|.

o M. Blaze. "Cryptography Policy and the Infonnation Economy." Draft. 17
December 1996. |PostScript|, IPDI-"|, [ASCII Text [.

o My prepared testimony before the Senate Commerce Committee
subcommittee on Science, Technology, and Space. June 26, 1996 ]ASC1I
Text |.

0 M. Blaze. "My Life as an International Arms Courier." January, 1995.
Adapated from posting to camp. risks |ASC.I1 Textl

Peer-to-Peer Networking

My dissertation work, over ten years ago, anticipated and analyzed what we would
now call "Peer-to-Peer" file distribution.

0 M. Blaze. Caching in Large-Scale Distributed File Systems. PhD thesis.
Princeton University Department of Computer Science. November 1992.
|'PostScript_|.

Other People's Papers

From time to time, I make available papers from other researchers that I didn't write
myself but that are of wide interest and don't otherwise have a home. Here's what's
available now:

o S. Fluhrer, I. Mantin and A. Shamir. Weaknesses in the Key Scheduling
Algorithm of RC4. Preliminary Draft, July 25, 2001. [Postscript 1.

0 A. Biryukov and A. Shamir. Real Time Cryptanalysis of the Alleged A5/1 on
a PC. Preliminary Draft, December 9, 1999. [Postscript |.

Click here to return to the c 
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Citations by First Author - B

A. Back, U. Moller, and A. Stiglic, Traffic Analysis Attacks and Trade-Offs in Anonymity Providing
Systems, Proceedings of the 4th Information Hiding Workshop (IHW2001), Springer-Verlag, LNCS v.
2137, pp. 243-254. ],gdf|

S. Bakhtiari, R. Safavi-Naini, and J. Pieprzyk, A Message Authentication Code based on Latin
Squares, Australian Conference on Information Security and Privacy (ACISP '97), Springer-Verlag,
LNCS 1270, pp. 194-203, 1997. [.ps.Zl

S. Bakhtiari, R. Safavi-Naini, and J. Pieprzyk, On Password-Based Authenticated Key Exchange using
Collisionful Hash Functions. In Australian Conference on Information Security and Privacy (ACISP
'96), Springer-Verlag, LNCS 1172, pp. 299-310, 1996. |.ps.Z1

S. Bakhtiari, R. Safavi-Naini, and J. Piprzyk, On Selectable Collisionful Hash Functions, Australian
Conference on Information Security and Privacy (ACISP '96), Springer-Verlag, LNCS 1172, pages
287-298, 1996. |.Qs.Z|

T. Baldin, G. Bleumer, and R. Kanne, CryptoManager - Eine intuitive Programmierschnittstelle fiir
kryptographische Systeme; Sicherheitsschnittstellen - Konzepte, Anwendungen und-Einsatzbeispiele,
Proc. Workshop Security Application Programming Interfaces 94, Deutscher Universitats Verlag,
Miinchen 1994, 79-94. ].ps'.gz|

T. Baldin and G. Bleumer, CryptoManager++ —- An object oriented software library for cryptographic
mechanisms; 12th IFIP International Conference on Information Security (IFIP/Sec '96), Chapman &
Hall, London 1996, 489-491. |.ps.gz|

D. Balfanz and L. Gong, Experience with Secure Multi-Processing in Java, Proceedings of the 18th
IEEE International Conference on Distributed Computing Systems (ICDCS), Amsterdam,
Netherlands, May 1998. |.ps.gz|

J. Bar—Ilan and D. Beaver, Non-Cryptographic Fault-Tolerant Computing in a Constant Expected
Number of Rounds of Interaction (extended abstract); Proceedings of PODC, ACM, 1989, 201-209.
|.pdf|

R. Bar-Yehuda, B. Chor, E. Kushilevitz, and A. Orlitsky, Privacy, Additional Information, and
Communication, IEEE IT 39(6), 1993, pp. 1930-1943. ].ps.Z| ‘

N. Baric and B. Pfitzmann, Collision-Free Accumulators and Fail-Stop Signature Schemes Without
Trees; Eurocrypt '97, LNCS 1233, Springer-Verlag, Berlin 1997, 480-494. l.ps.gz|

E. Basturk, M. Bellare, C. S. Chow, and R. Guerin, Secure transport protocols for high-speed
networks, IBM Research Report 19981, March, 1994.

O. Baudron, H. Gilbert, L. Granboulan, H. Handschuh, A. Joux, P. Nguyen, F. Noilhan, D.
Pointcheval, T. Pornin, G. Poupard, J. Stern, and S. Vaudenay, Report on the AES Candidates,
Proceedings of the Second AES Candidate Conference, Rome, Italy, 1999. ].pdf|

B. Baum—Waidner, B. Pfitzmann, and M. Waidner, Unconditional Byzantine Agreement with Good
Majority; STACS'91, LNCS 480, Springer-Verlag, Heidelberg 1991, 285-295. ].ps.gz|

D. Bayer, S. Haber, and W. Stornetta, Improving the Efficiency and Reliability of Digital Time-
Stamping, Sequences 11: Methods in Communication, Security, and Computer Science, eds. R.
Capocelli, A. DeSantis, and U. Vaccaro, Springer-Verlag, 1993, pp. 329-334. Lp_d_f1

P. Beauchemin, G. Brassard, C. Crépeau, C. Goutier, and C. Pomerance, Two observations on
probabilistic primality testing; In Advances In Cryptology: Proceedings of Crypto '86, volume 263 of
Lecture Notes in Computer Science, pages 443-450. Springer-Verlag, 1987. Lgggl

P. Beauchemin, G. Brassard, C. Crépeau, C. Goutier, and C. Pomerance, The generation of random
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numbers that are probably prime, Journal of Cryptology, 1(1):53-64, 1988. [gps],

D. Beaver, S. Micali, and P. Rogaway, The Round Complexity of Secure -Protocols (extended
abstract); Proceedings of the 22nd STOC, ACM, 1990, 503-513. l.gs| |.Qs.gz|

D. Beaver, J. Feigenbaum, J. Kilian, and P. Rogaway, Security with Low Communication Overhead
(extended abstract), Advances in Cryptology - Crypto '90 Proceedings, Springer-Verlag, 1991, 62-
76. Lpdfl

D. Beaver, J. Feigenbaum, J. Kilian, and P. Rogaway, Locally Random Reductions: Improvements
and Applications, Journal of Crypto|ogy, 10 (1997), pp. 17-36. ].pdf1].ps|

D. Beaver, Commodity-Based Cryptography (extended abstract); Proceedings of the 29th STOC,
ACM, 1997, 446-455. ].gd[|

D. Beaver and S. Haber, Cryptographic Protocols Provably Secure Against Dynamic Adversaries
(extended abstract); Advances in Cryptology - Eurocrypt '92, Springer-Verlag, 1993, 307-323. |.pdl_‘1

D. Beaver, J. Feigenbaum, and V. Shoup, Hiding Instances in Zero—Know|edge Proof Systems
(extended abstract), in Advances in Cryptology — Crypto '90, Lecture Notes in Computer Science,
vol. 537, Springer, Berlin, 1991, pp. 326-338. |.pdf|

D. Beaver, S. Micali, and P. Rogaway, The round complexity of secure protocols; Proceedings of the
22nd Annual ACM Symposium on the Theory of Computing, (STOC 90), 1990, 503-513. L951
L2s._cl_z_i.

D. Beaver, Foundations of Secure Interactive Computing (extended abstract); Advances in
Cryptology — Crypto '91 Proceedings, Springer-Verlag, 1992, 377-391. .Lp_cm

D. Beaver and S. Goldwasser, Multlparty Computation with Faulty Majority, Advances in Cryptology:
Crypto '89, ed. Gilles Brassard. ].Qdf|

D. Beaver and N. So, Global, Unpredictable Bit Generation Without Broadcast (extended abstract);
Advances in Cryptology — Eurocrypt '93, Springer-Verlag, 1994, 424-434. Lpdf]

D. Beaver, Efficient Multlparty Protocols Using Circuit Randomization (extended abstract); Advances
in Cryptology - Crypto '91 Proceedings, Springer-Verlag, 1992, 420-432. l.pdf|

D. Beaver, How to Break a "Secure" Oblivious Transfer Protocol (extended abstract); Advances in
Cryptology - Eurocrypt '92, Springer-Verlag, 1993, 285-296. Lpgfl

D. Beaver, J. Feigenbaum, R. Ostrovsky, and V. Shoup, Instance-Hiding Proof Systems; submitted
for journal publication. Available as DIMACS Technical Report 93-65, Rutgers University, Piscataway,
1993. |.ps.Z|_

R. Beigel and J. Feigenbaum, On Being Incoherent Without Being Veg Hard, Computational
Complexity, 2 (1992), pp. 1-17. _

A. Beimel, Y. Isahi, T. Malkin, and E. Kushilevitz, 0ne—way functions are essential for single-server
private information retrieval, Proc. of the 31st Annu. ACM Symp. on the Theory of Computing
(sroc), pp. 89-98, 1999. [.95]

A. Beimel and B. Chor, Secret Sharing with Public Reconstruction, IEEE Trans. on Info. Theory, 44
(5):1887-1896, 1998. Extended abstract in Crypto '95. |.ps|

A. Beimel and M. Franklin, Reliable communication over partially authenticated networks, Theoretical
Computer Science, (220)1:185--210, 1999. Preliminary version in WDAG '97, volume 1320 of LNCS,
pages 245-259, Springer, 1997. l.ps|

A. Beimel, Secure Schemes for Secret Sharing and Key Distribution, Ph.D. Thesis, Dept. of
Computer Science, Technion, 1996. 1.95] .

A. Beimel, T. Malkin, and S. Micali, The All-or-Nothing Nature of Two-Party Secure Computation,
CRYPTO '99., vol. 1666 of LNCS, pages 80 - 97, 1999. LD_S_]

A. Beimel and B. Chor, universally ideal secret sharing schemes. IEEE Trans. on Info. Theory, 40
(3):786-794, 1994. Extended abstract in Crypto '92. 1.95],
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Table I05 Zone numbers 

I North America 6 Australasia
2 Africa 7 USSR
3 Europe 8 Eastern Asia -
4 Europe 9 Far East and Middle East
5 South America 0 Spare 

(USSR) Throughout each of these zones there is a linked numbering scheme that
means, for example, that no subscriber in Canada has the same national number as a
subscriber in the USA. Consequently, to connect to anyone in zone 1 the digit 1 is
followed by the national number. A similar situation exists in the USSR. Europe is
at the other extreme; there are many countries with large national networks that
have nine digits in their national numbers. For these, a two-digit country code is
required, and that can only be achieved by having two zone numbers allocated to
Europe.

The division of the world into the zones shown in Table 10.5 is intended to be

satisfactory until early in the next century, but clearly, as some large countries
develop their telephone networks, some adjustment will be necessary at some futuretime.

The national and international numbering scheme we have discussed above are
the simplest. However, in several parts of the world there are small exceptions
particularly in regard to local calls. In the scheme where the national number is used

for all calls within a country, it can lead to irritation on the part of the subscriber and
long set-up times for the exchange equipment. Consequently, in many countries

‘ local calls use a shorter code. For calls within the same arm, the area code is
omitted, and for small single-exchange areas no exchange code is used for own-
exchange calls. Coupled with this last arrangement will be a very short code for calls
to adjacent exchanges; these arrangements are particularly well suited to rural
areas. The disadvantage of short codes is that they change with the location of the
mlling subscriber, and therefore a short code directory must be available in each
exchange area.

10.33 Ronteing Calls

The early type of switching equipment, milled step-by-step or Strowger, operated by
using the dialled pulses to move the selectors to the position conesponding to the
digit dialled. In many ways this was an excellent system, but one major disadvantage
was that it allowed no flexibility in the way calls were routed f the route was pre-

- determined by the dialled digits. Although some systems were modified to overcome
this problem it was not until common-control equipment became widely used that
the path a call took between calling and called subscribers could be chosen to allow
the most efficient use of the available capacity in the system. The function of the’
common control in the routing process was to store the dialled digits in a register
and then translate them into routing digits which would indicate to the switching
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system the path to take through the network. This register — translator combination
is essential to automatic trunk and ‘international dialling schemes; it allows the

telephone administration to manage the system elliciently by changing routes as
circunntanees alter without having to change subscribers’ numbers This therefore

' separates the subscriber from the system. The subscriber dials the national number
from any location and the register-translator automatically selecu an appropriate
IOUIC.

10.34 Digital Systems

Several factors have acted to push telephony from analogue to digital working. To
make such a major change, telephone administrations and equipment manufac-
turers have been persuaded that it is in digital operation that the future lies, and the
decade from the mid-seventies has been characterized in all equipment producing

countries by huge investments of manpower and plant in a race to manufacture an
efficient digital telecommunications system. There are more manufacturers involved
than at any other time and great financial commitmens have been made in the hope
that a market will be available for the many products being developed.: necessary at some future

Traditionally the two basic elements of a telephone system were transmission and
have discussed above are ~. ' . ' ' '
ere are small ex tion .L

' m _ is ‘L (repeated every 2 meet
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347

llllllllllllllllllllm._

lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllilllllllllllllllllllllllllllllliIlllllllllllllllllIlllllllllllllllliimiiiiiiii......

Petitioner Apple Inc. — Exhibit 1002, p. 3796

 



Petitioner Apple Inc. - Exhibit 1002, p. 3797

 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 
lllllllllllllllllllllllllllllllllllllllllillllllllllflllllillllllllllllll

switching, However, with digital operation the whole system is considered as an
entity. ‘ - . .

Following the development of PCM several countries installed PCM links
between analogue exchanges. These worked in a basic 24- or 32-channel format with
an encoder and decoder. We can see how the 32-channel system is formed with
reference to Fig. 10.37. Strictlyspeaking, it should be referred to as a 30-channel, 32-
time-slot system, because two of the time slots contain signalling and synchronizing
information, not speech samples. The sampling rate of each speech channel
determines the length of each time slot. For telephony the sampling rate used is
8 kHz, which means that the time between adjacent samples of the same channel is
125 psec. One frame, consisting of 32 Lime-slots lasts for this time. A time slot is
therefore approximately 3.9 psec long For reasons that we shall see in a moment,
16 frames are put together to form a multi-frame which has a time span of 2 msec.
This is the basic unit of the PCM system applied to telephony.

Within a time slot there is the encoded information about the speech sample for
that channel In most systems it is coded into 256 (=23) levels and there are
therefore 8 binary digits within each time slot; each digit must be less than 0.48 use:
long. The technique of PCM is given in detail in Section 3.5.

The channel digits bearing speech information must be sent to the right
destination and monitored for release and clear-down. Signals must therefore be
associated with each channel and in PCM telephony that is done by allocating a
signalling word to each channel once per multi-frame. Sufficient information for
signalling can be contained in a 4-digit word so that an 8 digit word can contain two
signals. Hence a signalling time slot can contain enough information for two signals .

Figure 10.37 indicates that time slot sixteen (TSI6) is used to carry the signalling.
In the second frame it carries the signals related to speech channels 0 and 15, in the ‘
third frame those for channels 1 and I6 and so on until frame 16 when TSI6 has

signals for speech channels 14 and 29. The next frame is the first of the following
multi-frame and the sequence is repeated.

 
Flg 10.38 Digital telephone exchange.
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take place before concentration through a digital switch. Alternatively for very
small units no exchange facflity would be available, but a simple digital concentrator
would be used to take in the analogue channels, convert them to PCM and
multiplex them onto a single highway to the nearest local exchange. Calls between
subscribers on the same concentrator would then have to pass through the local
exchange. Signalling in these PCM links would be on T816 and the control,
software and firmware at the main exchange would convert it to common channel if
a trunk call was required.

The introduction of digital systems is rarely a starting point for the telephone
system. Usually a system exists and the digital equipment has to be grafted on to it.
Whatever method is used, interworking between the old and new systems is
required,.and one area of difficulty is the interfacing of various analogue signalling
systems with the new equipment designed to operate on TS16 or common channel.
This interfacing can be a severe problem if there are many existing signalling
schemes in a panicular network, and the development of satisfactory units can add
considerably to system costs. ' ‘

10.35 Conclusion

In some respects, the whole concept of telecommunications is changing, and with it
the servics and functions provided by telecommunications operating companies.
The very rapid growth of information technology, with its demand for high-speed,
large-capacity, data links, with video output, and the introduction of new facilities
on telephone exchanges, are both causing manufacturers to rethink the whole
philosophy of how communication systems should best be provided..In the next few
years the main point at issue will be to decide whether future systems should be fully
integrated, or not. If so, should they be based on a digital telephone system, with its
centralized switching units, or on one of the many data networks, with distributed
control? Conversely, economy and efficiency may’ dictate an extension of the
present hybrid scheme in which both methods co-exist, with perhaps an element of
inter-working between them. It is too early in the development of distributed
systems to predict what changes will take place in the next decade, but that major
redesign will occur is beyond doubt.
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Chapter 21 Opening, Saving, and Protecting Documents 487

Word provides several ways to restrict changes to documents. You can assign a
password to prevent other users from opening a document or to keep others from

saving changes to the document. You can also request or require that other users
on a network open a document as read-only.

You can also assign a password so that other users can annotate a documen_t and
mark revisions. You or someone else who knows the password must open the
document normally and review the changes before they become permanent. For
more infonnation, see Chapter 25, “Annotating, Revising, and Routing
Documents.”

If you use form fields to create a form, you can assign a password so that other
users can fill in those parts of the form but cannot change anything else in the
document. For more information, see Chapter 14, “Forms.”
 

Warning If you assign a password for any of these types of protection, it’s a good
idea to write it down. Without the password, you carmot open the document. 

Setting Passwords and Selecting Save Options
To assign a password to a document and set options that control whether changes
can be saved, choose the Options button in the Save As dialog box or choose
Options from the Tools menu, and then select the Save tab.

Choose the Help button for
more information aboutthese

options.

~ Use these options to control
changes to a document.
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Protection Password To prevent other users from opening a document, type a

password in the Protection Password box. Only users who know the password can
open the document. Passwords are case-sensitive.

Write Reservation Password To prevent other users from saving changes to a

document, type a password in the Write Reservation Password box, and then
choose the OK button. Word will prompt you to type the password again to

confirm it. Word then requires you to type the password to open the document

nomially. If you do not know the password, you can still open the document as
read—only by choosing the Read Only button in the Password dialog box that
appears when you open the document.

Read-Only Recommended To recommend, but not require, that other users open a
document as read-only, select the Read—Only Recommended check box. When
another user opens a document that’s protected by this option, Word indicates that
the document should be opened as read—only unless changes need to be saved. The
user can then open the document normally or as a read-only document.

To protect a document with a password

1. Open the document you want to protect with a password.

2. From the File menu, choose Save As.

If you have not yet named the document, type a name in the File Name box.

3. Choose the Options button.

4. In the Protection Password box or the Write Reservation Password box, type a
password, and then choose the OK button. _

A password can contain up to 15 characters and can include letters, numbers,
symbols, and spaces. As you type the password, Word displays an asterisk C’)
for each character you type. Note that passwords are case-sensitive.

5. When Word prompts you to confirm the password, retype it and then choose
the OK button. -

6. To save the document, choose the OK button.

Make sure that you write down the document password, exactlyuas you typed H
‘ it. You will need to type it the next time you open the document. ’ .._._.

Tip If you want to allow other users to add only comments to a document, you
can protect it by using the Protect Document command on the Tools menu. Other _'
users can then open the document, but they can only make comments by using
annotations.

lllllllii ‘iii‘ |
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cument, type 3
F To change or delete a password

v the password can 1
1. Open the document whose password you want to change or delete.

2. From the File menu, choose Save As.

3. Choose the Options button.
4. In the Protection Password box or the Write Reservation Password box, select

the row of asterisks that represents the existing password, and then do‘ one of
the following:

g changes to a
box, and then

ord again to
i the document

be document as

3-108 box that I To change the password, type the new password.

I To delete the password, press DELETE.
5. Choose the OK button.

If you changed the password, Word asks you to retype the new password.

other users open 3
eck box. When _

Vord indicates that
:d to be saved. »'I3h
zument.

6. To save the document with the new password, choose the OK button.

- I Other Ways of, Protecting Documents
Word offers other methods of protecting your documents.

 For information about See

_ Opening documents as read-only “To open an existing document,” earlier in
File Name box. this chapter

’ Preventing any changes to documents Chapter 14, “Forms”

Sword box, type_a;__._ ‘ except for filling in form fields
Preventing any changes to documents Chapter 25, “Annotating, Revising, and

letters’ numbers‘ except for annotations and marked revisions Routing Documents
.ys an asterisk (£ .
isitive.

 

Note Protecting a form.or locking a document for annotations or revisions does

not keep another user from saving that document with a password or from setting
other save options. If you want to protect a document from all types of changes,

save it with a password by using one of the methods described in this chapter.

and then choose"

 

Some operating systems and networks also provide ways to protect documents.
To find out if your system has these features, check with your network

administrator or see the documentation for your operating system or network.
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CHAPTER 25

nnotating, Revising, and Routing
ocuments

Word provides three features that make it easy to revise documents and
incorporate comments from reviewers: armotations, revision marks, and routing.

To comment on a document rather than change it, use anno1au'ons—numbered

comments added in a separate annotation pane; To make changes directly in the
document, use revision marks. Revision marks show where text or graphics have
been added, deleted, or moved. In addition, revision marks allow you to track

changes by reviewer, date, and time.

You can use Word with Microsoft Mail or other compatible mail packages to send

an online copy of a document to recipients who can comment on or add to the
document. You can send multiple copies of the document to all reviewers at the
same time, or you can route a single copy sequentially through a list of reviewers.
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Revision marks

 
 

   Annotation
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I Using Annotations 552

I Using Revision Marks 557

I Protecting a Document for Annotations
and Revisions 561

I .RoutingaDocumentOnline 562
I Merging Annotations and
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QUICK

START
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Inserting Annotations

To comment on a document but not change the content, use annotations. To insen
an annotation, select the text you want to comment on. From the Insert menu,

choose Annotation. Word opens a separate annotation pane where you type your
comments. To insert additional annotations, follow the same procedure. or select

the text and press ALT+CTRL+A (Windows) or COMMAND+OP"l'lON+A (Macintosh)_ .
When you finish, choose the Close button in the annotation pane.

ruiacflrdy
Selected text that

you want to
comment on

delight and amazement 0
The key to the the Alhntrosrl IUCCIB tn: the inpronmem in in materials over the Condor.
Even thoughthe Condor: frame Md heenmmj
made olti hrweiht aluminum its wfht rude it‘ ossible for a email to no it atoll for more
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Annotation pane
where you type
comments

.___...1............_.._._._._....._..___.__...._.......__. 
Viewing Annotations
To view annotations, choose Annotations from the View menu. The annotation

pane displays comments from all reviewers. To view annotations from a single

reviewer, select that person's name from the box at the top of the annotation pane.
To view the range of text a particular armotation refers to, position the insertion
point within the comment in the armotation pane. Word highlights the text the
reviewer selected. When you finish viewing annotations, choose the Close button.

Marking Revisions

Use revision marking to track the changes that you or other reviewers make to a

document. To tum on revision marking, choose Revisions from the Tools menu or
double-click ‘‘MRI('‘ in the status bar. Select the Mark Revisions While Editing

check box, and then choose the OK button. From that point on, Word tracks all

revisions. By default, the revision marks are displayed on the screen and in the
printed document.

Deleted text
  

  
m 
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Usrng Annotations
eviewers to comment on a document rather than make changes ‘ _When you want r

directly to it, have them use annotations. Annotations are numbered comments
added in a separate annotation pane. Reviewers can include text as well as
graphics in the annotation pane. With the appropriate hardware, voice and pen
arutotations can also be included.

Each annotation has an annotation mark that includes the reviewer's initials and 3
Show/Hide 1] button sequential number. Word obtains the reviewer's initials from the User Info tab in

' the Options dialog box (Tools menu). In the annotation pane, the annotation mark
appears as normal text. In the document window, the annotation mark appears as
hidden text. (You can view annotation marks in the document when the
annotation pane is closed by clicking the Show/Hide {[ button on the "Standard
toolbar.)
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Annotation mark in the annotation pane ‘

rTrX‘l."-.
For information about routing online documents to multiple reviewers, see
“Routing a Document Online,” later in this chapter. ii

i"

Inserting Annotations
Before you insert an armotation,
want to comment on. That way,
the annotation refers. When you type
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To insert an annotation

1. Select the text or item you want to comment on, or position the insertion point
at the end of the text or item you want to comment on. -

2. From the Insert menu, choose Armotation.

Word inserts an annotation mark (initials and a number formatted as hidden

text) in the document and opens the annotation pane.

Word uses the reviewer‘s initials from the User Info tab in the Options dialog

box (Tools menu).

3. Type the annotation text in the annotation pane, and then do one of the
following:

I To close the annotation pane and retum to the document, choose the Close
button.

- I , To keep the annotation pane open to add additional annotations, click in the
document window, and repeat steps 1 through 3.

Using the keyboard You can also quickly insen annotations by using the
keyboard. Press ALT+Cl‘RL+A in Windows and COMMAND-t-OP"l'ION+A on the
Macintosh.

 

Tip Armotation marks are automatically displayed when the annotation pane is
open. If the annotation pane is closed, you can display annotation marks and
nonprinting characters in the document by clicking the Show/Hide {I button on the
Standard toolbar. Click the button again to hide annotation marks.

Viewing and Locating Annotations
When the annotation pane is open, it shows the annotations that correspond to the
part of the document displayed in the document window. As you scroll through
the document, the annotation pane scrolls as well. You can change the size of the
annotation pane by dragging the split box up or down on the vertical scroll bar.
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554 Part 7 Using Word in a Workgroup

D To view annotations

1. Do one of the following:

-" From the View menu, choose Annotations.

I Double—click an annotation mark in the document window. If you don't see
annotation marks, click the Show/Hide 1] button on the Standard toolbar,

2. To view the annotations of a single reviewer, select the name of the reviewer

from the Reviewers box at the top of the annotation pane. The default is A||
Reviewers, which displays the annotations of all reviewers.

3. When you finish viewing annotations, do one of the following:

I To close the annotation pane and return to the document, choose the Close
button.

I To keep the annotation pane open and return to the document, click in the
document window.

 

Note If a reviewer selected text before inserting an annotation, the selected text is

highlighted when you position the insertion point within the corresponding
annotation in the annotation pane. Text that is highlighted is not selected. To

quickly select the highlighted text so that you can modify it, press ALT+Fll
(Windows) or 0PI‘l0N+Fl I (Macintosh). 

To locate a specific annotation, choose Go To from the Edit menu. Under Go To
What, select Annotation. If you know which reviewer made the annotation, select
the reviewer’s name from the list. Choose the Next button until you find the

annotation you want.

Incorporating and Deleting Annotations
To incorporate the text of an annotation into a document, select the annotation
text or item, and then choose Copy from the Edit menu. Position the insertion

point in the document where you want the text or item to appear, and then choose
Paste from the Edit menu.

To delete an annotation, select the annotation mark in the document window and

then press BACKSPACE or DELETE. Word automatically renumbers annotation
marks each time you add, delete, or copy an annotation.
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‘ Printing Annotations
You can print annotations either separately from the rest of the document or with
the document. If you print annotations only, Word prints the page number of the
annotation mark, the reviewer’s initials, the annotation number, and then the 

 

 
 

 

 
 
 

 
 

 

 
 

 
 

 
 
 
 

 
 
 

 
 
 

 
mi: ‘ 5°‘? annotation text. If you print annotations with the document, Word prints this sameO a" information at the end of the document. Word prints hidden text in the document

rviewer so that you can see the location of the annotation marks.

 
is All

> To print annotations only

_ 1. From the File menu, choose Print.
he Close ‘ 2. In the Print What box, select Annotations, and then choose the OK button.

:k in the ' > To print a document with annotations . _—
1. From the File menu, choose Print.

". . — 2. Choose the Options button.
3. Under Include With Document, select the Annotations check box, and then

choose the OK button.

4. In the Print dialog box, select any other printing options you want, and then
choose the OK button.

Inserting and Listening to Voice Annotations
If your computer runs Windows—based applications, you must have a sound board
installed to listen to voice annotations. To record annotations, you must also have
a microphone.

If you have a Macintosh computer, you can listen to voice annotations without
having special sound equipment. To record annotations on a Macintosh, you must
have a microphone.

You can distinguish a voice annotation from other annotations by the sound
symbol—an audio cassette tape—which Word inserts in the armotation pane and
in the document at the position of the insertion point.
_j_‘a_ 

Tip To insert a combination of text and voice annotation, insert the text
annotation first. Then position the insertion point to the right of the annotation
mark in the document and insert the voice annotation.
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Note You can customize the marks Word uses to show document differences. For

more information, see “Customizing Revision Marks,” earlier in this chapter. 

P To compare two versions of a document

1. Open the edited version of the document.to search

2. From the Tools menu, choose Revisions.

3. Choose the Compare Versions button.

name, and 4. In the Original File Name box, type or select the name of the original
document, and then choose the OK button.

Word displays the edited document marking inserted, deleted, and revised text

. . ._ with revision marks. The options for displaying revision marks are set on the
—-2% ‘ -V ' Revisions tab in the Options dialog box (Tools menu).

5. To accept or reject the revisions, choose Revisionspfrom the Tools menu. For
- ‘ more information, see “incorporating Revisions,” earlier in this chapter.

 

Fxrotecting a Document-for Annotations and Revisions
':r'I1'Iore information To allow reviewers to comment on but not make changes to a document, you can
0[1W3Y5 l0 P'°l9<—‘i 3 protect it for annotations. To allow reviewers to change a document and keep a

I 9°“"‘emv See . record of all changes, you can protect it for revisions.
_ chapter 21, “Opening,

ing the

For maximum protection, you should also use a password when you protect a
document for annotations or revisions. Otherwise, anyone can remove protection
from the document by choosing Unprotect Document from the Tools menu.

P To protect a document for annotations or revision marks

1. Open the document you want to protect.

2. From the Tools menu, choose Protect Document.

3. Do one of the following:

I To allow reviewers to insert armotations but not change the contents of the
document, select the Annotations option button.

- To track revisions, select the Revisions option button. The reviewers
cannot turn off revision marking, and revisions carmot be accepted or
rejected.

'4. To ensure that a document is protected against untracked changes, type a
password. This prohibits anyone who does not know the password from
unprotecting the document.

5. Choose the OK button.
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D To review and incorporate revisions

1. From the Tools menu, choose Revisions.

2. Choose the Review button.

3. Do one of the following: _

 
 
 
 
 
 

 
 
 

I To move to a revision mark, click the appropriate Find button to search
forward or backward in the document.

I Click a revision mark in the document. '

For each selected revision mark, Word displays the reviewer’s name, and
the date and time the revision was entered.

4. Do one or more of the following: 

 
 
 

 
 
 

To Choose this button

Accept a revision Accept
RejectReject a revision

, Leave the revision mark unchanged and
move to the next or previous revision

Undo the last acceptance or rejection of a Undo Last
revision

   

. .

 
 Note To automatically move to the next revrs' ion mark while reviewing the

revisions, select the Find Next After Accept/Reject check box.
 

To accept or reject all revision marks 1. From the Tools menu, choose Revisions.

2. Do one of the following: 

 
 
 
 

 
 

 

 

I To accept all revisions, choose the Accept All button.

I To reject all revisions, choose the Reject All button.

Word displays a message asking you to confum that you want to accept or
reject all revisions.

3. Choose the OK button.

Comparing Versions of a Document
To compare two versions of a document, you use the Compare Versions button in
the Revisions dialog box. During the compare process, Word inserts revision
marks that you can review and incorporate as described earlier in “Incorporating
Revisions."

Make sure that the two documents you are comparing have different frlenames,
or——if they have the same narne—that they are in different directories.

lllll lluI...u..: . .
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 552 Part 7 Using Word in a Workgroup '

> To unprotect a document for annotations or revision marks .
0 From the Tools menu, choose Unprotect Document.

If the author has protected the document with a password, you must know the

password to unprotect the document.
 

Routing a Document Online Y
You can use Word and Microsoft Mail or a compatible mail program to route
documents online. For example, you might want others to review an important
memo before sending it out, or you might want several people to complete an

online questionnaire or form.

maze 
lllllllilllillllllllllltl

You can route a document to all reviewers at or you can route it to one reviewer after
once another.

You can route online copies in two ways. You can send a separate copy to all
reviewers at the same time, or you can send a single copy that goes to each person
on the list in turn, allowing each reviewer to see the comments of all previous
reviewers.

Reviewers retum their annotated or revised copies to you or the next person on
the distribution list by choosing the Send command from the File menu. When all V p
the copies have been returned, you can merge the annotations and revisions into ‘; -
the original document to simplify review of the comments. For more information .« ‘_
on merging comments, see “Merging Annotations and Revisions," later in this 4! ‘
chapter.

..:; ttlu
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In must know the

gram to route

v an important
» complete an

To route the document to

reviewers one after another,
‘-‘dick here. 
Protect the document for
revisions or annotations.

To route the document to all

reviewers at once. click here.

> To route a document to others

1. Open the document you want to route.

2. From the File menu, choose Add Routing Slip.

3. Choose the Address button. Select the names of the people to whom you wantreviewer after
to route the document, choose the Add button, and then choose the OK button.

If you want to route the document to one recipient after another, use the Move

:e copy to all up and down arrows to put the names in the correct routing order.
es to each person 4. In the Subject and Message Text boxes, type the subject and any message or
fall previous instructions you want to send with the document. Each recipient will receive

the same subject and message.

Word automatically appends instructions to your message telling recipients to
choose the Send command when they are finished.

next person on
menu. When all

1 revisions into ‘
IOFC information ‘
.” later in this

5. Under Route To Recipients, do one of the following:

I To route one copy of a document to one recipient after another, select the
One After Another option button. ’

I To route multiple copies of a document to all recipients at the same time,
select the All At Onc_e option button.
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Part 7 Using Word in a Workgroup___j 

6. Select any other options you want, and then choose the Route button.

If you want to continue to edit the document before you route it, choose the
Add Slip button, and continue to edit the document. When you are ready to

send the document, choose Send from me File menu. Word displays a message
asking you to confirm that you want to route the document.

The document is sent to the distribution list as an attached Word file. The

recipients can add annotations or revisions to the document and then return the
copy to you by choosing the Send command on the File menu.

If the document is being routed to one recipient after another, the Send

command automatically routes it to the next person on the list before it returns
to you. You will receive all the recipients’ comments in one document after it
has been routed to the last person on the list.

If you send the document to all recipients at the same time, you will receive
multiple copies of the document. You can then merge all changes into one
document. For more information, see the following section.

Merging Annotations and Revisions
If you have given individual copies of a document to multiple reviewers, you can
combine their annotations and revisions into the original document. When you
merge annotations and revisions, any annotations and revisions already in the

original document are preserved as additional comments are merged. Word
assigns a different color to each reviewer. If there are more than eight reviewers,
Word uses the colors again, so some reviewers may share the same color.

Note Annotations and revisions ca.nnot be merged back to the original document

unless they are marked. To ensure that revisions to a document are marked, you
should protect the document for revisions or annotations before making the
revisions. For information on protecting documents, see “Protecting Documents
for Annotations and Revisions," earlier in this chapter.

> To merge revision marks and annotations

1. Open the document that has revisions you want to merge into the original
document.

2. From the Tools menu, choose Revisions.

3. Choose the Merge Revisions button.

ilillllllillIllllllIIIllmillIiIIllmmmuumllillllIllilllllillllilillllliilllllillllilllilillIllllliillllllllllllllllllllilllliAif“,,g 
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572 Part 8 Using Word with Other Applications

Opening a Document Created in Another Application
To convert documents to and from different file formats, you must install the

appropriate converters. To import and export graphics contained in documents,
you must install graphics filters. If you performed a complete installation when

you installed Word, converters and graphics filters were also installed. If not, you
can run the Microsoft Word Setup program again. For instructions, double—click
the Help button on the Standard toolbar, and then type setup

Converters change the file format of a document, and they use graphics filters to
import and export graphics that are within, or linked to, a document. For
informa'tion about converting graphics files in such formats as TIFF and PICT,

and for a list of supplied graphics filters, see Chapter 16, “Importing and Creating
Graphics.”

If you want to import data from a database into a Word-document, you have three
options; To convert an entire database file from database applications that Word
can convert, such as Microsoft Excel, use the procedure under “Opening a
Document,” later in this chapter. To use information from a database to print form

letters, mailing labels, and other types of mail merge documents, see Chapter 29,
“Mail Merge: Step by Step,” and Chapter 30, “Mail Merge: Advanced
Techniques." To insert information from a database into a Word document as a

table, see Chapter 28, “Exchanging Information with Other Applications.”

To convert several documents at once, use the batch conversion macro

BatchConversion in the CONVERT.DOT (Windows) or Conversion Macros
(Macintosh) template. For infonnation about using this macro, see “Converting
Several Documents at Once,” later in this chapter.

Supplied Converters
Word provides converters for the applications in the following list and for several
plain-text file formats. For infonnation about specific converters, and for
instructions on how to obtain supplemental converters and graphics filters that

were not shipped with Word, double-click the Help button on the Standard
toolbar, and then type readme. Press ENTER twice, and then click File
Conversion.

Converters Supplied with Word for Windows .
Microsoft Word for Windows Microsoft Word 3.0-6.0 for MS-DOS

Microsoft Word 4.: and 5.x for the WordPerfect 5.x for MS-DOS and

Macintosh . Windows

0 urinnnuirnlrilni r lhllli
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Lotus 1-2-3 2.x and 34*’

RFI‘-DCA
Microsoft Write for Windows

Microsoft Excel BIFF 2.x, 3.0, 4.0”’,
and 5.0

‘ The converter can open. but not save. documents in this file format.

Converters Supplied with Word for the Macintosh
Microsoft Word for Windows WordPerfect for MS-DOS and
Microsoft Word 3.x for the Macintosh* wi"d°w5 5
Microsoft Word 4.x and 5.: for the Ma°W“‘°°
Macintosh MacWrite II 1.1‘
Microsoft Word 3.0-6.0 for MS-DOS Microsoft Excel BIFF 3.0, 4.0*, and
Microsoft Works 2.0 for the Macintosh 5-0

RFT-DCA

‘ The convener can open, but not save, documents in this file format.

Opening a Document
To convert most types of documents, simply open them. Word automatically
opens a copy of the document and converts the copy to Word format.

Select the type ol document you want to open.
Select All Files it you're not sure ol the documents extension.

Select the drive and directory or folder
where the document is located.

Type or select the filename and choose
the OK button. 

Most of the time, Word recognizes the file format, converts the document, and
then displays it in a Word window. If Word cannot recognize the format, it
displays the Convert File dialog box. Select the appropriate file format, and then
choose the OK button. Word converts and opens the document.

‘AW“’mW"‘ii"iiiiiI"IlllllllllllllillllllllllllllllllllillilliiilllilliiillillillllliiiliiliiillIllliliilliillllni.
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574 Pan 8 Using Word with Other Applications 

If a document isn't converted correctly, close it without saving changes and then
try convening again using a different converter. The original document remains
unchanged until you save it in Word format or in some other format. You can also

change the way Word converts some items. For more information, see
“Customizing Conversions and Improving Compatibility,” later in this chapter.

* To open a file created in another application

1. On the Standard toolbar, click the Open button. ‘
099” b”“°" 2. In the List Files Of Type box, select the type of file you want to open. If you

do not know the type of document or file format, select All Files.

3. In the File Name box, type or select the document you want to open.

lI

il
l
I

If the document you want to open does not appear in the File Name box, select i

a different drive, directory, or folder. {
.4. Choose the OK button to convert a copy of the document to Word format.  
 
 
 

 If the converter you need was not installed when you installed Word, Word

displays the Convert File dialog box and asks you to choose a converter. To
install additional converters, you need to run the Microsoft Word Setup program

again. For online instructions, double-click the Help button on the Standard
toolbar, and then type setup

  
  

 Using the List Documents Of Type Box (Windows)

If you don't see the document you want to open in the File Name list, try selecting
one of the options in the List Files Of Type box; these options are described in the
following table. If you don’t know the extension of the document you're looking
for, or if it doesn’t have an extension, select All Files.

  
  
  

  
  

 

 

 

  
  
 

Select To display

All Files (‘.‘) All documents in the selected directory.

Word Documents (.doc) Word documents and other documents with the .DOC
filenarne extension.

Document Templates (.dot) Word templates with the .DOT filename extension.

Rich Text Format (.rtf) Documents with the .RTF filename extension. For more

  information, see “Opening or Saving a Plain-Text File,”
later in this chapter.

Text Files (.txt) Documents with the .TXT filenarne extension. Includes
documents saved as ASCII text or MS-DOS text,

including Text Only, Text With Line Breaks, and Text
With Layout For more information, see “Opening or
Saving a Plain-Text File,” later in this chapter.
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CreatingaLink . _ _ _

Stan an application that supports OLE or DDE, and then open the source file.
Select the information to which you want to create a link, and then choose Copy

from the source application’s Edit menu. In the Word document, position the
insertion point where you want the linked object, and then choose Paste Special
from the Edit menu. Select the Paste Link option button, select the type of linked

object in the As box, and then choose the OK button.

Select Paste Link to create a
link

Select the type ol linked
object. 

The Paste Special dialog box

Editing an Embedded Object
Double-click the object to edit it. Some applications open a separate window for
editing. Others temporarily replace some of the Word menus and toolbars with
those of the source application. If the application opens a separate window, you
return to Word by choosing Exit from the application's File menu. If the

application replaces the Word menus and toolbars, you return to Word by clicking
outside the embedded object.

Editing a Linked Object

To edit the linked object itself, select the object and then choose the object’s name
from the Edit menu. For example; if you select a link to a Microsoft Excel
worksheet, the command on the Edit menu is Microsoft Excel Worksheet object.

When you choose the command and then choose Edit from the submenu that
appears, the source application opens for editing. To update, reconnect, or break a
link, choose Links from the Edit menu, make the changes, and then choose the
OK button.

 

 See the following pages for detailed information. 
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For an example of
embedding an object,
see "Examples of
Embedding and
Linking,‘ later in this
chapter.

For more inionnation.
see “Embedded

Objects and Links Are
Represented by
fields," later in this
chapter.

 

602 Part 8 Using Word with other Applications

Embedding Objects

 

Embedding means inserting information, such as a chart, an equation, or
spreadsheet data, in a Word document. Once embedded, the information—called
an objecr—becomes part of the Word document. When you double-click an
embedded object in Word, you open the application in which the object was
created; the object is displayed and ready for editing. When you return to Word,
any changes you’ve made to the object are reflected in the Word document.

Without leaving Word, you can embed an existing file or create and embed a new
object. An embedded object increases the file size of a Word document, because
the object is stored in the Word document. For example, if you embed a Microsoft
Excel worksheet in a Word document, the file size of the Word document

increases by approximately the file size of the worksheet. The file size increases
even if you display the object as an icon in the Word document, because Word
still stores the information about the file.

Creating an Embedded Object
Suppose you want to create a chart in a Word document. Position the insertion
point where you want the chart, and then choose Object from the Insert menu.
Word displays a list of the types of objects you can create and embed. Select
Microsoft Graph in the Object Type box, and then choose the OK button. Word
opens Microsoft Graph, in which you can create a chart. When you quit Microsoft
Graph, the chart is displayed in your Word document. When you want to edit the
chart, double-click it to start Microsoft Graph; you can then make changes to the

Select the type oi object
you want to embed.

Select this check box to

display the embedded
object as an icon in the
Word document.

You use the same process to create any other type of object, such as an equation. a
Microsoft Excel worksheet, or even a Word object. The only difference is in the

type of object you select in the Object dialog box. Whatever type you select,
Word opens the appropriate application for creating the object.  
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Note The applications you use to create embedded objects must have been
properly installed by using their original installation programs; otherwise, they
may not be listed in the Object dialog box. Supplemental applications supplied
with Word (WordArt, Equation Editor, and Graph) must be installed by using the
Microsoft Word Setup program. 

 

  
  
  

In addition to creating embedded objects as you work, you can embed existing
files or parts of files. If you embed an existing file, Word stores an independent
copy of the file in the Word document. The original file remains unchanged, even
if you change the embedded file. Changes to the original file don't affect the
Word document.

 

  
  You can display an embedded object as an icon by selecting the Display As Icon

check box in the Object dialog box when you insert the object. You might want to
Microsoft Excel icon use this option when the Word document will be read on-screen and the

' embedded object contains supplementary information. For example, if the Word
document is a summary of financial data from several Microsoft Excel .

worksheets, you might want to embed one of the worksheets as an icon next to the

paragraph in the Word document analyzing that portion of the data. If readers

want to see the data, they can double-click the icon to open the worksheet. If you
print the document, the icon is printed at its current position in the Word
document. Some objects created from a file—for example, ASCII text files-—are
always displayed as icons. You can change the icon by choosing the Change Icon
button, which appears when you select the Display As Icon check box.

    
  
  
  
  
  
  
  
 

Note If the source application supports drag-and-drop editing, you can embed an
object by selecting information in the source application and then draggingit. into
the Word document.  

  
The Object dialog box (Create From File tab)
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> To embed an object

1. Position the insenion point where you want to embed the object.

2. From the Insen menu, choose Object.

3. Do one of the following:

- To embed a new object, select the Create New tab. In the Object Type box,
select the type that describes the application in which you want to create
the object, and then choose the OK button.

The contents of the list depend on which applications installed on your
computer support linking and embedding.

I To embed an existing file, select the Create From File tab. In the File Name

box, type or select the name of the file you want to embed, and then choose
the OK button.

If you do not see the file that you want to embed, select a different drive,

directory, or folder, or choose the Find File button to search for the file you
want.

. 4. To display the object in the Word document as an icon instead of as the object
itself, select the Display As Icon check box.

‘ 5. To return to Word, do one of the following:

- If the object was created in another application that is in a separate

window, choose Exit from the File menu in that application. If a message
appears asking if you want to update the document, choose the Yes button.

I If the application temporarily replaces some of the Word menus and

toolbars, click anywhere outside the embedded object.
 

Note An embedded object increases the file size of a Word document because the
object is stored in the Word document. If you want to reduce the file size, see

“Converting an Embedded Object to a Graphic,” later in this chapter. 

1. In Word, position the insertion point where you want to embed the selection.

2. Switch to the source application, and then open the file from which you want
to select information to embed in the Word document.

3. Select the information you want to embed in the Word document.

4. From the Edit menu in the application the selection was created in, choose
Copy.

To embed a selection from an existing file

.5
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5. Switch to Word, and then choose Paste Special from the Edit menu.

6. Select the Paste option button.

7. In the As box, select the first item with the word “Object” in its name.

To display the embedded information as an icon in the Word document, select
the Display As Icon check box.: box,

ate 8. Choose the OK button.

,1. For information about When you embed an object, Word adds an {EMBED...} field to the document. If
eld 00d9S. 599 _ you see this field instead of the object you embedded, select the field and press

_ .- ChaPi9'.3-7-~ ","-59”'“9 Si-II}-‘r+F9, or choose Options from the Tools menu, select the View tab, and then
Name ""‘f°”"at'°" ‘mm clear the Field Codes check box.
choose = . elds."

Editing an Embedded Object

   

 
 

 
 

 
 

 
 

   

        

 
 

 
  

  

 
 

 

   

  

 

V

:ee):°u In most cases, double—clicking an embedded object opens the application in which
.. it was created. Note, however, that double-clicking some graphics brings up the

Meet Drawing toolbar rather than the original application.
For certain applications, some of the Word menus and toolbars are temporarily
replaced by those of the original application. For other applications, a separate

window opens, which contains the object in its original application.

13:“ Double-dick the embedded equation to edit it.
=7? _. - . ""Eic7§=fiW-=?i1'—'E>?EEiSf«¢é?0§Eff. I ""T:'.T?
E

==EEiE§E§§.“lE|E3E

5l—[‘i‘—- -= ==*‘— I; J E515.-E'E£tE} ESE] E: Equation Editor7 %naah:|n -- In|:nd‘u-ndhnpnbhu .

‘Se me *' —-aid‘-e temporaniy replaces
e ' _ ______>_ __W__ _ someottheword

-’ . :. _, _ _ -.. _ , '~‘7|.=,1x,5°€‘W9'-1" .E><C'W*Gi:?99°‘ .. ., . . if.‘ menus and toolbars.

-----------------E

cumtmatui.-an-ui_ar'—an-pnsu C|id( in the

. '7'“"“"; document to return
IOU. v -=‘§n:r A I to word.
1./ant ......................................................... ..

Some applications, such as Equation Editor, temporarily replace the Word
menus and toolbars for editing.

naliiiiiiiiiiIIiiiiii“ummmiiiiiilii.
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Doubleclick the embedded Paintbrush object.

 
 

 
 

_
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. . '7-5* The Paintbmsh
The Spirit of t application starts

Adventurer 51:1 .. so that you can
Anadman isadamywtdm .. . ed" the oblectampwzurlyvai also 'noNe|smni'sk.I .
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Some applications open a separate window for editing.

To edit an embedded object directly

1. Double-click the embedded object.

2. Edit the object.

3. Do one of the following:

I If you are editing the object in a separate application window, choose either
Exit or Quit from the File menu to return to Word.

I If you are editing the object in an application that temporarily replaces the
Word menus and toolbars, click anywhere outside the embedded object toreturn to Word.

 

Tip You can use a shortcut menu to carry out common commands for editing an
embedded object. Click the embedded object using the right mouse button
(Windows) or hold down CTRL and click the embedded object (Macintosh), and
then choose a command from the shortcut menu.
 

To edit an embedded object by using the Object command

1. Select the object you want to edit.

2. From the bottom of the Edit menu, choose the name of the object you want to
edit, and then choose Edit.

_ If you see both an Edit command and an Open command, choose Open to edit
the object in its own application window, or choose Edit to edit the object in
the Word window (the Word toolbars and menus may change).

=atinllIIlllllllllllillllllllllllllllllllllllillllllllllllllllllllillllillilllllllllllilllllitllllllllllllifii
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i E " ' ,1, 

'0 7 «I _ Note Some embedded objects, such as video and sound clips, play when you
3' ~’. . double-click them, instead of opening an application for editing. To edit one of

these objects, select it, choose the name of the object from the Edit menu, and
then choose Edit.

Converting an Embedded Object to a Different Format
-ugh Suppose you receive a Word document that has a Microsoft Excel worksheet
5:,-ms embedded in it. Microsoft Excel is not installed on your computer, but you do
can have another spreadsheet application. When you double-click the Microsoft Excel
act. worksheet to edit it, Word displays an error message saying that the Server could

not be found. Select the worksheet, choose the Object command from the Edit

menu, and then choose Convert. In the Convert dialog box, you can specify which

application you'll use in the future to edit the object. The applications displayed
in the list are the applications installed on your computer that are capable of

converting the object to their respective file formats.

If you select the Convert To option, Word converts the embedded object to the
format you choose in the Object Type box. The object remains in this format
unless you specifically convert it to another format.

Now suppose you have to return the Word document to the person who created it. _
You know that this person uses Microsoft Excel; therefore, you don’t want to y
permanently convert the embedded object to a different file format. However, you
do want to be able to edit the embedded object on your computer. By selecting the

Activate As option in the Convert dialog box, you can specify that all embedded
Microsoft Excel objects are to be temporarily converted to the file format you

specify. When you edit the object question, you use the new application, but

either 0 r..-_...-....-.
-:l

5 me changes are saved in Microsoft Excel format. When you double-click the object, it ‘E
ct to is temporarily convened to the new format.

If you select the Activate As option, Word converts all embedded objects of the .
—— selected type to the format you specify in the Object Type box. You can edit the i|'j

g an objects in the application you specify, but Word saves changes to the objects in lljtheir original file format. 3 I i
and 7}; .ll? 5

 
5 Select this option button to convert

.* an embedded object to a diflerent
'" " . iilelormat.  ?

 
__:.:.+.-..-._-:,,..,._..  
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608 Part 8 Using Word with other Applications

P To convert an embedded object to a different file format

1. Select the embedded object whose source application you want to change.

2. From the Edit menu, choose the name of the object you want to convert, and
then choose Convert.

3. Do one of the following:

- To permanently convert the embedded object to the file format you specify
in the Object Type box, select the Convert To option button.

I To activate all embedded objects of the selected type in the file format you
specify in the Object Type box, select the Activate As option button.

4. In the Object Type box, select the application whose file format you want to
convert the embedded object to, and then choose the OK button.

Note If you upgrade to a more recent version of an application after creating an
embedded object with that application and then want to edit the object, you must
first convert the object to the current version of the application.

Some applications can convert files created in older versions of the application to
the newer version when you open the file. When you run the application's setup j‘
program, you may be able to specify whether files are converted when you open ,
them.

Converting an Embedded Object to a Graphic
All embedded objects are represented in Word documents as graphics. You can
think of one of these graphics as a facade with information behind it. For
example, a Microsoft Excel worksheet embedded in a Word document looks like
an ordinary worksheet, but it is actually a graphic, or picture, of the original
worksheet. Behind the graphic is all of the infomiation necessary to open and edit
the file in Microsoft Excel. When you convert the Microsoft Excel object to a

- graphic, you remove the information behind the facade—that is, the information
that enables Word to open the object in Microsoft Excel for editing.

Converting an embedded object to a graphic reduces the file size of the Word
document. If you double-click the object after converting it to a graphic, Word *_
opens a separate window and displays the Drawing toolbar so that you can edit _ g.
the graphic just as you would edit any other graphic.

5 To convert an embedded object to a graphic

1. Select the object you want to convert.

2. From the Edit menu, choose the name of the object you want to convert,
then choose Convert.

and
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 ‘

3. In the Object Type box, select Picture, and then choose the OK button.

 

 

 

 
 

 
 
 

 

 

zhmga Using the keyboard You can convert objects to graphics quickly by using shortcut
‘Venn and keys. Select the embedded object, and then press CrRL+sHIl-'r+F9 (Windows) or

COMMAND+SHII=T+F9 (Macintosh) This method does not create an {Embed} field
.f _

‘W’ Y Linking to Another File

format you Let’s say you are preparing a monthly report for the accounting department that
non. must include up-to-date sales data The sales department maintains this constantly
J wam I changing data in a Microsoft Excel worksheet. You can link your Word document

0 to the sales worksheet (or a portion of it) and specify that your document be
automatically updated if the worksheet changes. Each time the sales department
changes the worksheet, the changes are reflected in your Word document.

1'; When you link to another file, Word stores the link in the fonn of a field code that
indicates the source of the object. In addition, Word usually stores a visual

_ _ repiesentation of the linked information.ilicauon to

 

 
  

n’s setup You can create links between two Word documents or between a Word document
you open and a file created in another application. Once you have established a link, you

can update it with a single keystroke, or you can specify that the data be updated _
in your Word document as soon as it changes in the source file. ;

Forinformation 3bOU1 - .. .' __ .".}. '~."._, v:‘:.‘_-:"j._ f C j _ :_- -.j _; 1 _. _ .- ',- it «I; "f
fie|ds,seeCh ter32, - A ‘-.-'~' .. ‘ -1 1' '2 9 " " ‘TYOU can ‘Inserting lnfoarrfiation Embedded Objects and by: fields" A.‘ 7

Jr . Fields.’ _ *L_inked‘an'd embedded objects in-Word are-:repijesen_ted‘by l=looks like - . .__woi~kj,_ng. withs_field= codes displayed, yot1‘don’t see the linked _or_5. embedded.aim] U T ‘ . . ., . . . 

zct to a the following _in"a Word for Windows c_l_ocuinent:-._ ». '
formation . 2 '_ ._ _ v. L - -=_ K: J 7 -'

' ' {LI_N_K"E_xcelfNo_rksh_ee_t’ "C:\\EXCEL\\:S_ALlES.X R1_C1‘:_R9(__‘75.f'»'-\a‘;'_\p_}_ I

Word I ' orIikeithe,fol1owing;itia_'Word;for the.lyIacintosh..docun1ent3 _1
Jan _ .» T {LINK ExcelHonksheetv‘-_g"Ha4r,d Drt'ye_ -R _

..su.izii.i.i.ii|iii.in.:ii.ii

' :_ example, the code-for a linkztoa Mici'o‘so_ft._E‘xcel;_woi'ksheet look

_1fo"s;'$e'éi13y7wiie'tli‘ £heiah,"ci§i£;efit‘6§"ih¢:‘—hei

‘H ' ' fl.1~‘='._F_1:€1‘._§!;,-,.C_{)<y.ié=S_,'.C‘l.1¢‘.C1_:<4' -b01$-ah" 7: 5 ‘- V - --

 
  

 
object i_t_se'1f;" you see the‘ code that _Word uses to designate the objec‘t.‘Fo'r

 

 »3‘?LT1‘1=::'4 
 

 
  
 

  
 

  
-Options‘ from‘ the5—"I‘ools '_l‘I'1_et_'lll’,": select the View/itab; and
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Creating a Link
Creating a link is as easy as copyi
(the source) and paste it into your
Paste Special command on the Edit menu.
must save the source file to disk.

 _

important To create a link between a Word document and another application,
you must be running both applications, and the other application must support
dynamic data exchange (DDE) or object linking and embedding (OLE). On the
Macintosh, you must be running both applications with System 7 or later, and
your computer must have enough memory to run both applications at the same
time.

ng and pasting. You copy a selection from a file
Word document (the destination) by using the

Before you can establish a link, you

. Select Paste Link to create
-'i' .. alink

' ‘aw _... ... + 
The Paste Special dialog box

To create a link to another file or Word document

1. Make sure that you save the source file before you link the information.

2. [:1 the application in which the information you want to link was created, open
the source file and then select the information you want to link.

3. From the Edit menu, choose Copy.

. Switch to the Word document, and then position the insertion point wh
want to insert the linked information.

5. From the Edit menu, choose Paste Special.

6. Select the Paste Link option button.

. Under As, select the format you want, and then choose the

ere you

OK button.
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> To create a link to another file or Word document without leaving Word
I. From the Insert menu, choose Object.

2. Select the Create From File tab.

3. In the File Name box, type or select the name of the file to which you want tolink.

4. Select the Link To File check box, and then choose the OK button.

Using this method, you can create a link only to an entire file; you cannot link to a
selection in a file.

 
Note Word creates automatic links by default. Word updates automatic links each
time you open the Word document. whereas it updates manual links only when
you specify. For information, see “Updating a Link,” later in this chapter. 

Reducing File Size of Documents Containing Linked
Graphics _ ‘
When a Word document contains links to graphics files, you can reduce the file
size of the Word document by storing only the links. By default, Word stores in
the Word document a “picture” of the linked graphic, which increases thefile size
of the Word document by the number of bytes taken up by the picture. To reduce
the size of the Word file, you can specify that Word store only the link itself and
not the picture. '

If you store only the link, the file size of the Word document will not increase

appreciably. However, if the source file is not available, you will see only a
rectangular placeholder in your document and the linked data will not be printed.
If the source file is available, Word displays a picture of the object based on data
in the source file, but it does not store the picture in the Word document. Because

the picture is created from the source file itself, you may notice that it takes longer
to display the picture than if it were stored in the Word document.

If the picture is stored in the Word document, Word displays a picture of the
linked graphic regardless of whether or not the source file is available.

> To reduce the file size of a document containing linked graphics
1. From the Edit menu, choose Links. '
2. In the Links dialog box, select the link or links to the graphics files.
3. Clear the Save Picture In Document check box, and then choose the OK

button.

 ll iIllllllllllilllllllllllll|lllllllllllllilllllllIllllllmm...

Petitioner Apple Inc. — Exhibit 1002, p. 3834



Petitioner Apple Inc. - Exhibit 1002, p. 3835

 
 

 
 
 

 
 
 

 
 
 
 

 

 
 
 
 
 

 
 

 

612 Part a Uslng Word with Other Applications ' l

Reconnecting or Changing a Link
You may lose a link if you rename or move the source file. If this happens, you '
must reconnect the link to the original source file or redirect the link to a different
file.

F To reconnect or change a link

1. From the Edit menu, choose Links.

2. From the list. select the link you want to reconnect or change. To select
multiple links, hold down CFRL (Windows) or SHIFI‘ (Macintosh) while you
click each link.

3. Choose the Change Source button.

4. In the File Name box, type or select the name of the file to which you want to
reconnect or change the link, and then choose the OK button.

If you do not see the file you want to open, select a different drive, directory,
or folder, or choose the Find File button to search for the file you want. '

lf‘ you have other links to the same source file, Word asks you to confirm that you
want to change all links from the previous source file to the new source file.

Updating a Link A
When infonnation in the source document changes, Word can update the
information in the Word document. You can specify either manual or automatic

updating for each link. By default, newly created links are set to automatic
updating, but you can easily change a link to manual updating.

- Word updates automatic links when you open the Word document and any
time the source document is changed while the Word document is open.

I Word updates manual links only when you choose the Update Now button in
the Links dialog box (Edit menu) or when you position the insertion point in
the linked object and press F9.

.--A-nu.-.u...-u
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znt drive, directory, 4

file you want. _

n to confirm that you
ew source file.

1 update the
tnual or automatic
to automatic

click each link.

3. Do one of the following:

I To update linked infonnation every time there’s a chan
. . ' ., ‘ select the Automatic option button next to Update.ncument and any ‘-' ‘ ' . .

"mm is 0 en I To update linked infonnation onZ ' __ option button next to Update.
litgjrggn :o[::1i:l if ~—=— 4. Choose the OK button.

ge in the source file,

ly when you choose, select the Manual

’ To update a link manually
I. From the Edit menu, choose Links.

click each link.

3. Choose the Update Now button.

For each selected link, the destination document reflects any changes made in
the source file since the last update.
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You can also click the
Insert Microsoft Excel
Worksheet button on

the Standard toolbar
to embed a
worksheet.
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Examples of Embedding and Linking
The following two scenarios illustrate common uses of embedding and linking.

Embedding a Microsoft Excel Worksheet in Word
Embedding is a way to get fast access to the features of another application. In the
following example, a table illustrates the relationship between various bicycle
designs and the drop in wind resistance. You can create a Word table to present
the data. However, if you embed a Microsoft Excel worksheet instead, you can
use the more powerful Microsoft Excel formulas to calculate the results you want
to present.

  
mution.Ya1the design at bicycles has not changed In reduce in!not tor ladrof inventive ideas. 5

(‘£ImI.SIh.IrrdFruIdrlm|r'¢lnAuudyrn1rrlcBlc1fla
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t~iqdesAGerrnanna1nodE. Va.rrlla.a_$wtssna.rnedos§
mtemathruJcycflngFedemrionwrooogrrhemavahioolg;ax'r"r‘ri1deégns in the commen:'al bicyda industry. Urrltnummty.lrom its wrrvetnicns
 

 
 

 

when a Emndr ' er:
’ ticyda that placed 9 q

later Faunaah
‘ Use a formula in Microsolt Excel

to calculate the data.  

heet, position the insertion point where you want
ose Object from the Insert menu. Select the

1 Worksheet in the Object Type box, and
1 opens, and you can now create the

from the File menu in Microsoft

update the worksheet in your

To create and embed the worls
to embed the worksheet, and then cho
Create New tab, select Microsoft Exce
then choose the OK button. Microsoft Exce
worksheet. When you have finished, choose Exit
Excel. A message appears, asking if you want to
document; if you choose the Yes button, the worksheet is inserted into the Word
document. You can double-click the worksheet object in the Word document at
any time to open Microsoft Excel and make changes.

Linking a Microsoft Excel Worksheet to a Word Document
Linking is a good way to make use of information that's stored and updated in
other files. The following example shows a monthly sales report that contains data
for a three-month period. The data is maintained by the sales department in a
large Microsoft Excel worksheet that also contains a lot of other data. By creating
a link to a specific section of the worksheet, you give yourself immediate access
to the most recent data needed for the monthly report. If the sales department
changes the worksheet, the Word document can be automatically updated.

J
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Month's Sales
Sales Forums!

cumulative Sales

‘To create the link, open the sales department’s Microsoft Excel worksheet, select
the data you want to include in the report, and then choose Copy from the Edit
menu. Open the monthly report in Word, position the insertion pomt where youeel "

ere you want -‘

,m,_ sclect me ". document. However, you can prevent automatic updates by choosing Links from
,pe box, and _ . the Edit menu, selecting the link, selecting the Manual option button at the bottom
W create me . _' of the dialog box, and then choosing the OK button.

:eltninM1§ru:s° ; 7 You use this same process to link other items—-such as graphics or Microsoft‘mo theyw°rd' Excel charts-—to the Word document
document at

locument

. updated in exchange information between documents in different applications or on different
at contains da computers connected by a network To make part of a document available for use
[mem in a with other applications or for other users on a network, you can create a pllb[l.§‘h(.’I‘
ta. By c'reafing'_'. for that portion of the document. A publisher contains the pan of the document
‘edme access you want to sbare—text, graphics, spreadsheet data, and so forth
epartment -f_.‘ -
pdated. ‘
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When you create a publisher, Word automatically creates an intermediate file
called an edition, which contains a copy of the information that's in the publisher_
An edition is a separate file that can be saved on a hard disk or a network server_
When you change information in the publisher, these changes are reflected in the
edition and in all documents subscribing (similar to linking) to the edition. You

can specify how often Word sends.updated information from the publisher to the
edition. You can also specify how often subscribers receive updated information
from the. edition.

Publisher Edition Subscriber

__-__-..-.-----—----..--------------------------u--------3u-------—-—————-—---------------------I-—--—-----—---—----------——-—---—_-----  
Changes in the publisher are reflected in the edition and in all documents

subscribing to the edition.

You can name and move an edition just as you would any other file. The
connection is maintained even if you change the name of the edition. However, if
you want Word to maintain the connection to all publishers and subscribers, do
not move the edition off the server volume or hard disk.

You can publish and subscribe from any application that runs under System 7 or
later and supports publishing and subscribing.

Creating a Publisher and an Edition
Use the Create Publisher command to publish information from a Word
document. You can edit a publisher the same way you edit other pans of a
document. When you create a publisher, Word puts gray brackets around the part
of the document that constitutes the publisher. You can see the brackets when you
click the Show/Hide 1| button on the Standard toolbar, but the brackets are not
printed.

Word uses a bookmark to mark a publisher. The name you give the edition when
you create a publisher is the name Word uses for the bookmark. If there is already
a bookmark by that name. Word adds a number to the end of the bookmark name
to make it unique. If you delete the bookmark, the publisher is deleted as well.
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The Preview box displays the beginning of the publisher.

 
 

 

 
 
 
 
 

 
 
 

 

 
 

 
 
 
 

 
 

 

 
 

 
 
 

 

.nediate file

in the publisher.
.etwork server.

reflected in the
: edition. You

nublisher to the

:d information

Type a name for the edition here.

Preview

Oraantn

faiindod five yer: ow byconductor and rmsie
director Hidnul Bum,our city‘: fines!
orchestra is new

”°"‘°',,,.,,,,,,',‘1A°,",::._,:';',,',‘: Name of new edition:Ifibel has ontoruhod the public 
The Create Publisher dialog box

5 To create a publisher 
v 1. Select the information you want to publish.

If you publish an entire document, including the final paragraph mark, Word
mumems includes any material that’s added to the document later as part of the
to the edition, publisher. To add information you do not want to publish to the end of the

document, exclude the final paragraph mark from the selected information. '
e. The 4 2. From the Edit menu, choose Publishing, and then choose Create Publisher.
'"' Pioweven If 3. Switch to the disk or open the folder in which you want to store the edition.bscnbers, do

If you want to store the edition on another Macintosh, choose the Desktop
button. Word displays all of the available hard disks and servers. Select the
computer you want, and then select the folder you want from the list.

4. In the Name Of New Edition box, type a name for the edition.
5. Choose the Publish button.

r System 7 or

Vord Word encloses the published information in brackets.

.415 of a Each time you create a new publisher, Word creates a new edition If you
round the part publish several pans of the same document, each publisher has its ownzkets when you i ' separate edition.

Note If you want to make editions available to o
ther computers on a network, you

must store the editions on your hard disk and use the file sharing option; make
sure to share the folder that contains the editions. To share files on the Macintosh
under System 7, choose Control Panels from the Apple menu, double-click the
Sharing Setup icon; and then choose the Start button under File Sharing. For more
information, see your Macintosh system documentation
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Update options

D Drthes than V

To update the edition 
Select the On Save option button.

620 Part 8 Using Word with Other Applications

Updating an Edition
Once you have created a publisher and anedition, you can specify how frequently
you want to update the edition with changes you make to the publisher. Unless
you specify otherwise, Word updates the edition as soon as you save changes to
the publisher. There are three update options in the Publisher Options dialog box:
On Save, Manually, and Send Edition When Edited. These options are described
in the procedure following this illustration.

Ira Descrlp

The Publisher Options dialog box

P To control how an edition is updated

1. Select the publisher whose update frequency you want to change.

2. From the Edit menu, choose Publishing, and then choose Publisher Options.

3. Under Send Editions, do one of the following:

Whenever you save the publisher

Only when you choose the Send Edition
Now button

Whenever you make changes to the
publisher

4. Choose the OK button.

Ill IlllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllIllllllllllllllllllllllllllllll

Do this

Clear the Send Edition When Edited

The date of the most recent edition

check box, and then select the
Manually option button.

Select the On Save option button, and
then select the Send Edition When
Edited check box.

M
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> To send an edition manually

 
 
 

 

 
 

 
 

 
 

 
 

 

)w frequemly 1. Select the publisher you want to update.
er. Unless 2. From the Edit menu, choose Publishing, and then choose Publisher Options.Ch3I18°5'° 3. Choose the Send Edition Now button.s dialog box: _

"’ "°“"“’°" Canceling a Publisher
If you decide that you no longer want to publish information in your document,Ion

other file.

> To cancel a publisher

1. Position the insertion point in the publisher you want to cancel.
2. From the Edit menu, choose Publishing, and then choose Publisher Options.

‘3. Choose the Cancel Publisher button.

:r Options.

in button.

Vhen Edited V
ct the

D To subscribe to an edition

1. Position the insertion point in the document where you want to insert a copy ofthe edition. '

-n button, and . Make sure that the insertion point is not positioned in another subscriber in theion When - . . __ _ document.

2. From the Edit menu, choose Publishing, and then choose Subscribe To.

ll it
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the list of files, select the edition you want to subscribe to.
ard disk or another computer, choose the
ailable hard disks and computers. Select
d then select the edition from the list.

3. From

If the edition is located on another h
Desktop button. Word displays all av
the hard disk or machine you want, an

4. In the Subscribe With box, select the fonnat you want to use for the subscriber
data.

5. Choose the Subscribe button.

Updating a Subscriber
When you've subscribed to an e
to receive updated infonnation from the
Word updates the subscriber automatically as soon as a ne
that is, any time the publisher sends changed infonnation to the edition.

dition, you can specify how frequently you want
edition. Unless you select another option, ,

w edition is available—-

To control how a subscriber is updated

1. Select the subscriber whose update frequency you want to change.
2. From the Edit menu, choose Publishing, and then choose Subscriber Options.
3. Under Get Editions, do one of the following:

Choose
To update the subscriber

The Automatically button
Whenever a change is made in the edition

Only when you specify ‘Hie Manually button

bscriber affects only how often the
Note Changing the update frequency of the su
subscriber receives updates from the edition, not how frequently the publisher
sends updates to the edition. You set the update frequency of the publisher

“Updating an Edition,” earlier in this chapter.independently. For information, see

To update a subscriber manually
1. Select the subscriber you want to update.

2. From the Edit menu, choose Publishing, and the

3. Choose the Get Edition Now button.

n choose Subscriber Options.  
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Note You can format a subscriber, but Word overwrites the subscriber each time

it receives an updated edition as long as the \* MERGEFORMAT switch remains

in the field. For more information, double-click the Help button on the Standard
toolbar and type format (\") switch 

Switching from a Subscriber to Its Publisher
If you need to change the contents or formatting of a subscriber, it's best to make
the changes in the publisher itself. This way, the changes will be reflected in the
subscriber. If you are connected to a network, you must have access to the
publisher to perform this procedure.

To switch from a subscriber to its publisher

1. Select the subscriber you want to edit.

2. From the Edit menu, choose Publishing, and then choose Subscriber Options.

3. Choose the Open Publisher button.

Word opens the document that contains the publisher you want.

4. Make the changes in the publisher.

When you finish making changes in the publisher, save and close the
document. Each subscriber reflects the changes according to the update

options you've selected in the publisher and subscriber.

Canceling a Subscriber
If you do not have access to the publisher to make changes and you do not need to
receive any more updates from the edition, you can cancel the subscriber. You
can then edit the information as you would edit any other text, without losing any

changes when updates are sent. The contents of the subscriber remain in the
document.

To cancel a subscriber

1. Select the subscriber you want to cancel.

2. From the Edit menu, choose Publishing, and then choose Subscriber Options.

3. Choose the Cancel Subscriber button.

Word asks you to confirm that you want to cancel the subscriber. When you
cancel a subscriber, Word deletes the brackets surrounding the subscriber.
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Inserting Tablesof Information from a Database
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Sometimes you may want to include in a Word document information from an
existing database, a Microsoft Excel worksheet, or another source of data. By
using the Database command on the Insert menu, you can specify the information
you want and automatically insert it as a table in a Word document. You can
screen, or “filter,” the information according to criteria you select. You can also
instruct Word to update the information in the Word documentif the source file
has changed.

[ Data source

 
—
M
M
T
j’
M
T r
—
M '
M ~

'1 Specified inionnation

-u inserted as a Word table_
- '
2
M

Specified information (darker shade)

Word can retrieve information from the following types Of files:

I Files from the following applications that are installed on your system:

Microsoft Accesses MiCf0S0fl EXC61

I Files from single—tier, file-basedidatabase applications for which you have an
open database connectivity (ODBC) driver installed in the System
subdirectory of your Windows directory. ODBC drivers for the following
applications are supplied with Word:

Microsoft FoxProo (or other Xbase
database application such as
dBASEo)

Microsoft Access

Paradoxo
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For a list of file I Files for which you have a file converter installed. In addition to converters for
00"V€"€'5 P'°Vided ASCH text files, Word provides file converters for many applications,

,n from an ‘:’°'gé5°9 including:
: ‘ ap er I . .
~ d_3t3- BY :' . ~ __ -convening Fne Microsoft Word for Windows WordPerfect 5.: for MS-DOS and
e information M ‘:4, :. Fonnam. windows
_Y°u can i 71 Microsoft Word for the Macintosh Microsoft Excel 2.x,2 3.0, 4.0,! and 5.03 .°“ C3" 3'50 ' __- versions 3.x,1 4.x, and 5.x

‘°“’°° me Microsoft Word for MS-DOS 3.0-6.0 Lotus 1-2-3 2;: and 3;:
 

1 Converts only from this fonnat.

- 1 Convener works only with Windows version.

' 3 Convener works only with Macintosh version.

-' - You can also insert infonnation from another Word document. For example, you
. might have set up a membership directory for use as a mail merge data source.

Instead of copying and pasting information from various data records, use the
Database command to insert just the information you request.

 

mm . Inserting the Data

rd table V‘ When you choose the Database command from the Insert menu, Word displays
the Database dialog box. Now you can locate the data source, select the
information you want, and format the table in which the information is displayed.

tem:

nu have an — V

, o - V Once you select the data source, the other
l°Wm8 buttons in the dialog box become available.

er Xbase ' A v_{ By default, Word inserts all of the information from the selected data source.
15 -- most cases, however, you’ll want to use only some of the available information.

_ j{_._ For example, from a large personnel file, you might want to list only the names,
" departments, and hiring dates of all employees who have worked for your

company 10 years or longer.

—- If information in the data source changes frequently and you want to keep your
A document up to date, you can insert the information as a Word field. The field is

‘- ll ‘-1' .'.. simply a “placeholder” that represents the table in your document. For more
2 '~_' information, see “Keeping the Table Information Up to Date,” later in this

_—~- ' ' chapter.
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’ To insert information from a data source as a table
1. Position the insertion point where you want the new table of information to be

included.

From the lnsen menu, choose Database.

Choose the Get Data button.

In the Open Data Source dialog box, type or select the filenarne of the data
source you want to open, and then choose the OK button.

If the data source is not listed, select the appropriate drive and directory or
folder. Then select the appropriate option in the List Files Of Type box.

If you open a Microsoft Excel worksheet, you can insert the entire worksheet
or a range of cells. If you open a Microsoft Access database, you can insert
records from a table or a selection of records defined by a query. For more
information, see the documentation for the application you are using.

To insert specific information from the data source or list the information in a
particular order, choose the Query Options button. Do one or more of the
following, and then choose the OK button.

I On the Filter Records tab, specify criteria to select the data records to
insert.

I On the Sort Records tab, select the data fields by which you want to sort
the information.

I On the Select Fields tab, remove any fields you don’t want from the
Selected Fields list The order of the fields in the list determines the order
in which the fields are inserted left to right.

If you don't want to insert the field names from the header row with the
data records, clear the Include Field Names check box.

. To format the table, choose the Table AutoFormat button.

. Choose the Insert Data button.

In the Insert Data dialog box, you can specify the range of records you want to
insen. The range refers only to the records that were selected by the query. If
you want to be able to update the information in the table automatically, select
the Insert Data As Field check box. Then choose the OK button.

Note If you insert more than 31 data fields, Word insens tab characters to
eparate the colunms of information. 
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Iatiofl [0 be To specify which oi the selected records are
inserted, type starting and ending record
numbers in the From and To boxes.

. . _ Select this check box it you want to
he dam 5.; keep the table intormation up to date.

nary or ’ ' :- =..-'_~ Modifying the table tonnat If you don’! select the Insert Data As Field check box,
box_ - __ ' Word inserts the information as an ordinary table. You can resize the table

’ columns and otherwise modify the table by using the commands on the Table
Noiksheet menu. If you insert the information as a field, however, you must choose the
'1‘ ‘men _ Database command again to reinsen the table and update the table format by
'r more choosing the Table AutoForrnat button. Otherwise, the table formatting you’ve
g‘ . 3‘ -7 applied is removed the next time you update the DATABASE field. Formatting
nation in a _ you’ve applied to text in the table is also removed. For more information, see
of the -' . “Keeping the Table Information Up to Date,” later in this chapter.

_ds to . Modifying the information in the table You may want to modify the information in
' - the table later. For example, you might want to include another colurrm of

information or select a different set of records from the data source. To do this,
I‘ I0 50“ click in the table and then choose the Database command again to select the

_ _ information you want in the table. If you insert the information as a field and then
me _ ' " V- — edit or format the text in the displayed table, your changes will be deleted the next
mg order time you update the DATABASE field. For more information, see “Keeping the

- Table Information Up to Date,” later in this chapter.

‘V"1’ ‘he It Word can’t recognize the field and record delimiters If Word can’! recognize the
characters used to separate data fields and data records in text-delimited files
(files in which data is separated by commas, tab characters, or other characters),

‘ Word asks you to select the separating characters (delimiters). Word recognizes
' . ; ,-‘ one data field delimiter and one data record delimiter. If a combination of two or
'°" want to . L . .1 more characters is used as a delimiter, then the remaining characters are treated as
a‘fi’;r;':lE;[ . text in the data fields.

zttlé
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Selecting the Data
To get only the infonnation you want from a data source, you create a query. A
query is simply a set of instructions, or rules, that describes the information you
want from the data source. You can think of the following statement as a query:

“Give me the names, addresses; and account numbers of all customers who have

not placed orders in the last six months."

The first part of the statement identifies the categories of information you want—
names, addresses, and account numbers. The second pan of the statement
indicates that you want information only for certain customers——those who have
not ordered anything in the last six months.

  
1173140,’

 i - Gellhe delffwelflffi
31j 3 custnng¢y@q tplawdjjjii omen, 1,791,453;/5 ,m,s_

jjjijfi
H115‘.

jéjjjii pmjjimjuig - .
jéjijtji ljjj;
jjjijjg gijj.. .
j;j——j$—; :___:

A query tells Word which infomtalion to select from a data source.

You create queries by selecting options in the Query Options dialog box. You
select data fields to specify the categories of information you want. The order in
which you select the data fields determines the order of the columns of
information in the table, from left to right. To get the information only from
certain data records, you specify one or more rules for selecting the records. To
list the rows of information in a particular order, you can sort the data records.

Select this tab to specify the
categories ot lntonnation in
the table. -

Select this tab to specify the
order information is listed in
the table.

Choose this button to delete
the current rules.

 
Word selects all data records with 'WA" in the data field "Slate."
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Specifying the Record-Selection Rules

On the Filter Records tab, you specify the rules that Word uses to retrieve the
information you want, based on the contents of selected data fields. When
specifying a rule, you can select any data field in the data source—even a data
field you don’t want to include in the table.

A record—selection rule is made up of three parts:

I A field name corresponding to a data. field in the selected data source

I A comparison phrase, such as “Equal T0" or “Is Not Blank” .

0 Text or numbers you want the contents of the data field to be compared with

If you compare text When comparing a data field that contains text, Word
compares the sequence of characters based on the ANSI sorting order. The text
“apple” is considered “less than” the word “berry” because, alphabetically,
“apple" precedes “berry.” Whether the text is uppercase or lowercase isn't
significant.

For example, to retrieve data records for members of your organization whose last
names begin with “A” through “L," you specify the following rule:
LastNarne Is Less Than M

Any name beginning with “A” through “L” is considered less than “M,” so only I
the data records that contain those names are selected. (The last name must be
contained in a separate data field, or else it must precede the first name in the
field—for example, “Bendal, Maria”.)

If you compare numbers mixed with text If numbers are mixed with letters,
hyphens, plus or minus signs, or other nonnumeric characters, Word compares the
numbers as. though they were a sequence of text characters. For example, a five-
digit U.S. ZIP Code is compared as a number, whereas a nine—digit “ZIP-I-4” code
such as 99999-9099 is compared as text, as are non-U.S. postal codes that contain
letters. ,

Comparing sequences of mixed numbers and nonnumeric characters—code
numbers, for example—can have different results if some items contain more

sequential numerals than others. For example, the following items are sorted inthis order:

0002xy, 002, Olly, 1, 1x, lyz, 22x, 2x

> The following items, however, are sorted in this order:

0001, 000lx, 000lyz, 0002, 0002x, 0002xy, 001 ly, 0O22x
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Specifying Multiple Rules
You can specify as many as six selection rules. Using multiple mles allows you to
narrow the range of data records that are selected. When you select multiple rules, _
you must specify AND or OR to connect each additional rule to the preceding
rule, as in the following examples.

Example 1 Example 2 ‘ "
State (Is) Equal To Oregon State (Is) Equal To Oregon 5

AND City (Is) Equal To Portland OR State (15) Equal To California ‘

The rules connected by AND select only data records that contain both “Oregon"
in the State field and “Portland” in the City field. The rules connected by OR
select all data records that contain either “Oregon” or “Califomia” in the State
field—a potentially larger number of records. The key difference between AND
and OR is as follows: «w~t~.._..-1-vyvvvinauxrnu-;
I When you use AND to connect rules, Word selects only those records that

. satisfy both (or all) rules. Each rule connected by AND eliminates more of the
records in the data source.

I When you use OR to connect rules, Word selects any record that satisfies at
least one of the connected rules. Each rule connected by OR selects more of '
the records in the data source.

AND has precedence You can use AND and OR separately or in combination. In
sets of rules that contain both AND and OR, rules connected by AND have
precedence over rules connected by OR. This means that the set of rules
connected by AND is used to select records before the set of mles connected by
OR. How you connect the rules—by using AND or by using OR—affects which
data records are selected.

Suppose you want to select data records of all clients who live in either Portland
or Salem, Oregon. In the Query Options dialog box, you would specify the
following rules to determine the contents of the data fields “City” and “State”:

State (Is) Equal To Oregon

AND City (Is) Equal To Portland
OR State (Is) Equal To Oregon

AND City (Is) Equal To Salem

Using the first set of rules connected by AND, Word compares the data records to‘
identify the clients who live in Portland, Oregon. Next, Word compares the data
records with the next set of mles connected by AND. Word then selects only data
records of clients in Oregon who live in either Portland or Salem.
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